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What Is SAS?

SAS is a set of solutions for enterprise-wide business users as well as a powerful
fourth-generation programming language for performing tasks such as these:

O data entry, retrieval, and management

report writing and graphics

statistical and mathematical analysis

business planning, forecasting, and decision support
operations research and project management

O oo o o

quality improvement
O applications development

With Base SAS software as the foundation, you can integrate with SAS many SAS
business solutions that enable you to perform large scale business functions, such as
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data warehousing and data mining, human resources management and decision
support, financial management and decision support, and others.

Overview of Base SAS Software

The core of the SAS System is Base SAS software, which consists of the following:
SAS language a programming language that you use to manage your data.

SAS procedures  software tools for data analysis and reporting.

macro facility a tool for extending and customizing SAS software programs and for
reducing text in your programs.

DATA step a programming tool that helps you find logic problems in DATA step

debugger programs.

Output Delivery  a system that delivers output in a variety of easy-to-access formats,
System (ODS) such as SAS data sets, listing files, or Hypertext Markup Language
(HTML).

SAS windowing  an interactive, graphical user interface that enables you to easily
environment run and test your SAS programs.

This document, along with SAS Language Reference: Dictionary, covers only the SAS
language. For a complete guide to Base SAS software functionality, also see these
documents: SAS Output Delivery System: User’s Guide, SAS National Language
Support (NLS): User’s Guide, Base SAS Procedures Guide, SAS Metadata LIBNAME
Engine: User’s Guide, SAS XML LIBNAME Engine User’s Guide, Base SAS Glossary,
SAS Macro Language: Reference, and the Getting Started with SAS online tutorial. The
SAS windowing environment is described in the online Help.

Components of the SAS Language

SAS Files

When you work with SAS, you use files that are created and maintained by SAS, as
well as files that are created and maintained by your operating environment, and that
are not related to SAS. Files with formats or structures known to SAS are referred to as
SAS files. All SAS files reside in a SAS data library.

The most commonly used SAS file is a SAS data set. A SAS data set is structured in
a format that SAS can process. Another common type of SAS file is a SAS catalog.
Many different kinds of information that are used in a SAS job are stored in SAS
catalogs, such as instructions for reading and printing data values, or function key
settings that you use in the SAS windowing environment. A SAS stored program is a
type of SAS file that contains compiled code that you create and save for repeated use.

Operating Environment Information: In some operating environments, a SAS data
library is a physical relationship among files; in others, it is a logical relationship. Refer
to the SAS documentation for your operating environment for details about the
characteristics of SAS data libraries in your operating environment. A
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SAS Data Sets

There are two kinds of SAS data sets:
O SAS data file
O SAS data view.

A SAS data file both describes and physically stores your data values. A SAS data
view, on the other hand, does not actually store values. Instead, it is a query that
creates a logical SAS data set that you can use as if it were a single SAS data set. It
enables you to look at data stored in one or more SAS data sets or in other vendors’
software files. SAS data views enable you to create logical SAS data sets without using
the storage space required by SAS data files.

A SAS data set consists of the following:

0 descriptor information

O data values.
The descriptor information describes the contents of the SAS data set to SAS. The data
values are data that has been collected or calculated. They are organized into rows,
called observations, and columns, called variables. An observation is a collection of data

values that usually relate to a single object. A variable is the set of data values that
describe a given characteristic. The following figure represents a SAS data set.

Figure 1.1 Representation of a SAS Data Set

descriptor o .
portion descriptive information
/variables
ID NAME TEAM  STRTWGHT ENDWGHT
1 1023 David Shaw red 189 165
2 1049 Amelia Serrano vellow 145 124 } observation
data
values 3 1219 Alan Nance red 210 192
4 1246 Ravi Sinha vellow 194 177
5 1078 Ashley McKnight red 127 118

Usually, an observation is the data that is associated with an entity such as an
inventory item, a regional sales office, a client, or a patient in a medical clinic.
Variables are characteristics of these entities, such as sale price, number in stock, and
originating vendor. When data values are incomplete, SAS uses a missing value to
represent a missing variable within an observation.

External Files

Data files that you use to read and write data, but which are in a structure unknown
to SAS, are called external files. External files can be used for storing

O raw data that you want to read into a SAS data file
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O SAS program statements
O procedure output.
Operating Environment Information: Refer to the SAS documentation for your

operating environment for details about the characteristics of external files in your
operating environment. A

Database Management System Files

SAS software is able to read and write data to and from other vendors’ software,
such as many common database management system (DBMS) files. In addition to Base

SAS software, you must license the SAS/ACCESS software for your DBMS and
operating environment.

SAS Language Elements

The SAS language consists of statements, expressions, options, formats, and
functions similar to those of many other programming languages. In SAS, you use
these elements within one of two groups of SAS statements:

o DATA steps
o PROC steps.

A DATA step consists of a group of statements in the SAS language that can
read data from external files

O

O write data to external files
O read SAS data sets and data views
O create SAS data sets and data views.

Once your data is accessible as a SAS data set, you can analyze the data and write
reports by using a set of tools known as SAS procedures.

A group of procedure statements is called a PROC step. SAS procedures analyze data
in SAS data sets to produce statistics, tables, reports, charts, and plots, to create SQL
queries, and to perform other analyses and operations on your data. They also provide
ways to manage and print SAS files.

You can also use global SAS statements and options outside of a DATA step or PROC
step.

SAS Macro Facility

Base SAS software includes the SAS Macro Facility, a powerful programming tool for
extending and customizing your SAS programs, and for reducing the amount of code
that you must enter to do common tasks. Macros are SAS files that contain compiled
macro program statements and stored text. You can use macros to automatically
generate SAS statements and commands, write messages to the SAS log, accept input,
or create and change the values of macro variables. For complete documentation, see
SAS Macro Language: Reference.
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Ways to Run Your SAS Session

Starting a SAS Session

You start a SAS session with the SAS command, which follows the rules for other
commands in your operating environment. In some operating environments, you
include the SAS command in a file of system commands or control statements; in
others, you enter the SAS command at a system prompt or select SAS from a menu.

Different Types of SAS Sessions

You can run SAS in any of several different ways that might be available for your
operating environment:

o SAS windowing environment

O interactive line mode

O noninteractive mode

0 batch (or background) mode.
In addition, SAS/ASSIST software provides a menu-driven system for creating and

running your SAS programs. For more information about SAS/ASSIST, see Getting
Started with SAS/ASSIST.

SAS Windowing Environment

In the SAS windowing environment, you can edit and execute programming
statements, display the SAS log, procedure output, and online Help, and more. The
following figure shows the SAS windowing environment.
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Figure 1.2 SAS Windowing Environment
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In the Explorer window, you can view and manage your SAS files, which are stored
in libraries, and create shortcuts to external files. The Results window helps you
navigate and manage output from SAS programs that you submit; you can view, save,
and manage individual output items. You use the Program Editor, Log, and Output
windows to enter, edit, and submit SAS programs, view messages about your SAS
session and programs that you submit, and browse output from programs that you
submit. For more detailed information about the SAS windowing environment, see
Chapter 18, “Introduction to the SAS Windowing Environment,” on page 279.

Interactive Line Mode
In interactive line mode, you enter program statements in sequence in response to
prompts from the SAS System. DATA and PROC steps execute when
o a RUN, QUIT, or a semicolon on a line by itself after lines of data are entered
0 another DATA or PROC statement is entered
0 the ENDSAS statement is encountered.

By default, the SAS log and output are displayed immediately following the program
statements.

Noninteractive Mode

In noninteractive mode, SAS program statements are stored in an external file. The
statements in the file execute immediately after you issue a SAS command referencing
the file. Depending on your operating environment and the SAS system options that you
use, the SAS log and output are either written to separate external files or displayed.
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Operating Environment Information: Refer to the SAS documentation for your
operating environment for information about how these files are named and where they
are stored. A

Batch Mode

You can run SAS jobs in batch mode in operating environments that support batch or
background execution. Place your SAS statements in a file and submit them for
execution along with the control statements and system commands required at your site.

When you submit a SAS job in batch mode, one file is created to contain the SAS log
for the job, and another is created to hold output that is produced in a PROC step or,
when directed, output that is produced in a DATA step by a PUT statement.

Operating Environment Information: Refer to the SAS documentation for your
operating environment for information about executing SAS jobs in batch mode. Also,
see the documentation specific to your site for local requirements for running jobs in
batch and for viewing output from batch jobs. A

Customizing Your SAS Session

Setting Default System Option Settings

You can use a configuration file to store system options with the settings that you
want. When you invoke SAS, these settings are in effect. SAS system options
determine how SAS initializes its interfaces with your computer hardware and the
operating environment, how it reads and writes data, how output appears, and other
global functions.

By placing SAS system options in a configuration file, you can avoid having to specify
the options every time that you invoke SAS. For example, you can specify the NODATE
system option in your configuration file to prevent the date from appearing at the top of
each page of your output.

Operating Environment Information: See the SAS documentation for your operating
environment for more information about the configuration file. In some operating
environments, you can use both a system-wide and a user-specific configuration file. A

Executing Statements Automatically

To execute SAS statements automatically each time you invoke SAS, store them in
an autoexec file. SAS executes the statements automatically after the system is
initialized. You can activate this file by specifying the AUTOEXEC= system option.

Any SAS statement can be included in an autoexec file. For example, you can set
report titles, footnotes, or create macros or macro variables automatically with an
autoexec file.

Operating Environment Information: See the SAS documentation for your operating
environment for information on how autoexec files should be set up so that they can be
located by SAS. A
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Customizing the SAS Windowing Environment

You can customize many aspects of the SAS windowing environment and store your
settings for use in future sessions. With the SAS windowing environment, you can

O

change the appearance and sorting order of items in the Explorer window
customize the Explorer window by registering member, entry, and file types
set up favorite folders

customize the toolbar

O o o o

set fonts, colors, and preferences.

See the SAS online Help for more information and for additional ways to customize
your SAS windowing environment.

Conceptual Information about Base SAS Software

SAS System Concepts

SAS system-wide concepts include the building blocks of SAS language: rules for
words and names, variables, missing values, expressions, dates, times, and intervals,
and each of the six SAS language elements — data set options, formats, functions,
informats, statements, and system options.

SAS system-wide concepts also include introductory information that helps you begin
to use SAS, including information about the SAS log, SAS output, error processing,
WHERE processing, and debugging. Information about SAS processing prepares you to
write SAS programs. Information on how to optimize system performance as well as
how to monitor performance.

DATA Step Concepts

Understanding essential DATA step concepts can help you construct DATA step
programs effectively. These concepts include how SAS processes the DATA step, how to
read raw data to create a SAS data set, and how to write a report with a DATA step.

More advanced concepts include how to combine and modify information once you
have created a SAS data set, how to perform BY-group processing of your data, how to
use array processing for more efficient programming, and how to create stored compiled
DATA step programs.

SAS Files Concepts

SAS file concepts include advanced topics that are helpful for advanced applications,
though not strictly necessary for writing simple SAS programs. These topics include the
elements that comprise the physical file structure that SAS uses, including data
libraries, data files, data views, catalogs, file protection, engines, and external files.

Advanced topics for data files include the audit trail, generation data sets, integrity
constraints, indexes, and file compression. In addition, these topics include compatibility
issues with earlier releases and how to process files across operating environments.
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Definition of SAS Processing

SAS processing is the way that the SAS language reads and transforms input data
and generates the kind of output that you request. The DATA step and the procedure
(PROC) step are the two steps in the SAS language. Generally, the DATA step
manipulates data, and the PROC step analyzes data, produces output, or manages SAS
files. These two types of steps, used alone or combined, form the basis of SAS programs.

The following figure shows a high level view of SAS processing using a DATA step
and a PROC step. The figure focuses primarily on the DATA step.

Figure 2.1 SAS Processing
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You can use different types of data as input to a DATA step. The DATA step is
composed of SAS statements that you write, which contain instructions for processing
the data. As each DATA step in a SAS program is compiling or executing, SAS
generates a log that contains processing messages and error messages. These messages
can help you debug a SAS program.

Types of Input to a SAS Program

You can use different sources of input data in your SAS program:
SAS data sets can be one of two types:

SAS data files store actual data values. A SAS data file consists
of a descriptor portion that describes the data in
the file, and a data portion.

SAS data views  contain references to data stored elsewhere. A
SAS data view uses descriptor information and
data from other files. It allow you to dynamically
combine data from various sources, without
using storage space to create a new data set.
Data views consist of DATA step views, PROC
SQL views, and SAS/ACCESS views. In most
cases, you can use a SAS data view as if it were a
SAS data file.

For more information, see Chapter 28, “SAS Data Files,” on page
481, and Chapter 29, “SAS Data Views,” on page 535.

Raw data specifies unprocessed data that have not been read into a SAS data
set. You can read raw data from two sources:

External files contain records comprised of formatted data
(data are arranged in columns) or free-formatted
data (data that are not arranged in columns).

Instream data is data included in your program. You use the
DATALINES statement at the beginning of your
data to identify the instream data.

For more information about raw data, see Chapter 21, “Reading
Raw Data,” on page 349.

Remote access allows you to read input data from nontraditional sources such as a
TCP/IP socket or a URL. SAS treats this data as if it were coming
from an external file. SAS allows you to access your input data
remotely in the following ways:

SAS catalog specifies the access method that enables you to
reference a SAS catalog as an external file.

FTP specifies the access method that enables you to
use File Transfer Protocol (FTP) to read from or
write to a file from any host machine that is
connected to a network with an FTP server
running.

TCP/IP socket specifies the access method that enables you to
read from or write to a Transmission Control
Protocol/Internet Protocol (TCP/IP) socket.
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URL specifies the access method that enables you to
use the Universal Resource Locator (URL) to
read from and write to a file from any host
machine that is connected to a network with a
URL server running.

For more information about accessing data remotely, see
FILENAME, CATALOG Access Method; FILENAME, FTP Access
Method; FILENAME, SOCKET Access Method; and FILENAME,
URL Access Method statements in the Statements section of SAS
Language Reference: Dictionary.

The DATA Step

The DATA step processes input data. In a DATA step, you can create a SAS data set,
which can be a SAS data file or a SAS data view. The DATA step uses input from raw
data, remote access, assignment statements, or SAS data sets. The DATA step can, for
example, compute values, select specific input records for processing, and use
conditional logic. The output from the DATA step can be of several types, such as a SAS
data set or a report. You can also write data to the SAS log or to an external data file.
For more information about DATA step processing, see Chapter 20, “DATA Step
Processing,” on page 321.

DATA Step Output

The output from the DATA step can be a SAS data set or an external file such as the
program log, a report, or an external data file. You can also update an existing file in
place, without creating a separate data set. Data must be in the form of a SAS data set
to be processed by many SAS procedures. You can create the following types of DATA
step output:

SAS log contains a list of processing messages and program errors. The SAS
log is produced by default.

SAS data file is a SAS data set that contains two parts: a data portion and a data
descriptor portion.

SAS data view is a SAS data set that uses descriptor information and data from
other files. SAS data views allow you to dynamically combine data
from various sources without using disk space to create a new data
set. While a SAS data file actually contains data values, SAS data
views contain only references to data stored elsewhere. SAS data
views are of member type VIEW. In most cases, you can use a SAS
data view as though it were a SAS data file.

External data contains the results of DATA step processing. These files are data or
file text files. The data can be records that are formatted or
free-formatted.

Report contains the results of DATA step processing. Although you usually
generate a report by using a PROC step, you can generate the
following two types of reports from the DATA step:

Listing file contains printed results of DATA step processing,
and usually contains headers and page breaks.
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HTML file contains results that you can display on the
World Wide Web. This type of output is
generated through the Output Delivery System
(ODS). For complete information about ODS, see
SAS Output Delivery System: User’s Guide.

The PROC Step

The PROC step consists of a group of SAS statements that call and execute a
procedure, usually with a SAS data set as input. Use PROCs to analyze the data in a
SAS data set, produce formatted reports or other results, or provide ways to manage
SAS files. You can modify PROCs with minimal effort to generate the output you need.
PROCs can also perform functions such as displaying information about a SAS data set.
For more information about SAS procedures, see Base SAS Procedures Guide.

PROC Step Output

The output from a PROC step can provide univariate descriptive statistics, frequency
tables, cross-tabulation tables, tabular reports consisting of descriptive statistics,
charts, plots, and so on. Output can also be in the form of an updated data set. For
more information about procedure output, see Base SAS Procedures Guide and SAS
Output Delivery System: User’s Guide.
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Words in the SAS Language

Definition of Word

A word or token in the SAS programming language is a collection of characters that
communicates a meaning to SAS and which cannot be divided into smaller units that
can be used independently. A word can contain a maximum of 32,767 characters.

A word or token ends when SAS encounters one of the following:

O the beginning of a new token
O a blank after a name or a number token

O the ending quotation mark of a literal token.

Each word or token in the SAS language belongs to one of four categories:
O names
O literals
0O numbers
O

special characters.
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Types of Words or Tokens
There are four basic types of words or tokens:

name
is a series of characters that begin with a letter or an underscore. Later characters
can include letters, underscores, and numeric digits. A name token can contain up
to 32,767 characters. In most contexts, however, SAS names are limited to a
shorter maximum length, such as 32 or 8 characters. See Table 3.1 on page 19.
Here are some examples of name tokens:

0O data

0O _new

O yearcutoff
O year_ 99

O descending

O n

literal
consists of 1 to 32,767 characters enclosed in single or double quotation marks.
Here are some examples of literals:

O ‘Chicago’

O "1990-91"

O 'Amelia Earhart’

O 'Amelia Earhart’’s plane’

O "Report for the Third Quarter"

Note: The surrounding quotation marks identify the token as a literal, but
SAS does not store these marks as part of the literal token. A

number
in general, is composed entirely of numeric digits, with an optional decimal point
and a leading plus or minus sign. SAS also recognizes numeric values in the
following forms as number tokens: scientific (E-) notation, hexadecimal notation,
missing value symbols, and date and time literals. Here are some examples of
number tokens:

O 5683

0 2.35

0O 0bOx

o -5

O 5.4E-1

0O r24aug90'd

special character
is usually any single keyboard character other than letters, numbers, the
underscore, and the blank. In general, each special character is a single token,
although some two-character operators, such as ** and <=, form single tokens.
The blank can end a name or a number token, but it is not a token. Here are some
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examples of special-character tokens:
o =

o

O

17

Placement and Spacing of Words in SAS Statements

Spacing Requirements

1 You can begin SAS statements in any column of a line and write several
statements on the same line.

2 You can begin a statement on one line and continue it on another line, but you
cannot split a word between two lines.

A blank is not treated as a character in a SAS statement unless it is enclosed in
quotation marks as a literal or part of a literal. Therefore, you can put multiple
blanks any place in a SAS statement where you can put a single blank, with no
effect on the syntax.

The rules for recognizing the boundaries of words or tokens determine the use of
spacing between them in SAS programs. If SAS can determine the beginning of

each token due to cues such as operators, you do not need to include blanks. If
SAS cannot determine the beginning of each token, you must use blanks. See
“Examples” on page 17.

Although SAS does not have rigid spacing requirements, SAS programs are easier to
read and maintain if you consistently indent statements. The examples illustrate useful

spacing conventions.

Examples

0 In this statement, blanks are not required because SAS can determine the

boundary of every token by examining the beginning of the next token:
total=x+y;

The first special-character token, the equal sign, marks the end of the name
token total. The plus sign, another special-character token, marks the end of the
name token x. The last special-character token, the semicolon, marks the end of
the y token. Though blanks are not needed to end any tokens in this example, you
may add them for readability, as shown here:

total = x + y;

This statement requires blanks because SAS cannot recognize the individual
tokens without them:

input group 15 room 20;

Without blanks, the entire statement up to the semicolon fits the rules for a
name token: it begins with a letter or underscore, contains letters, digits, or
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underscores thereafter, and is less than 32,767 characters long. Therefore, this
statement requires blanks to distinguish individual name and number tokens.

Names in the SAS Language

Definition of a SAS Name

A SAS name is a name token that represents

O variables

O 0O oooo oo d

SAS data sets

formats or informats

SAS procedures

options

arrays

statement labels

SAS macros or macro variables
SAS catalog entries

librefs or filerefs.

There are two kinds of names in SAS:

O
O

names of elements of the SAS language
names supplied by SAS users.

Rules for User-Supplied SAS Names

Rules for Most SAS Names

Note: The rules are more flexible for SAS variable names than for other language
elements. See “Rules for SAS Variable Names” on page 20. o

The length of a SAS name depends on the element it is assigned to. Many SAS
names can be 32 characters long; others have a maximum length of 8.

The first character must be a letter (A, B, C, . . ., Z) or underscore (_). Subsequent
characters can be letters, numeric digits (0, 1, . . ., 9), or underscores.

You can use upper or lowercase letters. SAS processes names as uppercase
regardless of how you type them.

4 Blanks cannot appear in SAS names.

5 Special characters, except for the underscore, are not allowed. In filerefs only, you

can use the dollar sign ($), pound sign (#), and at sign (@).

SAS reserves a few names for automatic variables and variable lists, SAS data
sets, and librefs.

a When creating variables, do not use the names of special SAS automatic
variables (for example, _N_ and _ERROR_) or special variable list names (for

s AN _

example, CHARACTER_, NUMERIC_, and _ALL_).
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b When associating a libref with a SAS data library, do not use these:

SASHELP
SASMSG
SASUSER
WORK

¢ When you create SAS data sets, do not use these names:

_NULL_
_DATA_
_LAST_

7 When assigning a fileref to an external file, do not use:

SASCAT

8 When you create a macro variable, do not use names that begin with sys.

Table 3.1 Maximum Length of User-Supplied SAS Names
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SAS Language Element

Maximum Length

Arrays

CALL routines

Catalog entries

DATA step statement labels
DATA step variable labels
DATA step variables
DATA step windows
Engines

Filerefs

Formats, character
Formats, numeric
Functions

Generation data sets
Informats, character
Informats, numeric
Librefs

Macro variables

Macro windows

Macros

Members of SAS data libraries (SAS data sets, views,
catalogs, indexes) except for generation data sets

Passwords

32
16
32
32
256
32
32

31
32
16
28
30
31

32
32
32
32
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SAS Language Element Maximum Length

Procedure names (first 8 characters must be unique, and may 16
not begin with “SAS”)

SCL variables 32

Rules for SAS Variable Names

The rules for SAS variable names have expanded to provide more functionality. The
setting of the VALIDVARNAME-= system option determines what rules apply to the
variables that you can create and process in your SAS session as well as to variables
that you want to read from existing data sets. The VALIDVARNAME= option has three
settings (V7, UPCASE, and ANY), each with varying degrees of flexibility for variable
names:

V7
is the default setting.
Variable name rules are as follows:
1 SAS variable names can be up to 32 characters in length.

2 The first character must begin with an English letter or an underscore.
Subsequent characters can be English letters, numeric digits, or underscores.

3 A variable name cannot contain blanks.

4 A variable name cannot contain any special characters other than the
underscore.

5 A variable name can contain mixed case. Mixed case is remembered and used
for presentation purposes only. (SAS stores the case used in the first
reference to a variable.) When SAS processes variable names, however, it
internally uppercases them. You cannot, therefore, use the same letters with
different combinations of lowercase and uppercase to represent different
variables. For example, cat, Cat, and CAT all represent the same variable.

6 You do not assign the names of special SAS automatic variables (such as _N_
and _ERROR_) or variable list names (such as _NUMERIC_,
_CHARACTER_, and _ALL ) to variables.

UPCASE
is the same as V7, except that variable names are uppercased, as in earlier
versions of SAS.

ANY
1 SAS variable names can be up to 32 characters in length.
2 The name can start with or contain any characters, including blanks.

CAUTION:
Available for Base SAS procedures and SAS/STAT procedures only.
VALIDVARNAME=ANY has been verified for use with only Base SAS
procedures and SAS/STAT procedures. Any other use of this option is
considered experimental and might cause undetected errors. A

Note: If you use any characters other than English letters, numeric digits,
or underscores, then you must express the variable name as a name literal
and you must set VALIDVARNAME=ANY. If you use either the percent sign
(%) or the ampersand (&), then you must use single quotation marks in the
name literal in order to avoid interaction with the SAS Macro Facility. See
“SAS Name Literals” on page 21. 2o
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3 A variable name can contain mixed case. Mixed case is stored and used for
presentation purposes only. (SAS stores the case that is used in the first
reference to a variable.) When SAS processes variable names, however, it
internally uppercases them. Therefore, you cannot use the same letters with
different combinations of lowercase and uppercase to represent different
variables. For example, cat, Cat, and CAT all represent the same variable.

SAS Name Literals

Definition of SAS Name Literals

A SAS name literal is a name token that is expressed as a string within quotation
marks, followed by the letter n. Name literals allow you to use special characters (or
blanks) that are not otherwise allowed in SAS names. Name literals are especially
useful for expressing DBMS column and table names that contain special characters.

Important Restrictions
0 You can use a name literal only for variables, statement labels, and DBMS column
and table names.
o0 You can use name literals in a DATA step or a PROC SQL step only.

0 When the name literal of a variable or DBMS column contains any characters that
are not allowed when VALIDVARNAME=V7, then you must set the system option
VALIDVARNAME=ANY.

0 If you use either the percent sign (%) or the ampersand (&), then you must use
single quotation marks in the name literal in order to avoid interaction with the
SAS Macro Facility.

0 When the name literal of a DBMS table or column contains any characters that
are not valid for SAS rules, then you might need to specify a SAS/ACCESS
LIBNAME statement option.

0 In a quoted string, SAS preserves and uses leading blanks, but SAS ignores and
trims trailing blanks.

Note: For more details and examples about the SAS/ACCESS LIBNAME statement
and about using DBMS table and column names that do not conform to SAS naming
conventions, see SAS/ACCESS for Relational Databases: Reference.

Avoiding Errors When Using Name Literals

For information on how to avoid creating name literals in error, see “Avoiding a
Common Error With Constants” on page 115.

Examples

Examples of SAS name literals are

O input ’'Bob’’s Asset Number’'n;
O input ’'Bob"s Asset Number’n;

O libname foo SAS/ACCESS-engine-name
SAS/ACCESS-engine-connection-options;
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data foo.’My Table'’n;

O input ’‘Amount Budgeted’n ‘Amount Spent’n
'Amount Difference’n;
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What Are the SAS Language Elements?

The major language elements of Base SAS software are as follows:

O 0O o oo o

data set options

formats and informats

functions and CALL routines

Application Response Measurement (ARM) macros
statements

SAS system options

For detailed information on each language element, see SAS Language Reference:
Dictionary.

Data Set Options

Definition of Data Set Option

Data set options specify actions that apply only to the SAS data set with which they
appear. They enable you to perform operations such as these:

O

O
O
O

renaming variables

selecting only the first or last n observations for processing
dropping variables from processing or from the output data set
specifying a password for a data set.

Syntax for Data Set Options

Specify a data set option in parentheses after a SAS data set name. To specify
several data set options, separate them with spaces.

(option-1=value-1<...option-n=value-n>)

These examples show data set options in SAS statements:

data scores(keep=team gamel game2 game3);

proc print data=new(drop=year);

set old(rename=(date=Start_Date));

Using Data Set Options

Using Data Set Options with Input or Qutput SAS Data Sets

Most SAS data set options can apply to either input or output SAS data sets in DATA
steps or procedure (PROC) steps. If a data set option is associated with an input data
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set, the action applies to the data set that is being read. If the option appears in the
DATA statement or after an output data set specification in a PROC step, SAS applies
the action to the output data set. In the DATA step, data set options for output data
sets must appear in the DATA statement, not in any OUTPUT statements that might
be present.

Some data set options, such as COMPRESS=, are meaningful only when you create a
SAS data set because they set attributes that exist for the life of the data set. To
change or cancel most data set options, you must re-create the data set. You can change
other options (such as PW= and LABEL=) with PROC DATASETS. For more
information, see “The DATASETS Procedure” in Base SAS Procedures Guide.

When data set options appear on both input and output data sets in the same DATA
or PROC step, SAS applies data set options to input data sets before it evaluates
programming statements or before it applies data set options to output data sets.
Likewise, data set options that are specified for the data set being created are applied
after programming statements are processed. For example, when using the RENAME=
data set option, the new names are not associated with the variables until the DATA
step ends.

In some instances, data set options conflict when they are used in the same
statement. For example, you cannot specify both the DROP= and KEEP= options for
the same variable in the same statement. Timing can also be an issue in some cases.
For example, if using KEEP= and RENAME= on a data set specified in the SET
statement, KEEP= needs to use the original variable names, because SAS will process
KEEP= before the data set is read. The new names specified in RENAME= will apply
to the programming statements that follow the SET statement.

How Data Set Options Interact with System Options

Many system options and data set options share the same name and have the same
function. System options remain in effect for all DATA and PROC steps in a SAS job or
session, unless they are respecified.

The data set option overrides the system option for the data set in the step in which
it appears. In this example, the OBS= system option in the OPTIONS statement
specifies that only the first 100 observations will be processed from any data set within
the SAS job. The OBS= data set option in the SET statement, however, overrides the
system option for data set TWO and specifies that only the first 5 observations will be
read from data set TWO. The PROC PRINT step prints the data set FINAL. This data
set contains the first 5 observations from data set TWO, followed by the first 100
observations from data set THREE:

options obs=100;
data final;

set two(obs=5) three;

run;

proc print data=final;

run;
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Formats and Informats

Formats

Definition of a Format

A format is an instruction that SAS uses to write data values. You use formats to
control the written appearance of data values, or, in some cases, to group data values
together for analysis. For example, the WORDS22. format, which converts numeric
values to their equivalent in words, writes the numeric value 692 as six hundred
ninety-two.

Syntax of a Format
SAS formats have the following form:
<$>format<w>.<d>

Here is an explanation of the syntax:

$

indicates a character format; its absence indicates a numeric format.

format
names the format. The format is a SAS format or a user-defined format that was
previously defined with the VALUE statement in PROC FORMAT. For more
information on user-defined formats, see “The FORMAT Procedure” in Base SAS
Procedures Guide.

w
specifies the format width, which for most formats is the number of columns in the
output data.

d
specifies an optional decimal scaling factor in the numeric formats.

Formats always contain a period (.) as a part of the name. If you omit the w and the d
values from the format, SAS uses default values. The d value that you specify with a
format tells SAS to display that many decimal places, regardless of how many decimal
places are in the data. Formats never change or truncate the internally stored data
values.

For example, in DOLLAR10.2, the w value of 10 specifies a maximum of 10 columns
for the value. The d value of 2 specifies that two of these columns are for the decimal
part of the value, which leaves eight columns for all the remaining characters in the
value. This includes the decimal point, the remaining numeric value, a minus sign if
the value is negative, the dollar sign, and commas, if any.

If the format width is too narrow to represent a value, then SAS tries to squeeze the
value into the space available. Character formats truncate values on the right.
Numeric formats sometimes revert to the BESTw.d format. SAS prints asterisks if you
do not specify an adequate width. In the following example, the result is x="**,

x=123;
put x=2.;

If you use an incompatible format, such as using a numeric format to write character

values, first SAS attempts to use an analogous format of the other type. If this is not
feasible, then an error message that describes the problem appears in the SAS log.
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Ways to Specify Formats

You can use formats in the following ways:
O in a PUT statement

The PUT statement with a format after the variable name uses a format to
write data values in a DATA step. For example, this PUT statement uses the
DOLLAR. format to write the numeric value for AMOUNT as a dollar amount:

amount=1145.32;
put amount dollarl0.2;

The DOLLARw.d format in the PUT statement produces this result:
$1,145.32

See the “PUT Statement” in SAS Language Reference: Dictionary for more
information.

with the PUT, PUTC, or PUTN functions

The PUT function writes a numeric variable, a character variable, or a constant
with any valid format and returns the resulting character value. For example, the
following statement converts the value of a numeric variable into a two-character
hexadecimal representation:

num=15;
char=put (num, hex2.);

The PUT function creates a character variable named CHAR that has a value of
OF.

The PUT function is useful for converting a numeric value to a character value.
See the “PUT Function” in SAS Language Reference: Dictionary for more
information.

with the %2SYSFUNC macro function

The %SYSFUNC (or %2QSYSFUNC) macro function executes SAS functions or
user-defined functions and applies an optional format to the result of the function
outside a DATA step. For example, the following program writes a numeric value
in a macro variable as a dollar amount.

gmacro tst(amount);
$put %$sysfunc(putn(&amount,dollarl0.2));
gmend tst;

$tst (1154.23);

For more information, see SAS Macro Language: Reference.
in a FORMAT statement in a DATA step or a PROC step.

The FORMAT statement permanently associates a format with a variable. SAS
uses the format to write the values of the variable that you specify. For example,
the following statement in a DATA step associates the COMMAw.d numeric
format with the variables SALES1 through SALES3:

format salesl-sales3 commal0.2;

Because the FORMAT statement permanently associates a format with a
variable, any subsequent DATA step or PROC step uses COMMA10.2 to write the
values of SALES1, SALES2, and SALES3. See the “FORMAT Statement” in SAS
Language Reference: Dictionary for more information.

Note: Formats that you specify in a PUT statement behave differently from
those that you associate with a variable in a FORMAT statement. The major
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difference is that formats that are specified in the PUT statement will preserve
leading blanks. If you assign formats with a FORMAT statement prior to a PUT
statement, all leading blanks are trimmed. The result is the same as if you used
the colon (:) format modifier. For details about using the colon (:) format modifier,
see the “PUT Statement, List” in SAS Language Reference: Dictionary. A

0 in an ATTRIB statement in a DATA step or a PROC step.

The ATTRIB statement can also associate a format, as well as other attributes,
with one or more variables. For example, in the following statement the ATTRIB
statement permanently associates the COMMAw.d format with the variables
SALES1 through SALESS:

attrib salesl-sales3 format=commall.2;

Because the ATTRIB statement permanently associates a format with a
variable, any subsequent DATA step or PROC step uses COMMA10.2 to write the
values of SALES1, SALES2, and SALES3. For more information, see the “ATTRIB
Statement” in SAS Language Reference: Dictionary.

Permanent versus Temporary Association

When you specify a format in a PUT statement, SAS uses the format to write data
values during the DATA step but does not permanently associate the format with a
variable. To permanently associate a format with a variable, use a FORMAT statement
or an ATTRIB statement in a DATA step. SAS permanently associates a format with
the variable by modifying the descriptor information in the SAS data set.

Using a FORMAT statement or an ATTRIB statement in a PROC step associates a
format with a variable for that PROC step, as well as for any output data sets that the
procedure creates that contain formatted variables. For more information on using
formats in SAS procedures, see Base SAS Procedures Guide.

Informats

Definition of an Informat

An informat is an instruction that SAS uses to read data values into a variable. For
example, the following value contains a dollar sign and commas:

$1,000,000

To remove the dollar sign ($) and commas (,) before storing the numeric value 1000000
in a variable, read this value with the COMMA11. informat.

Unless you explicitly define a variable first, SAS uses the informat to determine
whether the variable is numeric or character. SAS also uses the informat to determine
the length of character variables.

Syntax of an Informat
SAS informats have the following form:
<$>informat<w>.<d>

Here is an explanation of the syntax:

$

indicates a character informat; its absence indicates a numeric informat.
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informat
names the informat. The informat is a SAS informat or a user-defined informat
that was previously defined with the INVALUE statement in PROC FORMAT. For
more information on user-defined informats, see “The FORMAT Procedure” in
Base SAS Procedures Guide.

specifies the informat width, which for most informats is the number of columns in
the input data.

specifies an optional decimal scaling factor in the numeric informats. SAS divides
the input data by 10 to the power of d.

Note: Even though SAS can read up to 31 decimal places when you specify some
numeric informats, floating-point numbers with more than 12 decimal places might lose
precision due to the limitations of the eight-byte floating point representation used by
most computers. A

Informats always contain a period (.) as a part of the name. If you omit the w and
the d values from the informat, SAS uses default values. If the data contains decimal
points, SAS ignores the d value and reads the number of decimal places that are
actually in the input data.

If the informat width is too narrow to read all the columns in the input data, you
may get unexpected results. The problem frequently occurs with the date and time
informats. You must adjust the width of the informat to include blanks or special
characters between the day, month, year, or time. For more information about date and
time values, see Chapter 8, “Dates, Times, and Intervals,” on page 127.

When a problem occurs with an informat, SAS writes a note to the SAS log and
assigns a missing value to the variable. Problems occur if you use an incompatible
informat, such as a numeric informat to read character data, or if you specify the width
of a date and time informat that causes SAS to read a special character in the last
column.

Ways to Specify Informats

You can specify informats in the following ways:
O in an INPUT statement
The INPUT statement with an informat after a variable name is the simplest
way to read values into a variable. For example, the following INPUT statement
uses two informats:

input @15 style $3. @21 price 5.2;

The $w. character informat reads values into the variable STYLE. The w.d
numeric informat reads values into the variable PRICE.

For a complete discussion of the “INPUT Statement” , see SAS Language
Reference: Dictionary.

o with the INPUT, INPUTC, and INPUTN functions

The INPUT function reads a SAS character expression using a specified
informat. The informat determines whether the resulting value is numeric or
character. Thus, the INPUT function is useful for converting data. For example,

TempCharacter='98.6";
TemperatureNumber=input (TempCharacter,4.);

Here, the INPUT function in combination with the w.d informat reads the
character value of TempCharacter as a numeric value and assigns the numeric
value 98.6 to TemperatureNumber.
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Use the PUT function with a SAS format to convert numeric values to character
values. See the “PUT Function” in SAS Language Reference: Dictionary for an
example of a numeric-to-character conversion. For a complete discussion of the
“INPUT Function”, see SAS Language Reference: Dictionary.

0 in an INFORMAT statement in a DATA or a PROC step

The INFORMAT statement associates an informat with a variable. SAS uses
the informat in any subsequent INPUT statement to read values into the variable.
For example, in the following statements the INFORMAT statement associates the
DATEw. informat with the variables Birthdate and Interview:

informat Birthdate Interview date9.;
input @63 Birthdate Interview;

An informat that is associated with an INFORMAT statement behaves like an
informat that you specify with a colon (:) format modifier in an INPUT statement.
(For details about using the colon () modifier, see the “INPUT Statement, List” in
SAS Language Reference: Dictionary.) Therefore, SAS uses a modified list input to
read the variable so that

0 the w value in an informat does not determine column positions or input field

widths in an external file

O the blanks that are embedded in input data are treated as delimiters unless

you change the DELIMITER= option in an INFILE statement

o for character informats, the w value in an informat specifies the length of

character variables

0 for numeric informats, the w value is ignored

0 for numeric informats, the d value in an informat behaves in the usual way
for numeric informats

If you have coded the INPUT statement to use another style of input, such as
formatted input or column input, that style of input is not used when you use the
INFORMAT statement.

See the “INPUT Statement, List” in SAS Language Reference: Dictionary for
more information about how to use modified list input to read data.

0 in an ATTRIB statement in a DATA or a PROC step.

The ATTRIB statement can also associate an informat, as well as other
attributes, with one or more variables. For example, in the following statements,
the ATTRIB statement associates the DATEw. informat with the variables
Birthdate and Interview:

attrib Birthdate Interview informat=date9.;
input @63 Birthdate Interview;

An informat that is associated by using the INFORMAT= option in the ATTRIB
statement behaves like an informat that you specify with a colon (:) format
modifier in an INPUT statement. (For details about using the colon (:) modifier,
see the “INPUT Statement, List” in SAS Language Reference: Dictionary.)
Therefore, SAS uses a modified list input to read the variable in the same way as
it does for the INFORMAT statement.

See the “ATTRIB Statement” in SAS Language Reference: Dictionary for more
information.

Permanent versus Temporary Association

When you specify an informat in an INPUT statement, SAS uses the informat to read
input data values during that DATA step. SAS, however, does not permanently associate
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the informat with the variable. To permanently associate a format with a variable, use
an INFORMAT statement or an ATTRIB statement. SAS permanently associates an
informat with the variable by modifying the descriptor information in the SAS data set.

User-Defined Formats and Informats

In addition to the formats and informats that are supplied with Base SAS software,
you can create your own formats and informats. In Base SAS software, PROC FORMAT
allows you to create your own formats and informats for both character and numeric
variables.

When you execute a SAS program that uses user-defined formats or informats, these
formats and informats should be available. The two ways to make these formats and
informats available are

O to create permanent, not temporary, formats or informats with PROC FORMAT

O to store the source code that creates the formats or informats (the PROC FORMAT
step) with the SAS program that uses them.

To create permanent SAS formats and informats, see “The FORMAT Procedure” in Base
SAS Procedures Guide.

If you execute a program that cannot locate a user-defined format or informat, the
result depends on the setting of the FMTERR system option. If the user-defined format
or informat is not found, then these system options produce these results:

System option Results

FMTERR SAS produces an error that causes the current DATA or
PROC step to stop.

NOFMTERR SAS continues processing and substitutes a default format,
usually the BESTw. or $w. format.

Although using NOFMTERR enables SAS to process a variable, you lose the
information that the user-defined format or informat supplies.

To avoid problems, make sure that your program has access to all of the user-defined
formats and informats that are used in the program.

Byte Ordering for Integer Binary Data on Big Endian and Little Endian
Platforms

Definitions

Integer values for binary integer data are typically stored in one of three sizes:
one-byte, two-byte, or four-byte. The ordering of the bytes for the integer varies
depending on the platform (operating environment) on which the integers were
produced.

The ordering of bytes differs between the “big endian” and “little endian” platforms.
These colloquial terms are used to describe byte ordering for IBM mainframes (big
endian) and for Intel-based platforms (little endian). In SAS, the following platforms
are considered big endian: AIX, HP-UX, IBM mainframe, Macintosh, and Solaris. The
following platforms are considered little endian: OpenVMS Alpha, Digital UNIX, Intel
ABI, and Windows.
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How Bytes Are Ordered

On big endian platforms, the value 1 is stored in binary and is represented here in
hexadecimal notation. One byte is stored as 01, two bytes as 00 01, and four bytes as 00
00 00 01. On little endian platforms, the value 1 is stored in one byte as 01 (the same
as big endian), in two bytes as 01 00, and in four bytes as 01 00 00 00.

If an integer is negative, the “two’s complement” representation is used. The
high-order bit of the most significant byte of the integer will be set on. For example, —2
would be represented in one, two, and four bytes on big endian platforms as FE, FF FE,
and FF FF FF FE respectively. On little endian platforms, the representation would be
FE, FE FF, and FE FF FF FF. These representations result from the output of the
integer binary value —2 expressed in hexadecimal representation.

Writing Data Generated on Big Endian or Little Endian Platforms

SAS can read signed and unsigned integers regardless of whether they were
generated on a big endian or a little endian system. Likewise, SAS can write signed
and unsigned integers in both big endian and little endian format. The length of these
integers can be up to eight bytes.

The following table shows which format to use for various combinations of platforms.
In the Sign? column, “no” indicates that the number is unsigned and cannot be
negative. “Yes” indicates that the number can be either negative or positive.

Table 4.1 SAS Formats and Byte Ordering

Data created Data written Sign? Format/Informat

for... by...

big endian big endian yes IB or S370FIB

big endian big endian no PIB, S370FPIB,
S370FIBU

big endian little endian yes S370FIB

big endian little endian no S370FPIB

little endian big endian yes IBR

little endian big endian no PIBR

little endian little endian yes IB or IBR

little endian little endian no PIB or PIBR

big endian either yes S370FIB

big endian either no S370FPIB

little endian either yes IBR

little endian either no PIBR

Integer Binary Notation and Different Programming Languages

The following table compares integer binary notation according to programming

language.
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Table 4.2 Integer Binary Notation and Programming Languages

Language 2 Bytes 4 Bytes

SAS 1B2., IBR2., PIB2., PIBR2,, IB4., IBR4., PIB4., PIBR4.,
S370FIB2., S370FIBU2., S370FIB4., S370FIBU4.,
S370FPIB2. S370FPIB4.

PL/I FIXED BIN(15) FIXED BIN(31)

FORTRAN INTEGER*2 INTEGER*4

COBOL COMP PIC 9(4) COMP PIC 9(8)

IBM assembler H F

C short long

Working with Packed Decimal and Zoned Decimal Data

Definitions

Packed decimal  specifies a method of encoding decimal numbers by using each byte
to represent two decimal digits. Packed decimal representation
stores decimal data with exact precision. The fractional part of the
number is determined by the informat or format because there is no
separate mantissa and exponent.

An advantage of using packed decimal data is that exact precision
can be maintained. However, computations involving decimal data
might become inexact due to the lack of native instructions.

Zoned decimal specifies a method of encoding decimal numbers in which each digit
requires one byte of storage. The last byte contains the number’s
sign as well as the last digit. Zoned decimal data produces a
printable representation.

Nibble specifies 1/2 of a byte.

Packed Decimal Data

A packed decimal representation stores decimal digits in each “nibble” of a byte.
Each byte has two nibbles, and each nibble is indicated by a hexadecimal digit. For
example, the value 15 is stored in two nibbles, using the hexadecimal digits 1 and 5.

The sign indication is dependent on your operating environment. On IBM
mainframes, the sign is indicated by the last nibble. With formats, C indicates a
positive value, and D indicates a negative value. With informats, A, C, E, and F
indicate positive values, and B and D indicate negative values. Any other nibble is
invalid for signed packed decimal data. In all other operating environments, the sign is
indicated in its own byte. If the high-order bit is 1, then the number is negative.
Otherwise, it is positive.

The following applies to packed decimal data representation:

0 You can use the S370FPD format on all platforms to obtain the IBM mainframe
configuration.
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o0 You can have unsigned packed data with no sign indicator. The packed decimal
format and informat handles the representation. It is consistent between ASCII
and EBCDIC platforms.

0 Note that the S370FPDU format and informat expects to have an F in the last
nibble, while packed decimal expects no sign nibble.

Zoned Decimal Data

The following applies to zoned decimal data representation:

O A zoned decimal representation stores a decimal digit in the low order nibble of
each byte. For all but the byte containing the sign, the high-order nibble is the
numeric zone nibble (F on EBCDIC and 3 on ASCII).

0 The sign can be merged into a byte with a digit, or it can be separate, depending
on the representation. But the standard zoned decimal format and informat
expects the sign to be merged into the last byte.

0 The EBCDIC and ASCII zoned decimal formats produce the same printable
representation of numbers. There are two nibbles per byte, each indicated by a
hexadecimal digit. For example, the value 15 is stored in two bytes. The first byte
contains the hexadecimal value F1 and the second byte contains the hexadecimal
value C5.

Packed Julian Dates

The following applies to packed Julian dates:

0 The two formats and informats that handle Julian dates in packed decimal
representation are PDJULI and PDJULG. PDJULI uses the IBM mainframe year
computation, while PDJULG uses the Gregorian computation.

0 The IBM mainframe computation considers 1900 to be the base year, and the year
values in the data indicate the offset from 1900. For example, 98 means 1998, 100
means 2000, and 102 means 2002. 1998 would mean 3898.

0 The Gregorian computation allows for 2-digit or 4-digit years. If you use 2-digit
years, SAS uses the setting of the YEARCUTOFF= system option to determine the
true year.

Platforms Supporting Packed Decimal and Zoned Decimal Data

Some platforms have native instructions to support packed and zoned decimal data,
while others must use software to emulate the computations. For example, the IBM
mainframe has an Add Pack instruction to add packed decimal data, but the
Intel-based platforms have no such instruction and must convert the decimal data into
some other format.

Languages Supporting Packed Decimal and Zoned Decimal Data

Several different languages support packed decimal and zoned decimal data. The
following table shows how COBOL picture clauses correspond to SAS formats and
informats.

IBM VS COBOL II clauses Corresponding S370Fxxx
formats/informats

PIC S9(X) PACKED-DECIMAL S370FPDw.

PIC 9(X) PACKED-DECIMAL S370FPDUw.

PIC S9(W) DISPLAY S370FZDw.
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IBM VS COBOL II clauses Corresponding S370Fxxx
formats/informats

PIC 9(W) DISPLAY S370FZDUw.

PIC S9(W) DISPLAY SIGN LEADING S370FZDLw.

PIC S9(W) DISPLAY SIGN LEADING SEPARATE S370FZDSw.

PIC S9(W) DISPLAY SIGN TRAILING SEPARATE S370FZDTw.

For the packed decimal representation listed above, X indicates the number of digits
represented, and W is the number of bytes. For PIC S9(X) PACKED-DECIMAL, W is
ceil ((x+1)/2). For PIC 9(X) PACKED-DECIMAL, W is ceil (x/2). For example,
PIC S9(5) PACKED-DECIMAL represents five digits. If a sign is included, six nibbles
are needed. ceil ((5+1)/2) has a length of three bytes, and the value of W is 3.

Note that you can substitute COMP-3 for PACKED-DECIMAL.

In IBM assembly language, the P directive indicates packed decimal, and the Z
directive indicates zoned decimal. The following shows an excerpt from an assembly
language listing, showing the offset, the value, and the DC statement:

offset value (in hex) inst label directive

+000000 00001C 2 PEX1 DC PL3'1’
+000003 00001D 3 PEX2 DC PL3'-1"
+000006 FOFOC1 4 ZEX1 DC ZL3'1’
+000009 FOFOD1 5 ZEX2 DC ZL3'1’

In PL/I, the FIXED DECIMAL attribute is used in conjunction with packed decimal
data. You must use the PICTURE specification to represent zoned decimal data. There
is no standardized representation of decimal data for the FORTRAN or the C languages.

Summary of Packed Decimal and Zoned Decimal Formats and Informats

SAS uses a group of formats and informats to handle packed and zoned decimal data.
The following table lists the type of data representation for these formats and
informats. Note that the formats and informats that begin with S370 refer to IBM
mainframe representation.

Format Type of data Corresponding Comments
representation informat

PD Packed decimal PD Local signed packed decimal

PK Packed decimal PK Unsigned packed decimal; not
specific to your operating
environment

7D Zoned decimal 7D Local zoned decimal

none Zoned decimal ZDB Translates EBCDIC blank

(hex 40) to EBCDIC zero (hex
F0), then corresponds to the
informat as zoned decimal

none Zoned decimal ZDV Non-IBM zoned decimal
representation
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Format

Type of data
representation

Corresponding

informat

Comments

S370FPD

S370FPDU

S370FZD

S370FZDU

S370FZDL

S370FZDS

S370FZDT

PDJULI

PDJULG

none

none

none

none

none

Packed decimal

Packed decimal

Zoned decimal

Zoned decimal

Zoned decimal

Zoned decimal

Zoned decimal

Packed decimal

Packed decimal

Packed decimal

Packed decimal

Packed decimal

Packed decimal
Packed decimal

S370FPD

S370FPDU

S370FZD

S370FZDU

S370FZDL

S370FZDS

S370FZDT

PDJULI

PDJULG

RMFDUR

SHRSTAMP

SMFSTAMP

PDTIME
RMFSTAMP

Last nibble C (positive) or D
(negative)

Last nibble always F
(positive)

Last byte contains sign in
upper nibble: C (positive) or
D (negative)

Unsigned; sign nibble always
F

Sign nibble in first byte in
informat; separate leading
sign byte of hex CO (positive)
or DO (negative) in format

Leading sign of - (hex 60) or +
(hex 4E)

Trailing sign of - (hex 60) or +
(hex 4E)

Julian date in packed
representation - IBM
computation

Julian date in packed
representation - Gregorian
computation

Input layout is: mmsstétF

Input layout is:
yyyydddFhhmmssth, where
yyyydddF is the packed
Julian date; yyyy is a 0-based
year from 1900

Input layout is:
xxxxxxxxyyyydddF, where
yyyydddF is the packed
Julian date; yyyy is a 0-based
year from 1900

Input layout is: OhhmmssF

Input layout is:
OhhmmssFyyyydddF, where
yyyydddF is the packed
Julian date; yyyy is a 0-based
year from 1900
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Data Conversions and Encodings

An encoding maps each character in a character set to a unique numeric
representation, resulting in a table of all code points. A single character can have
different numeric representations in different encodings. For example, the ASCII
encoding for the dollar symbol $ is 24hex. The Danish EBCDIC encoding for the dollar
symbol $ is 67hex. In order for a version of SAS that normally uses ASCII to properly
interpret a data set that is encoded in Danish EBCDIC, the data must be transcoded.

Transcoding is the process of moving data from one encoding to another. When
transcoding the ASCII dollar sign to the Danish EBCDIC dollar sign, the hex
representation for the character is converted from the value 24 to a 67.

If you want to know what the encoding of a particular SAS data set is, for SAS 9 and
above follow these steps:

1 Locate the data set with SAS Explorer.
2 Right-click the data set.

3 Select Properties from the menu.

4 Click the Details tab.
5

The encoding of the data set is listed, along with other information.

Some situations where data might commonly be transcoded are:

0O when you share data between two different SAS sessions that are running in
different locales or in different operating environments,

0O when you perform text-string operations, such as converting to uppercase or
lowercase,

0O when you display or print characters from another language,
o when you copy and paste data between SAS sessions running in different locales.
For more information on SAS features designed to handle data conversions from

different encodings or operating environments, see SAS National Language Support
(NLS): User’s Guide.

Functions and CALL Routines

Definitions of Functions and CALL Routines

Definition of Functions

A SAS function performs a computation or system manipulation on arguments and
returns a value. Most functions use arguments supplied by the user, but a few obtain
their arguments from the operating environment.

In Base SAS software, you can use SAS functions in DATA step programming
statements, in a WHERE expression, in macro language statements, in PROC
REPORT, and in Structured Query Language (SQL).

Some statistical procedures also use SAS functions. In addition, some other SAS
software products offer functions that you can use in the DATA step. Refer to the
documentation that pertains to the specific SAS software product for additional
information about these functions.
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Definition of CALL Routines

A CALL routine alters variable values or performs other system functions. CALL
routines are similar to functions, but differ from functions in that you cannot use them
in assignment statements.

All SAS CALL routines are invoked with CALL statements; that is, the name of the
routine must appear after the keyword CALL on the CALL statement.

Syntax of Functions and CALL Routines

Syntax of Functions
The syntax of a function is as follows:
function-name (argument-1<...,argument-n>)
function-name (OF variable-list)
function-name (OF array-name{*})
Here is an explanation of the syntax:

function-name
names the function.

argument
can be a variable name, constant, or any SAS expression, including another
function. The number and kind of arguments that SAS allows are described with
individual functions. Multiple arguments are separated by a comma.

Tip: If the value of an argument is invalid (for example, missing or outside the
prescribed range), then SAS writes a note to the log indicating that the
argument is invalid, sets _ERROR_ to 1, and sets the result to a missing value.

Examples:

O x=max(cash,credit);

O x=sqrt(1500);

O NewCity=left(upcase(City));

O x=min(YearTemperature-July,YearTemperature-Dec);
O s=repeat(’'----+',16);

O x=min((enroll-drop), (enroll-fail));

O dollars=int(cash);

O if sum(cash,credit)>1000 then
put ’Goal reached’;

variable-list
can be any form of a SAS variable list, including individual variable names. If
more than one variable list appears, separate them with a space or with a comma
and another OF.
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Examples:

O a=sum(of x y 2z2);

0 The following two examples are equivalent.
0O a=sum(of x1-x10 yl-yl0 zl-z10);
a=sum(of x1-x10, of yl-yl0, of z1-z10);
O z=sum(of yl-yl0);

array-name{*}
names a currently defined array. Specifying an array in this way causes SAS to
treat the array as a list of the variables instead of processing only one element of
the array at a time.

Examples:

O array y{10} yl-yl1l0;
x=sum(of y{*});

Syntax of CALL Routines

The syntax of a CALL routine is as follows:

CALL routine-name (argument-1<, ... argument-n>),

CALL routine-name (OF variable-list);

CALL routine-name (argument-1 | OF variable-list-1 <, ...argument-n | OF
variable-list-n>);

Here is an explanation of the syntax:

routine-name
names a SAS CALL routine.

argument
can be a variable name, a constant, any SAS expression, an external module
name, an array reference, or a function. Multiple arguments are separated by a
comma. The number and kind of arguments that are allowed are described with
individual CALL routines in the SAS Language Reference: Dictionary.
Examples:

O call rxsubstr(rx,string,position);
O call set(dsid);

O call ranbin(Seed 1,n,p,X1);

O call label(abc{j},lab);

variable-list
can be any form of a SAS variable list, including variable names. If more than one
variable list appears, separate them with a space or with a comma and another OF.
Examples:
O call cats(inventory, of yl-yl5, of zl-z15);
call catt(of iteml7-item23 packl7-pack23);

Using Functions

Restrictions on Function Arguments

If the value of an argument is invalid, then SAS prints an error message and sets the
result to a missing value. Here are some common restrictions on function arguments:
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0 Some functions require that their arguments be restricted within a certain range.
For example, the argument of the LOG function must be greater than 0.

0 Most functions do not permit missing values as arguments. Exceptions include
some of the descriptive statistics functions and financial functions.

0 In general, the allowed range of the arguments is platform-dependent, such as

with the EXP function.

o For some probability functions, combinations of extreme values can cause

convergence problems.

Notes on Descriptive Statistic Functions

SAS provides functions that return descriptive statistics. Except for the MISSING
function, the functions correspond to the statistics produced by the MEANS procedure.

The computing method for each statistic is discussed in “SAS Elementary Statistics
Procedures” in Base SAS Procedures Guide. SAS calculates descriptive statistics for the

nonmissing values of the arguments.

Notes on Financial Functions

SAS provides a group of functions that perform financial calculations. The functions

are grouped into the following types:

Table 4.3 Types of Financial Functions

Function type Functions

Description

Cashflow CONVX, CONVXP
DUR, DURP
PVP, YIELDP
Parameter calculations COMPOUND
MORT
Internal rate of return INTRR, IRR
Net present and future NETPV, NPV
value
SAVING
Depreciation DACCxx
DEPxxx

calculates convexity for cashflows
calculates modified duration for cashflows

calculates present value and
yield-to-maturity for a periodic cashflow

calculates compound interest parameters
calculates amortization parameters
calculates the internal rate of return

calculates net present and future values

calculates the future value of periodic
saving

calculates the accumulated depreciation up
to the specified period

calculates depreciation for a single period

Special Considerations for Depreciation Functions

The period argument for depreciation functions can be fractional for all of the
functions except DEPDBSL and DACCDBSL. For fractional arguments, the
depreciation is prorated between the two consecutive time periods preceding and

following the fractional period.
CAUTION:

Verify the depreciation method for fractional periods. You must verify whether this
method is appropriate to use with fractional periods because many depreciation
schedules, specified as tables, have special rules for fractional periods. A
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Using DATA Step Functions within Macro Functions

The macro functions %SYSFUNC and %QSYSFUNC can call DATA step functions to
generate text in the macro facility. %SYSFUNC and %QSYSFUNC have one difference:
%QSYSFUNC masks special characters and mnemonics and %SYSFUNC does not. For
more information on these functions, see %2QSYSFUNC and %SYSFUNC in SAS Macro
Language: Reference.

%SYSFUNC arguments are a single DATA step function and an optional format, as
shown in the following examples:

$sysfunc(date(),worddate.)
$sysfunc(attrn(&dsid,NOBS))

You cannot nest DATA step functions within %SYSFUNC. However, you can nest
%SYSFUNC functions that call DATA step functions. For example:

$sysfunc(compress(%sysfunc(getoption(sasautos)),
gsStr(%)%(%')));

All arguments in DATA step functions within %SYSFUNC must be separated by
commas. You cannot use argument lists that are preceded by the word OF.

Because %SYSFUNC is a macro function, you do not need to enclose character values
in quotation marks as you do in DATA step functions. For example, the arguments to
the OPEN function are enclosed in quotation marks when you use the function alone,
but the arguments do not require quotation marks when used within %SYSFUNC.

dsid=open("sasuser.houses","i");
dsid=open("&mydata", "&mode");

%let dsid=%sysfunc(open(sasuser.houses,i));
%let dsid=%sysfunc(open(&mydata,&mode));

You can use these functions to call all of the DATA step SAS functions except those
that pertain to DATA step variables or processing. These prohibited functions are: DIF,
DIM, HBOUND, INPUT, IORCMSG, LAG, LBOUND, MISSING, PUT, RESOLVE,
SYMGET, and all of the variable information functions (for example, VLABEL).

Using Functions to Manipulate Files

SAS manipulates files in different ways, depending on whether you use functions or
statements. If you use functions such as FOPEN, FGET, and FCLOSE, you have more
opportunity to examine and manipulate your data than when you use statements such
as INFILE, INPUT, and PUT.

When you use external files, the FOPEN function allocates a buffer called the File
Data Buffer (FDB) and opens the external file for reading or updating. The FREAD
function reads a record from the external file and copies the data into the FDB. The
FGET function then moves the data to the DATA step variables. The function returns a
value that you can check with statements or other functions in the DATA step to
determine how to further process your data. After the records are processed, the
FWRITE function writes the contents of the FDB to the external file, and the FCLOSE
function closes the file.

When you use SAS data sets, the OPEN function opens the data set. The FETCH
and FETCHOBS functions read observations from an open SAS data set into the Data
Set Data Vector (DDV). The GETVARC and GETVARN functions then move the data to
DATA step variables. The functions return a value that you can check with statements
or other functions in the DATA step to determine how you want to further process your
data. After the data is processed, the CLOSE function closes the data set.
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For complete descriptions and examples, see the functions and CALL routines in SAS
Language Reference: Dictionary.

Using Random-Number Functions and CALL Routines

Seed Values

Random-number functions and CALL routines generate streams of random numbers
from an initial starting point, called a seed, that either the user or the computer clock
supplies. A seed must be a nonnegative integer with a value less than 2”1 (or
2,147,483,647). If you use a positive seed, you can always replicate the stream of
random numbers by using the same DATA step. If you use zero as the seed, the
computer clock initializes the stream, and the stream of random numbers is not
replicable.

Each random-number function and CALL routine generates pseudo-random numbers
from a specific statistical distribution. Every random-number function requires a seed
value expressed as an integer constant, or a variable that contains the integer constant.
Every CALL routine calls a variable that contains the seed value. Additionally, every
CALL routine requires a variable that contains the generated random numbers.

The seed variable must be initialized prior to the first execution of the function or
CALL routine. After each execution of a function, the current seed is updated
internally, but the value of the seed argument remains unchanged. After each iteration
of the CALL routine, however, the seed variable contains the current seed in the stream
that generates the next random number. With a function, it is not possible to control
the seed values, and, therefore, the random numbers after the initialization.

Comparison of Random-Number Functions and CALL Routines

Except for the NORMAL and UNIFORM functions, which are equivalent to the
RANNOR and RANUNTI functions, respectively, SAS provides a CALL routine that has
the same name as each random-number function. Using CALL routines gives you
greater control over the seed values.

With a CALL routine, you can generate multiple streams of random numbers within
a single DATA step. If you supply a different seed value to initialize each of the seed
variables, the streams of the generated random numbers are computationally
independent. With a function, however, you cannot generate more than one stream by
supplying multiple seeds within a DATA step. The following two examples illustrate the
difference.

Example 1: Generating Multiple Streams from a CALL Routine

This example uses the CALL RANUNI routine to generate three streams of random
numbers from the uniform distribution, with ten numbers each. See the results in
Output 4.1.

options nodate pageno=1 linesize=80 pagesize=60;

data multiple(drop=1i);
retain Seed 1 1298573062 Seed 2 447801538
Seed_3 631280;
do i=1 to 10;
call ranuni (Seed_1,X1);
call ranuni (Seed_2,X2);
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call ranuni (Seed_3,X3);

output;

end;

run;

proc print data=multiple;
title 'Multiple Streams from a CALL Routine’;

run;
Output 4.1 The CALL Routine Example
Multiple Streams from a CALL Routine

Obs Seed_1 Seed_2 Seed_3 X1 X2 X3
1 1394231558 512727191 367385659 0.64924 0.23876 0.17108
2 1921384255 1857602268 1297973981 0.89471 0.86501 0.60442
3 902955627 422181009 188867073 0.42047 0.19659 0.08795
4 440711467 761747298 379789529 0.20522 0.35472 0.17685
5 1044485023 1703172173 591320717 0.48638 0.79310 0.27536
6 2136205611 2077746915 870485645 0.99475 0.96753 0.40535
7 1028417321 1800207034 1916469763 0.47889 0.83829 0.89243
8 1163276804 473335603 753297438 0.54169 0.22041 0.35078
9 176629027 1114889939 2089210809 0.08225 0.51916 0.97286
10 1587189112 399894790 284959446 0.73909 0.18622 0.13269

Example 2: Assigning Values from a Single Stream to Multiple Variables

Using the same three seeds that were used in Example 1, this example uses a

function to create three variables. The results that are produced are different from
those in Example 1 because the values of all three variables are generated by the first
seed. When you use an individual function more than once in a DATA step, the function

accepts only the first seed value that you supply and ignores the rest.

options nodate pageno=1 linesize=80 pagesize=60;

data single(drop=i);

do i=1 to 3;

Yl=ranuni(1298573062);
Y2=ranuni(447801538);
Y3=ranuni(631280);

output;

end;

run;

proc print data=single;

title 'A Single Stream across Multiple Variables’;

run;

The following output shows the results. The values of Y1, Y2, and Y3 in this example
come from the same random-number stream generated from the first seed. You can see

this by comparing the values by observation across these three variables with the
values of X1 in Output 4.2.
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Output 4.2 The Function Example

A Single Stream across Multiple Variables 1
Obs Y1 Y2 Y3
1 0.64924 0.89471 0.42047
2 0.20522 0.48638 0.99475
3 0.47889 0.54169 0.08225

Pattern Matching Using SAS Regular Expressions (RX) and Perl
Regular Expressions (PRX)

Definition of Pattern Matching and Regular Expressions

Pattern matching enables you to search for and extract multiple matching patterns
from a character string in one step, as well as to make several substitutions in a string
in one step. The DATA step supports two kinds of pattern-matching functions and
CALL routines:

0 SAS regular expressions (RX)
o Perl regular expressions (PRX).

Regular expressions are a pattern language which provides fast tools for parsing
large amounts of text. Regular expressions are composed of characters and special
characters that are called metacharacters.

The asterisk (*) and the question mark (?) are two examples of metacharacters. The
asterisk (*) matches zero or more characters, and the question mark (?) matches one or
zero characters. For example, if you issue the 1s data*.txt command from a UNIX
shell prompt, UNIX displays all the files in the current directory that begin with the
letters “data” and end with the file extension “txt.”

The asterisk (*) and the question mark (?) are a limited form of regular expressions.
Perl regular expressions build on the asterisk and the question mark to make searching
more powerful and flexible.

Definition of SAS Regular Expression (RX) Functions and CALL Routines

SAS Regular expression (RX) functions and CALL routines refers to a group of
functions and CALL routines that uses SAS’ regular expression pattern matching to
parse character strings. You can search for character strings that have a specific
pattern that you specify, and change a matched substring to a different substring.

SAS regular expressions consist of CALL RXCHANGE, CALL RXFREE, CALL
RXSUBSTR, RXMATCH, and RXPARSE, and are part of the character string matching
category for functions and CALL routines. For more information on these functions and
CALL routines, see SAS Language Reference: Dictionary.

Definition of Perl Regular Expression (PRX) Functions and CALL Routines

Perl regular expression (PRX) functions and CALL routines refers to a group of
functions and CALL routines that uses a modified version of Perl as a pattern matching
language to parse character strings. PRX functions enable you to do the following:

O search for a pattern of characters within a string
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O extract a substring from a string
O search and replace text with other text

O parse large amounts of text, such as Web logs or other text data, more quickly
than with SAS regular expressions.

Perl regular expressions consist of CALL PRXCHANGE, CALL PRXDEBUG, CALL
PRXFREE, CALL PRXNEXT, CALL PRXPOSN, CALL PRXSUBSTR, PRXPAREN,
PRXMATCH, and PRXPARSE, and are part of the character string matching category
for functions and CALL routines. For more information on these functions and CALL
routines, see SAS Language Reference: Dictionary.

Benefits of Using Perl Regular Expressions in the DATA Step

Using Perl regular expressions in the DATA step enhances search and replace
options in text. You can use Perl regular expressions to do the following:

o validate data

O replace text

O extract a substring from a string

0 write Perl debug output to the SAS log.

You can write SAS programs that do not use regular expressions to produce the same
results as you do when you use Perl regular expressions. The code without the regular
expressions, however, requires more function calls to handle character positions in a
string and to manipulate parts of the string.

Perl regular expressions combine most, if not all, of these steps into one expression.
The resulting code has the following advantages.

O less prone to error

O easier to maintain

O clearer to read

0 more efficient in terms of improving system performance.

Using Perl Regular Expressions in the DATA Step - License Agreement

The following paragraph complies with sections 3 (a) and 4 (¢) of the artistic license:

The PRX functions use a modified version of Perl 5.6.1 to perform regular expression
compilation and matching. Perl is compiled into a library for use with SAS. The
modified and original Perl 5.6.1 files are freely available from the SAS Web site at http:/
/support.sas.com/rnd/base. Each of the modified files has a comment block at the top of
the file describing how and when the file was changed. The executables were given
non-standard Perl names. The standard version of Perl can be obtained from http://
www.perl.com.

Only Perl regular expressions are accessible from the PRX functions. Other parts of
the Perl language are not accessible. The modified version of Perl regular expressions
does not support the following:

o Perl variables.

the regular expression options /c, /g, and /o and the /e option with substitutions.
named characters, which use the \N{name} syntax.

the metacharacters \pP, \PP, and \X.

executing Perl code within a regular expression. This includes the syntax (?{code}),
(??{code}), and (?p{code}).

O unicode pattern matching.

O 0o o g
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0 using PATTERN?. The ? metacharacter is treated like a regular expression
start-and-end delimiter.

O the metacharacter \G.

O Perl comments between a pattern and replacement text. For example: s{regexp} #
perl comment {replacement}.

0 matching backslashes with m/\\\\/. Instead m/\\/ should be used to match a
backslash.

Syntax of Perl Regular Expressions

Perl regular expressions are composed of characters and special characters that are
called metacharacters. When performing a match, SAS searches a source string for a
substring that matches the Perl regular expression that you specify. Using
metacharacters enables SAS to perform special actions when searching for a match:

o If you use the metacharacter \d, SAS matches a digit between 0-9.
0 If you use /\dt/, SAS finds the digits in the string “Raleigh, NC 27506.”
o If you use /world/, SAS finds the substring “world” in the string “Hello world!”.

The following table contains a short list of Perl regular expression metacharacters
that you can use when you build your code. You can find a complete list of
metacharacters on the following Perl man page at http://www.perldoc.com/perl5.6.1/pod/
perlre.html.

Metacharacter Description

\ marks the next character as either a special character, a literal, a back
reference, or an octal escape:

nn nn

n" matches the character "n

"\n" matches a new line character

O

O "\\" matches "\"

O "\(" matches "("

| specifies the or condition when you compare alphanumeric strings.
A matches the position at the beginning of the input string.
$ matches the position at the end of the input string.

matches the preceding subexpression zero or more times:
n_n

O zo* matches "z" and "zoo"

O *is equivalent to {0}

+ matches the preceding subexpression one or more times:
O "zo+" matches "zo" and "zoo"
O "zo+" does not match "z"

O + is equivalent to {1,}

? matches the preceding subexpression zero or one time:
O "do(es)?" matches the "do" in "do" or "does"

O ? is equivalent to {0,1}
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Metacharacter Description

{n} n is a non-negative integer that matches exactly n times:
O "of2}" matches the two o’s in "food"

O "of{2}" does not match the "o" in "Bob"

{n,} n is a non-negative integer that matches n or more times:
"0{2,}" matches all the o’s in "foooood"

"0{2,}" does not match the "o" in "Bob"

O

{
O "ofl,}" is equivalent to "o+"
{

O "o0{0,}" is equivalent to "o*"

{n,m} m and n are non-negative integers, where n<=m. They match at least
n and at most m times:

O "o{1,3}" matches the first three o’s in "fooooood"
O "o0{0,1}" is equivalent to "0?"

Note: You cannot put a space between the comma and
the numbers. A

period (.) matches any single character except newline. To match any character
including newline, use a pattern such as "[.\n]".

(pattern) matches a pattern and captures the match. To retrieve the position
and length of the match that is captured, use CALL PRXPOSN. To
match parentheses characters, use "\(" or "\)".

x|y matches either x or y:

O "z|food" matches "z" or "food"

O "(z|Dood" matches "zood" or "food"

[xyz] specifies a character set that matches any one of the enclosed
characters:

O "[abc]" matches the "a" in "plain"

[*xyz] specifies a negative character set that matches any character that is
not enclosed:

O "[*abc]" matches the "p" in "plain"

[a-z] specifies a range of characters that matches any character in the range:

O "[a-z]" matches any lowercase alphabetic character in the range
"a" through "z"

[ra-z] specifies a range of characters that does not match any character in
the range:

O "[*a-z]" matches any character that is not in the range "a
through "z"

\b matches a word boundary (the position between a word and a space):
O "er\b" matches the "er" in "never"

O "er\b" does not match the "er" in "verb"
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Metacharacter Description

\B

\d
\D
\s

\S

\t

\w

\W

\num

matches a non-word boundary:
O "er\B" matches the "er" in "verb"

O "er\B" does not match the "er" in "never"

matches a digit character that is equivalent to [0-9].
matches a non-digit character that is equivalent to [*0-9].

matches any white space character including space, tab, form feed,
and so on, and is equivalent to [\f\n\r\t\v].

matches any character that is not a white space character and is
equivalent to [*"\f\n\r\t\v].

matches a tab character and is equivalent to "\x09".

matches any word character including the underscore and is
equivalent to [A-Za-z0-9_].

matches any non-word character and is equivalent to [*"A-Za-z0-9_].

matches num, where num is a positive integer. This is a reference
back to captured matches:

O "(.)\1" matches two consecutive identical characters.

Example 1: Validating Data

You can test for a pattern of characters within a string. For example, you can
examine a string to determine whether it contains a correctly formatted telephone
number. This type of test is called data validation.

The following example validates a list of phone numbers. To be valid, a phone
number must have one of the following forms: (XXX) XXX-XXXX or XXX-XXX-XXXX.

data null ; @

if N_ =1 then
do;
paren = "\([2-9]\d\d\) ?[2-9]\d\d-\d\d\d\d"; @
dash = "[2-9]\d\d-[2-9]\d\d-\d\d\d\d"; @
regexp = "/(" || paren || ")[(" || dash [| ")/"; @
retain re;
re = prxparse(regexp); @
if missing(re) then @
do;
putlog "ERROR: Invalid regexp " regexp; @
stop;
end;
end;

length first last home business $ 16;
input first last home business;

if “prxmatch(re, home) then @
putlog "NOTE: Invalid home phone number for " first last home;
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if “prxmatch(re, business) then @

putlog "NOTE:

datalines;

Invalid business phone number for " first last business;

Jerome Johnson (919)319-1677 (919)846-2198
Romeo Montague 800-899-2164 360-973-6201
Imani Rashid (508)852-2146 (508)366-9821

Palinor Kent

. 919-782-3199
Ruby Archuleta . .

Takei Ito 7042982145 .
Tom Joad 209/963/2764 2099-66-8474

r

The following items correspond to the lines that are numbered in the DATA step that

is shown above.

@ Create a DATA step.

@ Build a Perl regular expression to identify a phone number that matches
(XXX)XXX-XXXX, and assign the variable PAREN to hold the result. Use the
following syntax elements to build the Perl regular expression:

\(
(2-9]

\d
\d

\)
?

matches the open parenthesis in the area code.

matches the digits 2-9. This is the first number in the area
code.

matches a digit. This is the second number in the area code.
matches a digit. This is the third number in the area code.
matches the closed parenthesis in the area code.

matches the space (which is the preceding subexpression) zero
or one time. Spaces are significant in Perl regular expressions.
They match a space in the text that you are searching. If a
space precedes the question mark metacharacter (as it does in
this case), the pattern matches either zero spaces or one space
in this position in the phone number.

© Build a Perl regular expression to identify a phone number that matches
XXX-XXX-XXXX, and assign the variable DASH to hold the result.

@ Build a Perl regular expression that concatenates the regular expressions for
(XXX)XXX-XXXX and XXX—XXX—XXXX. The concatenation enables you to
search for both phone number formats from one regular expression.

The PAREN and DASH regular expressions are placed within parentheses. The
bar metacharacter (|) that is located between PAREN and DASH instructs the
compiler to match either pattern. The slashes around the entire pattern tell the
compiler where the start and end of the regular expression is located.

© Pass the Perl regular expression to PRXPARSE and compile the expression.
PRXPARSE returns a value to the compiled pattern. Using the value with other
Perl regular expression functions and CALL routines enables SAS to perform
operations with the compiled Perl regular expression.

@ Use the MISSING function to check whether the regular expression was
successfully compiled.

@ Use the PUTLOG statement to write an error message to the SAS log if the
regular expression did not compile.

© Search for a valid home phone number. PRXMATCH uses the value from
PRXPARSE along with the search text and returns the position where the regular



SAS Language Elements /A Pattern Matching Using SAS Regular Expressions (RX) and Perl Regular Expressions (PRX) 51

expression was found in the search text. If there is no match for the home phone
number, the PUTLOG statement writes a note to the SAS log.

© Search for a valid business phone number. PRXMATCH uses the value from
PRXPARSE along with the search text and returns the position where the regular
expression was found in the search text. If there is no match for the business
phone number, the PUTLOG statement writes a note to the SAS log.

The following lines are written to the SAS log:

NOTE: Invalid home phone number for Palinor Kent

NOTE: Invalid home phone number for Ruby Archuleta

NOTE: Invalid business phone number for Ruby Archuleta

NOTE: Invalid home phone number for Takei Ito 7042982145
NOTE: Invalid business phone number for Takei Ito

NOTE: Invalid home phone number for Tom Joad 209/963/2764
NOTE: Invalid business phone number for Tom Joad 2099-66-8474

Example 2: Replacing Text

You can use Perl regular expressions to find specific characters within a string. You
can then remove the characters or replace them with other characters. In this example,
the two occurrences of the less-than character (<) are replaced by &lt; and the two
occurrences of the greater-than character (>) are replaced by &gt;.

data null ; @
if N =1 then
do;
retain lt_re gt_re;
lt_re = prxparse(’'s/</&lt;/'); @
gt_re = prxparse(’'s/>/&gt;/'); @
if missing(lt_re) or missing(gt_re) then @

do;
putlog "ERROR: Invalid regexp."; @
stop;
end;
end;
input;
call prxchange(lt_re, -1, _infile ); @
call prxchange(gt_re, -1, _infile ); @
put _infile_ ;
datalines4;
The bracketing construct ( ... ) creates capture buffers. To refer to
the digit’th buffer use \<digit> within the match. Outside the match
use "$" instead of "\". (The \<digit> notation works in certain

circumstances outside the match. See the warning below about \1 vs $1

for details.) Referring back to another part of the match is called

backreference.

A

The following items correspond to the numbered lines in the DATA step that is
shown above.

@ Create a DATA step.

@ Use metacharacters to create a substitution syntax for a Perl regular expression,
and compile the expression. The substitution syntax specifies that a less-than
character (<) in the input is replaced by the value &1t; in the output.
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© Use metacharacters to create a substitution syntax for a Perl regular expression,
and compile the expression. The substitution syntax specifies that a greater-than
character (>) in the input is replaced by the value &gt; in the output.

@ Use the MISSING function to check whether the Perl regular expression compiled
without error.

© Use the PUTLOG statement to write an error message to the SAS log if neither of
the regular expressions was found.

@ Call the PRXCHANGE routine. Pass the LT_RE pattern-id, and search for and
replace all matching patterns. Put the results in _INFILE_ and write the
observation to the SAS log.

@ Call the PRXCHANGE routine. Pass the GT_RE paitern-id, and search for and
replace all matching patterns. Put the results in _INFILE_ and write the
observation to the SAS log.

The following lines are written to the SAS log:

The bracketing construct ( ... ) creates capture buffers. To refer to

the digit’th buffer use \&lt;digit&gt; within the match. Outside the match
use "$" instead of "\". (The \&lt;digit&gt; notation works in certain
circumstances outside the match. See the warning below about \1 vs $1

for details.) Referring back to another part of the match is called a
backreference.

Example 3: Extracting a Substring from a String

You can use Perl regular expressions to find and easily extract text from a string. In
this example, the DATA step creates a subset of North Carolina business phone
numbers. The program extracts the area code and checks it against a list of area codes
for North Carolina.

data null ; @

if N_=1 then
do;
paren = "\ (([2-9]\d\d)\) ?[2-9]\d\d-\d\d\d\d"; @
dash = "([2-9]\d\d)-[2-9]1\d\d-\d\d\d\d"; @
regexp = "/(" || paren || ")|(" || dash [| ")/"; @
retain re;
re = prxparse(regexp); @
if missing(re) then @
do;
putlog "ERROR: Invalid regexp " regexp; @
stop;
end;

retain areacode re;

areacode_re = prxparse("/828|336|704|910|919|252/"); @
if missing(areacode re) then
do;
putlog "ERROR: Invalid area code regexp";
stop;
end;

end;

length first last home business $ 16;
length areacode $ 3;
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input first last home business;

if “prxmatch(re, home) then

putlog "NOTE: Invalid home phone number for " first last home;

if prxmatch(re, business) then @
do;
which format = prxparen(re); @
call prxposn(re, which_format, pos, len); @
areacode = substr(business, pos, len);
if prxmatch(areacode re, areacode) then @
put "In North Carolina: " first last business;
end;
else
putlog "NOTE: Invalid business phone number for " first last business;
datalines;
Jerome Johnson (919)319-1677 (919)846-2198
Romeo Montague 800-899-2164 360-973-6201
Imani Rashid (508)852-2146 (508)366-9821
Palinor Kent 704-782-4673 704-782-3199
Ruby Archuleta 905-384-2839 905-328-3892
Takei Ito 704-298-2145 704-298-4738
Tom Joad 515-372-4829 515-389-2838

The following items correspond to the numbered lines in the DATA step that is
shown above.
@ Create a DATA step.

@ Build a Perl regular expression to identify a phone number that matches
(XXX)XXX-XXXX, and assign the variable PAREN to hold the result. Use the
following syntax elements to build the Perl regular expression:

\( matches the open parenthesis in the area code. The open
parenthesis marks the start of the submatch.

[2-9] matches the digits 2-9. This is the first number in the area
code.

\d matches a digit. This is the second number in the area code.

\d matches a digit. This is the third number in the area code.

\) matches the closed parenthesis in the area code. The closed

parenthesis marks the end of the submatch.

? matches the space (which is the preceding subexpression) zero
or one time. Spaces are significant in Perl regular expressions.
They match a space in the text that you are searching. If a
space precedes the question mark metacharacter (as it does in
this case), the pattern matches either zero spaces or one space
in this position in the phone number.
© Build a Perl regular expression to identify a phone number that matches
XXX-XXX-XXXX, and assign the variable DASH to hold the result.
@ Build a Perl regular expression that concatenates the regular expressions for
(XXX)XXX-XXXX and XXX—XXX—XXXX. The concatenation enables you to
search for both phone number formats from one regular expression.

The PAREN and DASH regular expressions are placed within parentheses. The
bar metacharacter (|) that is located between PAREN and DASH instructs the
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compiler to match either pattern. The slashes around the entire pattern tell the
compiler where the start and end of the regular expression is located.

© Pass the Perl regular expression to PRXPARSE and compile the expression.
PRXPARSE returns a value to the compiled pattern. Using the value with other
Perl regular expression functions and CALL routines enables SAS to perform
operations with the compiled Perl regular expression.

@ Use the MISSING function to check whether the Perl regular expression compiled
without error.

@ Use the PUTLOG statement to write an error message to the SAS log if the
regular expression did not compile.

© Compile a Perl regular expression that searches a string for a valid North
Carolina area code.

© Search for a valid business phone number.

@ Use the PRXPAREN function to determine which submatch to use. PRXPAREN
returns the last submatch that was matched. If an area code matches the form
(XXX), PRXPAREN returns the value 2. If an area code matches the form XXX,
PRXPAREN returns the value 4.

@ Call the PRXPOSN routine to retrieve the position and length of the submatch.

@ Use the PRXMATCH function to determine whether the area code is a valid North
Carolina area code, and write the observation to the log.

The following lines are written to the SAS log:

In North Carolina: Jerome Johnson (919)846-2198
In North Carolina: Palinor Kent 704-782-3199
In North Carolina: Takei Ito 704-298-4738

Writing Perl Debug Output to the SAS Log

The DATA step provides debugging support with the CALL PRXDEBUG routine.
CALL PRXDEBUG enables you to turn on and off Perl debug output messages that are
sent to the SAS log.

The following example writes Perl debug output to the SAS log.

data _null ;

/* CALL PRXDEBUG(1l) turns on Perl debug output. */
call prxdebug(l);
putlog ’'PRXPARSE: ’;
re = prxparse('/[bcld(ef*g)+h[ij]1k$/");
putlog 'PRXMATCH: ’;
pos = prxmatch(re, 'abcdefg gh ’);

/* CALL PRXDEBUG(0) turns off Perl debug output. */
call prxdebug(0);

run;

SAS writes the following output to the log.
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Output 4.3 SAS Debugging Output

PRXPARSE:
Compiling REx ‘[bcld(ef*g)+h[ij]1k$’
size 41 first at 1
rarest char g at 0
rarest char d at 0
1: ANYOF[bc](10)
10: EXACT <d>(12)
12: CURLYX[O0] {1,32767}(26)

14: OPEN1(16)

16: EXACT <e>(18)
18: STAR(21)

19: EXACT <f>(0)
21: EXACT <g>(23)
23: CLOSE1(25)

25: WHILEM[1/1](0)

26: NOTHING(27)

27: EXACT <h>(29)

29: ANYOF[ij](38)

38: EXACT <k>(40)

40: EOL(41)

41: END(O0)
anchored ‘de’ at 1 floating ‘gh’ at 3..2147483647 (checking floating) stclass
‘ANYOF[bc]’ minlen 7

PRXMATCH:

Guessing start of match, REx ‘[bc]d(ef*g)+h[ij]k$’ against ‘abcdefg gh '...
Did not find floating substr ‘gh’...

Match rejected by optimizer

For a detailed explanation of Perl debug output, see the “CALL PRXDEBUG
Routine” in SAS Language Reference: Dictionary.

Base SAS Functions for Web Applications

Four functions that manipulate Web-related content are available in Base SAS
software. HTMLENCODE and URLENCODE return encoded strings. HTMLDECODE
and URLDECODE return decoded strings. For information about Web-based SAS tools,
follow the Communities link on the SAS customer support home page, at
support.sas.com.

ARM Macros

Definition of ARM Macros

The ARM macros provide a way to measure the performance of applications as they
are executing. The macros write transaction records to the ARM log. The ARM log is an
external output text file that contains the logged ARM transaction records. You insert
the ARM macros into your SAS program at strategic points in order to generate calls to
the ARM API function calls. The ARM API function calls typically log the time of the
call and other related data to the log file. Measuring the time between these ARM API
function calls yields an approximate response-time measurement.

An ARM macro is self-contained and does not affect any code surrounding it,
provided that the variable name passed as an option to the ARM macro is unique. The
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ARM macros are used in open code (code that is not in PROC or DATA steps) and in
DATA step or SCL environments.

There are two categories of ARM macros:

0 ARM macros to instrument applications

o ARM post-processing macros to use with the ARM log.

Note: The ARM macros are not part of SAS Macro Facility. They are part of the
SAS ARM interface. See Chapter 15, “Monitoring Performance Using Application
Response Measurement (ARM),” on page 223 for information about the SAS ARM
interface that consists of the implementation of the ARM API as an ARM agent, ARM
macros, and ARM system options. A

Using ARM Macros

Overview of ARM Macros

The ARM macros invoke the ARM API function calls. The ARM macros
automatically manage the returned IDs from the ARM API function calls.

The ARM API function calls are implemented in SAS software with SAS ARM
macros and these function calls provide a way to measure the performance of SAS
applications as they are running. For each ARM API function call, there is a
corresponding macro. The following table shows the relationship among the SAS ARM
macros and the ARM API function calls:

Tahle 4.4 Relationship among SAS ARM Macros and ARM API Function Calls

SAS ARM Macro ARM API Function Call
%ARMINIT ARM_INIT

%ARMGTID ARM_GETID
%ARMSTRT ARM_START
%ARMUPDT ARM_UPDATE
%ARMSTOP ARM_STOP

%ARMEND ARM_END

The SAS ARM macro invokes the ARM API function call.
The following ARM macros are available:

%ARMINIT generates a call to the ARM_INIT function call, which names the

Macro application and optionally the users of the application and initializes
the ARM environment for the application. Typically, you would
insert this macro in your code once.

%ARMGTID generates a call to the ARM_GETID function call, which names a

Macro transaction. Use %ARMGTID for each unique transaction in order
to describe the type of transactions to be logged. A %ARMGTID is
typically coded for each transaction class in an application.

%ARMSTRT generates a call to the ARM_START function call, which signals the

Macro start of a transaction instance. Insert %ARMSTRT before each
transaction that you want to log. Whereas 2ARMGTID defines a
transaction class, %ARMSTRT indicates that a transaction is
executing.
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%ARMUPDT is an optional macro that generates a call to the ARM_UPDATE

Macro function call, which provides additional information about the
progress of a transaction. Insert %ARMUPDT between %ARMSTRT
and %ARMSTOP in order to supply information about the
transaction that is in progress.

%ARMSTOP generates a call to the ARM_STOP function call, which signals the

Macro end of a transaction instance. Insert %ARMSTOP where the
transaction is known to be complete.

%ARMEND generates a call to the ARM_END function call, which terminates

Macro the ARM environment and signals that the application will not

make any more ARM calls.

The ARM macros permit conditional execution by setting the appropriate macro
options and variables.
Some general points about the ARM macros follow:

0 A general recommendation with all ARM macros is to avoid, in the program, the
use of either macro variables or SAS variables beginning with the letters “_ARM.”

o All macro options are keyword parameters. There are no positional parameters.
Values for the macro options should be valid SAS values—that is, a SAS variable,
quoted character string, numeric constant, and so on.

0 ARM macros can function either inside a DATA step or in open code. Use the
_ARMACRO global variable or the MACONLY=YES | NO macro option to tell the
macro execution which mode is being used. For more information, see “Setting the
Macro Environment” on page 67.

Using Variables with ARM Macros

The ARM macros use variables to pass IDs and other information from one macro to
another. Because the ARM macros function within the same DATA step, across DATA
steps, and in open code, variables that are used by the macros can take the form of
DATA step variables or macro variables as determined by the macro environment.

SAS DATA step variables are used to pass ID information between two or more ARM
macros in the same DATA step. In the DATA step environment, but not in the SCL
environment, DROP statements are generated for these variables so that they are not
inadvertently included in any output data sets.

If ID information must be passed between two or more ARM macros across separate
DATA steps, then macro global variables are used.

The following SAS DATA step variables and macro variables are considered global:

Table 4.5 Global ARM Macro Variables

Variable Description Set By Used as Input by
_ARMAPID application ID %ARMINIT %ARMEND
_ARMTXID transaction class ID %ARMGTID %ARMSTRT
_ARMSHDL start handle %ARMSTRT %ARMUPDT,
%ARMSTOP
_ARMRC error status %ARMUPDT none
%ARMSTOP

%ARMEND
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Variable Description Set By Used as Input by
_ARMGLVL global level indicator calling program all
_ARMTLVL target level indicator calling program all
_ARMEXEC global enablement calling program all
_ARMACRO open code enablement calling program all
_ARMSCL SCL code enablement calling program all

ARM API Objects

The following three classes of objects are specified in the ARM API:

O applications represent the systems that you are creating, such as an inventory or
order entry application. Because the SAS interface to the ARM API provides totals
on a per application basis, you might want to consider this when you define the
scope of your application.

O transaction classesspecify a unit of work. You should create a transaction class for

each major type of work that you want to create within an application. In concept,
the transaction class is a template for the started transaction.

O transaction instances specify the actual start time for a unit of work. Transaction
instances have response time information that is associated with them.

The ARM API uses numeric identifiers or IDs to uniquely identify the ARM objects
that are input and output from the ARM macro. The three different classes of IDs that
correspond to the three ARM classes are

O application IDs

O transaction class IDs

o start handles (start time) for transaction instances.

ID Management Using ARM Macros

These examples demonstrate how the ARM macros work. The ARM macros
automatically manage application IDs, transaction IDs, and start handles. The default
ID management works best in simple ARM call schemes. See “Complex ARM Macro
Call Schemes” on page 61 for more information. By default, the ARM macros use IDs
that were generated from the most recent macro call. The following example
demonstrates how to use all of the ARM macros:

/*global macro variable to indicate ARM macros are outside the data step*/
%$let _armacro=l;

/* start of the application */

%arminit (appname=’'Sales App’, appuser='userxyz’);
/* define the transaction classes */
%armgtid(txnname='Sales Order’, txndet=’'Sales Order Transaction’);

/* more arm getid calls go here for different transaction classes */

/* start of a transaction */
garmstrt;

data _null ;



SAS Language Elements /A Using ARM Macros 59

/* place the actual transaction code here */
/* update the status of the transaction as it is running */
$armupdt (data='Sales transaction still running...’,maconly=no);

run;

/* place the actual transaction stop here */
/* the transaction has stopped */
%armstop(status=0);

/* end of the application */
%armend;

All ID management is performed by the macros without requiring the calling
program to track IDs. Each macro in the previous example uses the most recently
generated ID values from previous macros. The following example is identical, but the
comments explain the passing of IDs in more detail:

%let _armacro=l;

/*
This %arminit macro will generate both a SAS
* variable and global macro variable by the name
* of _armapid and set it in the ID that is returned
* from the arm init() function call that is
* wrapped by the macro.
*/

%arminit (appname=’'Sales App’, appuser='userxyz’);

/*
* This %$armgtid macro uses the _armapid SAS variable

* as input to the arm getid() function call that it wraps.
* It also generates both a SAS variable and global macro

* variable by the name of _armtxid and sets them to the

* ID that is returned from the arm getid function call that
* it wraps.

*/

%armgtid(txnname='Sales Order’, txndet=’'Sales Order Transaction’);

/*

* Because we are still in the same DATA step, the %armstrt
* macro below will use the _armtxid SAS variable that is

* generated from the previous %armgtid macro as input

* to the arm start() function call that it wraps. It

* also generates an _armshdl variable.

*/

garmstrt;

/*

* The %$armupdt call below uses the _armshdl SAS variable
* that is generated from the previous %armstrt macro.

*/

garmupdt (data='Sales transaction still running...’);

/*

* The armstop call also uses the same _armshdl SAS
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* variable from the %armstrt.
*/

%armstop(status=0);

/*

* The %armend call uses the _armapid SAS variable
* generated by the %arminit macro earlier to end
* the application.

*/

%armend;

run;

You can code the ARM macros across different DATA steps as follows and achieve the
same results:

data _null ;
/* note the end of the application */
%arminit (appname=’'Sales App’, appuser='’userxyz’);

run;

data _null ;
%armgtid(txnname='Sales Order’, txndet='Sales Order Transaction’);
/* more arm getid function calls go here for different transaction classes */

run;

data _null ;
/* note the start of the transaction */
garmstrt;

/* place the actual transaction here */

run;

data _null ;
/* update the status of the transaction as it is running */
$armupdt (data='Sales transaction still running...’);

run;

data _null ;
/* place the actual transaction stop here */

/* note that the transaction has stopped */
%armstop(status=0);

run;

data _null ;
/* note the end of the application */
%armend;

run;

The end result is the same as in the first example, except that the macros are using
the generated macro variables rather than the SAS variables for passing IDs.
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Complex ARM Macro Call Schemes

Allowing the macros to automatically use the global variables in basic scenarios
simplifies coding. However, macros that use global variables can lead to misleading
results in more complicated scenarios when you attempt to monitor concurrent
applications or transactions as follows:

data _null ;
%arminit (appname='App 1’,getid=yes,txnname='txn 1');

run;

/* start transaction instance 1%/

data _null ;
garmstrt;
run;

/* start transaction instance 2 */

data _null ;
garmstrt;
run;

/* WRONG! This assumes that the %armupdt is updating

* the first transaction. However, it is actually updating the

* second transaction instance because _armshdl contains the value
* from the last macro call that was executed, which is the second
* transaction.

*/

data _null ;
$armupdt (data='txn instance 1 still running...’);

run;

To save the IDs use the *var options (APPIDVAR=, TXNIDVAR=, and SHDLVAR=) t
pass or return the IDs in your own named variables. Here is an example that uses the
SHDLVAR= option to save the start handles:

data _null ;
%arminit (appname=’'xyz’,getid=YES,txname='txn 1’);

run;

/* start transaction instance 1 and save the ID using shdlvar= */
data _null ;
$armstrt(shdlvar=savhdll );

run;

/* start transaction instance 2 and save the ID using shdlvar= */
data _null ;
/*armstrt( shdlvar=savhdl2 );

run;

/* Now use the shandle= parameter after retrieving the first id. */
data _null ;
$armupdt (data='updating txn 1’, shdlvar=savhdll);

run;

/* Use the same technique to stop the transactions */
/* in the order they were started. */
data _null ;

61
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$armstop(shdlvar=savhdll);
$armstop(shdlvar=savhdl2);
garmend();

run;

As the previous example shows, using the *var option simplifies the code. The
previous technique is recommended for use on all ARM macro calls.

The following example demonstrates how to use all of the *var options to
automatically manage IDs for concurrent applications, transaction classes, transaction
instances, and correlated transaction instances:

data _null ;
%arminit (appname='Appl 1’, appuser=‘userid’, appidvar=appl);
%arminit (appname='Appl 2’, appuser=‘userid’, appidvar=app2);
%arminit (appname='Appl 3’, appuser=‘userid’, appidvar=app3);

run;

data _null ;

garmgtid(txnname='Txn 1A', txndet='Txn Class 1A',
appidvar=appl, txnidvar=txnidvar=txnla);
garmgtid(txnname='Txn 1B’, txndet='Txn Class 1B’,
appidvar=appl, txnidvar=txnidvar=txnlb);
%armgtid(txnname='Txn 2A’, txndet='Txn Class 2A’,
appidvar=app2, txnidvar=txnidvar=txn2a);
%armgtid(txnname='Txn 2B’, txndet='Txn Class 2B’,
appidvar=app2,txnidvar=txnidvar=txn2b);
garmgtid(txnname='Txn 3A’, txndet='Txn Class 3A’,
appidvar=app3, txnidvar=txnidvar=txn3a);
%armgtid(txnname='Txn 3B’, txndet='Txn Class 3B’,
appidvar=app3, txnidvar=txnidvar=txn3b);

run;

data _null ;
garmstrt(txnidvar=txnla,shdlvar=shla);
garmstrt(txnidvar=txnlb,shdlvar=shlb);
garmstrt(txnidvar=txn2a,shdlvar=sh2a);
garmstrt(txnidvar=txn2b,shdlvar=sh2b);
garmstrt(txnidvar=txn3a,shdlvar=sh3a);
garmstrt(txnidvar=txn3b,shdlvar=sh3b);

run;
data _null ;
garmupdt (data='Updating txn instance la...’, shdlvar=shla);
$armupdt (data='Updating txn instance 1b...’, shdlvar=shlb);
$armupdt (data='Updating txn instance 2a...’, shdlvar=sh2a);
$armupdt (data='Updating txn instance 2b...’, shdlvar=sh2b);
$armupdt (data='Updating txn instance 3a...’, shdlvar=sh3a);
$armupdt (data='Updating txn instance 3b...’, shdlvar=sh3b);
run;
data _null ;
$armstop(status=0, shdlvar=shla); $armstop(status=1, shdlvar=shlb);
$armstop(status=0, shdlvar=sh2a); $armstop(status=1, shdlvar=sh2b);
$armstop(status=0, shdlvar=sh3a); $armstop(status=1, shdlvar=sh3b);

run;
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data _null ;
%armend (appidvar=appl);
%armend (appidvar=app2);
%armend (appidvar=app3); run;

As the previous example demonstrates, you can establish your own naming
conventions to uniquely identify applications, transaction classes, and transaction
instances across different DATA steps, in open code, or in SCL programs.

The macros support explicit passing of the IDs using the APPID=, TXNID=, and
SHANDLE= options. These options are similar to the *var options, except that they do
not retrieve values across DATA steps using macro variables. The primary use of the
options is to supply numeric constants as ID values to the macros, because the *var
options do not accept numeric constants.

Note: The use of APPID=, TXNID=, and SHANDLE= is not recommended for new
applications. These options are maintained for compatibility with earlier ARM macro
releases only. Use APPIDVAR=, TXNIDVAR=, and SHDLVAR= instead of APPID=,
TXNID=, and SHANDLE-=, respectively. A

Because IDs are generated by the ARM agent, to pass a numeric literal requires that
you start a new SAS session. If any SAS subsystems are also functioning, you will not
know what the ID will be at execution time.

The use of APPIDVAR=, TXNIDVAR=, and SHDLVAR= options is recommended
when coding new applications.

Defining User Metrics in ARM Macros

A metric is a counter, gauge, numeric ID, or string that you define. You specify one or
more metrics for each ARM transaction class. When a start handle (instance of the
transaction class) is started, updated, or stopped, the application indicates a value for
the metric and writes it to the ARM log by the ARM agent.

The user metric name and user metric definition must be specified together in the
%ARMGTID. METRNAM1-7= names the user metric and must be a SAS character
variable or quoted literal value up to eight characters in length. METRDEF1-7=
defines the output of the user-defined metric. The value of METRDEF1-6= must be one
of the following:

COUNT32, use the counter to sum up the values over an interval. A counter
COUNT64, can also calculate average values, maximums, and minimums per
COUNTDIV transaction, and other statistical calculations.

GAUGE32, use the gauge when a sum of values is not needed. A gauge can
GAUGE®64, calculate average values, maximums, and minimums per
GAUGEDIV transaction, and other statistical calculations.

ID32, ID64 use the numeric ID simply as an identifier but not as a

measurement value, such as an error code or an employee ID. No
calculations can be performed on the numeric ID.

SHORTSTR, use the string ID as an identifier. No calculations can be performed
LONGSTR on the string ID.

Restriction: METRDEF7= can only equal LONGSTR and can be
a long string of 32 bytes. METRDEF1-6 cannot equal LONGSTR.

Note: 32 and 64 signify the number of bits in the counter, gauge, divisor, or ID. A

The METRVAL1-7= sends the value of the user-defined metric to the ARM agent for
logging when used in the %ARMSTRT, %ARMUPDT, and %ARMSTOP. The value of the
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user-defined metric must conform to the corresponding user metrics defined in the
%ARMGTID. The following example shows the user metrics:

%let _armacro=1l;
%arminit (appname=’'Sales App’, appuser='userxyz’);

/* name and define the user defined metrics */
%armgtid(txnname='Sales Order’, txndet='Sales Order Transaction’,
metrnaml=aname, metrdefl=count32);
/* aname is the NAME of the metric and can be anything up to 8 characters */

/* start of user defined metric */
/* initial value of the metric */
$armstrt(metrvall=0);

data myfile;
. /*some SAS statements*/
end=EOF;

run;

/* value of the metric is the automatic observation */
%armupdt (data='Sales transaction still running...’,maconly=no,
metrvall= N );

data myfile;
. /*more SAS statements*/

if EOF then
/* value of the metric is at the highest observation count */
$armstop(status=0, metrvall=_N_,maconly=no);

run;

%armend;

Defining Correlators in ARM Macros

A primary or parent transaction can contain several component or child transactions
nested within them. Child transactions can also contain other child transactions. It can
be very useful to know how much each child transaction contributes to the total
response time of the parent transaction. If a failure occurs within a parent transaction,
knowing which child transaction contains the failure is also useful information.
Correlators are used to track these parent and child transactions.

The use of correlators requires that multiple transaction start handles be active
simultaneously. This requires the use of the CORR= and SHDLVAR= options in the
%ARMSTRT macro. You define each parent and child transaction in the %ARMSTRT
macro using the SHDLVAR= option. For each child transaction, you must also define
the parent transaction using the PARNTVAR= option.
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Each child transaction is started after the parent transaction starts. Parent or child
transactions can be of the same or different transaction classes. You define the
transaction classes in the %2ARMGTID macro using the TXNIDVAR= option.

Both parent and child transactions can have updates specified in the %ARMUPDT
macro. User metrics can be specified for both transaction types in the %ARMSTRT
macro if the user metrics were defined in the corresponding transaction class in the
%ARMGTID macro.

All child transactions must stop in the 2ARMSTOP macro before the parent
transaction stops. The sibling (multiple child) transactions can be stopped in any order.

For example, the parent transaction 100 consists of child transactions 110, 120, and
130, each performing a different part of the unit of work represented by the parent
transaction 100. The child transaction 120 contains child transactions 121 and 122.
Transaction 200 has no child transactions. Here is a code fragment used to create these
relationships:

%arminit (appname='Application",appidvar=appid);

%armgtid(appidvar=appid, txnname='TranCls’,txndet='Transaction Class Def’,
txnidvar=txnid);

garmstrt(txnidvar=txnid,corr=1,shdlvar=HDL100);

garmstrt(txnidvar=txnid,corr=0,shdlvar=HDL200<,...user metrics>);

garmstrt(txnidvar=txnid,corr=2,shldvar=HDL110,parntvar=HDL100);

garmstrt(txnidvar=txnid,corr=3,shldvar=HDL120,parntvar=HDL100);

garmstrt(txnidvar=txnid,corr=2,shldvar=HDL130,parntvar=HDL100);

garmstrt(txnidvar=txnid,corr=2,shldvar=HDL121,parntvar=HDL120);

garmstrt(txnidvar=txnid,corr=2,shldvar=HDL122,parntvar=HDL120);

$armstop(shdlvar=HDL200) ;
$armstop(shdlvar=HDL121);
$armstop(shdlvar=HDL122);
$armstop(shdlvar=HDL120);
$armstop(shdlvar=HDL130);
$armstop(shdlvar=HDL110);
$armstop(shdlvar=HDL100) ;

Enabling ARM Macro Execution

Setting the _ARMEXEC Macro Variable

All ARM macros are disabled by default so that insertion of ARM macros within
created code will not result in inadvertent, unwanted logging. To globally activate
execution of the ARM macros, you must set the _ARMEXEC global macro variable to a
value of 1. Any other value for _LARMEXEC disables the ARM macros.

There are two methods of setting the _ARMEXEC macro variable. The first method
sets the variable during DATA step or SCL program compilation using %LET:

$let _armexec = 1;

If the _ARMEXEC value is not set to 1, then no code is generated and a message is
written in the log:

NOTE: ARMSTRT macro bypassed by _armexec.
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The second method of setting _ ARMEXEC variables is to use SYMPUT during
execution. To set the _ARMEXEC variable during DATA step or SCL program execution:

call symput(’_armexec’, 'l’);

With this technique, the macro checks the _ARMEXEC variable during program
execution and the ARM function call is executed or bypassed as appropriate.

Enabling ARM Macro Execution with SCL

There are two methods of setting the _ARMEXEC macro variable—during
compilation or execution. Both methods are explained in “Setting the _ARMEXEC
Macro Variable” on page 65, or you can use a combination of these methods. For
example, set _ARMEXEC to 1 using the compilation technique (perhaps in an autoexec
at SAS initialization), and then code a drop-down menu option or other means within
the application to turn _ARMEXEC on and off dynamically using CALL SYMPUT.

In SCL, if _ARMEXEC is not 1, when the program compiles, all macros will be set to
null and the ARM interface will be unavailable until it is recompiled with _ARMEXEC
set to 1.

Additionally, to enable proper compilation of the ARM macros within SCL, you must
set the _ARMSCL global macro variable to 1 prior to issuing any ARM macros. This
variable suppresses the generation of DROP statements, which are invalid in SCL.

Conditional ARM Macro Execution

It is useful to code the ARM macros in your program but to execute them only when
needed. All ARM macros support a LEVEL= option that specifies the execution level of
that particular macro.

If it is coded, then the execution level of the macro is compared to two global macro
variables, _ARMGLVL and _ARMTLVL. _ARMGLVL is the global level macro variable.
If the LEVEL= value on the ARM macro is less than or equal to the _ARMGLVL value,
then the macro is executed. If the LEVEL= value on the ARM macro is greater than
the _ARMGLVL value, then macro execution is bypassed:

/* Set the global level to 10 */
$let _armglvl = 10;

data _null ;
%arminit (appname='Appl 1’, appuser='userid’ );
$armgtid(txnname='Txn 1’, txndet='Transaction #1 detail’ );

/* These macros are executed */
sarmstrt( level=9 );
$armstop( level=9 );

/* These macros are executed */
sarmstrt( level=10 );
$armstop( level=10 );

/* These macros are NOT executed */
sarmstrt( level=1ll );
sarmstop( level=1ll );

%armend

run;
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_ARMTLVL is the target level macro variable and works similarly to the ARMGLVL,
except the LEVEL= value on the ARM macro must be exactly equal to the _ARMTLVL
value for the macro to execute:

/* Set the target level to 10 */
$let _armtlvl = 10;

data _null ;
%arminit (appname='Appl 1’, appuser='userid’ );
$armgtid(txnname='Txn 1’, txndet='Transaction #1 detail’ );

/* These macros are NOT executed */
sarmstrt( level=9 );
$armstop( level=9 );

/* These macros are executed */
sarmstrt( level=10 );
$armstop( level=10 );

/* These macros are NOT executed */
sarmstrt( level=1l1l );
$armstop( level=1l1l );

%armend

run;

The LEVEL= option can be placed on any ARM macro and this is highly
recommended. It allows you to design more granular levels of logging that can serve as
an effective filtering device by logging only as much data as you want. If you set both
_ARMGLVL and _ARMTLVL at the same time, then both values are compared to
determine whether the macro should be executed or not.

Setting the Macro Environment

You set the global ARM macro environment by using the _ARMACRO variable with
the value of 1 or 0. The value of 1 specifies that all ARM macros occur in open code and
the value of 0 specifies that the ARM macros occur only in DATA steps. You use the
MACONLY= option if an individual ARM macro is not placed outside of the global
environment that is defined by the _ARMACRO setting. For SCL programs, you specify
_ARMSCL with a value of 1.

The following table shows the global value, the temporary option needed, and the
results.

Tahle 4.6 Using _ARMACRO and _ARMSCL to Set the ARM Macro Environment

Global Value Temporary Option Result

%let _ARMACRO=0; MACONLY=NO macro is in DATA step
%let _ARMACRO=1, MACONLY=YES macro is in open code
%let _ARMSCL=1; none macro is in SCL

%let _ARMSCL=0; none macro is not in SCL
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The following example shows how to set the macro environment in a DATA step:

/* set global environment */

$let _armacro = 1;

data _null ;

%arminit (appname='Appl 1’, appuser='userl’,

appidvar=appl, maconly=no);

/* exception to global value */

run;

/* using global setting */

/* maconly= parameter not needed */

%armgtid(txnname='Txn 1A', txndet='Txn Class 1A',

appidvar=appl, txnidvar=txnla);

The following example shows how to set the macro environment in SCL using

autoexec:

/* set global environment */

$let _armscl = 1;

$let _armexec = 1;

The following example shows how to set the macro environment in SCL:

init:

%arminit (appname='Appl 1’, appuser='userl’,

appidvar=appl);

%armgtid(txnname='Txn 1A', txndet='Txn Class 1A',

return;

main:

appidvar=appl, txnidvar=txnla);

garmstrt(txnidvar=txnla,shdlvar=strtl);

return;
term:

$armstop(shdlvar=strtl);

%armend (appidvar=appl);

return;

Using ARM Post-Processing Macros

Post-processing ARM macros are also available. These ARM macros are specific to
the SAS ARM implementation; they are not part of the ARM API standard.

After logging performance data to the ARM log, you can then use the ARM macros to
read the log and create SAS data sets for reporting and analysis. The default name of
the file is ARMLOG.LOG. To specify a different output file, use the ARMLOC= system
option. There are three ARM post-processing macros:

%ARMCONV
Macro

%ARMPROC
Macro

%ARMJOIN
Macro

converts an ARM log created in SAS 9 or later, which uses a simple
format, into the label=item ARM format used in SAS 8.2.

processes the ARM log and outputs six SAS data sets that contain
the information from the log. It processes ARM logs that include
user metadata definitions on class transactions and user data values
on start handles, update, and stop transactions.

processes the six SAS data sets that are created by %ARMPROC
and creates data sets and SQL views that contain common
information about applications and transactions.
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For SAS 9 or later, the simple format of the ARM log records is comma delimited, which
consists of columns of data separated by commas. The datetime stamp and the call
identifier always appear in the same column location.

The format used in SAS 8.2. is a label=item format and is easier to read.
Unfortunately, SAS spends a lot of time formatting the string, and this affects
performance. In SAS 9 or later, ARM logs can be compared with SAS 8.2 ARM logs by
using the following methods:

1 You can generate the SAS 9 or later ARM log and process it using the SAS 9 or
later %2ARMPROC and %ARMJOIN. The resulting data sets contain the complete
statistics for the end of the start handle and the end of the application.

2 To convert SAS 9 or later ARM log format to the SAS 8.2 format you use the SAS
ARM macro %ARMCONV.

Statements

Definition of Statements

A SAS statement is a series of items that may include keywords, SAS names, special
characters, and operators. All SAS statements end with a semicolon. A SAS statement
either requests SAS to perform an operation or gives information to the system.

This section covers two kinds of SAS statements:

O those that are used in DATA step programming

O those that are global in scope and can be used anywhere in a SAS program.

Base SAS Procedures Guide gives detailed descriptions of the SAS statements that
are specific to each SAS procedure. SAS Output Delivery System: User’s Guide gives
detailed descriptions of the Output Delivery System (ODS) statements.

Executable and Declarative DATA Step Statements

DATA step statements are executable or declarative statements that can appear in
the DATA step. Executable statements result in some action during individual iterations
of the DATA step; declarative statements supply information to SAS and take effect
when the system compiles program statements.

The following tables show the SAS executable and declarative statements that you
can use in the DATA step.

Table 4.7 Executable Statements in the DATA Step

Executable Statements

ABORT IF, Subsetting PUT
assignment IF-THEN/ELSE PUT, Column
CALL INFILE PUT, Formatted
CONTINUE INPUT PUT, List
DECLARE INPUT, Column PUT, Named

DELETE INPUT, Formatted PUT, _ODS_
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Executable Statements

DESCRIBE INPUT, List PUTLOG
DISPLAY INPUT, Named REDIRECT
DO LEAVE REMOVE
DO, Iterative LINK REPLACE
DO Until LIST RETURN
DO While LOSTCARD SELECT
ERROR MERGE SET
EXECUTE MODIFY STOP
FILE _NEW_ Sum

FILE, ODS Null UPDATE
GO TO OUTPUT

Table 4.8 Declarative Statements in the DATA Step

Declarative Statements

ARRAY DATALINES LABEL
Array Reference DATALINES4 Labels, Statement
ATTRIB DROP LENGTH
BY END RENAME
CARDS FORMAT RETAIN
CARDS4 INFORMAT WHERE
DATA KEEP WINDOW

Global Statements

Global statements generally provide information to SAS, request information or data,
move between different modes of execution, or set values for system options. Other
global statements (ODS statements) deliver output in a variety of formats, such as in
Hypertext Markup Language (HTML). You can use global statements anywhere in a
SAS program. Global statements are not executable; they take effect as soon as SAS
compiles program statements.

Other SAS software products have additional global statements that are used with
those products. For information, see the SAS documentation for those products.
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SAS System Options

Definition of SAS System Options

System options are instructions that affect your SAS session. They control the way
that SAS performs operations such as SAS System initialization, hardware and
software interfacing, and the input, processing, and output of jobs and SAS files.

Syntax of SAS System Options
The syntax for specifying system options in an OPTIONS statement is
OPTIONS option(s);

Here is an explanation of the syntax:

option
specifies one or more SAS system options that you want to change.

The following example shows how to use the system options NODATE and
LINESIZE= in an OPTIONS statement:

options nodate linesize=72;

Operating Environment Information: On the command line or in a configuration file,
the syntax is specific to your operating environment. For details, see the SAS
documentation for your operating environment. A

Using SAS System Options

Default Settings

Operating Environment Information: SAS system options are initialized with default
settings when SAS is invoked. However, the default settings for some SAS system
options vary both by operating environment and by site. For details, see the SAS
documentation for your operating environment. A

Determining Which Settings Are in Effect

To determine which settings are in effect for SAS system options, use one of the
following:

OPLIST system option
writes to the SAS log the settings that were specified on the SAS invocation
command line. (See the SAS documentation for your operating environment for
more information.)

VERBOSE
writes to the SAS log the system options that were specified in the configuration
file and on the SAS invocation command line.

SAS System Options window
lists all system option settings.
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OPTIONS procedure
writes system option settings to the SAS log. To display the settings of system
options with a specific functionality, such as error handling, use the GROUP=
option:

proc options GROUP=errorhandling;
run;

(See Base SAS Procedures Guide for more information.)

GETOPTION function
returns the value of a specified system option.

VOPTION DICTIONARY table
lists in the SASHELRP library, all current system option settings. You can view this
table with SAS Explorer, or you can extract information from the VOPTION table
using PROC SQL.

dictionary.options SQL table
accessed with the SQL procedure, lists the system options that are in effect.

Determining Which SAS System Options Are Restricted

To determine which system options are restricted by your system administrator, use
the RESTRICT option of the OPTIONS procedure. The RESTRICT option display the
option’s value, scope, and how it was set. In the following example, the SAS log shows
that only one option, CMPOPT, is restricted:

proc options restrict;

run;

Output 4.4 Restricted Option Information

1 proc options restrict;
2 run;
SAS (r) Proprietary Software Release 9.1 TS1BO

Option Value Information For SAS Option CMPOPT
Option Value: (NOEXTRAMATH NOMISSCHECK NOPRECISE NOGUARDCHECK)
Option Scope: SAS Session
How option value set: Site Administrator Restricted

The OPTIONS procedure will display this information for all options that are
restricted. If your site administrator has not restricted any options, then the following
message will appear in the SAS log:

Your site administrator has not restricted any options.

Determining How a SAS System Option Value Was Set

To determine how a system option value was set, use the OPTIONS procedure with
the VALUE option specified in the OPTIONS statement. The VALUE option displays
the specified option’s value and scope. For example, the following statements write a
message to the SAS log that tells you how the option value for the system option
CENTER was set:

proc options option=center value;

run;
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The following partial SAS log shows that the option value for CENTER is the default
that was shipped with the product.

Output 4.5 Option Value Information for the System Option CENTER

2 proc options option=center value;
3 run;

Option Value Information for SAS Option CENTER
Option Value: CENTER
Option Scope: NoReb
How option value set: Shipped Default

Obtaining Descriptive Information about a System Option

You can quickly obtain basic descriptive information about a system option by
specifying the DEFINE option in the PROC OPTIONS statement.

The DEFINE option writes the following descriptive information about a system
option to the SAS log:

O description

o type
O when in the SAS session it can be set

For example, the following statements write a message to the SAS log that contains
descriptive information about the system option CENTER:

proc options option=center define;

run;

This partial SAS log tells you specific information about the system option CENTER.

Output 4.6 Descriptive Information for the System Option CENTER

1 proc options option=center define;
2 run;
CENTER

Option Definition Information for SAS Option CENTER
Group= LISTCONTROL
Group Description: Procedure output and display settings
Description: Center SAS procedure output
Type: The option value is of type BOOLEAN
When Can Set: Startup or anytime during the SAS Session
Restricted: Your Site Administrator can restrict modification of this option
Optsave: Proc Optsave or command Dmoptsave will save this option.

Changing SAS System Option Settings

SAS provides default settings for SAS system options. You can override the default
settings of any unrestricted system option. Depending on the function of the system
option, you can specify a setting in any of the following ways:

O on the command line: You can specify any unrestricted SAS system option setting
either on the SAS command line or in a configuration file. If you use the same
option settings frequently, it is usually more convenient to specify the options in a
configuration file, rather than on the command line. Either method sets your SAS
system options during SAS invocation. Many SAS system option settings can be
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specified only during SAS invocation. Descriptions of the individual options
provide details.

O in a configuration file: If you use the same option settings frequently, it is usually
more convenient to specify the options in a configuration file, rather than on the
command line.

0 in an OPTIONS statement: You can specify an OPTIONS statement at any time
during a session except within data lines or parmcard lines. Settings remain in
effect throughout the current program or process unless you reset them with
another OPTIONS statement or change them in the SAS System Options window.
You can also place an OPTIONS statement in an autoexec file.

0 in a SAS System Options window: If you are in a windowing environment, type
options in the toolbox or on the command line to open the SAS System Options
window. The SAS System Options window lists the names of the SAS system
options groups. You can then expand the groups to see the option names and to
change their current settings. Alternatively, you can use the Find Option command
in the Options pop-up menu to go directly to an option. Changes take effect
immediately and remain in effect throughout the session unless you reset them
with an OPTIONS statement or change them in the SAS System Options window.

Operating Environment Information: On UNIX, Open VMS, and z/OS hosts, SAS
system options can be restricted by a site administrator so that they cannot be changed
by a user. Depending upon your operating environment, system options can be restricted
globally, by group, or by user. You can use the OPTIONS procedure to determine which
options are restricted. For more information about how to restrict options, see the SAS
configuration guide for your operating environment. For more information about the
OPTIONS procedure, see the SAS documentation for your operating environment. 2

How Long System Option Settings Are in Effect

When you specify a SAS system option setting, the setting applies to all subsequent
steps for the duration of the SAS session or until you reset, as shown:

data one;
set items;

run;

/* option applies to all subsequent steps */
options obs=5;

/* printing ends with the fifth observation */
proc print data=one;

run;

/* the SET statement stops reading
after the fifth observation */
data two;
set items;

run;

To read more than five observations, you must reset the OBS= system option. For
more information about the “OBS= System Option” , see SAS Language Reference:
Dictionary.
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Order of Precedence

If a system option appears in more than one place, the order of precedence from
highest to lowest is as follows:

1 OPTIONS statement and SAS System Options window

2 autoexec file (that contains an OPTIONS statement)

3 command-line specification

4 configuration file specification

5 SAS system default settings.
Operating Environment Information: In some operating environments, you can specify

system options in other places. See the SAS documentation for your operating
environment. A

Table 4.9 on page 75 shows the order of precedence that SAS uses for execution mode
options. These options are a subset of the SAS invocation options and are specified on
the command line during SAS invocation.

Table 4.9 Order of Precedence for SAS Execution Mode Options

Execution Mode Option Precedence
OBJECTSERVER Highest
DMR 2nd
INITCMD 3rd

DMS 3rd
DMSEXP 3rd
EXPLORER 3rd

The order of precedence of SAS execution mode options consists of the following rules:
0 SAS uses the execution mode option with the highest precedence.

o If you specify more than one execution mode option of equal precedence, SAS uses
only the last option listed.

See the descriptions of the individual options for more details.

Interaction with Data Set Options

Some system options share the same name as a data set option that has the same
function. System options remain in effect for all DATA step and PROC steps in a SAS
session until their settings are changed. The data set option, however, overrides a
system option only for the particular data set in the step in which it appears.

In this example, the OBS= system option in the OPTIONS statement specifies that
only the first 100 observations will be read from any data set within the SAS job. The
OBS= data set option in the SET statement, however, overrides the system option and
specifies that only the first five observations will be read from data set TWO. The PROC
PRINT step uses the system option setting and reads and prints the first 100
observations from data set THREE:

options obs=100;
data one;

set two(obs=5);

run;
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proc print data=three;

run;

Comparisons
Note the differences between system options, data set options, and statement options.

system options
remain in effect for all DATA and PROC steps in a SAS job or current process
unless they are respecified.

data set options
apply to the processing of the SAS data set with which they appear. Some data set
options have corresponding system options or LIBNAME statement options. For
an individual data set, you can use the data set option to override the setting of
these other options.

statement options
control the action of the statement in which they appear. Options in global
statements, such as in the LIBNAME statement, can have a broader impact.
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Definition of SAS Variables

variables
are containers that you create within a program to store and use character and
numeric values. Variables have attributes, such as name and type, that enable you
to identify them and that define how they can be used.

character variables
are variables of type character that contain alphabetic characters, numeric digits 0
through 9, and other special characters.

numeric variables
are variables of type numeric that are stored as floating-point numbers, including
dates and times.

numeric precision
refers to the degree of accuracy with which numeric variables are stored in your
operating environment.

SAS Variable Attributes

A SAS variable has the attributes that are listed in the following table:

Table 5.1 Variable Attributes

Variable Attribute Possible Values Default Value

Name Any valid SAS name. See Chapter  None
3, “Rules for Words and Names in
the SAS Language,” on page 15.

Type ! Numeric and character Numeric

Length ! 2 to 8 bytes 2 8 bytes for numeric and
1 to 32,767 bytes for character character

Format See “Formats and Informats” on BEST12. for numeric,
page 27. $w. for character

Informat See “Formats and Informats” on w.d for numeric, $w.
page 27. for character

Label Up to 256 characters None

Position in observation 1-n None

Index type NONE, SIMPLE, COMPOSITE, or  None
BOTH

1 If they are not explicitly defined, a variable’s type and length are implicitly defined by its first
occurrence in a DATA step.

2 The minimum length is 2 bytes in some operating environments, 3 bytes in others. See the SAS
documentation for your operating environment.

Note: Starting with SAS 9.1, the maximum number of variables can be greater than
32,767. The maximum number is dependent on your environment and the file’s
attributes. A
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You can use the CONTENTS procedure, or the functions that are named in the
following definitions, to obtain information about a variable’s attributes:

name
identifies a variable. A variable name must conform to SAS naming rules. A SAS
name can be up to 32 characters long. The first character must be a letter (A, B,
C,. .., Z) or underscore (_). Subsequent characters can be letters, digits (0 to 9),
or underscores. Note that blanks are not allowed. Mixed case variables are
allowed. See Chapter 3, “Rules for Words and Names in the SAS Language,” on
page 15 for more details on mixed case variables.

The names _'N_, _ERROR_, FILE_, _INFILE_, MSG_, IORC_, and _CMD_
are reserved for the variables that are generated automatically for a DATA step.
Note that SAS products use variable names that start and end with an
underscore; it is recommended that you do not use names that start and end with
an underscore in your own applications. See “Automatic Variables” on page 85 for
more information.

To determine the value of this attribute, use the VNAME or VARNAME function.

Note: The rules for variable names that are described in this section apply
when the VALIDVARNAME= system option is set to VALIDVARNAME=V7, which
is the default setting. Other rules apply when this option is set differently. See
Chapter 3, “Rules for Words and Names in the SAS Language,” on page 15 for
more information. A

type
identifies a variable as numeric or character. Within a DATA step, a variable is
assumed to be numeric unless character is indicated. Numeric values represent
numbers, can be read in a variety of ways, and are stored in floating-point format.
Character values can contain letters, numbers, and special characters and can be
from 1 to 32,767 characters long.
To determine the value of this attribute, use the VIYPE or VARTYPE function.

length
refers to the number of bytes used to store each of the variable’s values in a SAS
data set. You can use a LENGTH statement to set the length of both numeric and
character variables. Variable lengths specified in a LENGTH statement affect the
length of numeric variables only in the output data set; during processing, all
numeric variables have a length of 8. Lengths of character variables specified in a
LENGTH statement affect both the length during processing and the length in the
output data set.

In an INPUT statement, you can assign a length other than the default length
to character variables. You can also assign a length to a variable in the ATTRIB
statement. A variable that appears for the first time on the left side of an
assignment statement has the same length as the expression on the right side of
the assignment statement.

To determine the value of this attribute, use the VLENGTH or VARLEN
function.

format
refers to the instructions that SAS uses when printing variable values. If no
format is specified, the default format is BEST12. for a numeric variable, and $w.
for a character variable. You can assign SAS formats to a variable in the FORMAT
or ATTRIB statement. You can use the FORMAT procedure to create your own
format for a variable.

To determine the value of this attribute, use the VFORMAT or VARFMT

function.
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informat
refers to the instructions that SAS uses when reading data values. If no informat
is specified, the default informat is w.d for a numeric variable, and $w. for a
character variable. You can assign SAS informats to a variable in the INFORMAT
or ATTRIB statement. You can use the FORMAT procedure to create your own
informat for a variable.

To determine the value of this attribute, use the VINFORMAT or VARINFMT

function.

label
refers to a descriptive label up to 256 characters long. A variable label, which can
be printed by some SAS procedures, is useful in report writing. You can assign a
label to a variable with a LABEL or ATTRIB statement.
To determine the value of this attribute, use the VLABEL or VARLABEL
function.

position in observation
is determined by the order in which the variables are defined in the DATA step.
You can find the position of a variable in the observations of a SAS data set by
using the CONTENTS procedure. This attribute is generally not important within
the DATA step except in variable lists, such as the following:

var rent-phone;

See “SAS Variable Lists” on page 86 for more information.

The positions of variables in a SAS data set affect the order in which they
appear in the output of SAS procedures, unless you control the order within your
program, for example, with a VAR statement.

To determine the value of this attribute, use the VARNUM function.

index type
indicates whether the variable is part of an index for the data set. See
“Understanding SAS Indexes” on page 512 for more information.
To determine the value of this attribute, use the OUT= option with the
CONTENTS procedure to create an output data set. The IDXUSAGE variable in
the output data set contains one of the following values for each variable:

Table 5.2 Index Type Attribute Values

Value Definition

NONE The variable is not indexed.

SIMPLE The variable is part of a simple index.

COMPOSITE The variable is part of one or more composite indexes.
BOTH The variable is part of both simple and composite indexes.

Ways to Create Variables

Overview

You can create variables in a DATA step in the following ways:
O using an assignment statement
O reading data with the INPUT statement in a DATA step
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Using an Assignment Statement

O specifying a new variable in a FORMAT or INFORMAT statement
O specifying a new variable in a LENGTH statement

O specifying a new variable in an ATTRIB statement.

Note: You can also create variables with the FGET function. See SAS Language
Reference: Dictionary for more information. A

81

Using an Assignment Statement

In a DATA step, you can create a new variable and assign it a value by using it for

the first time on the left side of an assignment statement. SAS determines the length of

a variable from its first occurrence in the DATA step. The new variable gets the same

type and length as the expression on the right side of the assignment statement.
When the type and length of a variable are not explicitly set, SAS gives the variable
a default type and length as shown in the examples in the following table.

Table 5.3 Resulting Variable Types and Lengths Produced When They Are Not

Explicitly Set
Expression Example Resulting Resulting Explanation
Type of X Length of X
Numeric variable length a 4; Numeric 8 Default numeric
x=a; variable length (8 bytes
unless otherwise
specified)
Character length a $§ 4; Character 4 Length of source
variable x=a; variable variable
Character literal  y='aBc’; Character 3 Length of first
x='ABCDE ; variable literal
encountered
Concatenation of  l1ength a $ 4 Character 12 Sum of the
variables b$6 variable lengths of all
c$ 2; variables
r
x=a||b]||c;
Concatenation of length a $§ 4; Character 7 Sum of the
variables and x=a||’CAT’; variable lengths of

literal

x=a| | 'CATNIP';

variables and
literals
encountered in
first assignment
statement

If a variable appears for the first time on the right side of an assignment statement,
SAS assumes that it is a numeric variable and that its value is missing. If no later
statement gives it a value, SAS prints a note in the log that the variable is uninitialized.

Note: A RETAIN statement initializes a variable and can assign it an initial value,
even if the RETAIN statement appears after the assignment statement. A
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Reading Data with the INPUT Statement in a DATA Step

When you read raw data in SAS by using an INPUT statement, you define variables
based on positions in the raw data. You can use one of the following methods with the
INPUT statement to provide information to SAS about how the raw data is organized:

O column input
list input (simple or modified)
formatted input

o o o

named input.

See SAS Language Reference: Dictionary for more information about using each method.
The following example uses simple list input to create a SAS data set named GEMS
and defines four variables based on the data provided:

data gems;
input Name $ Color $ Carats Owner §$;
datalines;

emerald green 1 smith

sapphire blue 2 johnson

ruby red 1 clark

r

Specifying a New Variable in a FORMAT or an INFORMAT Statement

You can create a variable and specify its format or informat with a FORMAT or an
INFORMAT statement. For example, the following FORMAT statement creates a
variable named Sale_Price with a format of 6.2 in a new data set named SALES:

data sales;
Sale_Price=49.99;
format Sale Price 6.2;

run;

SAS creates a numeric variable with the name Sale_Price and a length of 8.
See SAS Language Reference: Dictionary for more information about using the
FORMAT and INFORMAT statements.

Specifying a New Variable in a LENGTH Statement

You can use the LENGTH statement to create a variable and set the length of the
variable, as in the following example:

data sales;
length Salesperson $20;

run;

For character variables, you must allow for the longest possible value in the first
statement that uses the variable, because you cannot change the length with a
subsequent LENGTH statement within the same DATA step. The maximum length of
any character variable in SAS is 32,767 bytes. For numeric variables, you can change
the length of the variable by using a subsequent LENGTH statement.

When SAS assigns a value to a character variable, it pads the value with blanks or
truncates the value on the right side, if necessary, to make it match the length of the
target variable. Consider the following statements:
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length addressl address2 address3 $ 200;
address3=addressl| |address2;

Because the length of ADDRESSS is 200 bytes, only the first 200 bytes of the
concatenation (the value of ADDRESS1) are assigned to ADDRESS3. You might be able
to avoid this problem by using the TRIM function to remove trailing blanks from
ADDRESS1 before performing the concatenation, as follows:

address3=trim(addressl) | |address2;

See SAS Language Reference: Dictionary for more information about using the
LENGTH statement.

Specifying a New Variable in an ATTRIB Statement

The ATTRIB statement enables you to specify one or more of the following variable
attributes for an existing variable:

o FORMAT=
o INFORMAT=
o LABEL=

o LENGTH=.

If the variable does not already exist, one or more of the FORMAT=, INFORMAT=, and
LENGTH= attributes can be used to create a new variable. For example, the following
DATA step creates a variable named Flavor in a data set named LOLLIPOPS:

data lollipops;
Flavor="Cherry";
attrib Flavor format=$10.;

run;

Note: You cannot create a new variable by using a LABEL statement or the
ATTRIB statement’s LABEL= attribute by itself; labels can only be applied to existing
variables. A

See SAS Language Reference: Dictionary for more information about using the
ATTRIB statement.

Using the IN= Data Set Option

The IN= data set option creates a special boolean variable that indicates whether the
data set contributed data to the current observation. The variable has a value of 1
when true, and a value of 0 when false. You can use IN= on the SET, MERGE, and
UPDATE statements in a DATA step.

The following example shows a merge of the OLD and NEW data sets where the IN=
option is used to create a variable named X that indicates whether the NEW data set
contributed data to the observation:

data master missing;
merge old new(in=x);
by id;
if x=0 then output missing;
else output master;

run;
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Variable Type Conversions

If you define a numeric variable and assign the result of a character expression to it,
SAS tries to convert the character result of the expression to a numeric value and to
execute the statement. If the conversion is not possible, SAS prints a note to the log,
assigns the numeric variable a value of missing, and sets the automatic variable
_ERROR_ to 1. For a listing of the rules by which SAS automatically converts character
variables to numeric variables and vice-versa, see “Automatic Numeric-Character

Conversion” on page 116.

If you define a character variable and assign the result of a numeric expression to it,
SAS tries to convert the numeric result of the expression to a character value using the
BESTw. format, where w is the width of the character variable and has a maximum
value of 32. SAS then tries to execute the statement. If the character variable you use is
not long enough to contain a character representation of the number, SAS prints a note
to the log and assigns the character variable asterisks. If the value is too small, SAS
provides no error message and assigns the character variable the character zero (0).

Output 5.1 Automatic Variable Type Conversions (partial SAS log)

4

5 data _null_;

6 x= 3626885;

7 length y $ 4;
8 y=X;

9 put y;

36E5

NOTE: Numeric values have been converted to character
values at the places given by:
(Number of times) at (Line):(Column).

1 at 8:5
10 data _null_;
11 x1= 3626885;
12 length y1 $ 1;
13 yl=x1;
14 xs=0.000005;
15 length ys $ 1;
16 yS=Xs;
17 put yl= ys=;
18 run;

NOTE: Invalid character data, XL=3626885.00 ,
at line 13 column 6.
YL=* YS=0
XL=3626885 YL=* XS=5E-6 YS=0 _ERROR =1 N =1
NOTE: Numeric values have been converted
to character values at the places
given by: (Number of times) at
(Line): (Column).
1 at 13:6
1 at 16:6

In the first DATA step of the example, SAS is able to fit the value of Y into a 4-byte
field by representing its value in scientific notation. In the second DATA step, SAS
cannot fit the value of YL into a 1-byte field and displays an asterisk (*) instead.
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Aligning Variable Values

In SAS, numeric variables are automatically aligned. You can further control their
alignment by using a format.

However, when you assign a character value in an assignment statement, SAS stores
the value as it appears in the statement and does not perform any alignment. Output
5.2 illustrates the character value alignment produced by the following program:

data aircode;
input city $1-13;
length airport $ 10;
if city='San Francisco’ then airport=’SFO’;
else if city='Honolulu’ then airport='HNL’;
else if city='New York’ then airport=’'JFK or EWR';
else if city='Miami’ then airport=’ MIA "
datalines;
San Francisco
Honolulu
New York
Miami

r

proc print data=aircode;

run;

This example produces the following output:

Output 5.2 Output from the PRINT Procedure

The SAS System

OBS CITY AIRPORT

1 San Francisco SFO

2 Honolulu HNL

3 New York JFK or EWR
4 Miami MIA

Automatic Variables

Automatic variables are created automatically by the DATA step or by DATA step
statements. These variables are added to the program data vector but are not output to
the data set being created. The values of automatic variables are retained from one
iteration of the DATA step to the next, rather than set to missing.

Automatic variables that are created by specific statements are documented with
those statements. For examples, see the BY statement, the MODIFY statement, and
the WINDOW statement in SAS Language Reference: Dictionary.
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Two automatic variables are created by every DATA step: _N_ and _ERROR_.
N

s initially set to 1. Each time the DATA step loops past the DATA statement, the
variable _N_ increments by 1. The value of _N_ represents the number of times

the DATA step has iterated.

_ERROR_
is 0 by default but is set to 1 whenever an error is encountered, such as an input
data error, a conversion error, or a math error, as in division by 0 or a floating
point overflow. You can use the value of this variable to help locate errors in data
records and to print an error message to the SAS log.

For example, either of the two following statements writes to the SAS log,

during each iteration of the DATA step, the contents of an input record in which
an input error is encountered:

if _error =1 then put _infile_;

if _error_ then put _infile ;

SAS Variable Lists

Definition
A SAS variable list is an abbreviated method of referring to a list of variable names.
SAS allows you to use the following variable lists:

0O numbered range lists

O name range lists

O name prefix lists

O special SAS name lists.

With the exception of the numbered range list, you refer to the variables in a
variable list in the same order that SAS uses to keep track of the variables. SAS keeps
track of active variables in the order that the compiler encounters them within a DATA
step, whether they are read from existing data sets, an external file, or created in the
step. In a numbered range list, you can refer to variables that were created in any
order, provided that their names have the same prefix.

You can use variable lists in many SAS statements and data set options, including
those that define variables. However, they are especially useful after you define all of
the variables in your SAS program because they provide a quick way to reference
existing groups of data.

Note: Only the numbered range list is allowed in the RENAME= option. A

Numbered Range Lists

Numbered range lists require you to have a series of variables with the same name,
except for the last character or characters, which are consecutive numbers. For
example, the following two lists refer to the same variables:

x1,x2,x3,...,xn

x1l-xn
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In a numbered range list, you can begin with any number and end with any number
as long as you do not violate the rules for user-supplied variable names and the
numbers are consecutive.

For example, suppose you decide to give some of your numeric variables sequential
names, as in VAR1, VAR2, and so on. Then, you can write an INPUT statement as
follows:

input idnum name $ varl-var3;

Note that the character variable NAME is not included in the abbreviated list.

Name Range Lists

Name range lists rely on the order of variable definition, as shown in the following
table:

Table 5.4 Name Range Lists

Variable list Included variables

X---a all variables in order of variable definition, from
X to A inclusive.

X-numeric-a all numeric variables from X to A inclusive.

x-character-a all character variables from X to A inclusive.

You can use the VARNUM option in PROC CONTENTS to print the variables in the
order of definition.
For example, consider the following INPUT statement:

input idnum name $ weight pulse chins;
In later statements you can use these variable lists:

/* keeps only the numeric variables idnum, weight, and pulse */

keep idnum-numeric-pulse;

/* keeps the consecutive variables name, weight, and pulse */

keep name---pulse;

Name Prefix Lists

Some SAS functions and statements allow you to use a name prefix list to refer to all
variables that begin with a specified character string:

sum(of SALES:)

tells SAS to calculate the sum of all the variables that begin with “SALES,” such as
SALES_JAN, SALES_FEB, and SALES_MAR.
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Special SAS Name Lists
Special SAS name lists include

_NUMERIC_
specifies all numeric variables that are already defined in the current DATA step.

_CHARACTER_
specifies all character variables that are currently defined in the current DATA
step.

_ALL_
specifies all variables that are currently defined in the current DATA step.

Dropping, Keeping, and Renaming Variables

Using Statements or Data Set Options

The DROP, KEEP, and RENAME statements or the DROP=, KEEP=, and RENAME=
data set options control which variables are processed or output during the DATA step.
You can use one or a combination of these statements and data set options to achieve
the results you want. The action taken by SAS depends largely on whether you

O use a statement or data set option or both
O specify the data set options on an input or an output data set.

The following table summarizes the general differences between the DROP, KEEP,
and RENAME statements and the DROP=, KEEP=, and RENAME-= data set options.

Table 5.5 Statements versus Data Set Options for Dropping, Keeping, and
Renaming Variables

Statements Data Set Options

apply to output data sets only. apply to output or input data sets.

affect all output data sets. affect individual data sets.

can be used in DATA steps only. can be used in DATA steps and PROC steps.
can appear anywhere in DATA steps. must immediately follow the name of each data

set to which they apply.

Using the Input or Output Data Set

You must also consider whether you want to drop, keep, or rename the variable
before it is read into the program data vector or as it is written to the new SAS data set.
If you use the DROP, KEEP, or RENAME statement, the action always occurs as the
variables are written to the output data set. With SAS data set options, where you use
the option determines when the action occurs. If the option is used on an input data set,
the variable is dropped, kept, or renamed before it is read into the program data vector.
If used on an output data set, the data set option is applied as the variable is written to
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the new SAS data set. (In the DATA step, an input data set is one that is specified in a
SET, MERGE, or UPDATE statement. An output data set is one that is specified in the
DATA statement.) Consider the following facts when you make your decision:

o If variables are not written to the output data set and they do not require any

processing, using an input data set option to exclude them from the DATA step is

more efficient.

o If you want to rename a variable before processing it in a DATA step, you must

use the RENAME-= data set option in the input data set.
o If the action applies to output data sets, you can use either a statement or a data

set option in the output data set.

The following table summarizes the action of data set options and statements when

they are specified for input and output data sets. The last column of the table tells
whether the variable is available for processing in the DATA step. If you want to

rename the variable, use the information in the last column.

Table 5.6 Status of Variables and Variable Names When Dropping, Keeping, and

Renaming Variables

Where
Specified

Data Set Option
or Statement

Purpose

Status of Variable or
Variable Name

DROP=
KEEP=

Input data set

RENAME=

includes or excludes
variables from processing

changes name of variable
before processing

if excluded, variables are
not available for use in
DATA step

use new name in program
statements and output
data set options; use old
name in other input data
set options

Output data set = DROP, KEEP

RENAME

DROP=

KEEP=

RENAME=

specifies which variables
are written to all output
data sets

changes name of variables
in all output data sets

specifies which variables
are written to individual
output data sets

changes name of variables
in individual output data
sets

all variables available for
processing

use old name in program
statements; use new name
in output data set options

all variables are available
for processing

use old name in program
statements and other
output data set options

Order of Application

If your program requires that you use more than one data set option or a
combination of data set options and statements, it is helpful to know that SAS drops,
keeps, and renames variables in the following order:

O First, options on input data sets are evaluated left to right within SET, MERGE,

and UPDATE statements. DROP= and KEEP= options are applied before the

RENAME-= option.
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0 Next, DROP and KEEP statements are applied, followed by the RENAME
statement.

0 Finally, options on output data sets are evaluated left to right within the DATA
statement. DROP= and KEEP= options are applied before the RENAME= option.

Examples of Dropping, Keeping, and Renaming Variables

The following examples show specific ways to handle dropping, keeping, and

renaming variables:

o0 This example uses the DROP= and RENAME-= data set options and the INPUT
function to convert the variable POPRANK from character to numeric. The name
POPRANK is changed to TEMPVAR before processing so that a new variable
POPRANK can be written to the output data set. Note that the variable
TEMPVAR is dropped from the output data set and that the new name TEMPVAR
is used in the program statements.

data newstate(drop=tempvar);
length poprank 8;
set state(rename=(poprank=tempvar));
poprank=input (tempvar,8.);

run;

o0 This example uses the DROP statement and the DROP= data set option to control
the output of variables to two new SAS data sets. The DROP statement applies to
both data sets, CORN and BEAN. You must use the RENAME= data set option to
rename the output variables BEANWT and CORNWT in each data set.

data corn(rename=(cornwt=yield) drop=beanwt)
bean(rename=(beanwt=yield) drop=cornwt);
set harvest;
if crop='corn’ then output corn;
else if crop='bean’ then output bean;
drop crop;

run;

o0 This example shows how to use data set options in the DATA statement and the
RENAME statement together. Note that the new name QTRTOT is used in the
DROP= data set option.

data gtrl gqtr2 ytd(drop=qgqtrtot);
set ytdsales;
if gtr=1 then output gtrl;
else if gtr=2 then output qtr2;
else output ytd;
rename total=qgtrtot;

run;

Numeric Precision in SAS Software

How SAS Stores Numeric Values

To store numbers of large magnitude and to perform computations that require many
digits of precision to the right of the decimal point, SAS stores all numeric values using



SAS Variables /A Troubleshooting Problems Regarding Floating-Point Representation 91

floating-point, or real binary, representation. Floating-point representation is an
implementation of what is generally known as scientific notation, in which values are
represented as numbers between 0 and 1 times a power of 10. The following is an
example of a number in scientific notation:

4
1234 % 10

Numbers in scientific notation are comprised of the following parts:
0 The base is the number raised to a power; in this example, the base is 10.

0 The mantissa is the number multiplied by the base; in this example, the mantissa
is .1234.

0 The exponent is the power to which the base is raised; in this example, the
exponent is 4.

Floating-point representation is a form of scientific notation, except that on most
operating systems the base is not 10, but is either 2 or 16. The following table
summarizes various representations of floating-point numbers that are stored in 8 bytes.

Table 5.7 Summary of Floating-Point Numbers Stored in 8 Bytes

Maximum
Representation Base Exponent Bits Mantissa Bits
IBM mainframe 16 7 56
IEEE 2 11 52

SAS allows for truncated floating-point numbers via the LENGTH statement, which
reduces the number of mantissa bits. For more information on the effects of truncated
lengths, see “Storing Numbers with Less Precision” on page 95.

Troubleshooting Problems Regarding Floating-Point Representation

Overview

In most situations, the way that SAS stores numeric values does not affect you as a
user. However, floating-point representation can account for anomalies you might notice
in SAS program behavior. The following sections identify the types of problems that can
occur in various operating environments and how you can anticipate and avoid them.

Floating-Point Representation on IBM Mainframes

SAS for z/OS uses the traditional IBM mainframe floating-point representation as
follows:

SEEEEEEE MMMMMMMM MMMMMMMM MMMMMMMM

byte 1 byte 2 byte 3 byte 4

MMMMMMMM - MMMMMMMM = MMMMMMMM - MMMMMMMM
byte 5 byte 6 byte 7 byte 8



92

Troubleshooting Problems Regarding Floating-Point Representation A Chapter 5

This representation corresponds to bytes of data with each character being 1 bit, as
follows:

0 The S in byte 1 is the sign bit of the number. A value of 0 in the sign bit is used to
represent positive numbers.

0 The seven E characters in byte 1 represent a binary integer known as the
characteristic. The characteristic represents a signed exponent and is obtained by
adding the bias to the actual exponent. The bias is an offset used to allow for both
negative and positive exponents with the bias representing 0. If a bias is not used,
an additional sign bit for the exponent must be allocated. For example, if a system
employs a bias of 64, a characteristic with the value 66 represents an exponent of
+2, while a characteristic of 61 represents an exponent of -3.

0 The remaining M characters in bytes 2 through 8 represent the bits of the
mantissa. There is an implied radix point before the leftmost bit of the mantissa;
therefore, the mantissa is always less than 1. The term radix point is used instead
of decimal point because decimal point implies that you are working with decimal
(base 10) numbers, which might not be the case. The radix point can be thought of
as the generic form of decimal point.

The exponent has a base associated with it. Do not confuse this with the base in which
the exponent is represented; the exponent is always represented in binary, but the
exponent is used to determine how many times the base should be multiplied by the
mantissa. In the case of the IBM mainframes, the exponent’s base is 16. For other
machines, it is commonly either 2 or 16.

Each bit in the mantissa represents a fraction whose numerator is 1 and whose

denominator is a power of 2. For example, the leftmost bit in byte 2 represents (%) 1,

the next bit represents (%) 2, and so on. In other words, the mantissa is the sum ofa

series of fractions such as %, L, %, and so on. Therefore, for any floating-point number

to be represented exactly, you must be able to express it as the previously mentioned
sum. For example, 100 is represented as the following expression:

11 2
LT S
<4+8+64>X 6

To illustrate how the above expression is obtained, two examples follow. The first
example is in base 10. The value 100 is represented as follows:

100.

The period in this number is the radix point. The mantissa must be less than 1;
therefore, you normalize this value by shifting the radix point three places to the right,
which produces the following value:

.100
Because the radix point is shifted three places to the right, 3 is the exponent:
3
100 x 10 =100

The second example is in base 16. In hexadecimal notation, 100 (base 10) is written
as follows:
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64.

Shifting the radix point two places to the left produces the following value:

.64

Shifting the radix point also produces an exponent of 2, as in:

2
.64 x 16

The binary value of this number is .01100100, which can be represented in the
following expression:

1 2+ 1 3+ 1 6_1_|_1_|_i
2 2 2 48 64

In this example, the exponent is 2. To represent the exponent, you add the bias of 64
to the exponent. The hexadecimal representation of the resulting value, 66, is 42. The
binary representation is as follows:

01000010 01100100 00000000 00000000
00000000 00000000 00000000 00000000

Floating-Point Representation on OpenVMS

On OpenVMS, SAS stores numeric values in the D-floating format, which has the
following scheme:

mMmMMMMMMM - MMMMMMMM - MMMMMMMM - MMMMMMMM
byte 8 byte 7 byte 6 byte 5

MMMMMMMM MMMMMMMM SEEEEEEE EMMMMMMM
byte 4 byte 3 byte 2 byte 1

In D-floating format, the exponent is 8 bits instead of 7, but uses base 2 instead of
base 16 and a bias of 128, which means the magnitude of the D-floating format is not as
great as the magnitude of the IBM representation. The mantissa of the D-floating
format is, physically, 55 bits. However, all floating-point values under OpenVMS are
normalized, which means it is guaranteed that the high-order bit will always be 1.
Because of this guarantee, there is no need to physically represent the high-order bit in
the mantissa; therefore, the high-order bit is hidden.

For example, the decimal value 100 represented in binary is as follows:

01100100.
This value can be normalized by shifting the radix point as follows:

0.1100100
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Because the radix was shifted to the left seven places, the exponent, 7 plus the bias
of 128, is 135. Represented in binary, the number is as follows:

10000111
To represent the mantissa, subtract the hidden bit from the fraction field:
.100100

You can combine the sign (0), the exponent, and the mantissa to produce the
D-floating format:

MmMMMMMMM - MMMMMMMM = MMMMMMMM = MMMMMMMM
00000000 00000000 00000000 00000000

MMMMMMMM MMMMMMMM SEEEEEEE EMMMMMMM
00000000 00000000 01000011 11001000

Floating-Point Representation Using the IEEE Standard

The Institute of Electrical and Electronic Engineers (IEEE) representation is used by
many operating systems, including Windows and UNIX. The IEEE representation uses
an 11-bit exponent with a base of 2 and bias of 1023, which means that it has much
greater magnitude than the IBM mainframe representation, but sometimes at the
expense of 3 bits less in the mantissa. The value of 1 represented by the IEEE standard
is as follows:

3F FO 00 00 00 00 00 00

Precision Versus Magnitude

As discussed in previous sections, floating-point representation allows for numbers of
very large magnitude (numbers such as 2 to the 30th power) and high degrees of
precision (many digits to the right of the decimal place). However, operating systems
differ on how much precision and how much magnitude they allow.

In “How SAS Stores Numeric Values” on page 90, you can see that the number of
exponent bits and mantissa bits varies. The more bits that are reserved for the
mantissa, the more precise the number; the more bits that are reserved for the
exponent, the greater the magnitude the number can have.

Whether precision or magnitude is more important depends on the characteristics of
your data. For example, if you are working with physics applications, very large
numbers may be needed, and magnitude is probably more important. However, if you
are working with banking applications, where every digit is important but the number
of digits is not great, then precision is more important. Most often, SAS applications
need a moderate amount of both precision and magnitude, which is sufficiently provided
by floating-point representation.

Computational Considerations of Fractions

Regardless of how much precision is available, there is still the problem that some
numbers cannot be represented exactly. In the decimal number system, the fraction 1/3
cannot be represented exactly in decimal notation. Likewise, most decimal fractions (for
example, .1) cannot be represented exactly in base 2 or base 16 numbering systems.
This is the principle reason for difficulty in storing fractional numbers in floating-point
representation.

Consider the IBM mainframe representation of .1:

40 19 99 99 99 99 99 99
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Notice the trailing 9 digit, similar to the trailing 3 digit in the attempted decimal
representation of 1/3 (.3333 ...). This lack of precision is aggravated by arithmetic
operations. Consider what would happen if you added the decimal representation of 1/3
several times. When you add .33333 ... t0 .99999 ... , the theoretical answer is 1.33333
... 2, but in practice, this answer is not possible. The sums become imprecise as the
values continue.

Likewise, the same process happens when the following DATA step is executed:

data _null ;
do i=-1 to 1 by .1;
if i=0 then put 'AT ZERO';
end;

run;

The AT ZERO message in the DATA step is never printed because the accumulation
of the imprecise number introduces enough error that the exact value of 0 is never
encountered. The number is close, but never exactly 0. This problem is easily resolved
by explicitly rounding with each iteration, as the following statements illustrate:

data _null ;
i=-1;
do while(i<=1);
i=round(i+.1,.001);
if i=0 then put 'AT ZERO';
end;

run;

Numeric Comparison Considerations

As discussed in “Computational Considerations of Fractions” on page 94, imprecision
can cause problems with computations. Imprecision can also cause problems with
comparisons. Consider the following example in which the PUT statement is not
executed:

data _null ;

x=1/3;

if x=.33333 then put 'MATCH’;
run;

However, if you add the ROUND function, as in the following example, the PUT
statement is executed:

data _null ;

x=1/3;

if round(x,.00001)=.33333 then put ’'MATCH’;
run;

In general, if you are doing comparisons with fractional values, it is good practice to
use the ROUND function.

Storing Numbers with Less Precision

As discussed in “How SAS Stores Numeric Values” on page 90, SAS allows for
numeric values to be stored on disk with less than full precision. Use the LENGTH
statement to dictate the number of bytes that are used to store the floating-point
number. Use the LENGTH statement carefully to avoid significant data loss.

For example, the IBM mainframe representation uses 8 bytes for full precision, but
you can store as few as 2 bytes on disk. The value 1 is represented as 41 10 00 00 00 00
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00 00 in 8 bytes. In 2 bytes, it would be truncated to 41 10. You still have the full range
of magnitude because the exponent remains intact; there are simply fewer digits
involved. A decrease in the number of digits means either fewer digits to the right of
the decimal place or fewer digits to the left of the decimal place before trailing zeroes
must be used.

For example, consider the number 1234567890, which would be .1234567890 to the
10th power of 10 (in base 10). If you have only five digits of precision, the number
becomes 123460000 (rounding up). Note that this is the case regardless of the power of
10 that is used (.12346, 12.346, .0000012346, and so on).

The only reason to truncate length by using the LENGTH statement is to save disk
space. All values are expanded to full size to perform computations in DATA and PROC
steps. In addition, you must be careful in your choice of lengths, as the previous
discussion shows.

Consider a length of 2 bytes on an IBM mainframe system. This value allows for 1
byte to store the exponent and sign, and 1 byte for the mantissa. The largest value that
can be stored in 1 byte is 255. Therefore, if the exponent is 0 (meaning 16 to the Oth
power, or 1 multiplied by the mantissa), then the largest integer that can be stored with
complete certainty is 255. However, some larger integers can be stored because they are
multiples of 16. For example, consider the 8-byte representation of the numbers 256 to
272 in the following table:

Table 5.8 Representation of the Numbers 256 to 272 in Eight Bytes

Value Sign/Exp Mantissa 1 Mantissa 2-7 Considerations

256 43 10 000000000000 trailing zeros;
multiple of 16

257 43 10 100000000000 extra byte needed

258 43 10 200000000000

259 43 10 300000000000

271 43 10 F00000000000

272 43 11 000000000000 trailing zeros;

multiple of 16

The numbers from 257 to 271 cannot be stored exactly in the first 2 bytes; a third
byte is needed to store the number precisely. As a result, the following code produces
misleading results:

data temp;
length x 2;
x=257;
yl=x+1;

run;

data _null ;
set temp;
if x=257 then put 'FOUND’;
y2=x+1;

run;
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The PUT statement is never executed because the value of X is actually 256 (the
value 257 truncated to 2 bytes). Recall that 256 is stored in 2 bytes as 4310, but 257 is
also stored in 2 bytes as 4310, with the third byte of 10 truncated.

You receive no warning that the value of 257 is truncated in the first DATA step.
Note, however, that Y1 has the value 258 because the values of X are kept in full,
8-byte floating-point representation in the program data vector. The value is only
truncated when stored in a SAS data set. Y2 has the value 257, because X is truncated
before the number is read into the program data vector.

CAUTION:
Do not use the LENGTH statement if your variable values are not integers. Fractional
numbers lose precision if truncated. Also, use the LENGTH statement to truncate
values only when disk space is limited. Refer to the length table in the SAS
documentation for your operating environment for maximum values. 2

Truncating Numbers and Making Comparisons

The TRUNC function truncates a number to a requested length and then expands
the number back to full length. The truncation and subsequent expansion duplicate the
effect of storing numbers in less than full length and then reading them. For example,
if the variable

x=1/3;
is stored with a length of 3, then the following comparison is not true:
if x=1/3 then ...;
However, adding the TRUNC function makes the comparison true, as in the following:

if x=trunc(1l/3,3) then ...;

Determining How Many Bytes Are Needed to Store a Number Accurately

To determine the minimum number of bytes needed to store a value accurately, you
can use the TRUNC function. For example, the following program finds the minimum
length of bytes (MINLEN) needed for numbers stored in a native SAS data set named

NUMBERS. The data set NUMBERS contains the variable VALUE. VALUE contains a
range of numbers, in this example, from 269 to 272:

data numbers;
input value;
datalines;

269

270

271

272

r

data temp;
set numbers;
x=value;
do L=8 to 1 by -1;
if x NE trunc(x,L) then
do;
minlen=L+1;
output;
return;
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end;
end;

run;

proc print noobs;
var value minlen;

run;

The following output shows the results from this code.

Output 5.3 Using the TRUNC Function

The SAS System

VALUE MINLEN
269 3
270 3
271 3
272 2

Note that the minimum length required for the value 271 is greater than the minimum
required for the value 272. This fact illustrates that it is possible for the largest
number in a range of numbers to require fewer bytes of storage than a smaller number.
If precision is needed for all numbers in a range, you should obtain the minimum
length for all the numbers, not just the largest one.

Double-Precision Versus Single-Precision Floating-Point Numbers

You might have data created by an external program that you want to read into a
SAS data set. If the data is in floating-point representation, you can use the RBw.d
informat to read in the data. However, there are exceptions.

The RBw.d informat might truncate double-precision floating-point numbers if the w
value is less than the size of the double-precision floating-point number (8 on all the
operating systems discussed in this section). Therefore, the RB8. informat corresponds
to a full 8-byte floating point. The RB4. informat corresponds to an 8-byte floating point
truncated to 4 bytes, exactly the same as a LENGTH 4 in the DATA step.

An 8-byte floating point that is truncated to 4 bytes might not be the same as float in
a C program. In the C language, an 8-byte floating-point number is called a double. In
FORTRAN, it is a REAL*8. In IBM’s PL/I, it is a FLOAT BINARY(53). A 4-byte
floating-point number is called a float in the C language, REAL*4 in FORTRAN, and
FLOAT BINARY(21) in IBM’s PL/I.

On the IBM mainframes, a single-precision floating-point number is exactly the same
as a double-precision number truncated to 4 bytes. On operating systems that use the
IEEE standard, this is not the case; a single-precision floating-point number uses a
different number of bits for its exponent and uses a different bias, so that reading in
values using the RB4. informat does not produce the expected results.

Transferring Data between Operating Systems

The problems of precision and magnitude when you use floating-point numbers are
not confined to a single operating system. Additional problems can arise when you
move from one operating system to another, unless you use caution. This section
discusses factors to consider when you are transporting data sets with very large or
very small numeric values by using the UPLOAD and DOWNLOAD procedures, the
CPORT and CIMPORT procedures, or transport engines.
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Table 5.7 on page 91 shows the maximum number of digits of the base, exponent, and
mantissa. Because there are differences in the maximum values that can be stored in
different operating environments, there might be problems in transferring your
floating-point data from one machine to another.

Consider, for example, transporting data between an IBM mainframe and a PC. The
IBM mainframe has a range limit of approximately .54E-78 to .72E76 (and their
negative equivalents and 0) for its floating-point numbers. Other machines, such as the
PC, have wider limits (the PC has an upper limit of approximately 1E308). Therefore, if
you are transferring numbers in the magnitude of 1E100 from a PC to a mainframe,
you lose that magnitude. During data transfer, the number is set to the minimum or
maximum allowable on that operating system, so 1E100 on a PC is converted to a value
that is approximately .72E76 on an IBM mainframe.

CAUTION:
Transfer of data between machines can affect numeric precision. If you are transferring
data from an IBM mainframe to a PC, notice that the number of bits for the
mantissa is 4 less than that for an IBM mainframe, which means you lose 4 bits
when moving to a PC. This precision and magnitude difference is a factor when
moving from one operating environment to any other where the floating-point
representation is different. A
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Definition of Missing Values

missing value

is a value that indicates that no data value is stored for the variable in the current
observation. There are three kinds of missing values:

O numeric
O character
O special numeric.
By default, SAS prints a missing numeric value as a single period (.) and a

missing character value as a blank space. See “Special Missing Values” on page
102 for more information about special numeric missing values.
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Special Missing Values

Definition

special missing value

is a type of numeric missing value that enables you to represent different
categories of missing data by using the letters A-Z or an underscore.

Tips

SAS accepts either uppercase or lowercase letters. Values are displayed and
printed as uppercase.

If you do not begin a special numeric missing value with a period, SAS identifies it
as a variable name. Therefore, to use a special numeric missing value in a SAS
expression or assignment statement, you must begin the value with a period,
followed by the letter or underscore, as in the following example:

x=.d;

When SAS prints a special missing value, it prints only the letter or underscore.

O When data values contain characters in numeric fields that you want SAS to

interpret as special missing values, use the MISSING statement to specify those
characters. For further information, see the MISSING statement in SAS
Language Reference: Dictionary.

Example

The following example uses data from a marketing research company. Five testers
were hired to test five different products for ease of use and effectiveness. If a tester
was absent, there is no rating to report, and the value is recorded with an X for
“absent.” If the tester was unable to test the product adequately, there is no rating, and
the value is recorded with an I for “incomplete test.” The following program reads the
data and displays the resulting SAS data set. Note the special missing values in the
first and third data lines:

data period_a;

missing X I;
input Id $4. Foodprl Foodpr2 Foodpr3 Coffeeml Coffeem2;

datalines;

1001 115 45 65 I 78
1002 86 27 55 72 86
1004 93 52 X 76 88
1015 73 35 43 112 108
1027 101 127 39 76 79

r

proc print data=period_a;

title 'Results of Test Period A’;
footnotel ’'X indicates TESTER ABSENT';
footnote2 ’'I indicates TEST WAS INCOMPLETE';

run;
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The following output is produced:

Output 6.1 Output with Multiple Missing Values

Results of Test Period A

Obs Id Foodprl Foodpr2 Foodpr3 Coffeeml Coffeem2
1 1001 115 45 65 I 78
2 1002 86 27 55 72 86
3 1004 93 52 X 76 88
4 1015 73 35 43 112 108
5 1027 101 127 39 76 79

X indicates TESTER ABSENT
I indicates TEST WAS INCOMPLETE

Order of Missing Values

Numeric Variables

Within SAS, a missing value for a numeric variable is smaller than all numbers; if
you sort your data set by a numeric variable, observations with missing values for that
variable appear first in the sorted data set. For numeric variables, you can compare
special missing values with numbers and with each other. Table 6.1 on page 103 shows
the sorting order of numeric values.

Table 6.1 Numeric Value Sort Order

Sort Order Symbol Description
smallest " underscore
period
A-7Z special missing values A
(smallest) through Z
(largest)
-n negative numbers
0 Zero
largest +n positive numbers

For example, the numeric missing value (.) is sorted before the special numeric
missing value .A, and both are sorted before the special missing value .Z. SAS does not
distinguish between lowercase and uppercase letters when sorting special numeric
missing values.

Note: The numeric missing value sort order is the same regardless of whether your
system uses the ASCII or EBCDIC collating sequence. A
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Character Variables

Missing values of character variables are smaller than any printable character value.
Therefore, when you sort a data set by a character variable, observations with missing
(blank) values of the BY variable always appear before observations in which values of
the BY variable contain only printable characters. However, some usually unprintable
characters (for example, machine carriage-control characters and real or binary numeric
data that have been read in error as character data) have values less than the blank.
Therefore, when your data includes unprintable characters, missing values may not
appear first in a sorted data set.

When Variable Values Are Automatically Set to Missing hy SAS

When Reading Raw Data
At the beginning of each iteration of the DATA step, SAS sets the value of each
variable you create in the DATA step to missing, with the following exceptions:
O variables named in a RETAIN statement
variables created in a SUM statement
data elements in a _'TEMPORARY_ array
variables created with options in the FILE or INFILE statements
variables created by the FGET function
data elements which are initialized in an ARRAY statement

O O oo o d

automatic variables.

SAS replaces the missing values as it encounters values that you assign to the
variables. Thus, if you use program statements to create new variables, their values in
each observation are missing until you assign the values in an assignment statement,
as shown in the following DATA step:

data new;
input x;
if x=1 then y=2;
datalines;

4

1

3

1

r

This DATA step produces a SAS data set with the following variable values:

OBS X Y
1 4
2 1 2
3 3 .
4 1 2

When X equals 1, the value of Y is set to 2. Since no other statements set Y’s value
when X is not equal to 1, Y remains missing (.) for those observations.
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When Reading a SAS Data Set

When variables are read with a SET, MERGE, or UPDATE statement, SAS sets the
values to missing only before the first iteration of the DATA step. (If you use a BY
statement, the variable values are also set to missing when the BY group changes.) The
variables retain their values until new values become available; for example, through
an assignment statement or through the next execution of the SET, MERGE, or
UPDATE statement. Variables created with options in the SET, MERGE, and UPDATE
statements also retain their values from one iteration to the next.

When all of the rows in a data set in a match-merge operation (with a BY statement)
have been processed, the variables in the output data set retain their values as
described earlier. That is, as long as there is no change in the BY value in effect when
all of the rows in the data set have been processed, the variables in the output data set
retain their values from the final observation. FIRST.variable and LAST.variable, the
automatic variables that are generated by the BY statement, both retain their values.
Their initial value is 1.

When the BY value changes, the variables are set to missing and remain missing
because the data set contains no additional observations to provide replacement values.
When all of the rows in a data set in a one-to-one merge operation (without a BY
statement) have been processed, the variables in the output data set are set to missing
and remain missing.

When Missing Values Are Generated hy SAS

Propagation of Missing Values in Calculations

SAS assigns missing values to prevent problems from arising. If you use a missing
value in an arithmetic calculation, SAS sets the result of that calculation to missing.
Then, if you use that result in another calculation, the next result is also missing. This
action is called propagation of missing values. SAS prints notes in the log to notify you
which arithmetic expressions have missing values and when they were created;
however, processing continues.

lllegal Operations

SAS prints a note in the log and assigns a missing value to the result if you try to
perform an illegal operation, such as the following:

o dividing by zero

O taking the logarithm of zero

O using an expression to produce a number too large to be represented as a
floating-point number (known as overflow).

lllegal Character-to-Numeric Conversions

SAS automatically converts character values to numeric values if a character
variable is used in an arithmetic expression. If a character value contains
nonnumerical information and SAS tries to convert it to a numeric value, a note is
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printed in the log, the result of the conversion is set to missing, and the _ERROR_
automatic variable is set to 1.

Special Missing Values

The result of any numeric missing value in a SAS expression is a period. Thus, both
special missing values and ordinary numeric missing values propagate as a period.
data a;
x=.d;
y=x+1;
put y=;

run;

This DATA step results in the following log:

Output 6.2 SAS Log Results for a Missing Value

1 data a;

2 x= .d;
3 y=x+1;
4 put y=;
5 run;

y=.

NOTE: Missing values were generated as a result of performing an
operation on missing values.
Each place is given by:
(Number of times) at (Line):(Column).
1 at 3:6
NOTE: The data set WORK.A has 1 observations and 2 variables.
NOTE: DATA statement used:
real time 0.58 seconds
cpu time 0.05 seconds

Preventing Propagation of Missing Values

If you do not want missing values to propagate in your arithmetic expressions, you
can omit missing values from computations by using the sample statistic functions. For
a list of these functions, see the descriptive statistics category in “Functions and CALL
Routines by Category” in the SAS Language Reference: Dictionary. For example,
consider the following DATA step:

data test;
X=.;
y=5;
a=x+y;
b=sum(x,y);
c=5;
c+x;
put a= b= c=;

run;
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Output 6.3 SAS Log Results for a Missing Value in a Statistic Function

1
2
3
4
5
6
7
8
9
NOTE:

NOTE:
NOTE:

a=. b=

data test;

X=.;
y=5;

a=x+y;
b=sum(x,y);
c=5;

c+x;

put a= b= c=;

run;

5 c=5

Missing values were generated as a result of performing
an operation on missing values.

Each place is given by:

(Number of times) at (Line):(Column).

1 at 4:6

The data set WORK.TEST has 1 observations and 5 variables.
DATA statement used:

real time 0.11 seconds

cpu time 0.03 seconds

107

Adding X and Y together in an expression produces a missing result because the value
of X is missing. The value of A, therefore, is missing. However, since the SUM function

ignores missing values, adding X to Y produces the value 5, not a missing value.

Note:

The SUM statement also ignores missing values, so the value of C is also 5. A

Working with Missing Values

How to Represent Missing Values in Raw Data

Table 6.2 on page 107 shows how to represent each type of missing value in raw data

so that

SAS will read and store the value appropriately.

Table 6.2 Representing Missing Values

These missing values ... Are represented by ... Explanation

Numeric a single decimal point

Character ’? a blank enclosed in quotes

Special a decimal point followed by
a letter, for example, .B

Special _ a decimal point followed by

an underscore

How to Set Variable Values to Missing in a DATA Step

You can set values to missing within your DATA step by using program statements

such as this one:

if age<0 then age=.;
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This statement sets the stored value of AGE to a numeric missing value if AGE has a
value less than 0.

Note: You can display a missing numeric value with a character other than a period
by using the DATA step’s MISSING statement or the MISSING= system option. A

The following example sets the stored value of NAME to a missing character value if
NAME has a value of “none”:

if name="none" then name=’' ';

Alternatively, if you want to set to a missing value for one or more variable values,
you can use the CALL MISSING routine. For example,

call missing(sales, name);
sets both variable values to a missing value.

Note: You can mix character and numeric variables in the CALL MISSING routine
argument list. A

How to Check for Missing Values in a DATA Step

You can use the N and NMISS functions to return the number of nonmissing and
missing values, respectively, from a list of numeric arguments.

When you check for ordinary missing numeric values, you can use code that is
similar to the following:

if numvar=. then do;

If your data contains special missing values, you can check for either an ordinary or
special missing value with a statement that is similar to the following:

if numvar<=.z then do;

To check for a missing character value, you can use a statement that is similar to the
following:

if charvar=’ ' then do;

The MISSING function enables you to check for either a character or numeric missing
value, as in:

if missing(var) then do;

In each case, SAS checks whether the value of the variable in the current observation
satisfies the condition specified. If it does, SAS executes the DO group.

Note: Missing values have a value of false when you use them with logical
operators such as AND or OR. A
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Definitions for SAS Expressions

expression
is generally a sequence of operands and operators that form a set of instructions
that are performed to produce a resulting value. You use expressions in SAS
program statements to create variables, assign values, calculate new values,
transform variables, and perform conditional processing. SAS expressions can
resolve to numeric values, character values, or Boolean values.

operands
are constants or variables that can be numeric or character.

operators
are symbols that represent a comparison, arithmetic calculation, or logical
operation; a SAS function; or grouping parentheses.

simple expression
is an expression with no more than one operator. A simple expression can consist
of a single

O constant
O variable
o function.

compound expression
is an expression that includes several operators. When SAS encounters a
compound expression, it follows rules to determine the order in which to evaluate
each part of the expression.

WHERE expressions
is a type of SAS expression that is used within a WHERE statement or WHERE=
data set option to specify a condition for selecting observations for processing in a
DATA or PROC step. For syntax and further information on WHERE expressions,
see Chapter 12, “WHERE-Expression Processing,” on page 195 and SAS Language
Reference: Dictionary

Examples of SAS Expressions

The following are examples of SAS expressions:
o3

o x

0O x+1

O age<100
O trim(last)||’, '||first

SAS Constants in Expressions

Definition

A SAS constant is a number or a character string that indicates a fixed value.
Constants can be used as expressions in many SAS statements, including variable
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assignment and IF-THEN statements. They can also be used as values for certain
options. Constants are also called literals.
The following are types of SAS constants:

O character

O numeric

O date, time, and datetime
O bit testing.

Character Constants

A character constant consists of 1 to 32,767 characters and must be enclosed in
quotation marks. Character constants can also be represented in hexadecimal form.

Using Quotation Marks With Character Constants
In the following SAS statement, Tom is a character constant:
if name='Tom’ then do;

If a character constant includes a single quotation mark, surround it with double
quotation marks. For example, to specify the character value Tom’s as a constant, enter

name="Tom'’'s"

Another way to write the same string is to enclose the string in single quotation marks
and to express the apostrophe as two consecutive quotation marks. SAS treats the two
consecutive quotation marks as one quotation mark:

name='Tom’’'s’
The same principle holds true for double quotation marks:

name="Tom""s"

CAUTION:
Matching quotation marks correctly is important. Missing or extraneous quotation marks
cause SAS to misread both the erroneous statement and the statements that follow
it. For example, in name='0'Brien’ ;, 0 is the character value of NAME, Brien is
extraneous, and ’; begins another quoted string. A

Comparing Character Constants and Character Variables

It is important to remember that character constants are enclosed in quotation
marks, but names of character variables are not. This distinction applies wherever you
can use a character constant, such as in titles, footnotes, labels, and other descriptive
strings; in option values; and in operating environment-specific strings, such as file
specifications and commands.

The following statements use character constants:

0O x='abc’;

O if name=’Smith’ then do;

The following statements use character variables:
O x=abc;

O if name=Smith then do;
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In the second set of examples, SAS searches for variables named ABC and SMITH,
instead of constants.

Note: SAS distinguishes between uppercase and lowercase when comparing quoted
values. For example, the character values 'Smith’ and 'SMITH’ are not equivalent. A

Character Constants Expressed in Hexadecimal Notation

SAS character constants can be expressed in hexadecimal notation. A character hex
constant is a string of an even number of hex characters enclosed in single or double
quotation marks, followed immediately by an X, as in this example:

'534153'x

A comma can be used to make the string more readable, but it is not part of and does
not alter the hex value. If the string contains a comma, the comma must separate an
even number of hex characters within the string, as in this example:

if value='3132,3334’'x then do;

CAUTION:
Trailing blanks or leading blanks cause an error. Any trailing blanks or leading blanks
within the quotation marks cause an error message to be written to the log. A

Numeric Constants

A numeric constant is a number that appears in a SAS statement. Numeric
constants can be presented in many forms, including

O standard notation

O scientific (E) notation

0 hexadecimal notation.

Numeric Constants Expressed in Standard Notation

Most numeric constants are written just as numeric data values are. The numeric
constant in the following expression is 100:

part/all*100

Numeric constants can be expressed in standard notation in the following ways:

Table 7.1 Standard Notation for Numeric Constants

Numeric Constant Description
1 is an unsigned integer
-5 contains a minus sign

+49 contains a plus sign
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Numeric Constant Description
1.23 contains decimal places
01 contains a leading zero which is not significant

Numeric Constants Expressed in Scientific Notation

In scientific notation, the number before the E is multiplied by the power of ten that
is indicated by the number after the E. For example, 2E4 is the same as 2x10" or
20,000. For numeric constants larger than (10” )-1, you must use scientific notation.
Additional examples follow:

O 1.2e23

O 0.5e-10

Numeric Constants Expressed in Hexadecimal Notation

A numeric constant that is expressed as a hexadecimal value starts with a numeric
digit (usually 0), can be followed by more hexadecimal digits, and ends with the letter
X. The constant can contain up to 16 valid hexadecimal digits (0 to 9, A to F). The
following are numeric hex constants:

O Oclx

O 9x
You can use numeric hex constants in a DATA step, as follows:

data test;
input abend pib2.;
if abend=0clx or abend=0b0ax then do;
.. more SAS statements ..

run;

Date, Time, and Datetime Constants

You can create a date constant, time constant, or datetime constant by specifying the
date or time in single or double quotation marks, followed by a D (date), T (time), or DT
(datetime) to indicate the type of value.

Any trailing blanks or leading blanks included within the quotation marks will not
affect the processing of the date constant, time constant, or datetime constant.

Use the following patterns to create date and time constants:

‘ddmmm<yy>yy’D or "ddmmm<yy>yy"D represents a SAS date value:

O date='1jan2006'd;

O date='01jan04’d;
’hh:mm<:ss.s>"T or "hh:mm<:ss.s>"T represents a SAS time value:

O time='9:25't;

O time='9:25:19pm’'t;
‘ddmmm<yy>yy:hh:mm<:ss.s>’DT or "ddmmm<yy>yy:hh:mm<:ss.s>"DT represents a
SAS datetime value:

O if begin='01lmay04:9:30:00’'dt then end='31dec90:5:00:00'dt;

O dtime='18jan2003:9:27:05am’'dt;
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For more information on SAS dates, refer to Chapter 8, “Dates, Times, and
Intervals,” on page 127.

Bit Testing Constants

Bit masks are used in bit testing to compare internal bits in a value’s representation.
You can perform bit testing on both character and numeric variables. The general form
of the operation is:

expression comparison-operator bit-mask
The following are the components of the bit-testing operation:

expression
can be any valid SAS expression. Both character and numeric variables can be bit
tested. When SAS tests a character value, it aligns the left-most bit of the mask
with the left-most bit of the string; the test proceeds through the corresponding
bits, moving to the right. When SAS tests a numeric value, the value is truncated
from a floating-point number to a 32-bit integer. The right-most bit of the mask is
aligned with the right-most bit of the number, and the test proceeds through the
corresponding bits, moving to the left.

comparison-operator
compares an expression with the bit mask. Refer to “Comparison Operators” on
page 118 for a discussion of these operators.

bit-mask
is a string of 0s, 1s, and periods in quotation marks that is immediately followed
by a B. Zeros test whether the bit is off; ones test whether the bit is on; and
periods ignore the bit. Commas and blanks can be inserted in the bit mask for
readability without affecting its meaning.

CAUTION:
Truncation can occur when SAS uses a bit mask. If the expression is longer than the bit
mask, SAS truncates the expression before it compares it with the bit mask. A false
comparison may result. An expression’s length (in bits) must be less than or equal to
the length of the bit mask. If the bit mask is longer than a character expression, SAS
prints a warning in the log, stating that the bit mask is truncated on the left, and
continues processing. A

The following example tests a character variable:
if a='..1.0000’'b then do;

If the third bit of A (counting from the left) is on, and the fifth through eighth bits are
off, the comparison is true and the expression result is 1. Otherwise, the comparison is
false and the expression result is 0. The following is a more detailed example:

data test;
input @88 bits S$charl.;
if bits='10000000'b
then category='a’;
else if bits='01000000'b
then category='b’;
else if bits='00100000'b
then category='c’;

run;
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Note: Bit masks cannot be used as bit literals in assignment statements. For
example, the following statement is not valid:

x='0101"b; /* incorrect */
A

The $BINARYw. and BINARYw. formats and the $BINARYw., BINARYw.d, and
BITSw.d informats can be useful for bit testing. You can use them to convert character
and numeric values to their binary values, and vice versa, and to extract specified bits

from input data. See SAS Language Reference: Dictionary for complete descriptions of
these formats and informats.

Avoiding a Common Error With Constants

When you use a string in quotation marks followed by a variable name, always put a
blank space between the closing quotation mark and the variable name. Otherwise,
SAS might interpret a character constant followed by a variable name as a special SAS
constant as illustrated in this table.

Table 7.2 Characters That Cause Misinterpretation When Following a Character
Constant

Characters that follow a

character constant Possible interpretation Examples

b bit testing constant ’00100000’b

d date constant ’01jan04’d

dt datetime constant ’18jan2005:9:27:05am’dt
n name literal "My Table’n

t time constant ’9:25:19pm’t

X hexadecimal notation ’534153’x

In the following example, ’821’t is evaluated as a time constant. For more information
about SAS time constants, see “Date, Time, and Datetime Constants” on page 113.

data work.europe;
set ia.europe;
if flight='821’then
flight='230";

run;

The program writes the following lines to the SAS log:

Output 7.1 Log Results from an Error Caused by a Time Literal Misinterpretation

ERROR: Invalid date/time/datetime constant ’821't.
ERROR 77--185: Invalid number conversion on '821't.

ERROR 388--185: Expecting an arithmetic operator.

Inserting a blank space between the ending quotation mark and the succeeding
character in the IF statement eliminates this misinterpretation. No error message is



116

SAS Variables in Expressions A Chapter 7

generated and all observations with a FLIGHT value of 821 are replaced with a value of
230.

if flight='821' then
flight='230";

SAS Variables in Expressions

Definition

variable
is a set of data values that describe a given characteristic. A variable can be used
in an expression.

Automatic Numeric-Character Gonversion

If you specify a variable in an expression, but the variable value does not match the
type called for, SAS attempts to convert the value to the expected type. SAS
automatically converts character variables to numeric variables and numeric variables
to character variables, according to the following rules:

0 If you use a character variable with an operator that requires numeric operands,
such as the plus sign, SAS converts the character variable to numeric.

o If you use a comparison operator, such as the equal sign, to compare a character
variable and a numeric variable, the character variable is converted to numeric.

o If you use a numeric variable with an operator that requires a character value,
such as the concatenation operator, the numeric value is converted to character
using the BEST12. format. Because SAS stores the results of the conversion
beginning with the right-most byte, you must store the converted values in a
variable of sufficient length to accommodate the BEST12. format. You can use the
LEFT function to left-justify a result.

O If you use a numeric variable on the left side of an assignment statement and a
character variable on the right, the character variable is converted to numeric. In
the opposite situation, where the character variable is on the left and the numeric
is on the right, SAS converts the numeric variable to character using the BESTn.
format, where n is the length of the variable on the left.

When SAS performs an automatic conversion, it prints a note in the SAS log
informing you that the conversion took place. If converting a character variable to
numeric produces invalid numeric values, SAS assigns a missing value to the result,
prints an error message in the log, and sets the value of the automatic variable
_ERROR_ to 1.

Note: You can also use the PUT and INPUT functions to convert data values. These
functions can be more efficient than automatic conversion. See “The Concatenation
Operator” on page 123 for an example of the PUT function. See SAS Language
Reference: Dictionary for more details on these functions. A

For more information on SAS variables, see Chapter 5, “SAS Variables,” on page 77
or the SAS Language Reference: Dictionary.
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SAS Functions in Expressions

A SAS function is a keyword that you use to perform a specific computation or
system manipulation. Functions return a value, might require one or more arguments,
and can be used in expressions. For further information on SAS functions, see SAS
Language Reference: Dictionary.

SAS Operators in Expressions

Definitions

A SAS operator is a symbol that represents a comparison, arithmetic calculation, or
logical operation; a SAS function; or grouping parentheses. SAS uses two major kinds
of operators:

O prefix operators

O infix operators.

A prefix operator is an operator that is applied to the variable, constant, function, or
parenthetic expression that immediately follows it. The plus sign (+) and minus sign (-)
can be used as prefix operators. The word NOT and its equivalent symbols are also

prefix operators. The following are examples of prefix operators used with variables,
constants, functions, and parenthetic expressions:

O +y
O -25
O -cos(anglel)
O +(x*y)
An infix operator applies to the operands on each side of it, for example, 6<8. Infix
operators include the following:
O arithmetic
comparison
logical, or Boolean
minimum

maximum

O 0o o o o

concatenation.

When used to perform arithmetic operations, the plus and minus signs are infix
operators.

SAS also provides several other operators that are used only with certain SAS
statements. The WHERE statement uses a special group of SAS operators, valid only
when used with WHERE expressions. For a discussion of these operators, see Chapter
12, “WHERE-Expression Processing,” on page 195.
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Arithmetic Operators

Arithmetic operators indicate that an arithmetic calculation is performed, as shown
in the following table:

Table 7.3 Arithmetic Operators

Symbol Definition Example Result

wE exponentiation a**3 raise A to the third
power

* rnultiplication1 2%y multiply 2 by the
value of Y

/ division var/5 divide the value of
VAR by 5

+ addition num+3 add 3 to the value of
NUM

- subtraction sale-discount subtract the value of

DISCOUNT from the
value of SALE

1 The asterisk (*) is always necessary to indicate multiplication; 2Y and 2 (Y) are not valid expressions.

If a missing value is an operand for an arithmetic operator, the result is a missing
value. See Chapter 6, “Missing Values,” on page 101 for a discussion of how to prevent
the propagation of missing values.

See “Order of Evaluation in Compound Expressions” on page 124 for the order in
which SAS evaluates these operators.

Comparison Operators

Comparison operators set up a comparison, operation, or calculation with two
variables, constants, or expressions. If the comparison is true, the result is 1. If the
comparison is false, the result is 0.

Comparison operators can be expressed as symbols or with their mnemonic
equivalents, which are shown in the following table:

Table 7.4 Comparison Operators

Symbol Mnemonic Definition Example
Equivalent

= EQ equal to =3

A= NE not equal to! a ne 3

- NE not equal to

~= NE not equal to

> GT greater than num>5

< LT less than num<8

>= GE greater than or equal sales>=300

to2
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Symbol Mnemonic Definition Example
Equivalent

<= LE less than or equal to3 sales<=100
IN equal to one of a list num in (3, 4, 5)

1 The symbol you use for NE depends on your terminal.

2 The symbol => is also accepted for compatibility with previous releases of SAS. It is not supported in
WHERE clauses or in PROC SQL.

3 The symbol =< is also accepted for compatibility with previous releases of SAS. It is not supported in
WHERE clauses or in PROC SQL.

See “Order of Evaluation in Compound Expressions” on page 124 for the order in
which SAS evaluates these operators.

Note: You can add a colon (:) modifier to any of the operators to compare only a
specified prefix of a character string. See “Character Comparisons” on page 120 for
details. 2

Note: You can use the IN operator to compare a value that is produced by an
expression on the left of the operator to a list of values that are given on the right. The
form of the comparison is:

expression IN (value-I1<...,value-n>)
The components of the comparison are as follows:

expression can be any valid SAS expression, but is usually a variable name
when it is used with the IN operator.

value must be a constant.

For examples of using the IN operator, see “The IN Operator in Numeric
Comparisons” on page 120. 2

Numeric Comparisons

SAS makes numeric comparisons that are based on values. In the expression A<=B,
if A has the value 4 and B has the value 3, then A<=B has the value 0, or false. If A is
5 and B is 9, then the expression has the value 1, or true. If A and B each have the
value 47, then the expression is true and has the value 1.

Comparison operators appear frequently in IF-THEN statements, as in this example:

if x<y then c=5;
else c=12;

You can also use comparisons in expressions in assignment statements. For example,
the preceding statements can be recoded as follows:

c=5%(x<y)+12*(x>=y);

Since SAS evaluates quantities inside parentheses before performing any operations,
the expressions (x<y) and (x>=y) are evaluated first and the result (1 or 0) is
substituted for the expressions in parentheses. Therefore, if X=6 and Y=8, the
expression evaluates as follows:

c=5%(1)+12*(0)

The result of this statement is C=5.
You might get an incorrect result when you compare numeric values of different
lengths because values less than 8 bytes have less precision than those longer than 8
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bytes. Rounding also affects the outcome of numeric comparisons. See Chapter 5, “SAS
Variables,” on page 77 for a complete discussion of numeric precision.

A missing numeric value is smaller than any other numeric value, and missing
numeric values have their own sort order (see Chapter 6, “Missing Values,” on page 101
for more information).

The IN Operator in Numeric Comparisons

In a DATA step, you can use a shorthand notation to specify a range of sequential
integers to search. The range is specified by using the syntax M:N as a value in the list
to search, where M is the lower bound and N is the upper bound. M and N must be
integers, and M, N, and all the integers between M and N are included in the range.
For example, the following statements are equivalent.

Ody=xin (1, 2, 3, 4, 5, 6, 7, 8, 9, 10);

Oy =x in (1:10);

You can use multiple ranges in the same IN list, and you can use ranges with other
constants in an IN list. The following example shows a range that is used with other
constants to test if X is 0, 1, 2, 3, 4, 5, or 9.

if x in (0,9,1:5);

Note: PROC SQL or WHERE clauses do not support this syntax. 2

Character Comparisons

You can perform comparisons on character operands, but the comparison always
yields a numeric result (1 or 0). Character operands are compared character by
character from left to right. Character order depends on the collating sequence, usually
ASCII or EBCDIC, used by your computer.

For example, in the EBCDIC and ASCII collating sequences, G is greater than a;
therefore, this expression is true:

'Gray’'>'Adams’

Two character values of unequal length are compared as if blanks were attached to
the end of the shorter value before the comparison is made. A blank, or missing
character value, is smaller than any other printable character value. For example,
because . is less than h, this expression is true:

'C. Jones'’<’Charles Jones’

Since trailing blanks are ignored in a comparison, ' fox ’ is equivalent to ' fox’.
However, because blanks at the beginning and in the middle of a character value are
significant to SAS, ’ fox’ is not equivalent to 'fox"’.

You can compare only a specified prefix of a character string by using a colon (:) after
the comparison operator. In the following example, the colon modifier after the equal
sign tells SAS to look at only the first character of values of the variable LASTNAME
and to select the observations with names beginning with the letter s:

if lastname=:'S’;

Because printable characters are greater than blanks, both of the following
statements select observations with values of LASTNAME that are greater than or
equal to the letter s:

O if lastname>='S’;

O if lastname>=:'S’;
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Note: If you compare a zero-length character value with any other character value
in either an IN: comparison or an EQ: comparison, the two character values are not
considered equal. The result always evaluates to 0, or false. A

The operations that are discussed in this section show you how to compare entire
character strings and the beginnings of character strings. Several SAS character
functions enable you to search for and extract values from within character strings. See
SAS Language Reference: Dictionary for complete descriptions of all SAS functions.

The IN Operator in Character Comparisons

You can use the IN operator with character strings to determine whether a variable’s
value is among a list of character values. The following statements produce the same
results:

O if state in ('NY’,'NJ’,’'PA’) then region+l;

O if state='NY’ or state='NJ’ or state='PA’ then region+l;

Logical (Boolean) Operators and Expressions

Logical operators, also called Boolean operators, are usually used in expressions to
link sequences of comparisons. The logical operators are shown in the following table:

Tahle 7.5 Logical Operators

Symbol Mnemonic Equivalent Example

& AND (a>b & c>d)
| OR! (a>b or c>d)
! OR

! OR

- NOT? not (a>b)

" NOT

~ NOT

The symbol you use for OR depends on your operating environment.
The symbol you use for NOT depends on your operating environment.

Cy.

See “Order of Evaluation in Compound Expressions” on page 124 for the order in
which SAS evaluates these operators.

In addition, a numeric expression without any logical operators can serve as a
Boolean expression. For an example of Boolean numeric expressions, see “Boolean
Numeric Expressions” on page 123.
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The AND Operator

If both of the quantities linked by AND are 1 (true), then the result of the AND
operation is 1; otherwise, the result is 0. For example, in the following comparison:

a<b & c>0

the result is true (has a value of 1) only when both A<B and C>0 are 1 (true): that is,
when A is less than B and C is positive.

Two comparisons with a common variable linked by AND can be condensed with an
implied AND. For example, the following two subsetting IF statements produce the
same result:

O if 16<=age and age<=65;

O if 16<=age<=65;

The OR Operator

If either of the quantities linked by an OR is 1 (true), then the result of the OR
operation is 1 (true); otherwise, the OR operation produces a 0. For example, consider
the following comparison:

a<b|c>0

The result is true (with a value of 1) when A<B is 1 (true) regardless of the value of C.
It is also true when the value of C>0 is 1 (true), regardless of the values of A and B.
Therefore, it is true when either or both of those relationships hold.

Be careful when using the OR operator with a series of comparisons (in an IF,
SELECT, or WHERE statement, for instance). Remember that only one comparison in a
series of OR comparisons must be true to make a condition true, and any nonzero,
nonmissing constant is always evaluated as true (see “Boolean Numeric Expressions”
on page 123). Therefore, the following subsetting IF statement is always true:

if x=1 or 2;

SAS first evaluates X=1, and the result can be either true or false; however, since the 2
is evaluated as nonzero and nonmissing (true), the entire expression is true. In this
statement, however, the condition is not necessarily true because either comparison can
evaluate as true or false:

if x=1 or x=2;

The NOT Operator

The prefix operator NOT is also a logical operator. The result of putting NOT in front
of a quantity whose value is 0 (false) is 1 (true). That is, the result of negating a false
statement is 1 (true). For example, if X=Y is 0 (false) then NOT(X=Y) is 1 (true). The
result of NOT in front of a quantity whose value is missing is also 1 (true). The result
of NOT in front of a quantity with a nonzero, nonmissing value is 0 (false). That is, the
result of negating a true statement is 0 (false).

For example, the following two expressions are equivalent:

O not(name='SMITH')

O name ne ’'SMITH’
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Furthermore, NOT(A&B) is equivalent to NOT A|NOT B, and NOT(A | B) is the
same as NOT A & NOT B. For example, the following two expressions are equivalent:

O not(a=b & c>d)
ODaneb | cled

Boolean Numeric Expressions

In computing terms, a value of true is a 1 and a value of false is a 0. In SAS, any
numeric value other than 0 or missing is true, and a value of 0 or missing is false.
Therefore, a numeric variable or expression can stand alone in a condition. If its value
is a number other than 0 or missing, the condition is true; if its value is 0 or missing,
the condition is false.

0 | . = False
1 = True

For example, suppose that you want to fill in variable REMARKS depending on
whether the value of COST is present for a given observation. You can write the
IF-THEN statement as follows:

if cost then remarks='Ready to budget’;
This statement is equivalent to:

if cost ne . and cost ne 0
then remarks='Ready to budget’;

A numeric expression can be simply a numeric constant, as follows:
if 5 then do;
The numeric value that is returned by a function is also a valid numeric expression:

if index(address,’Avenue’) then do;

The MIN and MAX Operators

The MIN and MAX operators are used to find the minimum or maximum value of
two quantities. Surround the operators with the two quantities whose minimum or
maximum value you want to know. The MIN (><) operator returns the lower of the two
values. The MAX (<>) operator returns the higher of the two values. For example, if
A<B, then A><B returns the value of A.

If missing values are part of the comparison, SAS uses the sorting order for missing
values that is described in “Order of Missing Values” on page 103. For example, the
maximum value that is returned by .A<>.Z is the value .Z.

Note: In a WHERE statement or clause, the <> operator is equivalent to NE. 2

The Concatenation Operator

The concatenation operator (| |) concatenates character values. The results of a
concatenation operation are usually stored in a variable with an assignment statement,
as in level='grade ’||’A’. The length of the resulting variable is the sum of the
lengths of each variable or constant in the concatenation operation, unless you use a
LENGTH or ATTRIB statement to specify a different length for the new variable.

The concatenation operator does not trim leading or trailing blanks. If variables are
padded with trailing blanks, check the lengths of the variables and use the TRIM
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function to trim trailing blanks from values before concatenating them. See SAS
Language Reference: Dictionary for descriptions and examples of additional character
functions.

For example, in this DATA step, the value that results from the concatenation
contains blanks because the length of the COLOR variable is eight:

data namegame;
length color name $8 game $12;
color='black’;
name='jack’;
game=color | |name;
put game=;
run;
The value of GAME is 'black  jack’. To correct this problem, use the TRIM
function in the concatenation operation as follows:

game=trim(color) | |name;

This statement produces a value of ‘blackjack’ for the variable GAME. The following
additional examples demonstrate uses of the concatenation operator:

o If A has the value ' fortune’, B has the value ' five’, and C has the value
“hundred’, then the following statement produces the value
' fortunefivehundred’ for the variable D:

d=a| |b]||c;
o0 This example concatenates the value of a variable with a character constant.

newname='Mr. or Ms. ' ||oldname;

If the value of OLDNAME is 'Jones’, then NEWNAME will have the value 'Mr.

or Ms. Jones'.

O Because the concatenation operation does not trim blanks, the following
expression produces the value ' JOHN  SMITH':

name='JOHN  ’||’SMITH’;

0 This example uses the PUT function to convert a numeric value to a character
value. The TRIM function is used to trim blanks.
month='sep’;
year=99;
date=trim(month) || left(put(year,8.));

The value of DATE is the character value’sep99-’.

Order of Evaluation in Compound Expressions

Table 7.6 on page 125 shows the order of evaluation in compound expressions. The
table contains the following columns:

Priority
lists the priority of evaluation. In compound expressions, SAS evaluates the part
of the expression containing operators in Group I first, then each group in order.

Order of Evaluation
lists the rules governing which part of the expression SAS evaluates first.
Parentheses are often used in compound expressions to group operands;
expressions within parentheses are evaluated before those outside of them. The



Expressions A Order of Evaluation in Compound Expressions 125

rules also list how a compound expression that contains more than one operator
from the same group is evaluated.

Symbols
lists the symbols that you use to request the comparisons, operations, and
calculations.

Mnemonic Equivalent
lists alternate forms of the symbol. In some cases, such as when your keyboard
does not support special symbols, you should use the alternate form.

Definition
defines the symbol.

Example
provides an example of how to use the symbol or mnemonic equivalent in a SAS
expression.

Table 7.6 Order of Evaluation in Compound Expressions

Priority Order of Symbols Mnemonic Definition Example
Evaluation Equivalent
Group I right to wE exponentiationl y=a**2;
left
+ positive preﬁx2 y=+(a*b);
- negative preﬁx3 =-(a+b);
a7 NOT logical not* if not z
then put x;
>< MIN minimum? x=(a><b);
<> MAX maximum x=(a<>b);
Group II left to * multiplication c=a*b;
right
/ division f=g/h;
Group IIT left to + addition c=a+b;
right
- subtraction f=g-h;
Group IV left to R concatenate name=
right character "3’ ||’ SMITH";
values®
Group v’ left to < LT less than if x<y then
right8 c=5;
<= LE less than or if x le
equal to y then a=0;
= EQ equal to if y eq (x+a)
then output;
—= NE not equal to if x ne z
then output;
>= GE greater than or if y>=a

equal to

then output;
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Priority Order of Symbols Mnemonic Definition Example
Evaluation Equivalent
> GT greater than if z>a
then output;
IN equal tooneof a if state in
list ('NY’,'NJ’','PA’)
then region='NE’;
y = x in (1:10);
Group VI left to & AND logical and if a=b & c=d
right
then x=1;

Group VII left to | 1! OR logical or’ if y=2 or x=3

right then a=d;

1 Because Group I operators are evaluated from right to left, the expression x=2**3**4 is evaluated as x=(2** (3**4)).

2 The plus (+) sign can be either a prefix or arithmetic operator. A plus sign is a prefix operator only when it appears at the
beginning of an expression or when it is immediately preceded by a left parenthesis or another operator.

3 The minus (-) sign can be either a prefix or arithmetic operator. A minus sign is a prefix operator only when it appears at
the beginning of an expression or when it is immediately preceded by a left parenthesis or another operator.

4 Depending on the characters available on your keyboard, the symbol can be the not sign (-), tilde (~), or caret (*). The SAS
system option CHARCODE allows various other substitutions for unavailable special characters.

5 For example, the SAS System evaluates —-3><-3 as — (3><-3), which is equal to — (-3 ), which equals +3. This is because
Group I operators are evaluated from right to left.

6 Depending on the characters available on your keyboard, the symbol you use as the concatenation operator can be a double
vertical bar (| |), broken vertical bar (}}), or exclamation mark (!!).

7 Group V operators are comparison operators. The result of a comparison operation is 1 if the comparison is true and 0 if it is
false. Missing values are the lowest in any comparison operation.The symbols =< (less than or equal to) are also allowed for
compatibility with previous versions of the SAS System.When making character comparisons, you can use a colon (:) after
any of the comparison operators to compare only the first character(s) of the value. SAS truncates the longer value to the
length of the shorter value during the comparison. For example, if name=: ' P’ compares the value of the first character of
NAME to the letter P.

8 An exception to this rule occurs when two comparison operators surround a quantity. For example, the expression x<y<z is
evaluated as (x<y) and (y<z).

9 Depending on the characters available on your keyboard, the symbol you use for the logical or can be a single vertical bar (|),

broken vertical bar (}), or exclamation mark (!). You can also use the mnemonic equivalent OR.
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About SAS Date, Time, and Datetime Values

Definitions

SAS date value
is a value that represents the number of days between January 1, 1960, and a
specified date. SAS can perform calculations on dates ranging from A.D. 1582 to
A.D. 19,900. Dates before January 1, 1960, are negative numbers; dates after are
positive numbers.
0 SAS date values account for all leap year days, including the leap year day in
the year 2000.
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0 SAS date values can reliably tell you what day of the week a particular day
fell on as far back as September 1752, when the calendar was adjusted by
dropping several days. SAS day-of-the-week and length-of-time calculations
are accurate in the future to A.D. 19,900.

O Various SAS language elements handle SAS date values: functions, formats
and informats.

SAS time value
is a value representing the number of seconds since midnight of the current day.
SAS time values are between 0 and 86400.

SAS datetime value
is a value representing the number of seconds between January 1, 1960 and an
hour/minute/second within a specified date.

The following figure shows some dates written in calendar form and as SAS date
values.

Figure 8.1 How SAS Converts Calendar Dates to SAS Date Values

Calendar Date
Jul4 1776 Jan 11959 Jan11960 Jan1 1961 Jan 11 2202
—|—b 72— ! |— 52— —
-67019 -365 0 366 88399

SAS Date Value

Two-Digit and Four-Digit Years

SAS software can read two-digit or four-digit year values. If SAS encounters a
two-digit year, the YEARCUTOFF= option can be used to specify which century within
a 100 year span the two-digit year should be attributed to. For example,
YEARCUTOFF=1950 means that two-digit years 50 through 99 correspond to 1950
through 1999, while two-digit years 00 through 49 correspond to 2000 through 2049.
Note that while the default value of the YEARCUTOFF= option in Version 8 of the SAS
System is 1920, you can adjust the YEARCUTOFF= value in a DATA step to
accommodate the range of date values you are working with at the moment. To correctly
handle 2-digit years representing dates between 2000 and 2099, you should specify an
appropriate YEARCUTOFF= value between 1901 and 2000. For more information, see
the “YEARCUTOFF= System Option” in SAS Language Reference: Dictionary.

The Year 2000

Using the YEARCUTOFF= System Option

SAS software treats the year 2000 like any other leap year. If you use two-digit year
numbers for dates, you’ll probably need to adjust the default setting for the
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YEARCUTOFF-= option to work with date ranges for your data, or switch to four-digit
years. The following program changes the YEARCUTOFF= value to 1950. This change
means that all two digit dates are now assumed to fall in the 100-year span from 1950
to 2049.

options yearcutoff=1950;
data _null ;
a='26oct02'd;
put ’SAS date='a;
put ’'formatted date='a date9.;

run;
The PUT statement writes the following lines to the SAS log:

SAS date=15639
formated date=260CT2002

Note: Whenever possible, specify a year using all four digits. Most SAS date and
time language elements support four digit year values. A

Example: How YEARCUTOFF= Affects Two and Four-Digit Years

The following example shows what happens with data that contains both two and
four-digit years. Note how the YEARCUTOFF= option is set to 1920.

options yearcutoff=1920 nodate pageno=1 linesize=80 pagesize=60;

data schedule;
input @1 jobid $ @6 projdate mmddyylO.;
datalines;

A100 01/15/25

All0 03/15/2025

A200 01/30/96

B100 02/05/00

B200 06/15/2000

r

proc print data=schedule;
format projdate mmddyyl0.;

run;

The resulting output from the PROC PRINT statement looks like this:

Output 8.1 Output from The Previous DATA Step Showing 4-Digit Years That
Result from Setting YEARCUTOFF= to 1920

The SAS System 1
Obs jobid projdate
1 Al00 01/15/1925
2 All0 03/15/2025
3 A200 01/30/1996
4 B100 02/05/2000
5 B200 06/15/2000
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Here are some facts to note in this example:

O

In the datalines in the DATA step, the first record contains a two-digit year of 25,
and the second record contains a four-digit year of 2025. Because the
YEARCUTOFF= system option is set to 1920, the two-digit year defaults to a year
in the 1900s in observation number 1. The four-digit year in observation number 2
is unaffected by the YEARCUTOFF= option.

The third record is similar to the first and defaults to a year in the 1900s based on
the value of YEARCUTOFF=.

The output from records 4 and 5 shows results that are similar to records 1 and 2.
The fourth record specifies a two-digit year of 00, and the fifth one specifies a
four-digit year of 2000. Because of the value of the YEARCUTOFF= option, the
years in the two resulting observations are the same.

As you can see, specifying a two-digit year may or may not result in the intended
century prefix. The optimal value of the YEARCUTOFF= option depends on the range
of the dates that you are processing.

In Releases 6.06 through 6.12 of SAS, the default value for the YEARCUTOFF=
system option is 1900; in Version 7 and Version 8, the default value is 1920.

For more information on how SAS handles dates, see the section on dates, times and
datetime values.

Practices That Help Ensure Date Integrity

The following practices help ensure that your date values are correct during all the
conversions that occur during processing:

O Store dates as SAS date values, not as simple numeric or character values.
0 Use the YEARCUTOFF= system option when converting two-digit dates to SAS

date values.

0 Examine sets of raw data coming into your SAS process to make sure that any

dates containing two-digit years will be correctly interpreted by the
YEARCUTOFF= system option. Look out for

O two-digit years that are distributed over more than a 100-year period. For
dates covering more than a 100-year span, you must either use four digit
years in the data, or use conditional logic in a DATA step to interpret them
correctly.

O two-digit years that need an adjustment to the default YEARCUTOFF=
range. For example, if the default value for YEARCUTOFF= in your
operating environment is 1920 and you have a two-digit date in your data
that represents 1919, you will have to adjust your YEARCUTOFF= value
downward by a year in the SAS program that processes this value.

0 Make sure that output SAS data sets represent dates as SAS date values.
O Check your SAS programs to make sure that formats and informats that use

two-digit years, such as DATE7., MMDDYY6., or MMDDYY8., are reading and
writing data correctly.

Note: The YEARCUTOFF= option has no effect on dates that are already stored as
SAS date values. A
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Working with SAS Dates and Times

Informats and Formats

The SAS System converts date, time and datetime values back and forth between
calendar dates and clock times with SAS language elements called formats and
informats.

0 Formats present a value, recognized by SAS, such as a time or date value, as a

calendar date or clock time in a variety of lengths and notations.

0 Informats read notations or a value, such as a clock time or a calendar date, which

may be in a variety of lengths, and then convert the data to a SAS date, time, or
datetime value.

Date and Time Tools by Task

The following table correlates tasks with various SAS System language elements
that are available for working with time and date data.

Table 8.1 Tasks with Dates and Times, Part 1

To do this Use this List Input Result

Write SAS date values in  Date formats DATEw. 14686 17MAROO

recognizable forms
DATED9. 14686 17MAR2000a
DAYw. 14686 17
DDMMYYuw. 14686 17/03/00
DDMMYY10. 14686 17/03/2000
DDMMYYBuw. 14686 17 03 00
DDMMYYBI10. 14686 17 03 2000
DDMMYYCuw. 14686 17:03:20
DDMMYYC10. 14686 17:03:2000
DDMMYYDuw. 14686 17-03-00
DDMMYYD10. 14686 17-03-2000
DDMMYYNuw. 14686 17MARO00
DDMMYYN10 14686 17MAR2000
DDMMYYPuw. 14686 17.03.00
DDMMYYP10. 14686 17.03.2000
DDMMYYSw. 14686 17/03/00
DDMMYYS10. 14686 17/03/2000
DOWNAME. 14686 Friday
JULDAYw. 14686 77
JULIANw. 14686 00077

MMDDYYw. 14686 03/17/00
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To do this Use this List Input Result
MMDDYY10. 14686 03/17/2000
MMDDYYBuw. 14686 03 17 00
MMDDYYB10.w. 14686 03 17 2000
MMDDYYCuw. 14686 03:17:00
MMDDYYC10 14686 03:17:2000
MMDDYYDuw. 14686 03-17-00
MMDDYYD10. 14686 03-17-2000
MMDDYYNuw. 14686 031700
MMDDYYN10. 14686 03172000
MMDDYYP 14686 03.17.00
MMDDYYP10. 14686 03.17.2000
MMDDYYS 14686 03/17/00
MMDDYYS10. 14686 03/17/2000
MMYY.xw. 14686 03M2000
MMYYCuw. 14686 03:2000
MMYYD. 14686 03-2000
MMYYN. 14686 032000
MMYYP. 14686 03.2000
MMYYS. 14686 03/2000
MONNAME. 14686 March
MONTH. 14686 3
MONYY. 14686 MAR2000
PDJULGw. 14686 2000077F
PDJULIw. 14686 0100077F
QTRw. 14686 1
QTRRw. 14686 I
TIMEw.d 14686 4:04:46
TIMEAMPMw.d 14686 4:04:46 AM
TOD 14686 4:04:46
WEEKDATEw. 14686 Friday,

March 17,
2000
WEEKDAYw. 14686 6
WORDDATE.w. 14686 March 17,
2000
WORDDATXw. 14686 17 MARCH
2000
YEARw. 14686 2000
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To do this Use this List Input Result
YYMMuw. 14686 2000M03
YYMMCuw. 14686 2000:03
YYMMDDuw. 14686 2000-03
YYMMPuw. 14686 2000.03
YYMMS. 14686 2000/03
YYMMN. 14686 200003
YYMMDDuw. 14686 00-03-17
YYMON. 14686 2000MAR
YYQuw. 14686 2000Q1
YYQCuw. 14686 2000:1
YYQDw. 14686 2000-1
YYQPw. 14686 2000.1
YYQSw. 14686 2000/1
YYQNw. 14686 20001
YYQRw. 14686 2000QI
YYQRCuw. 14686 2000:1
YYQRDw. 14686 2000-I
YYQRPw.w. 14686 2000.1
YYQRSw. 14686 2000/1
YYQRNuw. 14686 111
Table 8.2 Tasks with Dates and Times, Part 2
To do this Use this List Input Result
Date Tasks
Read calendar dates as Date informats DATEw. 17MAR2000 14686
SAS date
Note:
YEARCUTOFF=1920
DATED9. 17MAR2000 14686
DDMMYYuw. 170300 14686
DDMMYYS. 17032000 14686
JULIANw. 0077 14686
JULIANT. 2000077 14686
MMDDYYuw. 031700 14686
MMDDYY1o0. 03172000 14686
MONYYw. MARO00 14670
YYMMDDuw. 000317 14686
YYMMDD10. 20000317 14686
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To do this Use this List Input Result
YYQu. 00Q1 14610
Create date values from Date functions = DATEJUL 2000077 14686
pieces
DATETIME ’17TMAR2000°D, 1268870400
00,00,00
TIME 14,45,32 53132
MDY 03,17,00 14686
MDY 03,17,2000 14686
YYQ 00,1 14610
Extract a date from a Date functions = DATEPART ’17TMAR00:00:00 14686
datetime value DT
Return today’s date as a  Date functions = DATE() or () SAS date for
SAS date TODAY() today
(equivalent)
Extract calendar dates Date functions DAY 14686 17
from SAS
HOUR 14686 4
JULDATE 14686 77
JULDATE7 14686 2000077
MINUTE 14686 4
MONTH 14686 3
QTR 14686 3
SECOND 14686 46
WEEKDAY 14686 6
YEAR 14686 2000
Write a date as a SAS date ‘ddmmmyy’d ’17mar00’d
constant in an expression constant or 14686
‘ddmmmyyyy’ "17mar2000’d
Write today’s date as a SYSDATE SYSDATE &SYSDATE Date at time
string automatic of SAS
macro variable initialization
in
DDMMMYY
SYSDATE9 SYSDATE9 &SYSDATE9 Date at time
of SAS
initialization
in
DDMMMYYYY
Time Tasks
Write SAS time values time formats HHMM. 53132 14:46

as time values
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To do this Use this List Input Result
HOUR. 53132 15
MMSS. 53132 885
TIME. 53132 14:45:32
TOD. 53132 14:45:32
Read time values as SAS  Time informats TIME 14:45:32 53132
time values
Write the current time SYSTIME SYSTIME &SYSTIME Time at
as a string automatic moment of
macro variable execution in
HH:MM
Return the current time Time functions TIME() ) SAS time
of day as a SAS time value at
value moment of
execution in
NNNNN.NN
Return the time part of a  Time functions = TIMEPART SAS datetime SAS time
SAS datetime value value in value part of
NNNNNNNNNN.N date value in
NNNNN.NN
Datetime Tasks
Write SAS datetime Datetime DATEAMPM 1217083532 26JUL98:02:45
values as datetime formats PM
values
DATETIME 1268870400 17MAR00:00:00
:00
Read datetime values as Datetime DATETIME 17MARO00:00:00:00 1268870400
SAS datetime values informats
Return the current date Datetime DATETIME() 0 SAS
and time of day as a SAS  functions datetime
datetime value value at
moment of
execution in
NNNNNNNNNN.N
Interval Tasks
Return the number of Interval INTCK week 2 1055
specified time intervals functions 01aug60
that lie betwe;en the two 01jan01
date or datetime values
Advances a date, time, Interval INTNX day 14086
or datetime value by a functions 14086
given interval, and 01jan60

returns a date, time, or
datetime value

The SAS System also supports international formats and informats that are
equivalent to some of the most commonly used English-language date formats and
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informats. For details, see the SAS formats and informats in SAS Language Reference:
Dictionary.

Examples

Example 1: Displaying Date, Time, and Datetime Values as Recognizable
Dates and Times

The following example demonstrates how a value may be displayed as a date, a time,
or a datetime. Remember to select the SAS language element that converts a SAS date,
time, or datetime value to the intended date, time or datetime format. See the previous
tables for examples.

Note:

o Time formats count the number of seconds within a day, so the values will be
between 0 and 86400.

0o DATETIME formats count the number of seconds since January 1, 1960, so for
datetimes that are greater than 02JAN1960:00:00:01, (integer of 86401) the
datetime value will always be greater than the time value.

0 When in doubt, look at the contents of your data set for clues as to which type of
value you are dealing with.

A

This program uses the DATETIME, DATE and TIMEAMPM formats to display the
value 86399 to a date and time, a calendar date, and a time.

data test;

options nodate pageno=1 linesize=80 pagesize=60;
Timel=86399;

format Timel datetime.;

Datel=86399;

format Datel date.;

Time2=86399;

format Time2 timeampm. ;

run;

proc print data=test;

title ’'Same Number, Different SAS Values';
footnotel ’'Timel is a SAS DATETIME value’;
footnote2 ’'Datel is a SAS DATE value’;
footnote3 ’'Time2 is a SAS TIME value'.;

run;

Output 8.2 Datetime, Date and Time Values for 86399

Same Number, Different SAS Values 1
Obs Timel Datel Time2
1 01JAN60:23:59:59 20JUL96 11:59:59 PM

Timel is a SAS DATETIME value
Datel is a SAS DATE value
Time2 is a SAS TIME value.
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Example 2: Reading, Writing, and Calculating Date Values

This program reads four regional meeting dates and calculates the dates on which
announcements should be mailed.

data meeting;

options nodate pageno=1 linesize=80 pagesize=60;
input region $ mtg : mmddyyS8.;
sendmail=mtg-45;

datalines;

11-24-99

12-28-99

12-03-99

10-04-99

s H 0n =2

proc print data=meeting;
format mtg sendmail date9.;
title 'When To Send Announcements’;

run;

Output 8.3 Calculated Date Values: When to Send Mail

When To Send Announcements

Obs region mtg sendmail
1 N 24NOV1999 100CT1999
2 S 28DEC1999 13NOV1999
3 E 03DEC1999 190CT1999
4 \ 040CT1999 20AUG1999

About Date and Time Intervals

Definitions

duration
is an integer representing the difference between any two dates or times or
datetimes. Date durations are integer values representing the difference, in the
number of days, between two SAS dates. Time durations are decimal values
representing the number of seconds between two times or datetimes.

Tip: Date and datetimes durations can be easily calculated by subtracting the
smaller date or datetime from the larger. When dealing with SAS times, special
care must be taken if the beginning and the end of a duration are on different
calendar days. Whenever possible, the simplest solution is to use datetimes
rather than times.

interval
is a unit of measurement that SAS can count within an elapsed period of time,
such as DAYS, MONTHS, or HOURS. The SAS System determines date and time
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intervals based on fixed points on the calendar and/or the clock. The starting point
of an interval calculation defaults to the beginning of the period in which the
beginning value falls, which may not be the actual beginning value specified. For
instance, if you are using the INTCK function to count the months between two
dates, regardless of the actual day of the month specified by the date in the
beginning value, SAS treats it as the first of that month.

Syntax

SAS provides date, time, and datetime intervals for counting different periods of
elapsed time. You can create multiples of the intervals and shift their starting point.
Use them with the INTCK and INTNX functions and with procedures that support
numbered lists (such as the PLOT procedure). The form of an interval is

name<multiple><.starting-point>
The terms in an interval have the following definitions:

name
is the name of the interval. See the following table for a list of intervals and their
definitions.

multiple
creates a multiple of the interval. Multiple can be any positive number. The
default is 1. For example, YEAR2 indicates a two-year interval.

.starting-point
is the starting point of the interval. By default, the starting point is 1. A value
greater than 1 shifts the start to a later point within the interval. The unit for
shifting depends on the interval, as shown in the following table. For example,
YEAR.3 specifies a yearly period from the first of March through the end of
February of the following year.

Intervals By Category

Table 8.3 Intervals Used with Date and Time Functions
Category Interval Definition Default Shift Period Example Description
Starting
Point
Date DAY Daily Each day Days DAY3 Three-day
intervals intervals
starting on
Sunday
WEEK Weekly Each Sunday Days WEEK.7 Weekly with
intervals of (1=Sunday ... Saturday as
seven days 7=Saturday) the first day
of the week
WEEKDAY Daily Each day Days WEEKDAY1W  Six-day week
<daysW> intervals with with Sunday
Friday- as a weekend
Saturday- day

Sunday
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Category Interval Definition Default Shift Period Example Description
Starting
Point
counted as WEEKDAY35W Five-day
the same day week with
(five-day work Tuesday and
week with a Thursday as
Saturday- weekend days
Sunday (W indicates
weekend). that day 3
Days and day 5 are
identifies the weekend
weekend days days)
by number
(1=Sunday ...
7=Saturday).
By default,
days=117.
TENDAY Ten-day First, Ten-day TENDAY4.2 Four ten-day
intervals (a eleventh, and  periods periods
U.S. twenty-first of starting at
automobile each month the second
industry TENDAY
convention) period
SEMIMONTH Half-month First and Semi-monthly SEMIMONTH2.2Intervals
intervals sixteenth of periods from the
each month sixteenth of
one month
through the
fifteenth of
the next
month
MONTH Monthly First of each Months MONTH2.2 February-
intervals month March,
April-May,
June-July,
August-
September,
October-
November,
and
December-
January of
the following
year
QTR Quarterly January 1 Months QTR3.2 Three-month
(three-month) April 1 intervals
intervals starting on
July 1 April 1, July
October 1 1, October 1,

and January
1
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Category Interval Definition Default Shift Period Example Description
Starting
Point
SEMIYEAR Semiannual January 1 Months SEMIYEAR.3  Six-month
(six-month) intervals,
) July 1
intervals March-
August and
September-
February
YEAR Yearly January 1 Months
intervals
Datetime Add DT To any date Midnight of DTMONTH
interval January 1, DTWEEKDAY
1960
Time SECOND Second Start of the Seconds
intervals day
(midnight)
MINUTE Minute Start of the Minutes
intervals day
(midnight)
HOUR Hourly Start of the Hours
intervals day
(midnight)

Example: Calculating a Duration

This program reads the project start and end dates and calculates the duration

between them.

data projects;

options nodate pageno=1 linesize=80 pagesize=60;
input Projid startdate date9. enddate date9.;

Duration=enddate-startdate;

398
942
167
250

r

datalines;
170ct1997
22janl998
15dec1999
043an2001

02nov1997
10mar1998
15feb2000
11jan2001

proc print data=projects;

format startdate enddate date9.;

title ’'Days Between Project Start and Project End’;

run;
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Output 8.4 Output from the PRINT Procedure

Days Between Project Start and Project End run 8
Obs Projid Startdate Enddate Duration

1 398 170CT1997 02NOV1997 16

2 942 22JAN1998 10MAR1998 47

3 167 15DEC1999 15FEB2000 62

4 250 04JAN2001 11JAN2001 7

Boundaries of Intervals

The SAS System associates date and time intervals with fixed points on the calendar.
For example, the MONTH interval represents the time from the beginning of one
calendar month to the next, not a period of 30 or 31 days. When you use date and time
intervals (for example, with the INTCK or INTNX functions), the SAS System bases its
calculations on the calendar divisions that are present. Consider the following examples:

Table 8.4 Using INTCK And INTNX

Example Results Explanation

mnthnuml= mnthnuml=1 The number of MONTH
intck( intervals the INTCK function
'month’,

’25aug2000'd,
'05sep2000d) ;

mnthnum2=
intck(
'month’,
’0laug2000'd,
’31aug2000’d) ;

next=intnx(
'month’,
’25aug2000'd,1);

mnthnum?2=0

next represents 01sep2000

counts depends on whether the
first day of a month falls
within the period.

The INTNX function produces
the SAS date value that
corresponds to the beginning of
the next interval.

Note: The only intervals that do not begin on the same date in each year are WEEK
and WEEKDAY. A Sunday can occur on any date because the year is not divided evenly

into weeks. A
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Single-Unit Intervals

Single-unit intervals begin at the following points on the calendar:

Table 8.5 Single-Unit Intervals

These single-unit intervals

Begin at this point on the
calendar

DAY and WEEKDAY
WEEK
TENDAY

SEMIMONTH

MONTH
QTR

SEMIYEAR
YEAR

each day
each Sunday

the first, eleventh, and
twenty-first of each month

the first and sixteenth of each
month

the first of each month

the first of January, April, July
and October

the first of January and July
the first of January

Single-unit time intervals begin as follows:

Table 8.6 Single-Unit Time Intervals

These single-unit time intervals Begin at this point

SECOND each second
MINUTE each minute
HOUR each hour

Multiunit Intervals

Multiunit Intervals Other Than Multiweek Intervals

Multiunit intervals, such as MONTH2 or DAY50, also depend on calendar measures,
but they introduce a new problem: the SAS System can find the beginning of a unit (for
example, the first of a month), but where does that unit fall in the interval? For
example, does the first of October mark the first or the second month in a two-month
interval?

For all multiunit intervals except multiweek intervals, the SAS System creates an
interval beginning on January 1, 1960, and counts forward from that date to determine
where individual intervals begin on the calendar. As a practical matter, when a year
can be divided evenly by an interval, think of the intervals as beginning with the
current year. Thus, MONTH2 intervals begin with January, March, May, July,
September, and November. Consider this example:
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Table 8.7 Month2 Intervals

SAS statements Results

howmanyl=intck

(‘month2’,’15feb2000’d, '15mar2000'd) ;
howmanyl=1

count=intck

('day50’,'01oct2000'd, '01jan2000’d) ;
count=1

In the above example, the SAS System counts 50 days beginning with January 1, 1960;
then another 50 days; and so on. As part of this count, the SAS System counts one
DAY50 interval between October 1, 1998 and January 1, 1999. As an example, to
determine the date on which the next DAY50 interval begins, use the INTNX function,
as follows:

Table 8.8 Using the INTNX Function

SAS statements Results

start=intnx

('day50’,'0loct98’d,1);
SAS date value 14200, or Nov 17, 1998

The next interval begins on November 17, 1998.

Time intervals (those that represent divisions of a day) are aligned with the start of
the day, that is, midnight. For example, HOURS intervals divide the day into the
periods 00:00 to 08:00, 8:00 to 16:00, and 16:00 to 24:00 (the next midnight).

Multiweek Intervals

Multiweek intervals, such as WEEK2, present a special case. In general, weekly
intervals begin on Sunday, and the SAS System counts a week whenever it passes a
Sunday. However, the SAS System cannot calculate multiweek intervals based on
January 1, 1960, because that date fell on a Friday, as shown:

Figure 8.2 Calculating Multi Week Intervals

Dec Su Mo Tu We Th | Fr Sa  Jan

1959 27 28 29 30 31 | 1 2 1960

Therefore, the SAS System begins the first interval on Sunday of the week containing
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January 1, 1960—that is, on Sunday, December 27, 1959. The SAS System counts
multiweek intervals from that point. The following example counts the number of
two-week intervals in the month of August, 1998:

Table 8.9 Counting Two-Week Intervals

SAS statements Results

count=intck

('week2’,'01laug98’'D, ’'31laug98’'D);
count=3

To see the beginning date of the next interval, use the INTNX function, as shown here:

Table 8.10 Using INTNX to See The Beginning Date of an Interval

SAS statements Results

begin=intnx(’'week2’,’0laugl998'd,1);

“Begin” represents SAS date 14093 or
August 02, 1998

The next interval begins on August 16.

Shifted Intervals

Shifting the beginning point of an interval is useful when you want to make the
interval represent a period in your data. For example, if your company’s fiscal year
begins on July 1, you can create a year beginning in July by specifying the YEAR.7
interval. Similarly, you can create a period matching U.S. presidential elections by
specifying the YEAR4.11 interval. This section discusses how to use shifted intervals
and how the SAS System creates them.

How to Use Shifted Intervals

When you shift a time interval by a subperiod, the shift value must be less than or
equal to the number of subperiods in the interval. For example, YEAR.12 is valid
(yearly periods beginning in December), but YEAR.13 is not. Similarly, YEAR2.25 is not
valid because there is no twenty-fifth month in the two-year period.

In addition, you cannot shift an interval by itself. For example, you cannot shift the
interval MONTH because the shifting subperiod for MONTH is one month and MONTH
contains only one monthly subperiod. However, you can shift multi-unit intervals by the
subperiod. For example, MONTH2.2 specifies bimonthly periods starting on the first
day of the second month.

How the SAS System Creates Shifted Intervals

For all intervals except those based on weeks, the SAS System creates shifted
intervals by creating the interval based on January 1, 1960, by moving forward the
required number of subperiods, and by counting shifted intervals from that point. For
example, suppose you create a shifted interval called DAY50.5. The SAS System creates
a 50-day interval in which January 1, 1960 is day 1. The SAS System then moves
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forward to day 5. (Note that the difference, or amount of movement, is 4 days.) The
SAS System begins counting shifted intervals from that point. The INTNX function
demonstrates that the next interval begins on January 5, 1960:

Table 8.11 Using INTNX to Determine When an Interval Begins

SAS statements Results

start=intnx

(’day50.5’,’01janl960’d,1);
SAS date value 4, or Jan 5, 1960

For shifted intervals based on weeks, the SAS System first creates an interval based on
Sunday of the week containing January 1, 1960 (that is, December 27, 1959), then
moves forward the required number of days. For example, suppose you want to create
the interval WEEK2.8 (biweekly periods beginning on the second Sunday of the period).
The SAS System measures a two-week interval based on Sunday of the week containing
January 1, 1960, and begins counting shifted intervals on the eighth day of that. The
INTNX function shows the beginning of the next interval:

Table 8.12 Using the INTNX Function to Show the Beginning of the Next Interval

SAS statements Results

start=intnx
('week2.8’,’01janl1960’'d,1);
SAS date value 2, or Jan 3, 1960

You can also shift time intervals. For example, HOURS.7 intervals divide the day into
the periods 06:00 to 14:00, 14:00 to 22:00, and 22:00 to 06:00.
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Types of Errors in SAS

Summary of Types of Errors That SAS Recognizes

SAS performs error processing during both the compilation and the execution phases
of SAS processing. You can debug SAS programs by understanding processing messages
in the SAS log and then fixing your code. You can use the DATA Step Debugger to
detect logic errors in a DATA step during execution.

SAS recognizes five types of errors.
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Type of error

When this error occurs

When the error is
detected

syntax

semantic

execution-time

data

macro-related

when programming statements do
not conform to the rules of the SAS
language

when the language element is
correct, but the element may not be
valid for a particular usage

when SAS attempts to execute a
program and execution fails

when data values are invalid

when you use the macro facility
incorrectly

compile time

compile time

execution time

execution time

macro compile time or
execution time, DATA or
PROC step compile time or
execution time

Syntax Errors

Syntax errors occur when program statements do not conform to the rules of the SAS

language. Here are some examples of syntax errors:

O o o o d

When SAS encounters a syntax error, it first attempts to correct the error by attempting

misspelled SAS keyword

unmatched quotation marks

missing a semicolon

invalid statement option

invalid data set option.

to interpret what you mean, then continues processing your program based on its
assumptions. If SAS cannot correct the error, it prints an error message to the log.
In the following example, the DATA statement is misspelled, and SAS prints a
warning message to the log. Because SAS could interpret the misspelled word, the
program runs and produces output.

date temp;

x=1;

run;

proc print data=temp;

run;
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Output 9.1 SAS Log: Syntax Error (misspelled key word)

149

1 date temp;

14

2 x=1;
3 run;

NOTE: DATA statement used:

real time 0.17
cpu time 0.04
4
5 proc print data=temp;
6 run;

NOTE: PROCEDURE PRINT used:
real time 0.14
cpu time 0.03

Some errors are explained fully by the message that SAS prints in the log; other
error messages are not as easy to interpret because SAS is not always able to detect

seconds
seconds

seconds
seconds

WARNING 14-169: Assuming the symbol DATA was misspelled as date.

NOTE: The data set WORK.TEMP has 1 observations and 1 variables.

exactly where the error occurred. For example, when you fail to end a SAS statement

with a semicolon, SAS does not always detect the error at the point where it occurs
because SAS statements are free-format (they can begin and end anywhere). In the
following example, the semicolon at the end of the DATA statement is missing. SAS

prints the word ERROR in the log, identifies the possible location of the error, prints an
explanation of the error, and stops processing the DATA step.

data temp
x=1;

run;

proc print data=temp;

run;



150 Semantic Errors A Chapter 9

Output 9.2 SAS Log: Syntax Error (missing semicolon)

1 data temp
2 x=1;
76

ERROR 76-322: Syntax error, statement will be ignored.
3 run;

NOTE: The SAS System stopped processing this step because of errors.
NOTE: DATA statement used:

real time 0.11 seconds
cpu time 0.02 seconds
4
5 proc print data=temp;
ERROR: File WORK.TEMP.DATA does not exist.
6 run;

NOTE: The SAS System stopped processing this step because of errors.
NOTE: PROCEDURE PRINT used:

real time 0.06 seconds

cpu time 0.01 seconds

Whether subsequent steps are executed depends on which method of running SAS
you use, as well as on your operating environment.

Semantic Errors

Semantic errors occur when the form of the elements in a SAS statement is correct,
but the elements are not valid for that usage. Semantic errors are detected at compile
time and can cause SAS to enter syntax check mode. (For a description of syntax check
mode, see “Syntax Check Mode” on page 156.)

Examples of semantic errors include the following:

O specifying the wrong number of arguments for a function
O using a numeric variable name where only a character variable is valid
O using illegal references to an array.

In the following example, SAS detects an illegal reference to the array ALL.

data _null ;
array all{*} x1-x5;

all=3;
datalines;
1 1.5
.3
2 4.5
327
3 ..
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Output 9.3 SAS Log: Semantic Error (illegal reference to an array)

cpu time 0.02 seconds
1 data _null ;
2 array all{*} x1-x5;
ERROR: Illegal reference to the array all.
3 all=3;
4 datalines;

NOTE: The SAS System stopped processing this step because of errors.
NOTE: DATA statement used:

real time 2.28 seconds

cpu time 0.06 seconds

10 ;
11

The following is another example of a semantic error. In this DATA step, the libref
SOMELIB has not been previously assigned in a LIBNAME statement.

data test;
set somelib.old;

run;

Output 9.4 SAS Log: Semantic Error (libref not previously assigned)

cpu time 0.00 seconds

1 data test;
ERROR: Libname SOMELIB is not assigned.
2 set somelib.old;
3 run;
NOTE: The SAS System stopped processing this step because of errors.
WARNING: The data set WORK.TEST may be incomplete. When this step was stopped
there were 0 observations and 0 variables.
NOTE: DATA statement used:
real time 0.17 seconds

Execution-Time Errors

Definition

Execution-time errors are errors that occur when SAS executes a program that
processes data values. Most execution-time errors produce warning messages or notes
in the SAS log but allow the program to continue executing. *The location of an
execution-time error is usually given as line and column numbers in a note or error

message.
Common execution-time errors include the following:

o illegal arguments to functions
o illegal mathematical operations (for example, division by 0)
O observations in the wrong order for BY-group processing

* When you run SAS in noninteractive mode, more serious errors can cause SAS to enter syntax check mode and stop
processing the program.
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O reference to a nonexistent member of an array (occurs when the array’s subscript
is out of range)

O open and close errors on SAS data sets and other files in INFILE and FILE
statements

o INPUT statements that do not match the data lines (for example, an INPUT
statement in which you list the wrong columns for a variable or fail to indicate
that the variable is a character variable).

Out-of-Resources Condition

An execution-time error can also occur when you encounter an out-of-resources
condition, such as a full disk, or insufficient memory for a SAS procedure to complete.
When these conditions occur, SAS attempts to find resources for current use. For
example, SAS may ask the user for permission to delete temporary data sets that might
no longer be needed, or to free the memory in which macro variables are stored.

When an out-of-resources condition occurs in a windowing environment, you can use
the SAS CLEANUP system option to display a requestor panel that enables you to
choose how to resolve the error. When you run SAS in batch, noninteractive, or
interactive line mode, the operation of CLEANUP depends on your operating
environment. For more information, see the CLEANUP system option in SAS Language
Reference: Dictionary, and in the SAS documentation for your operating environment.

Examples

In the following example, an execution-time error occurs when SAS uses data values
from the second observation to perform the division operation in the assignment
statement. Division by 0 is an illegal mathematical operation and causes an
execution-time error.

options linesize=64 nodate pageno=1 pagesize=25;

data inventory;

input Item $ 1-14 TotalCost 15-20
UnitsOnHand 21-23;

UnitCost=TotalCost/UnitsOnHand;
datalines;

Hammers 440 55

Nylon cord 35 0

Ceiling fans 1155 30

r

proc print data=inventory;
format TotalCost dollar8.2 UnitCost dollar8.2;

run;



Error Processing and Debugging /A Execution-Time Errors

Output 9.5 SAS Log: Execution-Time Error (division by 0)
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cpu time 0.02 seconds

1

2 options linesize=64 nodate pageno=1 pagesize=25;

3

4 data inventory;

5 input Item $ 1-14 TotalCost 15-20

6 UnitsOnHand 21-23;

7 UnitCost=TotalCost/UnitsOnHand;

8 datalines;

NOTE: Division by zero detected at line 12 column 22.

RULE: ————#———=lo———to—e-2c ot 3ot cbmm b5
10 Nylon cord 35 0

Item=Nylon cord TotalCost=35 UnitsOnHand=0 UnitCost=. _ERROR_=1
N =2

NOTE: Mathematical operations could not be performed at the
following places. The results of the operations have been
set to missing values.

Each place is given by:
(Number of times) at (Line):(Column).

1 at 12:22
NOTE: The data set WORK.INVENTORY has 3 observations and 4
variables.
NOTE: DATA statement used:
real time 2.78 seconds
cpu time 0.08 seconds
12 ;
13
14 proc print data=inventory;
15 format TotalCost dollar8.2 UnitCost dollar8.2;

16 run;

NOTE: There were 3 observations read from the dataset
WORK.INVENTORY.

NOTE: PROCEDURE PRINT used:
real time 2.62 seconds

Output 9.6 SAS Listing Output: Execution-Time Error (division by 0)

The SAS System 1
Total Units
Obs Item Cost OnHand UnitCost
1 Hammers $440.00 55 $8.00
2 Nylon cord $35.00 0 .
3 Ceiling fans $1155.00 30 $38.50

SAS executes the entire step, assigns a missing value for the variable UnitCost in

the output, and writes the following to the SAS log:
O a note that describes the error
O the values that are stored in the input buffer
O the contents of the program data vector at the time the error occurred

O a note explaining the error.

Note that the values that are listed in the program data vector include the _N_ and

_ERROR_ automatic variables. These automatic variables are assigned temporarily to

each observation and are not stored with the data set.
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In the following example of an execution-time error, the program processes an array
and SAS encounters a value of the array’s subscript that is out of range. SAS prints an
error message to the log and stops processing.

options linesize=64 nodate pageno=1 pagesize=25;

data test;
array all{*} x1-x3;
input I measure;
if measure > 0 then
all{I} = measure;
datalines;
1 1.5

3
2 4.5

~e

proc print data=test;

run;

Output 9.7 SAS Log: Execution-Time Error (subscript out of range)

cpu time 0.02 seconds
options linesize=64 nodate pageno=1 pagesize=25;

1

2

3 data test;

4 array all{*} x1-x3;

5 input I measure;

6 if measure > 0 then

7 all{I} = measure;

8 datalines;

ERROR: Array subscript out of range at line 12 column 7.

10 .3
x1=. x2=. x3=. I=. measure=3 _ERROR =1 _N_ =2
NOTE: The SAS System stopped processing this step because of
errors.
WARNING: The data set WORK.TEST may be incomplete. When this
step was stopped there were 1 observations and 5

variables.
NOTE: DATA statement used:
real time 0.90 seconds
cpu time 0.09 seconds
12 ;
13

14 proc print data=test;
15 run;
NOTE: There were 1 observations read from the dataset WORK.TEST.
NOTE: PROCEDURE PRINT used:
real time 0.81 seconds

Data Errors

Data errors occur when some data values are not appropriate for the SAS statements
that you have specified in the program. For example, if you define a variable as
numeric, but the data value is actually character, SAS generates a data error. SAS
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detects data errors during program execution and continues to execute the program,
and does the following:

O writes an invalid data note to the SAS log.

O prints the input line and column numbers that contain the invalid value in the
SAS log. Unprintable characters appear in hexadecimal. To help determine
column numbers, SAS prints a rule line above the input line.
prints the observation under the rule line.

sets the automatic variable _"ERROR_ to 1 for the current observation.

In this example, a character value in the Number variable results in a data error
during program execution:

options linesize=64 nodate pageno=1 pagesize=25;

data age;
input Name $ Number;
datalines;

Sue 35

Joe XX

Steve 22

r

proc print data=age;

run;

The SAS log shows that there is an error in line 8, position 5-6 of the program.

Output 9.8 SAS Log: Data Error

cpu time 0.01 seconds

1

2 options linesize=64 nodate pageno=1 pagesize=25;

3

4 data age;

5 input Name $ Number;

6 datalines;

NOTE: Invalid data for Number in line 8 5-6.
RULE:-—-—-—+----1l-——-4———-2—-———F+——--3 et b ot —— -5 ————§
8 Joe xx

Name=Joe Number=. _ERROR =1 N =2

NOTE: The data set WORK.AGE has 3 observations and 2 variables.
NOTE: DATA statement used:

real time 0.06 seconds

cpu time 0.02 seconds

10 ;
11
12 proc print data=age;
13 run;
NOTE: There were 3 observations read from the dataset WORK.AGE.
NOTE: PROCEDURE PRINT used:
real time 0.01 seconds
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Output 9.9 SAS Listing Output: Data Error

The SAS System 1
Obs Name Number
1 Sue 35
2 Joe .
3 Steve 22

You can also use the INVALIDDATA= system option to assign a value to a variable
when your program encounters invalid data. For more information, see the
INVALIDDATA= system option in SAS Language Reference: Dictionary.

Format Modifiers for Error Reporting

The INPUT statement uses the ? and the ?? format modifiers for error reporting.
The format modifiers control the amount of information that is written to the SAS log.
Both the ? and the ?? modifiers suppress the invalid data message. However, the ??
modifier also sets the automatic variable _[ERROR_ to 0. For example, these two sets of
statements are equivalent:

O input x ?? 10-12;

O input x ? 10-12;
_error =0;

In either case, SAS sets the invalid values of X to missing values.

Macro-related Errors

Several types of macro-related errors exist:

O macro compile time and macro execution-time errors, generated when you use the
macro facility itself

O errors in the SAS code produced by the macro facility.

For more information about macros, see SAS Macro Language: Reference.

Error Processing in SAS

Syntax Check Mode

If you want processing to stop when a statement in a DATA step has a syntax error,
you can enable SAS to enter syntax check mode. SAS internally sets the OBS= option
to 0 and the REPLACE/NOREPLACE option to NOREPLACE. When these options are
in effect, SAS acts as follows:

O reads the remaining statements in the DATA step or PROC step
0 checks that statements are valid SAS statements
O executes global statements
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O writes errors to the SAS log

O creates the descriptor portion of any output data sets that are specified in program
statements

0 does not write any observations to new data sets that SAS creates

O does not execute most of the subsequent DATA steps or procedures in the program
(exceptions include PROC DATASETS and PROC CONTENTS).

Note: Any data sets that are created after SAS has entered syntax check mode do
not replace existing data sets with the same name. 2

When syntax checking is enabled, if SAS encounters a syntax or semantic error in a
DATA step, SAS underlines the point where it detects the error and identifies the error
by number. SAS then enters syntax check mode and remains in this mode until the
program finishes executing. When SAS enters syntax check mode, all DATA step
statements and PROC step statements are validated.

Enabling Syntax Check Mode

You use the SYNTAXCHECK system option to enable syntax check mode when you
run SAS in non-interactive or batch mode. You use the DMSSYNCHK system option to
enable syntax check mode when you run SAS in the windowing environment. To disable
syntax check mode, use the NOSYNTAXCHECK and NODMSSYNCHK system options.

In an OPTIONS statement, place the OPTIONS statement that enables
SYNTAXCHECK or DMSSYNCHK before the step for which you want it to apply. If
you place the OPTIONS statement inside a step, then SYNTAXCHECK or
DMSSYNCHK will not take effect until the beginning of the next step.

For more information about the DMSSYNCHK system option and the
SYNTAXCHECK system option in SAS Language Reference: Dictionary.

Processing Multiple Errors

Depending on the type and severity of the error, the method you use to run SAS, and
your operating environment, SAS either stops program processing or flags errors and
continues processing. SAS continues to check individual statements in procedures after
it finds certain kinds of errors. Thus, in some cases SAS can detect multiple errors in a
single statement and may issue more error messages for a given situation, particularly
if the statement containing the error creates an output SAS data set.

The following example illustrates a statement with two errors:

data temporary;
Iteml=4;

run;

proc print data=temporary;
var Iteml Item2 Item3;

run;
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Output 9.10 SAS Log: Multiple Program Errors

cpu time 0.00 seconds
1 data temporary;
2 Tteml=4;
3 run;
NOTE: The data set WORK.TEMPORARY has 1 observations and 1
variables.
NOTE: DATA statement used:
real time 0.10 seconds
cpu time 0.01 seconds

4

5 proc print data=temporary;

ERROR: Variable ITEM2 not found.

ERROR: Variable ITEM3 not found.

6 var Iteml Item2 Item3;

7 run;

NOTE: The SAS System stopped processing this step because of
errors.

NOTE: PROCEDURE PRINT used:
real time 0.53 seconds
cpu time 0.01 seconds

SAS displays two error messages, one for the variable Item2 and one for the variable
Item3.

When you are running debugged production programs that are unlikely to encounter
errors, you might want to force SAS to abend after a single error occurs. You can use
the ERRORABEND system option to do this.

Using System Options to Control Error Handling

You can use the following system options to control error handling (resolve errors) in
your program:

BYERR controls whether SAS generates an error message and sets the error
flag when a _NULL_ data set is used in the SORT procedure.

DKRICOND= controls the level of error detection for input data sets during the
processing of DROP=, KEEP=, and RENAME= data set options.

DKROCOND= controls the level of error detection for output data sets during the

processing of DROP=, KEEP=, and RENAME= data set options and
the corresponding DATA step statements.

DSNFERR controls how SAS responds when a SAS data set is not found.
ERRORABEND  specifies how SAS responds to errors.
ERRORCHECK= controls error handling in batch processing.

ERRORS= controls the maximum number of observations for which complete
error messages are printed.

FMTERR determines whether SAS generates an error message when a format
of a variable cannot be found.

INVALIDDATA= specifies the value that SAS assigns to a variable when invalid
numeric data is encountered.

MERROR controls whether SAS issues a warning message when a macro-like
name does not match a macro keyword.
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SERROR controls whether SAS issues a warning message when a defined
macro variable reference does not match a macro variable.

VNFERR controls how SAS responds when a _NULL_ data set is used.

For more information about SAS system options, see SAS Language Reference:
Dictionary.

Using Return Codes

In some operating environments, SAS passes a return code to the system, but the
way in which return codes are accessed is specific to your operating environment.

Operating Environment Information: For more information about return codes, see the
SAS documentation for your operating environment. A

Other Error-Checking Options

To help determine your programming errors, you can use the following methods:

0 the IORC_ automatic variable that SAS creates (and the associated IORCMSG
function) when you use the MODIFY statement or the KEY= data set option in the
SET statement

o the ERROR= system option to limit the number of identical errors that SAS writes
to the log

o the SYSRC and SYSMSG functions to return information when a data set or
external-files access function encounters an error condition

o the SYSRC and SYSERR macro variables

o log control options:

MSGLEVEL= controls the level of detail in messages that are written to the
SAS log.

PRINTMSGLIST controls the printing of extended lists of messages to the SAS
log.

SOURCE controls whether SAS writes source statements to the SAS log.

SOURCE2 controls whether SAS writes source statements included by

%INCLUDE to the SAS log.

Debugging Logic Errors in the DATA Step

To debug logic errors in a DATA step, you can use the DATA step debugger. This tool
enables you to issue commands to execute DATA step statements one by one and then
pause to display the resulting variables’ values in a window. By observing the results
that are displayed, you can determine where the logic error lies. Because the debugger
is interactive, you can repeat the process of issuing commands and observing results as
many times as needed in a single debugging session. To invoke the debugger, add the
DEBUG option to the DATA statement and execute the program. For detailed
information about how to use the DATA step debugger, see SAS Language Reference:
Dictionary.
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Definitions for SAS Output

SAS output is the result of executing SAS programs. Most SAS procedures and some
DATA step applications produce output.
There are three types of SAS output:

SAS log

contains a description of the SAS session and lists the lines of source code that
were executed. Depending on the setting of SAS system options, the method of
running SAS, and the program statements that you specify, the log can include the
following types of information:

O program statements

names of data sets created by the program

notes, warnings, or error messages encountered during program execution
the number of variables and observations each data set contains

O o o o

processing time required for each step.

You can write specific information to the SAS log (such as variable values or text
strings) by using the SAS statements that are described in “Writing to the Log” on
page 165.

The log is also used by some of the SAS procedures that perform utility
functions, for example the DATASETS and OPTIONS procedures. See Base SAS
Procedures Guide for more information.

Because the SAS log provides a journal of program processing, it is an essential
debugging tool. However, certain system options must be in effect to make the log
effective for debugging your SAS programs. “Customizing the Log” on page 165
describes several SAS system options that you can use.

program results

contain the results of most SAS procedures and some DATA step applications.
Results can be routed to a file, and printed as a listing. If you use the Output
Delivery System (ODS), you can produce results for a high resolution printer or
create HTML output for use with a web browser. You can customize your output
by modifying or creating your own table definitions, which are descriptions of how
you want to format your output. For more information about the flexibility of
ODS, see SAS Output Delivery System: User’s Guide.

SAS console log

When the SAS log is not active, it contains information, warning, and error
messages. When the SAS log is active, the SAS console log is used only for fatal
system initialization errors or late termination messages.

Operating Environment Information: See the SAS documentation for your
operating environment for specific information on the destination of the SAS
console log. A
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Routing SAS Output

The destination of your output depends on

O the operating environment

O the setting of SAS system options

O whether you use ODS

0 the method of running SAS.

There are several ways to route SAS output to a destination other than the default

destination. You can route the output to your terminal, to an external file, or directly to
a printer. If you use ODS, you can route output to a data set for most procedures.

Operating Environment Information: See the SAS documentation for your operating
environment for specific information. 2

The following table shows the default destination of SAS output for each method of
operation.

Table 10.1 Default Destinations of SAS Qutput

Method of Running SAS Destination of SAS Output

windowing mode (Explorer window) the Log window or the output window
interactive line mode the terminal display (as statements are entered)
noninteractive mode depends on the operating environment

batch mode depends on the operating environment

Operating Environment Information: The default destination for SAS output is specific
to your operating environment. For specific information, see the SAS documentation for
your operating environment. A

The SAS Log

Structure of the Log

The SAS log is a record of everything you do in your SAS session or with your SAS
program. Original program statements are identified by line numbers. Interspersed
with SAS statements are messages from SAS. These messages may begin with the
words NOTE, INFO, WARNING, ERROR, or an error number, and they may refer to a
SAS statement by its line number in the log.

For example, in the following output, the number 1 prints to the left of the OPTIONS
statement. This means that it is the first line in the program. In interactive mode, SAS
continues with the sequence of line numbering until you end your session. If you
submit the program again (or submit other programs in your current SAS session), the
first program line number will be the next consecutive number.

Operating Environment Information: The SAS log appears differently depending on
your operating environment. See the SAS documentation for your operating
environment. A
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Output 10.1  Sample SAS Log

NOTE: Copyright (c) 2002--2003 by SAS Institute Inc., Cary, NC, USA. @
NOTE: SAS (r) 9.1 (TS1BO) @

Licensed to SAS Institute Inc., Site 0000000001. @
NOTE: This session is executing on the HP-UX B.10.20 platform. @

NOTE: SAS initialization used:
real time 4.20 seconds
cpu time 1.18 seconds

options pagesize=24 linesize=64 nodate; @

data logsample; @

infile ’/u/abcdef/testdir/sampledata.dat’;

input LastName $ 1-12 ID $ Gender $ Birth : date7. @
scorel score2 score3

score

! 4 score5 scoreé6;

format Birth mmddyyS8.;
run;

oo WN

=
Q
H
=

The infile ’/u/abcdef/testdir/sampledata.dat’ is: @
File Name=/u/abcdef/testdir/sampledata.dat,

Owner Name=abcdef,Group Name=pubs,

Access Permission=rw-r--r--,

File Size (bytes)=296

NOTE: 5 records were read from the infile @
' /u/abcdef/testdir/sampledata.dat’.
The minimum record length was 58.
The maximum record length was 59.
NOTE: The data set WORK.LOGSAMPLE has 5 observations and 10
variables. @
NOTE: DATA statement used:

real time 0.44 seconds
cpu time 0.13 seconds
9
10 proc sort data=logsample; @
11 by LastName;
12

NOTE: There were 5 observations read from the dataset
WORK.LOGSAMPLE.

NOTE: The data set WORK.LOGSAMPLE has 5 observations and 10
variables. @

NOTE: PROCEDURE SORT used:
real time 0.16 seconds
cpu time 0.03 seconds

13 proc print data=logsample; @@
14 by LastName;
15 run;

NOTE: There were 5 observations read from the dataset
WORK.LOGSAMPLE.

NOTE: PROCEDURE PRINT used:
real time 0.31 seconds
cpu time 0.05 seconds

The following list corresponds to the circled numbers in the SAS log shown above:
@ copyright information.
@ SAS system release used to run this program.

© name and site number of the computer installation where the program ran.
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O platform used to run the program.

© OPTIONS statement. This statement uses SAS system options to set a page size
of 24 and a line size of 64, and to suppress the date in the output.

@ SAS statements that make up the program (if the SAS system option SOURCE is
enabled).

@ long statement continued to the next line. Note that the continuation line is
preceded by an exclamation point (!), and that the line number does not change.

@ input file information-notes or warning messages about the raw data and where
they were obtained (if the SAS system option NOTES is enabled).

© the number and record length of records read from the input file (if the SAS
system option NOTES is enabled).

@ SAS data set that your program created; notes that contain the number of
observations and variables for each data set created (if the SAS system option
NOTES is enabled).

@ procedure that sorts your data set

@ note about the sorted SAS data set

® procedure that prints your data set.

Writing to the Log

You can instruct SAS to write additional information to the log by using the following
statements:

PUT statement
writes selected lines (including text strings and DATA step variable values) to the
SAS log. This behavior of the PUT statement requires that your program does not
execute a FILE statement before the PUT statement in the current iteration of a
DATA step, and that it does not execute a FILE LOG; statement.

%PUT statement
enables you to write a text string or macro variable values to the SAS log. %PUT
is a SAS macro program statement that is independent of the DATA step and can
be used anywhere.

LIST statement
writes to the SAS log the input data records for the data line that is being
processed. The LIST statement operates only on data that are read with an
INPUT statement. It has no effect on data that are read with a SET, MERGE,
MODIFY, or UPDATE statement. Use the LIST statement in a DATA step.

ERROR statement
sets the automatic _ERROR_ variable to 1 and optionally writes to the log a
message that you specify. Use the ERROR statement in a DATA step.

Use the PUT, LIST, and ERROR statements in combination with conditional
processing to debug DATA steps by writing selected information to the log.

Customizing the Log

Altering the Contents of the Log

When you have large SAS production programs or an application that you run on a
regular basis without changes, you might want to suppress part of the log. SAS system
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options enable you to suppress SAS statements and system messages, as well as to
limit the number of error messages. Note that all SAS system options remain in effect
for the duration of your session or until you change the options. You should not
suppress log messages until you have successfully executed the program without errors.

The following list describes some of the SAS system options that you can use to alter
the contents of the log:

CPUID | NOCPUID
controls whether hardware information is written to the SAS log.

ECHOAUTO | NOECHOAUTO
controls whether autoexec code in an input file is written to the log.

ERRORS=n
specifies the maximum number of observations for which data error messages are
printed.

MPRINT | NOMPRINT
controls whether SAS statements that are generated by macro execution are
written to the SAS log.

MSGLEVEL=N | I
controls the level of detail in messages that are written to the SAS log. If the
MSGLEVEL system option is set to N, the log displays notes, warnings, and error
messages only. If MSGLEVEL is set to I, the log displays additional notes
pertaining to index usage, merge processing, and sort utilities, along with
standard notes, warnings, and error messages.

NEWS=external-file
controls whether news information that is maintained at your site is written to the

SAS log.

NOTES | NONOTES
controls whether notes (messages beginning with NOTE) are written to the SAS
log. NONOTES does not suppress error or warning messages.

OVP | NOOVP
controls whether output lines that are printed by SAS are overprinted.

PRINTMSGLIST | NOPRINTMSGLIST
controls whether extended lists of messages are written to the SAS log.

SOURCE | NOSOURCE
controls whether SAS writes source statements to the SAS log.

SOURCE2 | NOSOURCE2
controls whether SAS writes secondary source statements from files included by
%INCLUDE statements to the SAS log.

SYMBOLGEN | NOSYMBOLGEN
controls whether the results of resolving macro variable references are written to
the SAS log.

See SAS Language Reference: Dictionary for more information about how to use
these and other SAS system options.

Operating Environment Information: See the documentation for your operating
environment for other options that affect log output. A

Customizing the Appearance of the Log

The following SAS statements and SAS system options enable you to customize the
log. Customizing the log is helpful when you use the log for report writing or for
creating a permanent record.



DATE system
option

FILE statement

LINESIZE=
system option

MISSING=
system option

NUMBER
system option

PAGE statement

PAGESIZE=
system option

SKIP statement
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controls whether the date and time that the SAS job began are
printed at the top of each page of the SAS log and any output
created by SAS.

enables you to write the results of PUT statements to an external
file. You can use the following two options in the FILE statement to
customize the log for that report.

LINESIZE=value specifies the maximum number of columns per
line for reports and the maximum record length
for data files.

PAGESIZE=value specifies the maximum number of lines to print
on each page of output.

Note: FILE statement options apply only to the output specified
in the FILE statement, whereas the LINESIZE= and PAGESIZE=
SAS system options apply to all subsequent listings. A

specifies the line size (printer line width) for the SAS log and SAS
output that are used by the DATA step and procedures.

specifies the character to be printed for missing numeric variable
values.

controls whether the page number prints on the first title line of
each page of printed output.

skips to a new page in the SAS log and continues printing from
there.

specifies the number of lines that you can print per page of SAS
output.

skips a specified number of lines in the SAS log.

Operating Environment Information: The range of values for the FILE statement and
for SAS system options depends on your operating environment. See the SAS
documentation for your operating environment for more information. A

For more information about how to use these and other SAS system options and
statements, see SAS Language Reference: Dictionary.

Traditional SAS Listing Output

Example of Traditional Listing Output

Many SAS procedures process or analyze data and can produce output as one result.
You can also generate a listing by the DATA step, using a combination of the FILE and

PUT statements.

See the procedure descriptions in Base SAS Procedures Guide for examples of output
from SAS procedures. For a discussion and examples of DATA step output, see the
FILE and PUT statements in SAS Language Reference: Dictionary.

This example produces a listing that is generated by the PUT and FILE statements
in a DATA step. The input file is the SAS data set GRAIN_PRODUCERS.
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options pagesize=60 linesize=64 nodate pageno=1;

title ’‘Leading Grain Producers’;
title2 'for 1996';

data _null ;
set grain producers;
file print header=newpage;
if year=1996;
format country $cntry.;
label type='Grain’;
put country @25 type @50 kilotons;
return;
newpage:
put ’‘Country’ @25 ’‘Grain’ @50 ‘Kilotons’;

put 60*'=';
return;
run;
Leading Grain Producers 1
for 1996
Country Grain Kilotons
Brazil Wheat 3302
Brazil Rice 10035
Brazil Corn 31975
China Wheat 109000
China Rice 190100
China Corn 119350
India Wheat 62620
India Rice 120012
India Corn 8660
Indonesia Wheat .
Indonesia Rice 51165
Indonesia Corn 8925
United States Wheat 62099
United States Rice 7771
United States Corn 236064

Making Output Descriptive

There are several ways to customize SAS procedure output and DATA step output.
You can change the look of output by adding informative titles, footnotes, and labels,
and by changing the way the information is formatted on the page. The following list
describes some of the statements and SAS system options that you can use.

CENTER | NOCENTER system option
controls whether output is centered. By default, SAS centers titles and procedure
output on the page and on the terminal display.

DATE | NODATE system option
controls printing of date and time values. When this option is enabled, SAS prints
on the top of each page of output the date and time the SAS job started. When you
run SAS in interactive mode, the date and time the job started is the date and
time you started your SAS session.

FOOTNOTE statements
print footnotes at the bottom of each output page. You can also use the
FOOTNOTES window for this purpose.
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FORMCHAR=
specifies the default output formatting characters for some procedures such as
CALENDAR, FREQ, REPORT, and TABULATE.

FORMDLIM=
specifies a character that is used to delimit page breaks in SAS output.

LABEL statement
associates descriptive labels with variables. With most procedure output, SAS
writes the label rather than the variable name.

The LABEL statement also provides descriptive labels when it is used with
certain SAS procedures. See Base SAS Procedures Guide for information on using
the LABEL statement with a specific procedure (for example, the PRINT
procedure).

LINESIZE= and PAGESIZE= system options

can change the default number of lines per page (page size) and characters per
line (line size) for printed output. The default depends on the method of running
SAS and the settings of certain SAS system options. Specify new page and line
sizes in the OPTIONS statement or OPTIONS window. You can also specify line
and page size for DATA step output in the FILE statement.

The values you use for the LINESIZE= and PAGESIZE= system options can
significantly affect the appearance of the output that is produced by some SAS
procedures.

NUMBER | NONUMBER and PAGENO= system options
control page numbering. The NUMBER system option controls whether the page
number prints on the first title line of each page of printed output. You can also
specify a beginning page number for the next page of output produced by SAS by
using the PAGENO= system option.

TITLE statements
print titles at the top of each output page. By default, SAS prints the following
title:

The SAS System

You can use the TITLE statement or TITLES window to replace the default title
or specify other descriptive titles for SAS programs. You can use the null title
statement (title;) to suppress a TITLE statement.

See SAS Language Reference: Dictionary for more information about how to use
these and other SAS system options and statements.

Reformatting Values

Certain SAS statements, procedures, and options enable you to print values using
specified formats. You can apply or change formats with the FORMAT and ATTRIB
statements, or with the VAR window in a windowing environment.

The FORMAT procedure enables you to design your own formats and informats,
giving you added flexibility in displaying values. See the FORMAT procedure in Base
SAS Procedures Guide for more information.

Printing Missing Values

SAS represents ordinary missing numeric values in a SAS listing as a single period,
and missing character values as a blank space. If you specified special missing values
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for numeric variables, SAS writes the letter or the underscore. For character variables,
SAS writes a series of blanks equal to the length of the variable.

The MISSING= system option enables you to specify a character to print in place of
the period for ordinary missing numeric values.

Changing the Destination of the Log and the Qutput

You can redirect both the SAS log and procedure output to your terminal display, to a
printer, or to an external file. You can redirect output using the following methods:

PRINTTO procedure
routes DATA step, log, or procedure output from the system default destinations to
the destination you choose.

FILENAME statement
associates a fileref with an external file or output device and enables you to specify
file and device attributes.

FILE command
stores the contents of the LOG or OUTPUT windows in files you specify, when the
command is issued from within the windowing environment.

SAS system options
redefine the destination of log and output for an entire SAS program. These
system options are specified when you invoke SAS. The system options used to
route output are the ALTLOG=, ALTPRINT=, LOG=, and PRINT= options.

Operating Environment Information: The way you specify output destinations when
you use SAS system options is dependent on your operating environment. See the SAS
documentation for your operating environment for details. A

Output Delivery System

Gallery of 0DS Samples

Introduction to the 0DS Samples

This section shows you samples of the different kinds of formatted output that you
can produce with ODS. The input file contains sales records for TruBlend Coffee
Makers, a company that distributes coffee machines.

Listing Output

Traditional SAS output is Listing output. You do not need to change your SAS
programs to create listing output. By default, you continue to create this kind of output
even if you also create a type of output that contains more formatting.
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Output 10.2 Listing Output

m

Average Quarterly Sales Amount by Each Sales Representative 1
————————————————————————————————— Quarter=]l -—-—————————
The MEANS Procedure

Analysis Variable : AmountSold
N
SalesRep Obs N Mean Std Dev Minimum Maximum
Garcia 8 8 14752.5 22806.1 495.0 63333.7
Hollingsworth 5 5 11926.9 12165.2 774.3 31899.1
Jensen 5 5 10015.7 8009.5 3406.7 20904.8
Average Quarterly Sales Amount by Each Sales Representative 2
————————————————————————————————— Quarter=2 -——————————
The MEANS Procedure
Analysis Variable : AmountSold
N
SalesRep Obs N Mean Std Dev Minimum Maximum
Garcia 6 6 18143.3 20439.6 1238.8 53113.6
Hollingsworth 6 6 16026.8 14355.0 1237.5 34686.4
Jensen 6 6 12455.1 12713.7 1393.7 34376.7
Average Quarterly Sales Amount by Each Sales Representative 3
————————————————————————————————— Quarter=3 -——————————
The MEANS Procedure
Analysis Variable : AmountSold
N
SalesRep Obs N Mean Std Dev Minimum Maximum
Garcia 21 21 10729.8 11457.0 2787.3 38712.5
Hollingsworth 15 15 7313.6 7280.4 1485.0 30970.0
Jensen 21 21 10585.3 7361.7 2227.5 27129.7
Average Quarterly Sales Amount by Each Sales Representative 4
————————————————————————————————— Quarter=4 -—————————
The MEANS Procedure
Analysis Variable : AmountSold
N
SalesRep Obs N Mean Std Dev Minimum Maximum
Garcia 5 5 11973.0 10971.8 3716.4 30970.0
Hollingsworth 6 6 13624.4 12624.6 5419.8 38093.1
Jensen 6 6 19010.4 15441.0 1703.4 38836.4
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PostScript Output
With ODS, you can produce output in PostScript format.

Display 10.1 PostScript Output Viewed with Ghostview

sales—ps—file.ps
Thu Jul 2816:39:02 2t

Sales for Malik and Chang

Magstep

Orientation
Media

Chang 630
Subtotal for Chang is $630.00.

Malik 350

Subtotalfor Malik is $350.00.
Tatalfor all departmentsis: $980.00.
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HTML Output

With ODS, you can produce output in HTML (Hypertext Markup Language.) You can
browse these files with Internet Explorer, Netscape, or any other browser that fully
supports HTML 4.0.

Note: To create HTML 3.2 output, use the ODS HTMLS3 statement. A

Display 10.2 HTML Output Viewed with Microsoft Internet Explorer

7} SAS Output Frame - Microsoft Internet Explorer provided by SAS =131x

I

Region and City Size by Sale Type

All Products

Internet In Store

%60 525 $48 420 §108 245
1825 545 625 1825 $36 500 3,650 $62,125
623 §15 575 623 $12 460 1,246 $28,035
4863 | $121725 4,869 $97 380 9738 | $2191058
France
2303 | §57 575 2303 | $46080 4606 | §103635
2,148 §54 725 2,149 $42 980 4,286 $87 705
1,264 531,150 Missing Missing 1254 $31,150
5706 | $143.450 4452 $89 040 10,1568 | §232490
2655 | §AB37A 4927 | 98,540 75682 | §164915
3426 $a85,600 3426 $68 520 6852 | §154,120
1,033 525,825 1,033 §20 BE0 2,066 $46 485
7114 | $177 500 9386 | §187 720 16,500 | §3B5,520
7,379 | $184.475 9851 | §193020 17030 | §377 495
7400 [ $185950 7400 | §148000 14,800 | §333950
2810 | 72550 1656 | $33120 4,566 | §105670
17 BE9 | $442575 18707 | §374,140 36396 | §817.115
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RTF Output

With ODS, you can produce RTF (Rich Text Format) output which is used with
Microsoft Word.

Display 10.3 RTF Output Viewed with Microsoft Word

aurfile.ttf - Micrasoft Word o [=[ 9]

Fle Edt ¥ew lnset Fomat Ieok Toble Windaw Help Type a question for help 3¢

DeHan gLy i Bad o o  wBOESE & BT 5 50,

Column 1: Statistics for Fady and Japan Column 2: Statistics for Canade and Brogil

| saleType | ek Tape
| mswre | S

Italy L Sum 76000 1900000 Brazil L Sum 76000 1900000
M Sum 149000 37250.00 M Sum 149000 3725000
5 Sum 59000 1475000 5 Sum 59000 1475000

Ttaly L Sum 76000 19000.00 Brazil L Sum 76000 19000.00
M Sum 149000 37250.00 M Sum 149000 3725000
8 Sum 50000 14750.00 5 Sum 50000 14750.00

4sas.

This Graphic Was Insertad by ODS
wiww. YourLink.com

wconld

Page 1 Sec 2 11 At 7.4 LnS51 col 1 REC TRE EXT OVR

N
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PDF Output

With ODS, you can produce output in PDF (Portable Document Format), which can
be viewed with Adobe Acrobat.

Display 10.4 PDF Output Viewed with Adobe Acrobat

The Tabulate Procedun
Cross-tabular summ
: Table 1

$406991.00 $434.453 00

XML Output

With ODS, you can produce output that is tagged with XML (Extensible Markup
Language) tags.
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Output 10.3 XML Output File

<?xml version="1.0" encoding="windows-1252"2>

<odsxml>

<head>

<meta operator="user"/>

</head>

<body>

<proc name="Print">

<label name="IDX"/>

<title class="SystemTitle" toc-level="1">US Census of Population and Housing</title>
<branch name="Print" label="The Print Procedure" class="ContentProcName" toc-level="1">
<leaf name="Print" label="Data Set SASHELP.CLASS" class="ContentItem" toc-level="2">
<output name="Print" label="Data Set SASHELP.CLASS" clabel="Data Set SASHELP.CLASS">
<output-object type="table" class="Table">

<style>
<border spacing="1" padding="7" rules="groups" frame="box"/>
</style>
<colspecs columns="6">
<colgroup>
<colspec name="1" width="2" align="right" type="int"/>
</colgroup>
<colgroup>
<colspec name="2" width="7" type="string"/>
<colspec name="3" width="1" type="string"/>
<colspec name="4" width="2" align="decimal" type="double"/>
<colspec name="5" width="4" align="decimal" type="double"/>
<colspec name="6" width="5" align="decimal" type="double"/>
</colgroup>
</colspecs>
<output-head>
<row>
<header type="string" class="Header" row="1" column="1">
<value>Obs</value>
</header>
<header type="string" class="Header" row="1" column="2">
<value>Name</value>
</header>
<header type="string" class="Header" row="1" column="3">
<value>Sex</value>
</header>
<header type="string" class="Header" row="1" column="4">
<value>Age</value>
</header>
<header type="string" class="Header" row="1" column="5">
<value>Height</value>
</header>
<header type="string" class="Header" row="1" column="6">
<value>Weight</value>
</header>
</row>
</output-head>
<output-body>
<row>
<header type="double" class="RowHeader" row="2" column="1">
<value> 1</value>
</header>
<data type="string" class="Data" row="2" column="2">
<value>Alfred</value>
</data>
... more xml tagged output...
<

/odsxml>




SAS Output A Commonly Used ODS Terminology 177

Excel Output
With ODS, you can produce tabular output , which can be viewed with Excel.
Display 10.5 Excel Output File

Fd Microsoft Excel ~0/x
U= E s | &S 3 R - = W, LI

Type a guestion for help .

Ik
BT traffic. xls

Commonly Used 0DS Terminology

data component
is a form, similar to a SAS data set, that contains the results (numbers and
characters) of a DATA step or PROC step that supports ODS.

table definition
is a set of instructions that describes how to format the data. This description
includes but is not limited to

O the order of the columns
O text and order of column headings
O formats for data

o font sizes and font faces.
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output object
is an object that contains both the results of a DATA step or PROC step and
information about how to format the results. An output object has a name, label,
and path. For example, the Basic Statistical Measurement table generated from
the UNIVARIATE procedure is an output object. It contains the data component
and formatted presentation of the mean, median, mode, standard deviation,
variance, range, and interquartile range.

Note: Although many output objects include formatting instructions, not all of
them do. In some cases the output object consists of only the data component. A

ODS destinations
are designations that produce specific types of output. ODS supports a number of
destinations, including the following:

LISTING
produces traditional SAS output (monospace format).

Markup Family
produce SAS output that is formatted using one of many different markup
languages such as HTML (Hypertext Markup Language), XML (Extensible
Markup Language), and LaTeX that you can access with a web browser. SAS
supplies many markup languages for you to use ranging from DOCBOOK to
TROFF. You can specify a markup language that SAS supplies or create one
of your own and store it as a user-defined markup language.

DOCUMENT
produces a hierarchy of output objects that enables you to produce multiple
ODS output formats without rerunning a PROC or DATA step and gives you
more control over the structure of the output.

OUTPUT
produces a SAS data set.

Printer Family
produces output that is formatted for a high-resolution printer such as a
PostScript (PS), PDF, or PCL file.

RTF
produces output that is formatted for use with Microsoft Word.

ODS output
ODS output consists of formatted output from any of the ODS destinations. For
example, the OUTPUT destination produces SAS data sets; the LISTING
destination produces listing output; the HTML destination produces output that is
formatted in Hypertext Markup Language.

How Does 0DS Work?

Components of SAS Qutput

The PROC or DATA step supplies raw data and the name of the table definition that
contains the formatting instructions, and ODS formats the output. You can use the
Output Delivery System to format output from individual procedures and from the
DATA step in many different forms other than the default SAS listing output.

The following figure shows how SAS produces ODS output.
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Figure 10.1 ODS Processing: What Goes in and What Comes Out

ODS Processing: What Goes In and What Comes Out

Data Talble

Compoenent \+/ Definition
'

Output
Object
T
| | vt 1 \ '
I
DOCUMENT LISTING QUTPUT | HTML MARKUP PRINTER RTF oos
| Destinations
I
I
| R
Documant  Listing sAs | HTMLAZ Ms PS PCL PDF RTF oS
Cutput Output  Dala Set : Output Windows Output | Outputs
| Printers
: SAS  Userdefined
I TAGSETS* TAGSETS

SAS Formatted Destinations

Third-Party Formatted Destinations

* List of Tagsets that SAS Supplies and Supports

Table 10.2 * List of Tagsets that SAS Supplies and Supports

CHTML HTML4 SASIOXML
CSVALL HTMLCSS SASREPORT
DEFAULT IMODE SASXML
DOCBOOK PHTML SASXMOG
EVENT_MAP

* List of Tagsets that SAS Supplies but Does Not Support
Table 10.3 Additional Tagsets that SAS Supplies but Does Not Support

COLORLATEX LATEX SHORT_MAP
CSV LATEX2 STYLE_DISPLAY
CSVBYLINE NAMEDHTML STYLE_POPUP

SASXMOH
SASXMOIM
SASXMOR
WML

TPL_STYLE_MAP
TROFF
WMLOLIST

179
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GRAPH ODSSTYLE TEXT_MAP
GTABLEAPPLET PYX TPL_STYLE_LIST
CAUTION:

These tagsets are experimental tagsets. Do not use these tagsets in production jobs. ~

Features of 0DS

ODS is designed to overcome the limitations of traditional SAS output and to make it
easy to access and create the new formatting options. ODS provides a method of
delivering output in a variety of formats, and makes the formatted output easy to access.

Important features of ODS include the following:

0 ODS combines raw data with one or more table definitions to produce one or more
output objects. These objects can be sent to any or all ODS destinations. You
control the specific type of output from ODS by selecting an ODS destination. The
currently available ODS destinations can produce

O traditional monospace output

O

an output data set
an ODS document that contains a hierarchy file of the output objects

O

output that is formatted for a high-resolution printer such as PostScript and
PDF

O output that is formatted in various markup languages such as HTML
0 RTF output that is formatted for use with Microsoft Word.
o ODS provides table definitions that define the structure of the output from SAS

procedures and from the DATA step. You can customize the output by modifying
these definitions, or by creating your own.

O

o ODS provides a way for you to choose individual output objects to send to ODS
destinations. For example, PROC UNIVARIATE produces five output objects. You
can easily create HTML output, an output data set, traditional listing output, or
printer output from any or all of these output objects. You can send different
output objects to different destinations.

0 In the SAS windowing environment, ODS stores a link to each output object in the
Results folder in the Results window.

0 Because formatting is now centralized in ODS, the addition of a new ODS
destination does not affect any procedures or the DATA step. As future
destinations are added to ODS, they will automatically become available to the
DATA step and all procedures that support ODS.

o With ODS, you can produce output for numerous destinations from a single source,
but you do not need to maintain separate sources for each destination. This
feature saves you time and system resources by enabling you to produce multiple
kinds of output with a single run of your procedure or data query.

What Are the 0ODS Destinations?

Overview of ODS Destination Categories

ODS enables you to produce SAS procedure and DATA step output to many different
destinations. ODS destinations are organized into two categories.
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SAS Formatted  produce output that is controlled and interpreted by SAS, such as a

destinations SAS data set, SAS output listing, or an ODS document.

Third-Party produce output which enables you to apply styles, markup

Formatted languages, or enables you to print to physical printers using page

destinations description languages. For example, you can produce output in
PostScript, HTML, XML, or a style or markup language that you
created.

The following table lists the ODS destination categories, the destination that each
category includes, and the formatted output that results from each destination.

Table 10.4 Destination Category Table

Category Destinations Results

SAS Formatted DOCUMENT ODS document
LISTING SAS output listing
OUTPUT SAS data set

Third-Party Formatted HTML HTML file for online viewing
MARKUP markup language tagsets
PRINTER printable output in one of three

different formats: PCL, PDF,
or PS (PostScript)

RTF output written in Rich Text
Format for use with Microsoft
Word 2000

As future destinations are added to ODS, they automatically will become available to
the DATA step and to all procedures that support ODS.

Definition of Destination-Independent Input

Destination-independent input means that one destination can support a feature
even though another destination does not support it. In this case, the request is ignored
by the destination that does not support it. Otherwise, ODS would support a small
subset of features that are only common to all destinations. If this was true, then it
would be difficult to move your reports from one output format to another output
format. ODS provides many output formatting options, so that you can use the
appropriate format for the output that you want. It is best to use the appropriate
destination suited for your purpose.

The SAS Formatted Destinations

The SAS formatted destinations create SAS entities such as a SAS data set, a SAS
output listing, or an ODS document. The statements in the ODS SAS Formatted
category create the SAS entities.

The three SAS formatted destinations are:

DOCUMENT Destination
The DOCUMENT destination enables you to restructure, navigate, and replay
your data in different ways and to different destinations as you like without
needing to rerun your analysis or repeat your database query. The DOCUMENT
destination makes your entire output stream available in "raw" form and
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accessible to you to customize. The output is kept in the original internal
representation as a data component plus a table definition. When the output is in
a DOCUMENT form, it is possible to rearrange, restructure, and reformat without
rerunning your analysis. Unlike other ODS destinations, the DOCUMENT
destination has a GUI interface. However, everything that you can do through the
GUI, you can also do with batch commands using the ODS DOCUMENT
statement and the DOCUMENT procedure.

Prior to SAS 9, each procedure or DATA step produced output that was sent to
each destination that you specified. While you could always send your output to as
many destinations as you wanted, you needed to rerun your procedure or data
query if you decided to use a destination that you had not originally designated.
The DOCUMENT destination eliminates the need to rerun procedures or repeat
data queries by enabling you to store your output objects and replay them to
different destinations.

LISTING Destination

The LISTING destination produces output that looks the same as the traditional
SAS output. The LISTING destination is the default destination that opens when
you start your SAS session. Thus ODS is always being used, even when you do not
explicitly invoke ODS.

The LISTING destination enables you to produce traditional SAS output with
the same look and presentation as it had in previous versions of SAS.

Because most procedures share some of the same table definitions, the output is
more consistent. For example, if you have two different procedures producing an
ANOVA table, they will both produce it in the same way because each procedure
uses the same template to describe the table. However, there are four procedures
that do not use a default table definition to produce their output: PRINT
procedure, REPORT procedure, TABULATE procedure, and FREQ procedure’s
n-way tables. These procedures use the structure that you specified in your
program code to define their tables.

OUTPUT Destination

The OUTPUT destination produces SAS output data sets. Because ODS already
knows the logical structure of the data and its native form, ODS can output a SAS
data set that represents exactly the same resulting data set that the procedure
worked with internally. The output data sets can be used for further analysis, or
for sophisticated reports in which you want to combine similar statistics across
different data sets into a single table. You can easily access and process your
output data sets using all of the SAS data set features. For example, you can
access your output data using variable names and perform WHERE-expression
processing just as you would process data from any other SAS data set.

The Third-Party Formatted Destinations

The third-party formatted destinations enable you to apply styles to the output
objects that are used by applications other than SAS. For example, these destinations
support attributes such as "font" and "color."

Note: For a list of style elements and valid values, see the style attributes table in
the DEFINE STYLE statement section. A

The four categories of third-party formatted destinations are:
0 HTML (Hypertext Markup Language )

The HTML destination produces HTML 3.2-compatible output. You can,
however, produce (HTML 4 stylesheet) output using the HTML4 tagsets.

The HTML destination can create some or all of the following:
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o an HTML file (called the body file) that contains the results from the
procedure

O a table of contents that links to the body file
O a table of pages that links to the body file

0 a frame that displays the table of contents, the table of pages, and the body
file.

The body file is required with all ODS HTML output. If you do not want to link
to your output, then you do not have to create a table of contents, a table of pages,
or a frame file. However, if your output is very large, you might want to create a
table of contents and a table of pages for easier reading and transversing through
your file.

The HTML destination is intended only for on-line use, not for printing. To
print hard-copies of the output objects, use the PRINTER destination.

Markup Languages (MARKUP) Family

ODS statements in the MARKUP family produce output that is formatted using
one of many different markup languages such as HTML (Hypertext Markup
Language), XML (Extensible Markup Language), and LaTeX. Just as table
definitions describe how to lay out a table, and style attributes describe the style
of the output, tagsets describe how to produce a markup language output. You can
use a tagset that SAS supplies or you can create your own using the TEMPLATE
procedure. Like table definitions and style attributes, tagsets enable you to modify
your markup language output. For example, each variety of XML can be specified
as a new tagset. SAS supplies you with a collection of XML tagsets and enables
you to produce a customized variety of XML. The important point is that you can
implement a tagset that SAS supplies or a customized tagset that you created
without having to wait for the next release of SAS. With the addition of modifying
and creating your own tagsets by using PROC TEMPLATE, now you have greater
flexibility in customizing your output.

Because the MARKUP destination is so flexible, you can use either the SAS
tagsets or a tagset that you created. For a complete listing of the markup
language tagsets that SAS supplies, see the section on listing tagset names in the
ODS MARKUP statement. To learn how to define your own tagsets, see the
section on methods to create your own tagsets in the TEMPLATE Procedure:
Creating Markup Language Tagsets section.

The MARKUP destination cannot replace ODS PRINTER or ODS RTF
destinations because it cannot do text measurement. Therefore, it cannot produce
output for a page description language or a hybrid language like RTF which
requires all of the text to be measured and placed at a specific position on the page.

Printer Family
The PRINTER destination produces output for
O printing to physical printers such as Windows printers under Windows, PCL,
and PostScript printers on other operating systems
O producing portable PostScript, PCL, and PDF files.

The PRINTER destinations produce ODS output that contain page description
languages: they describe precise positions where each line of text, each rule, and
each graphical element are to be placed on the page. In general, you cannot edit or
alter these formats. Therefore, the output from ODS PRINTER is intended to be
the final form of the report.

Rich Text Format (RTF)

RTF produces output for Microsoft Word. While there are other applications
that can read RTF files, the RTF output might not work successfully with them.
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The RTF destination enables you to view and edit the RTF output. ODS does
not define the “vertical measurement," meaning that SAS does not determine the
optimal place to position each item on the page. For example, page breaks are not
always fixed, so when you edit your text, you do not want your RTF output tables
to split at inappropriate places. Your tables can remain whole and intact on one
page or can have logical breaks where you specified.

However, because Microsoft Word needs to know the widths of table columns
and it cannot adjust tables if they are too wide for the page, ODS measures the
width of the text and tables (horizontal measurement). Therefore, all the column
widths can be set properly by SAS and the table can be divided into panels if it is
too wide to fit on a single page.

In short, when producing RTF output for input to Microsoft Word, SAS
determines the horizontal measurement and Microsoft Word controls the vertical
measurement. Because Microsoft Word can determine how much room there is on
the page, your tables will display consistently as you specified even after you
modified your RTF file.

What Controls the Formatting Features of Third-Party Formats?

All of the formatting features that control the appearance of the third-party
formatted destinations beyond what the LISTING destination can do are controlled by
two mechanisms:

o ODS statement options

o ODS style attributes

The ODS statement options control three features:

1 Features that are specific to a given destination, such as stylesheets for HTML.

2 Features that are global to the document, such as AUTHOR and table of contents
generation.

3 Features that we expect users to change on each document, such as the output file
name.

The ODS style attributes control the way that individual elements are created.
Attributes are aspects of a given style, such as type face, weight, font size, and color.
The values of the attributes collectively determine the appearance of each part of the
document to which the style is applied. With style attributes, it is unnecessary to insert
destination-specific code (such as raw HTML) into the document. Each output
destination will interpret the attributes that are necessary to generate the presentation
of the document. Because not all destinations are the same, not all attributes can be
interpreted by all destinations. Style attributes that are incompatible with a selected
destination are ignored. For example, PostScript does not support active links, so the
URL= attribute is ignored when producing PostScript output.

0DS Destinations and System Resources

ODS destinations can be open or closed. You open and close a destination with the
appropriate ODS statement. When a destination is open, ODS sends the output objects
to it. An open destination uses system resources even if you use the selection and
exclusion features of ODS to select or exclude all objects from the destination.
Therefore, to conserve resources, close unnecessary destinations. For more information
about using each destination, see the topic on ODS statements in the Dictionary of ODS
Language Statements .

By default, the LISTING destination is open and all other destinations are closed.
Consequently, if you do nothing, your SAS programs run and produce listing output
looking just as they did in previous releases of SAS before ODS was available.
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What Are Table Definitions, Table Elements, and Table Attributes?

A table definition describes how to generate the output for a tabular output object.
(Most ODS output is tabular.) A table definition determines the order of column
headers and the order of variables, as well the overall look of the output object that
uses it. For information about customizing the table definition, see the topic on the
TEMPLATE procedure in the TEMPLATE Procedure: Creating Tabular Output section.

In addition to the parts of the table definition that order the headers and columns,
each table definition contains or references table elements. A table element is a
collection of table attributes that apply to a particular header, footer, or column.
Typically, a table attribute specifies something about the data rather than about its
presentation. For example, FORMAT specifies the SAS format, such as the number of
decimal places. However, some table attributes describe presentation aspects of the
data, such as how many blank characters to place between columns.

Note: The attributes of table definitions that control the presentation of the data
have no effect on output objects that go to the LISTING or OUTPUT destination.
However, the attributes that control the structure of the table and the data values do
affect listing output. A

For information on table attributes, see the section on table attributes in the
TEMPLATE Procedure: Creating Tabular Output section.

What Are Style Definitions, Style Elements, and Style Attributes?

To customize the output at the level of your entire output stream in a SAS session,
you specify a style definition. A style definition describes how to generate the
presentation aspects (color, font face, font size, and so on) of the entire SAS output. A
style definition determines the overall look of the documents that use it.

Each style definition is composed of style elements. A style element is a collection of
style attributes that apply to a particular part of the output. For example, a style
element can contain instructions for the presentation of column headers, or for the
presentation of the data inside the cells. Style elements can also specify default colors
and fonts for output that uses the style definition.

Each style attribute specifies a value for one aspect of the presentation. For example,
the BACKGROUND-= attribute specifies the color for the background of an HTML table
or for a colored table in printed output. The FONT_STYLE= attribute specifies whether
to use a Roman or an italic font. For information on style attributes, see the section on
style attributes in the TEMPLATE Procedure: Creating a Style Definition section.

Note: Because style definitions control the presentation of the data, they have no
effect on output objects that go to the LISTING or OUTPUT destination. A

What Style Definitions Are Shipped with SAS Software?

Base SAS software is shipped with many style definitions. To see a list of these
styles, you can view them in the SAS Explorer Window, use the TEMPLATE procedure,
or use the SQL procedure.

0o SAS Explorer Window:

To display a list of the available styles using the SAS Explorer Window, follow
these steps:

1 From any window in an interactive SAS session, select View » Results
2 In the Results window, select View » Templates
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3 In the Templates window, select and open Sashelp.tmplmst.

4 Select and open the styles folder, which contains a list of available style
definitions. If you want to view the underlying SAS code for a style
definition, then select the style and open it.

Operating Environment Information: For information on navigating in the
Explorer window without a mouse, see the section on “Window Controls and
General Navigation” in the SAS documentation for your operating
environment. A

o TEMPLATE Procedure:

You can also display a list of the available styles by submitting the following
PROC TEMPLATE statements:

proc template;
list styles;

run;

0 SQL Procedure:

You can also display a list of the available styles by submitting the following
PROC SQL statements:

proc sql;
select * from dictionary.styles;

For more information on how ODS destinations use styles and how you can
customize styles, see the section on the DEFINE STYLE statement.

How Do | Use Style Definitions with Base SAS Procedures?
o Most Base SAS Procedures

Most Base SAS procedures that support ODS use one or more table definitions
to produce output objects. These table definitions include definitions for table
elements: columns, headers, and footers. Each table element can specify the use of
one or more style elements for various parts of the output. These style elements
cannot be specified within the syntax of the procedure, but you can use customized
styles for the ODS destinations that you use. For more information about
customizing tables and styles, see the TEMPLATE Procedure: Creating a Style
Definition section.

The PRINT, REPORT and TABULATE Procedures

The PRINT, REPORT and TABULATE procedures provide a way for you to
access table elements from the procedure step itself. Accessing the table elements
enables you to do such things as specify background colors for specific cells, change
the font face for column headers, and more. The PRINT, REPORT, and
TABULATE procedures provide a way for you to customize the markup language
and printed output directly from the procedure statements that create the report.
For more information about customizing the styles for these procedures, see the
Base SAS Procedures Guide.

Changing SAS Registry Settings for 0DS

Overview of ODS and the SAS Registry

The SAS registry is the central storage area for configuration data that ODS uses.
This configuration data is stored in a hierarchical form, which works in a similar
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manner to the way directory-based file structures work under UNIX, Windows, VMS,
and the z/OS UNIX system. However, the SAS registry uses keys and subkeys as the
basis for its structure, instead of using directories and subdirectories, like similar file
systems in DOS or UNIX. A key is a word or a text string that refers to a particular
aspect of SAS. Each key can be a place holder without values or subkeys associated
with it, or it can have many subkeys with associated values. For example, the ODS key
has DESTINATIONS, GUI, ICONS, and PREFERENCES subkeys. A subkey is a key
inside another key. For example, PRINTER is a subkey of the DESTINATIONS subkey.

Display 10.6 SAS Registry of ODS Subkeys
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Changing Your Default HTML Version Setting

By default, the SAS registry is configured to generate HTML4 output when you
specify the ODS HTML statement. To permanently change the default HTML version,
you can change the setting of the HTML version in the SAS registry.

CAUTION:

If you make a mistake when you modify the SAS registry, then your system might become
unstable or unusable. You will not be warned if an entry is incorrect. Incorrect entries
can cause errors, and can even prevent you from bringing up a SAS session. See the
section on configuring the SAS registry in SAS Language Reference: Concepts for

more information. A
To change the default setting of the HTML version in the SAS registry:

1 Select Solutions » Accessories » Registry Editor or
Issue the command REGEDIT.

2 Select ODS » Default HMTL Version
3 Select Edit » Modify or

Click the right mouse button and select MODIFY. The Edit String Value window
appears.

4 Type the HTML version in the value Data text box and select OK.
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Display 10.7 SAS Registry Showing HTML Version Setting
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Changing 0DS Destination Default Settings

ODS destination subkeys are stored in the SAS registry. To change the values for
these destinations subkeys:

1 Select ODS » Destinations

2 Select a destination subkey

3 Select a subkey in the Contents of window

4 Select Edit » Modify or
Click the right mouse button and select MODIFY.

5 Type in the Value Data entry into the Edit Value String or Edit Signed Integer
Value window and select OK.
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Display 10.8 Registry Editor Window
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Customized 0DS Output

SAS Output

By default, ODS output is formatted according to instructions that a PROC step or
DATA step defines. However, ODS provides ways for you to customize the output. You
can customize the output for an entire SAS job, or you can customize the output for a
single output object.

Selection and Exclusion Lists

You can specify which output objects that you want to produce by selecting or
excluding them in a list. For each ODS destination, ODS maintains either a selection
list or an exclusion list. A selection list is a list of output objects that are sent to the
destination. An exclusion list is a list of output objects that are excluded from the
destination. ODS also maintains an overall selection list or an overall exclusion list. You
can use these lists to control which output objects go to the specified ODS destinations.
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To see the contents of the lists use the ODS SHOW statement. The lists are written
to the SAS log. The following table shows the default lists:

Table 10.5 Default List for Each ODS Destination

ODS Destination Default List
OUTPUT EXCLUDE ALL
All others SELECT ALL

How Does 0DS Determine the Destinations for an Output Object?

To specify an output object, you need to know which output objects your SAS
program produces. The ODS TRACE statement writes to the SAS log a trace record
that includes the path, the label, and other information about each output object that is
produced. For more information, see the ODS TRACE statement. You can specify an
output object as any of the following:

o a full path. For example,

Univariate.City Pop 90.TestsForLocation

is the full path of the output object.

O a partial path. A partial path consists of any part of the full path that begins
immediately after a period (.) and continues to the end of the full path. For
example, if the full path is

Univariate.City Pop 90.TestsForLocation
then the partial paths are:

City Pop_ 90.TestsForLocation
TestsForLocation

O a label that is enclosed in quotation marks.

For example,

"Tests For Location"

O a label path. For example, the label path for the output object is
"The UNIVARIATE Procedure"."CityPop_90"."Tests For Location"
Note: The trace record shows the label path only if you specify the LABEL

option in the ODS TRACE statement. A

O a partial label path. A partial label path consists of any part of the label that
begins immediately after a period (.) and continues to the end of the label. For
example, if the label path is

"The UNIVARIATE Procedure"."CityPop 90"."Tests For Location"
then the partial label paths are:

"CityPop_90"."Tests For Location"
"Tests For Location"

O a mixture of labels and paths.

O any of the partial path specifications, followed by a pound sign (#) and a number.
For example, TestsForLocation#3 refers to the third output object that is named
TestsForLocation.
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As each output object is produced, ODS uses the selection and exclusion lists to
determine which destination or destinations the output object will be sent to. The
following figure illustrates this process:

Figure 10.2 Directing an Output Object to a Destination

For each destination, ODS first asks if the list for that destination includes the object. If it does
not, ODS does not send the output object to that destination. If the list for that destination does
include the object, ODS reads the overall list. If the overall list includes the object, ODS sends
it to the destination. If the overall list does not include the object, ODS does not send it to the
destination.
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Note: Although you can maintain a selection list for one destination and an
exclusion list for another, it is easier to understand the results if you maintain the same
types of lists for all the destinations where you route output. A

Customized Output for an Output Object

For a procedure, the name of the table definition that is used for an output object
comes from the procedure code. The DATA step uses a default table definition unless
you specify an alternative with the TEMPLATE= suboption in the ODS option in the
FILE statement. For more information, see the section on the TEMPLATE= suboption
in the FILE Statement for ODS .

To find out which table definitions a procedure or the DATA step uses for the output
objects, you must look at a trace record. To produce a trace record in your SAS log,
submit the following SAS statements:

ods trace on;
your-proc-or-DATA-step
ods trace off;

Remember that not all procedures use table definitions. If you produce a trace record
for one of these procedures, no definition appears in the trace record. Conversely, some
procedures use multiple table definitions to produce their output. If you produce a trace
record for one of these procedures, more than one definition appears in the trace record.

The trace record refers to the table definition as a template. For a detailed
explanation of the trace record, see the section on the ODS TRACE statement.
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You can use PROC TEMPLATE to modify an entire table definition. When a
procedure or DATA step uses a table definition, it uses the elements that are defined or
referenced in its table definition. In general, you cannot directly specify a table element
for your procedure or DATA step to use without modifying the definition itself.

Note: Three Base SAS procedures, PROC PRINT, PROC REPORT and PROC
TABULATE, do provide a way for you to access table elements from the procedure step
itself. Accessing the table elements enables you to customize your report. For more
information about these procedures, see the Base SAS Procedures Guide »

Customizing Titles and Footnotes

The global TITLE and FOOTNOTE statements can be used to enhance the readability
of any report. These statements have associated options that allow you to customize the
style of the titles and footnotes when used with ODS. Because these options control
only the presentation of the titles and footnotes, they have no effect on objects that go
to the LISTING or OUTPUT destination. Examples of these style options are: BOLD,
COLOR=, and FONT=. For a complete list of style options, detailed information about
the style options, and example code that uses these style options, refer to the TITLE
statement and FOOTNOTE statement in SAS Language Reference: Dictionary.

When used with SAS/GRAPH, you can choose whether to render the titles and
footnotes as part of the HTML body or as part of the graphics image. Where the titles
and footnotes are rendered determines how you control the font, size, and color of the
titles and footnotes text. For details on this ODS and SAS/GRAPH interaction, refer to
Controlling Titles and Footnotes with ODS Output in SAS/GRAPH Software:
Reference, Volumes 1 and 2.

For information on titles and footnotes rendered with and without using the graphics
option USEGOPT, refer to the ODS USEGOPT Statement.
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Definition of

BY-Group Processing

BY-group processing is a method of processing observations from one or more SAS
data sets that are grouped or ordered by values of one or more common variables. You
can use BY-group processing in both DATA and PROC steps.

The most common use of BY-group processing in the DATA step is to combine two or
more SAS data sets by using the BY statement with a SET, MERGE, MODIFY, or
UPDATE statement. When you create reports or summaries with SAS procedures,
BY-group processing allows you to group information in the output according to values
of one or more variables.

References for BY-Group Processing

O

For more information about BY-Group processing, see Chapter 22, “BY-Group
Processing in the DATA Step,” on page 367.

For information about how to use BY-group processing with SAS procedures, see
“Fundamental Concepts for Using Base SAS Procedures” and individual
procedures in Base SAS Procedures Guide.

For information about using BY-group processing to combine information from
multiple SAS data sets, see Chapter 23, “Reading, Combining, and Modifying SAS
Data Sets,” on page 379. For even more extensive examples of BY-group
processing, see Combining and Modifying SAS Data Sets: Examples.

For information about the BY statement, see Statements in SAS Language
Reference: Dictionary.

For information about how to use BY-group processing with other software
products, see the SAS documentation for those products.
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Definition of WHERE-Expression Processing

WHERE-expression processing
enables you to conditionally select a subset of observations, so that SAS processes
only the observations that meet a set of specified conditions. For example, if you
have a SAS data set containing sales records, you may want to print just the
subset of observations for which the sales are greater than $300,000 but less than
$600,000. In addition, WHERE-expression processing may improve efficiency of a
request. For example, if a WHERE expression can be optimized with an index, it
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is not necessary for SAS to read all observations in the data set in order to
perform the request.

WHERE expression
defines a condition that selected observations must satisfy in order to be processed.
You can have a single WHERE expression, referred to as a simple expression, such
as the following:

where sales gt 600000;

Or you can have multiple WHERE expressions, referred to as a compound
expression, such as the following:

where sales gt 600000 and salary 1t 100000;

Where to Use a WHERE Expression

In SAS, you can use a WHERE expression in the following situations:

0 WHERE statement in both DATA and PROC steps. For example, the following
PRINT procedure includes a WHERE statement so that only the observations
where the year is greater than 2001 are printed:

proc print data=employees;
where startdate > '01jan2001’'d;

run;

o WHERE-= data set option. The following PRINT procedure includes the WHERE=
data set option:

proc print data=employees (where=(startdate > ’01jan2001’'d));

run;

0o WHERE clause in the SQL procedure, SCL, and SAS/IML software. For example,
the following SQL procedure includes a WHERE clause to select only the states
where the murder count is greater than seven:

proc sql;
select state from crime

where murder > 7;
o WHERE command in windowing environments like SAS/FSP software:

where age > 15

0 SAS view (DATA step view, SAS/ACCESS view, PROC SQL view), stored with the
definition. For example, the following SQL procedure creates an SQL view named
STAT from the data file CRIME and defines a WHERE expression for the SQL
view definition:

proc sql;
create view stat as
select * from crime

where murder > 7;
In some cases, you can combine the methods that you use to specify a WHERE
expression. That is, you can use a WHERE statement as follows:
O in conjunction with a WHERE= data set option

o0 along with the WHERE= data set option in windowing procedures, and in
conjunction with the WHERE command
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O on a SAS view that has a stored WHERE expression.

For example, it might be useful to combine methods when you merge data sets. That
is, you might want different criteria to apply to each data set when you create a subset
of data. However, when you combine methods to create a subset of data, there are some
restrictions. For example, in the DATA step, if a WHERE statement and a WHERE=
data set option apply to the same data set, the data set option takes precedence. For
details, see the documentation for the method you are using to specify a WHERE
expression.

Note: By default, a WHERE expression does not evaluate added and modified
observations. To specify whether a WHERE expression should evaluate updates, you
can specify the WHEREUP= data set option. See the WHEREUP= data set option in
SAS Language Reference: Dictionary. A

Syntax of WHERE Expression

A WHERE expression is a type of SAS expression that defines a condition for
selecting observations. A WHERE expression can be as simple as a single variable
name or a constant (which is a fixed value). A WHERE expression can be a SAS
function, or it can be a sequence of operands and operators that define a condition for
selecting observations. In general, the syntax of a WHERE expression is as follows:

WHERE operand <operator> <operand>

operand something to be operated on. An operand can be a variable, a SAS
function, or a constant. See “Specifying an Operand” on page 197.

operator a symbol that requests a comparison, logical operation, or arithmetic
calculation. All SAS expression operators are valid for a WHERE
expression, which include arithmetic, comparison, logical, minimum
and maximum, concatenation, parentheses to control order of
evaluation, and prefix operators. In addition, you can use special
WHERE expression operators, which include BETWEEN-AND,
CONTAINS, IS NULL or IS MISSING, LIKE, sounds-like, and
SAME-AND. See “Specifying an Operator” on page 199.

For more information on SAS expressions, see Chapter 7, “Expressions,” on page 109.

Specifying an Operand

Variable

A variable is a column in a SAS data set. Each SAS variable has attributes like
name and type (character or numeric). The variable type determines how you specify
the value for which you are searching. For example:

where score > 50;
where date >= ’01jan2001’d and time >= ’'9:00't;
where state = ’'Texas’;

In a WHERE expression, you cannot use automatic variables created by the DATA
step (for example, FIRST.variable, LAST.variable, _N_, or variables created in
assignment statements).



198

Specifying an Operand A Chapter 12

As in other SAS expressions, the names of numeric variables can stand alone. SAS
treats numeric values of 0 or missing as false; other values are true. For example, the
following WHERE expression returns all values for EMPNUM and ID that are not
missing or that have a value of 0:

where empnum and id;

The names of character variables can also stand alone. SAS selects observations
where the value of the character variable is not blank. For example, the following
WHERE expression returns all values not equal to blank:

where lastname;

SAS Function

A SAS function returns a value from a computation or system manipulation. Most
functions use arguments that you supply, but a few obtain their arguments from the
operating environment. To use a SAS function in a WHERE expression, type its name
and argument(s) enclosed in parentheses. Some functions you may want to specify
include:

o SUBSTR extracts a substring
0 TODAY returns the current date

0 PUT returns a given value using a given format.

The following DATA step produces a SAS data set that contains only observations
from data set CUSTOMER in which the value of NAME begins with Mac and the value
of variable CITY is Charleston or Atlanta:

data testmacs;
set customer;
where substr (name,1,3) = ’'Mac’ and
(city='Charleston’ or city='Atlanta’);

run;

Note: SAS functions used in a WHERE expression that can be optimized by an
index are the SUBSTR function and the TRIM function. 2

For more information on SAS functions, see “Functions and CALL Routines” on page
38.

Constant

A constant is a fixed value such as a number or quoted character string, that is, the
value for which you are searching. A constant is a value of a variable obtained from the
SAS data set, or values created within the WHERE expression itself. Constants are
also called literals. For example, a constant could be a flight number or the name of a
city. A constant can also be a time, date, or datetime value.

The value will be either numeric or character. Note the following rules regarding
whether to use quotation marks:

o If the value is numeric, do not use quotation marks.
where price > 200;

o If the value is character, use quotation marks.
where lastname eq 'Martin’;

0 You can use either single or double quotation marks, but do not mix them. Quoted
values must be exact matches, including case.
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o0 It might be necessary to use single quotation marks when double quotation marks
appear in the value, or use double quotation marks when single quotation marks
appear in the value.

where item = '6" decorative pot’;
where name ? "D’Amico";

0 A SAS date constant must be enclosed in quotation marks. When you specify date
values, case is not important. You can use single or double quotation marks. The
following expressions are equivalent:

where birthday = ’'24sepl975’'d;
where birthday = "24sepl975"d;

Specifying an Operator

Arithmetic Operators

Arithmetic operators allow you to perform a mathematical operation. The arithmetic
operators include the following:

Table 12.1 Arithmetic Operators

Symbol Definition Example

* multiplication where bonus = salary * .10;
/ division where f = g/h;

+ addition where ¢ = a+b;

- subtraction where f = g-h;

wE exponentiation where y = a**2;

Comparison Operators

Comparison operators (also called binary operators) compare a variable with a value
or with another variable. Comparison operators propose a relationship and ask SAS to
determine whether that relationship holds. For example, the following WHERE
expression accesses only those observations that have the value 78753 for the numeric
variable ZIPCODE:

where zipcode eq 78753;

The following table lists the comparison operators:

Tahle 12.2 Comparison Operators

Symbol Mnemonic Definition Example

Equivalent
= EQ equal to where empnum eq 3374;
A=or ~=or-=or NE not equal to where status ne fulltime;
<>
> GT greater than where hiredate gt

'01jun1982'd;



200

Specifying an Operator A Chapter 12

Symbol Mnemonic Definition Example
Equivalent
< LT less than where empnum < 2000;
>= GE greater than or equal to where empnum >= 3374,
<= LE less than or equal to where empnum <= 3374;
IN equal to one from a list of where state in (NC’,'TX);
values

When you do character comparisons, you can use the colon (:) modifier to compare
only a specified prefix of a character string. For example, in the following WHERE
expression, the colon modifier, used after the equal sign, tells SAS to look at only the
first character in the values for variable LASTNAME and to select the observations
with names beginning with the letter s:

where lastname=: ’'S’;

Note that in the SQL procedure, the colon modifier that is used in conjunction with an
operator is not supported; you can use the LIKE operator instead.

IN Operator

The IN operator, which is a comparison operator, searches for character and numeric
values that are equal to one from a list of values. The list of values must be in
parentheses, with each character value in quotation marks and separated by either a
comma or blank.

For example, suppose you want all sites that are in North Carolina or Texas. You
could specify:

where state = 'NC’ or state = 'TX';

However, it is easier to use the IN operator, which selects any state in the list:
where state in (’'NC’,'TX’);

In addition, you can use the NOT logical operator to exclude a list.

where state not in (’CA’, 'TN’', 'MA’);

Fully-Bounded Range Condition

A fully-bounded range condition consists of a variable between two comparison
operators, specifying both an upper and lower limit. For example, the following
expression returns the employee numbers that fall within the range of 500 to 1000
(inclusive):

where 500 <= empnum <= 1000;
Note that the previous range condition expression is equivalent to the following:
where empnum >= 500 and empnum <= 1000;

You can combine the NOT logical operator with a fully-bounded range condition to
select observations that fall outside the range. Note that parentheses are required:

where not (500 <= empnum <= 1000);
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BETWEEN-AND Operator

The BETWEEN-AND operator is also considered a fully-bounded range condition
that selects observations in which the value of a variable falls within an inclusive range
of values.

You can specify the limits of the range as constants or expressions. Any range you
specify is an inclusive range, so that a value equal to one of the limits of the range is
within the range. The general syntax for using BETWEEN-AND is as follows:

WHERE variable BETWEEN value AND value;

For example:

where empnum between 500 and 1000;
where taxes between salary*0.30 and salary*0.50;

You can combine the NOT logical operator with the BETWEEN-AND operator to
select observations that fall outside the range:

where empnum not between 500 and 1000;

Note: The BETWEEN-AND operator and a fully-bounded range condition produce
the same results. That is, the following WHERE expressions are equivalent:

where 500 <= empnum <= 1000;
where empnum between 500 and 1000;

A

CONTAINS Operator

The most common usage of the CONTAINS (?) operator is to select observations by
searching for a specified set of characters within the values of a character variable. The
position of the string within the variable’s values does not matter; however, the
operator is case sensitive when making comparisons.

The following examples select observations having the values Mobay and Brisbayne
for the variable COMPANY, but they do not select observations containing Bayview:

where company contains ’‘bay’;

where company ? ’‘bay’;

You can combine the NOT logical operator with the CONTAINS operator to select
observations that are not included in a specified string:

where company not contains ’‘bay’;

You can also use the CONTAINS operator with two variables, that is, to determine if
one variable is contained in another. When you specify two variables, keep in mind the
possibility of trailing spaces, which can be resolved using the TRIM function.

proc sql;
select *
from tablel as a, table2 as b
where a.fullname contains trim(b.lastname) and
a.fullname contains trim(b.firstname);

In addition, the TRIM function is helpful when you search on a macro variable.

proc print;
where fullname contains trim("&lname");

run;
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IS NULL or IS MISSING Operator

The IS NULL or IS MISSING operator selects observations in which the value of a
variable is missing. The operator selects observations with both regular or special
missing value characters and can be used for both character and numeric variables.

where idnum is missing;
where name is null;

The following are equivalent for character data:

where name is null;
where name = ' ';

And the following is equivalent for numeric data. This statement differentiates missing
values with special missing value characters:

where idnum <= .Z;

You can combine the NOT logical operator with IS NULL or IS MISSING to select
nonmissing values, as follows:

where salary is not missing;

LIKE Operator

The LIKE operator selects observations by comparing the values of a character
variable to a specified pattern, which is referred to as pattern matching. The LIKE
operator is case sensitive. There are two special characters available for specifying a
pattern:

percent sign (%) specifies that any number of characters can occupy that position.

The following WHERE expression selects all employees with a name
that starts with the letter N. The names can be of any length.

where lastname like ’'N%';

underscore (_) matches just one character in the value for each underscore
character. You can specify more than one consecutive underscore
character in a pattern, and you can specify a percent sign and an
underscore in the same pattern. For example, you can use different
forms of the LIKE operator to select character values from this list
of first names:
Diana
Diane
Dianna
Dianthus
Dyan
The following table shows which of these names is selected by using various forms of
the LIKE operator:

Pattern Name Selected
like 'D_an’ Dyan

like 'D_an_’ Diana, Diane
like 'D_an_’ Dianna

like 'D_an%’ all names from list
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You can use a SAS character expression to specify a pattern, but you cannot use a
SAS character expression that uses a SAS function.

You can combine the NOT logical operator with LIKE to select values that do not
have the specified pattern, such as the following:

where frstname not like ’'D_an%’;

Sounds-like Operator

The sounds-like ( =*) operator selects observations that contain a spelling variation
of a specified word or words. The operator uses the Soundex algorithm to compare the
variable value and the operand. For more information, see the SOUNDEX function in
SAS Language Reference: Dictionary.

Note: Note that the SOUNDEX algorithm is English-biased, and is less useful for
languages other than English. A

Although the sounds-like operator is useful, it does not always select all possible
values. For example, consider that you want to select observations from the following
list of names that sound like Smith:

Schmitt
Smith
Smithson
Smitt
Smythe

The following WHERE expression selects all the names from this list except Schmitt
and Smithson:

where lastname=* ’'Smith’;

You can combine the NOT logical operator with the sounds-like operator to select
values that do not contain a spelling variation of a specified word or words, such as:

where lastname not =* ’'Smith’;

Note: The sounds-like operator cannot be optimized with an index. A

SAME-AND Operator

Use the SAME-AND operator to add more conditions to an existing WHERE
expression later in the program without retyping the original conditions. This is useful
with the following:

O interactive SAS procedures

0 full-screen SAS procedures that allow you to type a WHERE expression on the
command line

0 any kind of RUN-group processing.
Use the SAME-AND operator when you already have a WHERE expression defined

and you want to insert additional conditions. The SAME-AND operator has the
following form:

where-expression-1;
... SAS statements...
WHERE SAME AND where-expression-2;
... SAS statements...
WHERE SAME AND where-expression-n;
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SAS selects observations that satisfy the conditions after the SAME-AND operator in
addition to any previously defined conditions. SAS treats all of the existing conditions
as though they were conditions separated by AND operators in a single WHERE
expression.

The following example shows how to use the SAME-AND operator within RUN
groups in the GPLOT procedure. The SAS data set YEARS has three variables and
contains quarterly data for the 1990-1997 period:

proc gplot data=years;
plot unit*quar=year;

run;

where year > ’01janl991'd;

run;
where same and year < ’'01janl996’d;

run;

The following WHERE expression is equivalent to the preceding code:

where year > ’'01janl991’d and year < '01janl996'd;

MIN and MAX Operators

Use the MIN or MAX operators to find the minimum or maximum value of two
quantities. Surround the operators with the two quantities whose minimum or
maximum value you want to know.

0 The MIN operator returns the lower of the two values.
0 The MAX operator returns the higher of two values.

For example, if A is less than B, then the following would return the value of A:
where x = (a min b);

Note: The symbol representation >< is not supported, and <> is interpreted as “not
equal to.” A

Concatenation Operator

The concatenation operator concatenates character values. You indicate the
concatenation operator as follows:

o || (two OR symbols)

o !! (two explanation marks)

o |! (two broken vertical bars).
For example,

where name = ’'John’||’Smith’;

Prefix Operators

The plus sign (+) and minus sign (—) can be either prefix operators or arithmetic
operators. They are prefix operators when they appear at the beginning of an
expression or immediately preceding a left parentheses. A prefix operator is applied to
the variable, constant, SAS function, or parenthetic expression.

where z = —(x + y);

Note: The NOT operator is also considered a prefix operator. A
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Combining Expressions by Using Logical Operators

Syntax

You can combine or modify WHERE expressions by using the logical operators (also
called Boolean operators) AND, OR, and NOT. The basic syntax of a compound WHERE
expression is as follows:

WHERE where-expression-1 logical-operator where-expression-n ;

AND combines two conditions by finding observations that satisfy both
conditions. For example:

where skill eq ’'java’ and years eq 4;

OR combines two conditions by finding observations that satisfy either
condition or both. For example:

where skill eq ’java’ or years eq 4;

NOT modifies a condition by finding the complement of the specified
criteria. You can use the NOT logical operator in combination with
any SAS and WHERE expression operator. And you can combine the
NOT operator with AND and OR. For example:

where skill not eq ’java’ or years not eq 4;

The logical operators and their equivalent symbols are shown in the following table:

Table 12.3 Logical (Boolean) Operators

Symbol Mnemonic Equivalent
& AND

lor | or | OR

A or ~ or - NOT

Processing Compound Expressions

When SAS encounters a compound WHERE expression (multiple conditions), the
software follows rules to determine the order in which to evaluate each expression.
When WHERE expressions are combined, SAS processes the conditions in a specific
order:

1 The NOT expression is processed first.

2 Then the expressions joined by AND are processed.

3 Finally, the expressions joined by OR are processed.

For a complete discussion of the rules for evaluating compound expressions, see
“Order of Evaluation in Compound Expressions” on page 124.

Using Parentheses to Control Order of Evaluation

Even though SAS evaluates logical operators in a specific order, you can control the
order of evaluation by nesting expressions in parentheses. That is, an expression
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enclosed in parentheses is processed before one not enclosed. The expression within the
innermost set of parentheses is processed first, followed by the next deepest, moving
outward until all parentheses have been processed.

For example, suppose you want a list of all the Canadian sites that have both
SAS/GRAPH and SAS/STAT software, so you issue the following expression:

where product='GRAPH’ or product='STAT’ and country=’'Canada’;

The result, however, includes all sites that license SAS/GRAPH software along with
the Canadian sites that license SAS/STAT software. To obtain the correct results, you
can use parentheses, which causes SAS to evaluate the comparisons within the
parentheses first, providing a list of sites with either product licenses, then the result is
used for the remaining condition:

where (product='GRAPH’ or product=’'STAT’) and country=’'Canada’;

Constructing Efficient WHERE Expressions

Indexing a SAS data set can significantly improve the performance of WHERE
processing. An index is an optional file that you can create for SAS data files in order to
provide direct access to specific observations. Processing a WHERE expression without
an index requires SAS to sequentially read every observation to find the ones that
match the selection criteria. Having an index allows the software to determine which
observations satisfy the criteria without having to read all the observations, which is
referred to as optimizing the WHERE expression. However, by default, SAS decides
whether to use the index or read the entire data set sequentially. For details on how
SAS uses an index to process a WHERE expression, see “Using an Index for WHERE
Processing” on page 521.

In addition to creating indexes for the data set, here are some guidelines for writing
efficient WHERE expressions:

Table 12.4 Constructing Efficient WHERE Expressions

Guideline Efficient Inefficient

Avoid using the LIKE operator = where country like ’"A%INA’; where country like "%INA’;
that begins with % or _.

Avoid using arithmetic where salary > 48000; where salary > 12%4000;
expressions.

Use the IN operator instead of where state in (NC’ , 'PA’, where state =NC’ or state =
a compound expression. "VA?); 'PA’ or state = "VA’;

Processing a Segment of Data That Is Conditionally Selected

When you conditionally select a subset of observations with a WHERE expression,
you can also segment that subset by applying FIRSTOBS= and/or OBS= processing
(both as data set options and system options). When used with a WHERE expression,

o FIRSTOBS= specifies the observation number within the subset of data selected

by the WHERE expression to begin processing.

0 OBS= specifies when to stop processing observations from the subset of data
selected by the WHERE expression.
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When used with a WHERE expression, the values specified for OBS= and
FIRSTOBS= are not the physical observation number in the data set, but a logical
number in the subset. For example, obs=3 does not mean the third observation number
in the data set; instead, it means the third observation in the subset of data selected by
the WHERE expression.

Applying OBS= and FIRSTOBS= processing to a subset of data is supported for the
WHERE statement, WHERE= data set option, and WHERE clause in the SQL
procedure.

If you are processing a SAS view that is a view of another view (nested views),
applying OBS= and FIRSTOBS= to a subset of data could produce unexpected results.
For nested views, OBS= and FIRSTOBS= processing is applied to each view, starting
with the root (lowest-level) view, and then filtering observations for each view. The
result could be that no observations meet the subset and segment criteria. See
“Processing a SAS View” on page 207.

Applying FIRSTOBS= and 0BS= to a Subset of Data

The following SAS program illustrates how to specify a condition to subset data, and
how to specify a segment of the subset of data to process.

data A; @
do I=1 to 100;
X=I + 1;
output;
end;

run;

proc print data=work.a (firstobs=2 @ obs=4 @ ;
where I > 90; @

run;

© The DATA step creates a data set named WORK.A containing 100 observations
and two variables: I and X.

@ The WHERE expression I > 90 tells SAS to process only the observations that
meet the specified condition, which results in the subset of observations 91
through 100.

© The FIRSTOBS= data set option tells SAS to begin processing with the 2nd
observation in the subset of data, which is observation 92.

@ The OBS= data set option tells SAS to stop processing when it reaches the 4th
observation in the subset of data, which is observation 94.

The result of PROC PRINT is observations 92, 93, and 94.

Processing a SAS View

The following SAS program creates a data set, a view for the data set, then a second
view that subsets data from the first view. Both a WHERE statement and the OBS=
system option are used.

data a; @
do I=1 to 100;
X=I + 1;

output;
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end;

run;

data viewa/view=viewa; @
set a;
Z = X+1;

run;

data viewb/view=viewb; @
set viewa;
where I > 90;

run;
options obs=3; @

proc print data=work.viewb; @

run;

@ The first DATA step creates a data set named WORK.A, which contains 100
observations and two variables: I and X.

@ The second DATA step creates a view named WORK.VIEWA containing 100
observations and three variables: I, X (from data set WORK.A), and Z (assigned in
this DATA step).

© The third DATA step creates a view named WORK.VIEWB and subsets the data
with a WHERE statement, which results in the view accessing ten observations.

O The OBS= system option applies to the previous SET VIEWA statement, which
tells SAS to stop processing when it reaches the 3rd observation in the subset of
data being processed.

© When SAS processes the PRINT procedure, the following occurs:

1 First, SAS applies obs=3 to WORK.VIEWA, which stops processing at the 3rd
observation.

2 Next, SAS applies the condition I > 90 to the three observations being
processed. None of the observations meet the criteria.

3 PROC PRINT results in no observations.

To prevent the potential of unexpected results, you can specify obs=max when creating
WORK.VIEWA to force SAS to read all the observations in the root (lowest-level) view:

data viewa/view=viewa;
set a (obs=max);
Z = X+1;

run;

The PRINT procedure processes observations 91, 92, and 93.

Deciding Whether to Use a WHERE Expression or a Subsetting IF
Statement

To conditionally select observations from a SAS data set, you can use either a
WHERE expression or a subsetting IF statement. While they both test a condition to
determine if SAS should process an observation, they differ as follows:
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0 The subsetting IF statement can be used only in a DATA step. A subsetting IF

statement tests the condition after an observation is read into the Program Data
Vector (PDV). If the condition is true, SAS continues processing the current
observation. Otherwise, the observation is discarded, and processing continues
with the next observation.

You can use a WHERE expression in both a DATA step and SAS procedures, as
well as in a windowing environment, SCL programs, and as a data set option. A
WHERE expression tests the condition before an observation is read into the PDV.
If the condition is true, the observation is read into the PDV and processed. If the
condition is false, the observation is not read into the PDV, and processing
continues with the next observation, which can yield substantial savings when
observations contain many variables or very long character variables (up to 32K
bytes). Additionally, a WHERE expression can be optimized with an index, and
the WHERE expression allows more operators, such as LIKE and CONTAINS.

Note: Although it is generally more efficient to use a WHERE expression and

avoid the move to the PDV prior to processing, if the data set contains
observations with very few variables, the move to the PDV could be cheap.

However, one variable containing 32K bytes of character data is not cheap, even

though it is only one variable. A

In most cases, you can use either method. However, the following table provides a

list of tasks that require you to use a specific method:

Table 12.5 Tasks Requiring Either WHERE Expression or Subsetting IF Statement

Task Method
Make the selection in a procedure without using a preceding WHERE expression
DATA step

Take advantage of the efficiency available with an indexed data WHERE expression
set

Use one of a group of special operators, such as BETWEEN-AND, WHERE expression
CONTAINS, IS MISSING or IS NULL, LIKE, SAME-AND, and
Sounds-Like

Base the selection on anything other than a variable value that subsetting IF
already exists in a SAS data set. For example, you can select a

value that is read from raw data, or a value that is calculated or

assigned during the course of the DATA step

Make the selection at some point during a DATA step rather subsetting IF
than at the beginning

Execute the selection conditionally subsetting IF
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Definitions for Optimizing System Performance

performance statistics
are measurements of the total input and output operations (I/0), memory, and
CPU time used to process individual DATA or PROC steps. You can obtain these
statistics by using SAS system options that can help you measure your job’s initial
performance and to determine how to improve performance.

system performance
is measured by the overall amount of I/O, memory, and CPU time that your
system uses to process SAS programs. By using the techniques discussed in the
following sections, you can reduce or reallocate your usage of these three critical
resources to improve system performance. While you may not be able to take
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advantage of every technique for every situation, you can choose the ones that are
best suited for a particular situation.

Collecting and Interpreting Performance Statistics

Using the FULLSTIMER and STIMER System Options

The FULLSTIMER and STIMER system options control the printing of performance
statistics in the SAS log. These options produce different results, depending on your
operating environment. See the SAS documentation for your operating environment for
details about the output that SAS generates for these options.

The following output shows an example of the FULLSTIMER output in the SAS log,
as produced in a UNIX operating environment.

Output 13.1  Sample Results of Using the FULLSTIMER Option in a UNIX Operating
Environment

NOTE: DATA statement used:
real time 0.19 seconds
user cpu time 0.06 seconds
system cpu time 0.01 seconds
Memory 460k
Semaphores exclusive 194 shared 9 contended 0
SAS Task context switches 1 splits 0

The STIMER option reports a subset of the FULLSTIMER statistics. The following
output shows an example of the STIMER output in the SAS log in a UNIX operating
environment.

Output 13.2 Sample Results of Using the STIMER Option in a UNIX Operating
Environment

NOTE: DATA statement used:

real time 1.16 seconds
cpu time 0.09 seconds

Operating Environment Information: See the documentation for your operating
environment for information about how STIMER differs from FULLSTIMER in your
operating environment. The information that these options display varies depending on
your operating environment, so statistics that you see might differ from the ones
shown. A

Interpreting FULLSTIMER and STIMER Statistics

Several types of resource usage statistics are reported by the STIMER and
FULLSTIMER options, including real time (elapsed time) and CPU time. Real time
represents the clock time it took to execute a job or step; it is heavily dependent on the
capacity of the system and the current load. As more users share a particular resource,
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less of that resource is available to you. CPU time represents the actual processing time
required by the CPU to execute the job, exclusive of capacity and load factors. If you
must wait longer for a resource, your CPU time will not increase, but your real time
will increase. It is not advisable to use real time as the only criterion for the efficiency
of your program because you cannot always control the capacity and load demands on
your system. A more accurate assessment of system performance is CPU time, which
decreases more predictably as you modify your program to become more efficient.

The statistics reported by FULLSTIMER relate to the three critical computer
resources: /O, memory, and CPU time. Under many circumstances, reducing the use of
any of these three resources usually results in better throughput of a particular job and
a reduction of real time used. However, there are exceptions, as described in the
following sections.

Using Application Response Measurement to Monitor Performance

SAS provides the ability to monitor the performance of your applications using
Application Response Measurement (ARM). ARM enables you to monitor the
availability and performance of transactions within and across diverse applications.
The SAS ARM interface consists of the implementation of the ARM API as ARM
functions and an ARM agent. In addition, SAS supplies ARM macros, which generate
calls to the ARM functions, and new ARM system options, which enable you to manage
the ARM environment and to log internal SAS processing transactions. For
information, see Chapter 15, “Monitoring Performance Using Application Response
Measurement (ARM),” on page 223.

Techniques for Optimizing 1/0

Overview of Techniques for Optimizing 1/0

I/0 is one of the most important factors for optimizing performance. Most SAS jobs
consist of repeated cycles of reading a particular set of data to perform various data
analysis and data manipulation tasks. To improve the performance of a SAS job, you
must reduce the number of times SAS accesses disk or tape devices.

To do this, you can modify your SAS programs to process only the necessary variables
and observations by:

o using WHERE processing

o0 using DROP and KEEP statements

o0 using LENGTH statements

O using the OBS= and FIRSTOBS= data set options.

You can also modify your programs to reduce the number of times it processes the
data internally by:

O creating SAS data sets

O using indexes

O accessing data through views

O using engines efficiently.

You can reduce the number of data accesses by processing more data each time a
device is accessed by

0 setting the BUFNO=, BUFSIZE=, CATCACHE=, and COMPRESS= system options
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O using the SASFILE global statement to open a SAS data set and allocate enough
buffers to hold the entire data set in memory.

Note: Sometimes you may be able to use more than one method, making your SAS
job even more efficient. A

Using WHERE Processing

You might be able to use a WHERE statement in a procedure in order to perform the
same task as a DATA step with a subsetting IF statement. The WHERE statement can
eliminate extra DATA step processing when performing certain analyses because
unneeded observations are not processed.

For example, the following DATA step creates a data set SEATBELT, which contains
only those observations from the AUTO.SURVEY data set for which the value of
SEATBELT is YES. The new data set is then printed.

libname auto ’'/users/autodata’;
data seatbelt;

set auto.survey;

if seatbelt='yes’;

run;

proc print data=seatbelt;

run;

However, you can get the same output from the PROC PRINT step without creating
a data set if you use a WHERE statement in the PRINT procedure, as in the following
example:

proc print data=auto.survey;
where seatbelt='yes’;

run;

The WHERE statement can save resources by eliminating the number of times you
process the data. In this example, you might be able to use less time and memory by
eliminating the DATA step. Also, you use less I/O because there is no intermediate data
set. Note that you cannot use a WHERE statement in a DATA step that reads raw data.

The extent of savings that you can achieve depends on many factors, including the
size of the data set. It is recommended that you test your programs to determine which
is the most efficient solution. See “Deciding Whether to Use a WHERE Expression or a
Subsetting IF Statement” on page 208 for more information.

Using DROP and KEEP Statements

Another way to improve efficiency is to use DROP and KEEP statements to reduce
the size of your observations. When you create a temporary data set and include only
the variables that you need, you can reduce the number of I/O operations that are
required to process the data. See SAS Language Reference: Dictionary for more
information on the DROP and KEEP statements.

Using LENGTH Statements

You can also use LENGTH statements to reduce the size of your observations. When
you include only the necessary storage space for each variable, you can reduce the
number of I/O operations that are required to process the data. Before you change the
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length of a numeric variable, however, see “Specifying Variable Lengths” on page 219.
See SAS Language Reference: Dictionary for more information on the LENGTH
statement.

Using the 0BS= and FIRSTOBS= Data Set Options

You can also use the OBS= and FIRSTOBS= data set options to reduce the number of
observations processed. When you create a temporary data set and include only the
necessary observations, you can reduce the number of I/O operations that are required
to process the data. See SAS Language Reference: Dictionary for more information on
the OBS= and FIRSTOBS= data set options.

Creating SAS Data Sets

If you process the same raw data repeatedly, it is usually more efficient to create a
SAS data set. SAS can process SAS data sets more efficiently than it can process raw
data files.

Another consideration involves whether you are using data sets created with
previous releases of SAS. If you frequently process data sets created with previous
releases, it is sometimes more efficient to convert that data set to a new one by creating
it in the most recent version of SAS. See Chapter 35, “SAS 9.1 Compatibility with SAS
Files From Earlier Releases,” on page 581 for more information.

Using Indexes

An index is an optional file that you can create for a SAS data file to provide direct
access to specific observations. The index stores values in ascending value order for a
specific variable or variables and includes information as to the location of those values
within observations in the data file. In other words, an index allows you to locate an
observation by the value of the indexed variable.

Without an index, SAS accesses observations sequentially in the order in which they
are stored in the data file. With an index, SAS accesses the observation directly.
Therefore, by creating and using an index, you can access an observation faster.

In general, SAS can use an index to improve performance in these situations:

o For WHERE processing, an index can provide faster and more efficient access to a
subset of data.

0 For BY processing, an index returns observations in the index order, which is in
ascending value order, without using the SORT procedure.

0 For the SET and MODIFY statements, the KEY= option allows you to specify an
index in a DATA step to retrieve particular observations in a data file.

Note: An index exists to improve performance. However, an index conserves some
resources at the expense of others. Therefore, you must consider costs associated with
creating, using, and maintaining an index. See “Understanding SAS Indexes” on page
512 for more information about indexes and deciding whether to create one. A

Accessing Data Through Views

You can use the SQL procedure or a DATA step to create views of your data. A view
is a stored set of instructions that subsets your data with fewer statements. Also, you
can use a view to group data from several data sets without creating a new one, saving
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both processing time and disk space. See Chapter 29, “SAS Data Views,” on page 535
and the Base SAS Procedures Guide for more details.

Using Engines Efficiently

If you do not specify an engine on a LIBNAME statement, SAS must perform extra
processing steps in order to determine which engine to associate with the data library.
SAS must look at all of the files in the directory until it has enough information to
determine which engine to use. For example, the following statement is efficient
because it explicitly tells SAS to use a specific engine for the libref FRUITS:

/* Engine specified. */

libname fruits v9 ’/users/myid/mydir’;

The following statement does not explicitly specify an engine. In the output, notice the
NOTE about mixed engine types that is generated:

/* Engine not specified. */
libname fruits ’/users/myid/mydir’;

Output 13.3 Output From the LIBNAME Statement

Directory for library FRUITS contains files of mixed engine types.
Libref FRUITS was successfully assigned as follows:

Engine: V9
Physical Name: /users/myid/mydir

Operating Environment Information: In the z/OS operating environment, you do not
need to specify an engine for certain types of libraries. A

See Chapter 37, “SAS Engines,” on page 595 for more information about SAS engines.

Setting the BUFNO=, BUFSIZE=, CATCACHE=, and COMPRESS= System
Options

The following SAS system options can help you reduce the number of disk accesses
that are needed for SAS files, though they might increase memory usage.

BUFNO=
SAS uses the BUFNO= option to adjust the number of open page buffers when it
processes a SAS data set. Increasing this option’s value can improve your
application’s performance by allowing SAS to read more data with fewer passes;
however, your memory usage increases. Experiment with different values for this
option to determine the optimal value for your needs.

Note: You can also use the CBUFNO= system option to control the number of
extra page buffers to allocate for each open SAS catalog. A

See system options in SAS Language Reference: Dictionary and the SAS
documentation for your operating environment for more details on this option.

BUFSIZE=
When the Base SAS engine creates a data set, it uses the BUFSIZE= option to set
the permanent page size for the data set. The page size is the amount of data that
can be transferred for an I/O operation to one buffer. The default value for
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BUFSIZE= is determined by your operating environment. Note that the default is
set to optimize the sequential access method. To improve performance for direct
(random) access, you should change the value for BUFSIZE=.

Whether you use your operating environment’s default value or specify a value,
the engine always writes complete pages regardless of how full or empty those
pages are.

If you know that the total amount of data is going to be small, you can set a
small page size with the BUFSIZE= option, so that the total data set size remains
small and you minimize the amount of wasted space on a page. In contrast, if you
know that you are going to have many observations in a data set, you should
optimize BUFSIZE= so that as little overhead as possible is needed. Note that
each page requires some additional overhead.

Large data sets that are accessed sequentially benefit from larger page sizes
because sequential access reduces the number of system calls that are required to
read the data set. Note that because observations cannot span pages, typically
there is unused space on a page.

“Calculating Data Set Size” on page 219 discusses how to estimate data set size.

See system options in SAS Language Reference: Dictionary and the SAS
documentation for your operating environment for more details on this option.

CATCACHE=
SAS uses this option to determine the number of SAS catalogs to keep open at one
time. Increasing its value can use more memory, although this may be warranted
if your application uses catalogs that will be needed relatively soon by other
applications. (The catalogs closed by the first application are cached and can be
accessed more efficiently by subsequent applications.)

See system options in SAS Language Reference: Dictionary and the SAS

documentation for your operating environment for more details on this option.

COMPRESS=
One further technique that can reduce I/O processing is to store your data as
compressed data sets by using the COMPRESS= data set option. However, storing
your data this way means that more CPU time is needed to decompress the
observations as they are made available to SAS. But if your concern is I/O, and not
CPU usage, compressing your data may improve the I/O performance of your
application.

See SAS Language Reference: Dictionary for more details on this option.

Using the SASFILE Statement

The SASFILE global statement opens a SAS data set and allocates enough buffers to
hold the entire data set in memory. Once it is read, data is held in memory, available to
subsequent DATA and PROC steps, until either a second SASFILE statement closes the
file and frees the buffers or the program ends, which automatically closes the file and
frees the buffers.

Using the SASFILE statement can improve performance by

0 reducing multiple open/close operations (including allocation and freeing of

memory for buffers) to process a SAS data set to one open/close operation

0 reducing I/O processing by holding the data in memory.

If your SAS program consists of steps that read a SAS data set multiple times and
you have an adequate amount of memory so that the entire file can be held in real
memory, the program should benefit from using the SASFILE statement. Also,
SASFILE is especially useful as part of a program that starts a SAS server such as a
SAS/SHARE server. See SAS Language Reference: Dictionary for more information on
the SASFILE global statement.
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Techniques for Optimizing Memory Usage

If memory is a critical resource, several techniques can reduce your dependence on
increased memory. However, most of them also increase I/O processing or CPU usage.

However, by increasing memory available to SAS by increasing the value of the
MEMSIZE= system option (or by using the MEMLEAVE= option, in some operating
environments), you can decrease processing time because the amount of time that is
spent on paging, or reading pages of data into memory, is reduced. The SORTSIZE=
and SUMSIZE= system options enable you to limit the amount of memory that is
available to sorting and summarization procedures.

You can also make tradeoffs between memory and other resources, as discussed in
“Reducing CPU Time by Using More Memory or Reducing I/O” on page 218. To make
the most of the I/O subsystem, you must use more and larger buffers. However, these
buffers share space with the other memory demands of your SAS session.

Operating Environment Information: The MEMSIZE= system option is not available
in some operating environments. If MEMSIZE= is available in your operating
environment, it might not increase memory. See the documentation for your operating
environment for more information. 2

Techniques for Optimizing CPU Performance

Reducing CPU Time by Using More Memory or Reducing 1/0

Executing a single stream of code takes approximately the same amount of CPU time
each time that code is executed. Optimizing CPU performance in these instances is
usually a tradeoff. For example, you might be able to reduce CPU time by using more
memory, because more information can be read and stored in one operation, but less
memory is available to other processes.

Also, because the CPU performs all the processing that is needed to perform an I/O
operation, an option or technique that reduces the number of I/0 operations can also
have a positive effect on CPU usage.

Storing a Compiled Program for Computation-Intensive DATA Steps

Another technique that can improve CPU performance is to store a DATA step that is
executed repeatedly as a compiled program rather than as SAS statements. This is
especially true for large DATA step jobs that are not I/O-intensive. For more
information on storing compiled DATA steps, see Chapter 30, “Stored Compiled DATA
Step Programs,” on page 545.

Reducing Search Time for SAS Executable Files

The PATH= system option specifies the list of directories (or libraries, in some
operating environments) that contain SAS executable files. Your default configuration
file specifies a certain order for these directories. You can rearrange the directory
specifications in the PATH= option so that the most commonly accessed directories are
listed first. Place the least commonly accessed directories last.
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Operating Environment Information: The PATH= system option is not available in
some operating environments. See the documentation for your operating environment
for more information. A

Specifying Variable Lengths

When SAS processes the program data vector, it typically moves the data in one
large operation rather than by individual variables. When data is properly aligned (in
8-byte boundaries), data movement can occur in as little as 2 clock cycles (a single load
followed by a single store). SAS moves unaligned data by more complex means, at worst,
a single byte at a time. This would be at least eight times slower for an 8-byte variable.

Many high performance RISC (Reduced Instruction Set Computer) processors pay a
very large performance penalty for movement of unaligned data. When possible, leave
numeric data at full width (eight bytes). Note that SAS must widen short numeric data
for any arithmetic operation. On the other hand, short numeric data can save both
memory and I/O. You must determine which method is most advantageous for your
operating environment and situation.

Note: Alignment can be especially important when you process a data set by
selecting only specific variables or when you use WHERE processing. A

Using Parallel Processing

SAS System 9 supports a new wave of SAS functionality related to parallel
processing. Parallel processing means that processing is handled by multiple CPUs
simultaneously. This technology takes advantage of SMP machines and provides
performance gains for two types of SAS processes: threaded I/0 and threaded
application processing.

For information, see Chapter 14, “Support for Parallel Processing,” on page 221.

Calculating Data Set Size

If you have already applied optimization techniques but still experience lengthy
processing times or excessive memory usage, the size of your data sets might be very
large, in which case, further improvement might not be possible.

You can estimate the size of a data set by creating a dummy data set that contains the
same variables as your data set. Run the CONTENTS procedure, which shows the size
of each observation. Multiply the size by the number of observations in your data set to
obtain the total number of bytes that must be processed. You can compare processing
statistics with smaller data sets to determine if the performance of the large data sets
is in proportion to their size. If not, further optimization might still be possible.

Note: When you use this technique to calculate the size of a data set, you obtain
only an estimate. Internal requirements, such as the storage of variable names, might
cause the actual data set size to be slightly different. A
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Definition of Parallel Processing

SAS 9 supports a new wave of SAS functionality related to parallel processing.
Parallel processing refers to processing that is handled by multiple CPUs
simultaneously. This technology takes advantage of hardware that has multiple CPUs,
called SMP machines, and provides performance gains for two types of SAS processes:

0 threaded I/O
0 threaded application processing.

SMP machines have multiple CPUs and an operating environment that can spawn
and manage multiple pieces of executable code called threads. A thread is a single,
independent flow of control through a program or within a process. Threading takes
advantage of multiple CPUs by dividing processing among the available CPUs. A
thread-enabled operating environment provides support for threads; for example, each
thread needs a context (like a register set and a program counter), a segment of code to
execute, and a piece of memory to use in the process.

Even if your site does not use an SMP machine, SAS 9 can still provide increased
performance. Some types of threading can be performed using a single CPU.

Threaded

1/0

Some applications can process data faster than the data can be delivered to the
application. When an application cannot keep the available CPUs busy, the application
is said to be I/0O-bound.

SAS supports threaded I/O for SAS applications by providing the SAS Scalable
Performance Data (SPD) engine. The SPD engine boosts the performance of SAS
applications that are I/O bound through parallel processing of partitioned data sets.
Partitioned data sets can span disk drives but still be referenced as a single data set. In
this way, the SPD engine can read many millions of observations into SAS applications
very rapidly by spawning a thread for each data partition and evaluating WHERE
expressions in multiple CPUs. SAS 9.1 support for multiple CPUs, for example on a
Symmetric Multiprocessor (SMP) machine, and support for multiple disks per CPU
make SPD engine’s parallel I/O possible. See SAS Scalable Performance Data Engine:
Reference for full details on this engine’s capabilities.
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The benefits of support for multiple disks in SAS 9.1 is not limited to use by the SPD
engine. Multiple disks can be on an SMP machine, but they can also be a bank of disks
on a single-CPU machine. Increasing the number of disks that can be accessed
simultaneously increases the amount of data that can be delivered to an application.
This is because reading or writing data to and from disk takes much more time than
the associated CPU processing that directs the I/0. Even a single-CPU machine can
support multiple disk drives, which boosts performance. When an SMP machine is
used, the performance gain can be quite significant because each CPU can support
multiple disk drives. However, multiple CPUs cannot speed up I/O from a single disk
drive. The minimum configuration for I/O performance gain is at least one controller
per CPU and at least two disk drives for each controller. For example, a site with four
CPUs should have at least four controllers and eight disk drives.

Threaded

Application Processing

Some applications receive data faster than they can perform the necessary processing
on that data. These applications are sometimes referred to as CPU-bound. For
CPU-bound applications, the solution is to increase processing power. Support for SMP
machines provides access to threaded processing for CPU-bound applications. Even if
your application is not currently CPU-bound, if you increase the amount of data that can
be delivered to an application, you will naturally increase the need for faster processing
of that data. Modifying your application to process data in threads solves this problem.

For SAS 9, certain procedures such as SORT and SUMMARY have been modified so
that they can thread the processing through multiple CPUs, if they are available.

In addition, threaded processing is being integrated into a variety of other SAS features
in order to improve performance. For example, when you create an index, if sorting is
required, SAS attempts to sort the data using the thread-enabled sort.

Some types of processing are not suited to threading, while other types of processing
can benefit greatly. For example, sorting can be performed in multiple threads by
dividing the sorting process into separately executable sorting processes. One or more of
these threads can process data in each CPU. The sorted data from each thread is then
joined together and written to the output data set. Sorting can be performed in threads,
but the join process and the output process are nonthreadable processes. Even with
applications that are highly-threadable processes, simply providing additional disks and
CPUs might not improve performance. That is, a particular algorithm can benefit by
using four CPUs but cannot benefit an equal amount by adding four more CPUs.

For SAS procedures that are thread-enabled, new SAS system options are introduced
with SAS 9:

CPUCOUNT=
specifies how many CPUs can be used.

THREAD | NOTHREADS
controls whether to use threads.

For documentation on the SAS system options, see SAS Language Reference:
Dictionary. In addition, the documentation for each thread-enabled procedure provides
more information. See Base SAS Procedures Guide.
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Introduction to ARM

What Is ARM?

Application Response Measurement (ARM) enables you to monitor the availability
and performance of transactions within and across diverse applications.

Why Is ARM Needed?

There are many techniques for measuring response times, but only ARM measures
them accurately. Other approaches, although useful in other ways, can only measure
business service levels by making assumptions or guesses about what is a business
transaction, and when it begins and ends. Also, other approaches cannot provide
important information that ARM can, such as whether a transaction completed
successfully.

Using ARM, you can log transaction records from an application in order to

0 determine the application response times

0 determine the workload/throughput of your applications
o verify that service level objectives are being met

0 determine why the application is not available
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verify who is using an application

determine why a user is having poor response time

determine what queries are being issued by an application
determine the subcomponents of an application’s response time
determine which servers are being used

O 0O o o o g

calculate the load time for data warehouses.

Definitions for ARM

application
a computer program that processes data for a specific use such as for payroll,
inventory, and billing. It is the program for which you want to monitor
performance.

Application Response Measurement (ARM) API
an application programming interface that is used to implement software in order
to monitor the availability and performance of transactions within and across
diverse applications. The API is an open, vendor-neutral approach to monitor the
performance of distributed and client/server applications. The ARM API consists
of definitions for a standard set of function calls that are callable from an
application. The ARM API was jointly developed by the industry partnership
Computer Measurement Group, Inc. (CMG).

ARM agent
a software vendor’s implementation of the ARM API. Each ARM agent is a set of
executable routines that can be called by applications. The ARM agent runs
concurrently with SAS. The SAS application passes transaction information to the
agent, which collects the ARM transaction records and writes them to the ARM log.

ARM log
an external file that contains records of ARM transactions.

ARM macros
a group of SAS macros that provide user control for identifying transactions that
you want to log. You insert the macro calls into your SAS program at strategic
points; the macros generate calls to the ARM API function calls.

ARM system options
a group of SAS system options that control various aspects of the SAS ARM
interface.

ARM subsystem
a group of internal SAS processing transactions such as PROC and DATA step
processing and file input/output processing. You use the ARM system option
ARMSUBSYS= to turn on a subsystem or all subsystems.

SAS ARM interface
an interface that can be used to monitor the performance of SAS applications. In
the SAS ARM interface, the ARM API is implemented as an ARM agent. In
addition, SAS supplies ARM macros, which generate calls to the ARM API
function calls, and ARM system options, which enable you to manage the ARM
environment and to log internal SAS processing transactions.

transaction
a unit of work that is meaningful for monitoring an application’s performance. A
transaction can be started and stopped one or more times within a single
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execution of an application. For example, in a SAS application, a transaction could
be a step that updates a customer database. In SAS/MDDB Server software, a
transaction might be a query on a subcube. Another type of transaction might be
internal SAS processing that you want to monitor.

How Does ARM Work?

The ARM API is an application programming interface that a vendor, such as SAS,
can implement in order to monitor the availability and performance of transactions in
distributed or client/server applications. The ARM API consists of definitions for a
standard set of function calls that are callable from an application.

SAS implemented the ARM API as an ARM agent. In addition, SAS supplies ARM
macros, which generate calls to the ARM API function calls, and ARM SAS system
options, which manage the ARM environment and enable you to log internal SAS
processing transactions.

You must determine the transactions within your application that you want to
measure.

o To log internal SAS processing transactions, simply use the ARM system option
ARMSUBSYS= in order to turn on the transactions that you want to log.

0 To log transactions that you want to identify, insert ARM macros into the
application’s code.

You insert ARM macros at strategic points in the application’s code so that the
desired transaction response time and other statistics that you want are collected. The
ARM macros generate calls to the ARM API function calls that are contained on the
executable module that contains the ARM agent. The module accepts the function call
parameters, performs error checking, and passes the ARM data to the agent to
calculate the statistics and to log the records to an ARM log.

Typically, an ARM API function call occurs just before a transaction is initiated in
order to signify the beginning of the transaction. Then, an associated ARM API
function call occurs in the application where the transaction is known to be complete.
Basically, the application calls the ARM agent before a transaction starts and then
again after it ends, allowing those transactions to be measured and monitored.

The transaction’s response time and additional statistics are then routed to the ARM
agent, which then logs the information to the ARM log. The ARM API function calls
typically log the data to a file. The time between these ARM API function calls provides
an approximate response time measurement.

Will ARM Affect an Application’s Performance?

ARM is designed to be a high-speed interface that has minimal impact on
applications. An ARM agent is designed to quickly extract the information that is
needed and return control to the application immediately. Processing of the information
is done in a different process that can run when the system is otherwise idle.
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Using the ARM Interface

Overview

The SAS ARM interface provides the ability to monitor the performance of SAS
applications. The interface consists of the implementation of the ARM API as an ARM
agent. In addition, SAS supplies ARM macros, which generate calls to the ARM API
function calls; and ARM system options, which manage the ARM environment and also
enable you to log internal SAS processing transactions.

ARM System Options

SAS provides ARM system options, which are SAS system options that manage the
ARM environment and provide the ability to log internal SAS processing transactions,
such as file opening and closing and DATA step and PROC step response time.

The following ARM SAS system options are available:

ARMAGENT=
specifies another vendor’s ARM agent, which is an executable module that
contains a vendor’s implementation of the ARM API. By default, SAS uses the
SAS ARM agent.

ARMLOC=
specifies the location of the ARM log.

ARMSUBSYS=
initializes the SAS ARM subsystems, which determine the internal SAS processing
transactions to be monitored. Each subsystem is a group of internal SAS
processing transactions.
You can specify the ARM SAS system options
O in a configuration file so that they are set automatically when you invoke SAS
0 on the command line when you invoke SAS

O using the global OPTIONS statement either in the SAS program or in an autoexec
file

O from the System Options window.

See SAS system options in SAS Language Reference: Dictionary for details on each
ARM system option.

See “Logging Internal SAS Processing Transactions” on page 229 for an example that
sets the ARM system options.

ARM API Function Calls

The ARM API function calls are contained in the SAS ARM agent. Note that for the
SAS implementation, you do not explicitly insert ARM API function calls in a SAS
application; you insert ARM macros, which generate calls to the ARM API function calls.

These are the six ARM API function calls:

ARM_INIT
names the application and optionally the users of the application and initializes
the ARM environment for the application.
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ARM_GETID
names a transaction.

ARM_START
signals the start of a unique transaction.

ARM_UPDATE
provides information (optional) about the progress of a transaction.

ARM_STOP
signals the end of a transaction.

ARM_END
terminates the ARM environment and signals the end of an application.

ARM calls use numeric identifiers (IDs) to uniquely identify the ARM objects that are
input and output from the ARM API function calls. The three classes of IDs are

O application IDs

O transaction class IDs

O start handles (start time) for each instance of a transaction.

IDs are numeric, assigned integers. The agent usually assigns IDs. The scheme for

assigning IDs varies from one vendor’s agent to another, but, at a minimum, a unique
ID within a single session is guaranteed. Some agents allow you to preassign IDs.

ARM Macros

The ARM macros provide an efficient method for you to identify which transactions
in a SAS application you want to log. You insert the ARM macro calls in the SAS
program code, which in turn generate calls to the ARM API function calls in order to
log transaction information. The ARM macros automatically manage the returned IDs
from the ARM API function calls.

The following table shows the relationship between the ARM API function calls and
the ARM macros:

Table 15.1 Relationship Between ARM API Function Calls and ARM Macros

ARM API Function Calls ARM Macro
ARM_INIT %ARMINIT

ARM_GETID %ARMGTID
ARM_START %ARMSTRT
ARM_UPDATE %ARMUPDT
ARM_STOP %ARMSTOP
ARM_END %ARMEND

The following ARM macros are available:

%ARMINIT
generates a call to ARM_INIT, which names the application and optionally the
users of the application and initializes the ARM environment for the application.
Typically, you would insert this macro in your code once.
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%ARMGTID
generates a call to ARM_GETID, which names a transaction. Use %ARMGTID for
each unique transaction in order to describe the type of transactions to be logged.
A %2ARMGTID is typically coded for each transaction class in an application.

%ARMSTRT
generates a call to ARM_START, which signals the start of an instance of a
transaction. Insert %ARMSTRT before each transaction that you want to log.
Whereas %2ARMGTID defines a transaction class, %ARMSTRT indicates that a
transaction is executing.

%ARMUPDT
is an optional macro that generates a call to ARM_UPDATE, which provides
additional information about the progress of a transaction. Insert %ARMUPDT
between %ARMSTRT and %ARMSTOP in order to supply information about the
transaction that is in progress.

%ARMSTOP
generates a call to ARM_STOP, which signals the end of a transaction instance.
Insert %ARMSTOP where the transaction is known to be complete.

%ARMEND
generates a call to ARM_END, which terminates the ARM environment and
signals that the application will not make any more ARM calls.

The following post-processing ARM macros are also available. These macros are
specific to the SAS ARM implementation; they are not part of the ARM API standard.

%ARMCONV
converts an ARM log created in SAS 9 or later, which uses a comma delimited
format, into the ARM log format used in Release 8.2.

%ARMPROC
processes the ARM log and writes six SAS data sets that contain the information
from the log.

%ARMJOIN
processes the six SAS data sets that are created by %ARMPROC and creates data
sets that contain common information about applications and transactions.

For more information, see SAS ARM macros in SAS Language Reference: Dictionary.
See “Using ARM System Options and ARM Macros to Log Performance Statistics” on
page 231 for an example of inserting ARM macros in SAS code.

Logging the Transaction Records: the ARM Log

The SAS ARM agent supplies a basic logger that captures response time and CPU
time statistics and handles logging the information. By default, the logger runs in the
same session as your application and logs all ARM data synchronously to the external
file that is specified with the ARMLOC= SAS system option.

All information that is passed by the application during ARM calls is written to the
log, as well as other calculated statistics.

All ARM records are routed to the file to which the fileref points. Note that in
Release 8.2, the ARM records were either written to the SAS log or to a specified
external file. For SAS 9 or later, all ARM records are written to an external file. To
specify the external output file, use the ARMLOC= SAS system option.

For SAS 9 or later, the format of the log records is comma delimited, which consists
of columns of data separated by commas. The format of the ARM log that is written to
by the logger was designed to be easily readable. The date/time stamp and the call
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identifier always appear in the same column location. Subsequent information appears
as a name=value pair.
Here is a sample of an ARM log:

Output 15.1 ARM Log (SAS 9 or Later Format)

1,1320332339.838000,1,2.814046,5.988611,SAS,XXXXXX
G,1320332339.858000,1, l,MVA_DSI0.0PEN_CLOSE,DATA SET OPEN/CLOSE,LIBNAME,
ShortStr,MEMTYPE, ShortStr,MEMNAME, LongStr
S,1320332347.549000,1,1,1,2.914190,6.669590,WORK ,DATA , ONE
S,1320332348.390000,1,1,2,2.934219,6.729676,WORK ,DATA , TWO
P,1320332348.410000,1,1,1,2.954248,6.729676,0,WORK ,DATA , ONE
P,1320332348.420000,1,1,2,2.964262,6.729676,0,WORK ,DATA , TWO
S,1320332348.490000,1,1,3,2.994305,6.739691,WORK ,DATA , THREE
P,1320332348.530000,1,1,3,3.14334,6.749705,0,WORK ,DATA , THREE
S,1320332359.216000,1,1,4,3.224636,7.661016,WORK ,DATA , THREE
P,1320332360.948000,1,1,4,3.254680,7.851289,0,WORK ,DATA , THREE
S,1320332362.170000,1,1,5,3.304752,7.951433,WORK ,DATA , THREE
P,1320332367.358000,1,1,5,3.334795,8.51577,0,WORK ,DATA , THREE
S,1320332367.388000,1,1,6,3.354824,8.61592,WORK ,DATA , THREE
P,1320332367.398000,1,1,6,3.364838,8.61592,0,WORK ,DATA , THREE
S,1320332367.428000,1,1,7,3.384867,8.71606,WORK ,DATA , ONE
S,1320332367.438000,1,1,8,3.394881,8.71606,WORK ,DATA , TWO
P,1320332372.655000,1,1,8,3.424924,8.131692,0,WORK ,DATA , TWO
P,1320332372.665000,1,1,7,3.424924,8.141707,0,WORK ,DATA , ONE
S,1320332375.970000,1,1,9,3.454968,8.392067,WORK ,DATA , THREE
P,1320332377.282000,1,1,9,3.515054,8.562312,0,WORK ,DATA , THREE
S$,1320332377.302000,1,1,10,3.525068,8.572326,WORK ,DATA , THREE
P,1320332377.923000,1,1,10,3.575140,8.632412,0,WORK ,DATA , THREE
S$,1320332377.953000,1,1,11,3.585155,8.652441,WORK ,DATA , THREE
P,1320332383.521000,1,1,11,3.655256,8.832700,0,WORK ,DATA , THREE
S,1320332389.89000,1,1,12,3.715342,8.912816,WORK ,DATA , THREE
S$,1320332389.159000,1,1,13,3.725356,8.922830,SASUSER ,DATA , THREE
P,1320332391.182000,1,1,12,3.765414,9.32988,0,WORK ,DATA , THREE
P,1320332391.192000,1,1,13,3.775428,9.32988,0,SASUSER ,DATA , THREE
E,1320336057.253000,1,4.105904,10.194659

To convert the SAS 9 or later log format into the Release 8.2 format, use the SAS
macro %ARMCONV. For example, you might want to convert SAS 9 or later format to
the Release 8.2 format if you have an application that analyzes the output in Release
8.2 format.

Note: The record layout is described in the ARMSUBSYS= SAS system option in
SAS Language Reference: Dictionary. A

Examples

of Gathering Performance Data

Logging Internal SAS Processing Transactions

This example illustrates how to collect transaction statistics on internal SAS
processing. For this example, only file input/output information is logged.

The only additional code that is added to the SAS program is the OPTIONS
statement, which specifies the name of the ARM log output file and the ARMSUBSYS=
system option, which specifies the specific SAS subsystem ARM_DSIO.

The following SAS program does the following:

1 Creates three SAS data sets: WORK.ONE, WORK.TWO, and WORK.THREE.
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Builds an index for the variable A in WORK.THREE.

Prints two reports that are subsets of WORK.THREE.

Appends WORK.ONE to WORK.TWO.

Uses PROC SQL to modify WORK.THREE.

Prints the contents of WORK.THREE.

Copies all three WORK data sets to the permanent library SASUSER.

N o g AR ON

options armloc='myarmlog.txt’ armsubsys=(ARM DSIO OPENCLOSE);

data work.one work.two;
input a $ b;

datalines;

11

2 2

33

r

data work.three;
do a =1 to 200;

b = a;

c = a;

output;
end;

run;

proc datasets library=work;
modify three;
index create a;

run;

quit;

proc print data=work.three;
where a <= 101;

run;

proc print data=work.three;
where a <= 10;

run;

proc append data=work.one base=work.two;

run;

proc sql;
delete from work.three where a > 100;

run;

update work.three set a = 75 where a > 75;
run;

quit;

proc contents data=work.three;

run;
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proc copy in=work out=sasuser;
select three;

run;

Here is the resulting ARM log:

Output 15.2 ARM Log

1,1320332339.838000,1,2.814046,5.988611,SAS,XXXXXX
G,1320332339.858000,1, l,MVA_DSI0.0PEN_CLOSE,DATA SET OPEN/CLOSE,LIBNAME,
ShortStr,MEMTYPE, ShortStr,MEMNAME, LongStr
S,1320332347.549000,1,1,1,2.914190,6.669590,WORK ,DATA , ONE
S,1320332348.390000,1,1,2,2.934219,6.729676,WORK ,DATA , TWO
P,1320332348.410000,1,1,1,2.954248,6.729676,0,WORK ,DATA , ONE
P,1320332348.420000,1,1,2,2.964262,6.729676,0,WORK ,DATA , TWO
S,1320332348.490000,1,1,3,2.994305,6.739691,WORK ,DATA , THREE
P,1320332348.530000,1,1,3,3.14334,6.749705,0,WORK ,DATA , THREE
S,1320332359.216000,1,1,4,3.224636,7.661016,WORK ,DATA , THREE
P,1320332360.948000,1,1,4,3.254680,7.851289,0,WORK ,DATA , THREE
S,1320332362.170000,1,1,5,3.304752,7.951433,WORK ,DATA , THREE
P,1320332367.358000,1,1,5,3.334795,8.51577,0,WORK ,DATA , THREE
S,1320332367.388000,1,1,6,3.354824,8.61592,WORK ,DATA , THREE
P,1320332367.398000,1,1,6,3.364838,8.61592,0,WORK ,DATA , THREE
S,1320332367.428000,1,1,7,3.384867,8.71606,WORK ,DATA , ONE
S,1320332367.438000,1,1,8,3.394881,8.71606,WORK ,DATA , TWO
P,1320332372.655000,1,1,8,3.424924,8.131692,0,WORK ,DATA , TWO
P,1320332372.665000,1,1,7,3.424924,8.141707,0,WORK ,DATA , ONE
S,1320332375.970000,1,1,9,3.454968,8.392067,WORK ,DATA , THREE
P,1320332377.282000,1,1,9,3.515054,8.562312,0,WORK ,DATA , THREE
S$,1320332377.302000,1,1,10,3.525068,8.572326,WORK ,DATA , THREE
P,1320332377.923000,1,1,10,3.575140,8.632412,0,WORK ,DATA , THREE
S$,1320332377.953000,1,1,11,3.585155,8.652441,WORK ,DATA , THREE
P,1320332383.521000,1,1,11,3.655256,8.832700,0,WORK ,DATA , THREE
S,1320332389.89000,1,1,12,3.715342,8.912816,WORK ,DATA , THREE
S,1320332389.159000,1,1,13,3.725356,8.922830,SASUSER ,DATA , THREE
P,1320332391.182000,1,1,12,3.765414,9.32988,0,WORK ,DATA , THREE
P,1320332391.192000,1,1,13,3.775428,9.32988,0,SASUSER ,DATA , THREE
E,1320336057.253000,1,4.105904,10.194659

Using ARM System Options and ARM Macros to Log Performance
Statistics

This example uses the ARM system options as well as the ARM macros.

/* set up ARM environment with ARM system options */
options

armagent=sasarmmg

armsubsys=arm_all

armloc=mylog;

filename mylog ’C:\MyDocuments\myfiles\ARMlog.txt';

/* enable ARM macros */

%let _armexec=1;

/* initialize work datasets */
data workl work2 work3;
do I =1 to 100;
output;
end;
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run;

%arminit (APPNAME='Sample ARM’,APPUSER='Arm UserID'’ , MACONLY=YES);
%armgtid (TXNNAME='Sample 1’,MACONLY=YES);
/* armgtid and armstrt can be combined */
%armstrt (LEVEL=1,MACONLY=YES) ;
/* Step 1 */
data one;
set workl;
run;
$armstop (MACONLY=YES) ;
%armgtid (TXNNAME='Sample 2’ ,MACONLY=YES);
%armstrt (LEVEL=1,MACONLY=YES) ;
/* Step 2 */
data two;
set work2;
run;
%armstop (MACONLY=YES) ;
$armgtid (TXNNAME='Sample 3’ ,MACONLY=YES);
%armstrt (LEVEL=1,MACONLY=YES) ;
/* Step 3 */
data three;
set work3;
run;
%armstop (MACONLY=YES) ;
$armend (MACONLY=YES) ;

run;

Post Processing an ARM Log

The following code uses the post-processing ARM macros in order to convert the
ARM log into SAS data sets.

garmproc;
%armjoin;

run;

/* redirect output to text file */
proc printto print='F:\arm\armlogs\USWest2ARM.log’;

run;

proc print data=updtview;
title "Results of ARM calls";
sum deltelap deltcpu noncpu;
by txname;
sumby txname;

run;

/* redirect proc output to normal queue */
proc printto print=print;

run;
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Introduction to the SAS Registry

What Is the SAS Registry?

The SAS registry is the central storage area for configuration data for SAS. For
example, the registry stores

O the libraries and file shortcuts that SAS assigns at startup

0 the menu definitions for Explorer pop-up menus

O the printers that are defined for use

O configuration data for various SAS products.
This configuration data is stored in a hierarchical form, which works in a similar
manner to the way directory-based file structures work under the operating

environments in UNIX, Windows, VMS and under the z/OS UNIX System Services
(USS).

Who Should Use the SAS Registry?

The SAS registry is designed for use by system administrators and experienced SAS
users. This section provides an overview of registry tools, and describes how to import
and export portions of the registry.

CAUTION:
If you make a mistake when you edit the registry, your system might hecome unstable or
unusable. »

Wherever possible, use the administrative tools, such as the New Library window,
the PRTDEF procedure, Universal Print windows, and the Explorer Options window, to
make configuration changes, rather than editing the registry directly. Using the
administrative tools ensures that values are stored properly in the registry when you
change the configuration.

CAUTION:
If you use the Registry Editor to change values, you will not be warned if any entry is
incorrect. Incorrect entries can cause errors, and can even prevent you from starting
a SAS session. A

Where the SAS Registry Is Stored

Registry Files in the SASUSER and the SASHELP Libraries

Although the SAS registry is logically one data store, physically it consists of two
different files located in both the SASUSER and SASHELP libraries. The physical
filename for the registry is regstry.sas7bitm. By default, these registry files are hidden
in the SAS Explorer views of the SASHELP and SASUSER libraries.

0 The SASHELP library registry file contains the site defaults. The system

administrator usually configures the printers that a site uses, the global file

shortcuts or libraries that will be assigned at startup, and any other configuration
defaults for your site.
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0 The SASUSER library registry file contains the user defaults. When you change

your configuration information through a specialized window such as the Print
Setup window or the Explorer Options window, the settings are stored in the
SASUSER library.

How to Restore the Site Defaults

If you want to restore the original site defaults to your SAS session, delete the
regstry.sas7bitm file from your SASUSER library and restart your SAS session.

How Do | Display the SAS Registry?

You can use one of the following three methods to view the SAS registry:
O Issue the REGEDIT command. This opens the SAS Registry Editor
0 Select Solutions » Accessories » Registry Editor

0 Submit the following line of code:

proc registry list;

This method prints the registry to the SAS log, and it produces a large list that
contains all registry entries, including subkeys. Because of the large size, it might
take a few minutes to display the registry using this method.

For more information about how to view the SAS registry, see “The REGISTRY
Procedure” in Base SAS Procedures Guide.

Definitions for the SAS Registry

The SAS registry uses keys and subkeys as the basis for its structure, instead of using
directories and subdirectories like the file systems in DOS or UNIX. These terms and
several others described here are frequently used when discussing the SAS Registry:

key

An entry in the registry file that refers to a particular aspect of SAS.
Each entry in the registry file consists of a key name, followed on
the next line by one or more values. Key names are entered on a
single line between square brackets ([ and ]).

The key can be a place holder without values or subkeys
associated with it, or it can have many subkeys with associated
values. Subkeys are delimited with a backslash (\). The length of a
single key name or a sequence of key names cannot exceed 255
characters (including the square brackets and the backslash). Key
names can contain any character except the backslash and are not
case-sensitive.

The SAS Registry contains only one top-level key, called
SAS_REGISTRY. All the keys under SAS_REGISTRY are subkeys.
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subkey A key inside another key. Subkeys are delimited with a backslash
(\). Subkey names are not case-sensitive. The following key
contains one root key and two subkeys:

[SAS_REGISTRY\HKEY USER_ROOT\CORE]

SAS_REGISTRY
is the root key.

HKEY_USER_ROOT
is a subkey of SAS_REGISTRY. In the SAS registry, there is
one other subkey at this level it is HKEY_SYSTEM_ROOT.

CORE
is a subkey of HKEY_USER_ROOT, containing many default
attributes for printers, windowing and so on.

link a value whose contents reference a key. Links are designed for
internal SAS use only. These values always begin with the word
“link:”.

value the names and content associated with a key or subkey. There are

two components to a value, the value name and the value content,
also known as a value datum.

Display 16.1 Section of the Registry Editor Showing Value Names and Value Data for
the Subkey "HTML’

Contents of 'HTRL'

Marme Data
ab coco "0271E"
oococol  D2731E

.SASXREG file a text file with the file extension .SASXREG that contains the text
representation of the actual binary SAS Registry file.

Managing the SAS Registry

Primary Concerns about Managing the SAS Registry

CAUTION:
If you make a mistake when you edit the registry, your system might hecome unstable or
unusable. Whenever possible, use the administrative tools, such as the New Library
window, the PRTDEF procedure, Universal Print windows, and the Explorer Options
window, to make configuration changes, rather than editing the registry. This is to
insure values are stored properly in the registry when changing the configuration. »

CAUTION:
If you use the Registry Editor to change values, you will not be warned if any entry is
incorrect. Incorrect entries can cause errors, and can even prevent you from starting
a SAS session. A
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Backing Up the SASUSER Registry

Why Back Up the SASUSER Registry?

The SASUSER* part of the registry contains personal settings. It is a good idea to
back up the SASUSER part of the registry if you have made substantial customizations
to your SAS session. Substantial customizations include the following:

O installing new printers

0 modifying printer settings from the default printer settings that your system
administrator provides for you

O changing localization settings
O altering translation tables with TRANTAB.

When SAS Resets to the Default Settings

When SAS starts up, it automatically scans the registry file. SAS restores the
registry to its original settings under two conditions:

o If SAS detects that the registry is corrupt, then SAS rebuilds the file.

o0 If you delete the registry file called regstry.sas7bitm, which is located in the
SASUSER library, then SAS will restore the SASUSER registry to its default

settings.

CAUTION:
Do not delete the registry file that is located in SASHELP; this will prevent SAS from
starting. ~

Ways to Back Up the Registry
There are two methods for backing up the registry and each achieves different results:

Method 1: Save a copy of the SASUSER registry file called regstry.sas7bitm.
The result is an exact copy of the registry at the moment you copied it. If you need
to use that copy of the registry to restore a broken copy of the registry, then any
changes to the registry after the copy date are lost. However, it is probably better
to have this backup file than to revert to the original default registry.

Method 2: Use the Registry Editor or PROC REGISTRY to back up the parts of the

SASUSER registry that have changed.
The result is a concatenated copy of the registry, which can be restored from the
backup file. When you create the backup file using the EXPORT= statement in
PROC REGISTRY, or by using the Export Registry File utility in the Registry
Editor, SAS saves any portions of the registry that have been changed. When SAS
restores this backup file to the registry, the backup file is concatenated with the
current registry in the following way:

O Any completely new keys, subkeys or values that were added to the
SASUSER registry after the back up date are retained in the new registry.

* The SASHELP part of the registry contains settings that are common to all users at your site. SASHELP is write protected,
and can only be updated by a system administrator.



238 Recovering from Registry Failure A Chapter 16

O Any existing keys, subkeys or values that were changed after SAS was
initially installed, then changed again after the back up, are overwritten and
revert to the back up file values after the restore.

O Any existing keys, subkeys or values that retain the original default values,
will have the default values after the restore.

Using the Explorer to Back Up the SAS Registry
To use the Explorer to back up the SAS Registry:

1

2
3
4
5

Start SAS Explorer with the EXPLORER command, or select View » Explorer
Select Tools » Options » Explorer. The Explorer Options window appears.
Select the Members tab

Select ITEMSTOR in the Type list.

Click [Unhide].

If ITEMSTOR does not have an icon associated with it in the Type list, you will be
prompted to select an icon.

6 Open the Sasuser library in the Explorer window.
7 Right-click the Regstry.Itemstor file.
8 Select copy from the pop-up menu and copy the Regstry file. SAS will name the

file Regstry_copy.

Note: You can also use a copy command from your operating environment to
make a copy of your registry file for back up purposes. When viewed from outside
SAS Explorer, the file name is regstry.sas7bitm. Under z/OS, you cannot use
the environment copy command to copy your registry file unless your SASUSER
library is assigned to an HFS directory. A

Using the Registry Editor to Back Up the SAS Registry

Using the Registry Editor to back up the SAS registry is generally the preferred
backup method, because it retains any new keys or values in case you must restore the
registry from the backup.

To use the Registry Editor to back up the SAS Registry:

1
2
3

5

Open the Registry Editor with the regedit command.
Select the top-level key in the left pane of the registry window.

From the Registry Editor, select File » Export Registry File. A Save As window
appears.

Type a name for your registry backup file in the filename field. (SAS will apply the
proper file extension name for your operating system.)

Click .

This saves the registry backup file in SASUSER. You can control the location of your
registry backup file by specifying a different location in the Save As window.

Recovering from Registry Failure

This section gives instructions for restoring the registry with a back up file, and
shows you how to repair a corrupt registry file.

To install the registry backup file that was created using SAS Explorer or an
operating system copy command:

1

Change the name of your corrupt registry file to something else.
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2 Rename your backup file to regstry.sas7bitm, which is the name of your registry
file.

3 Copy your renamed registry file to the SASUSER location where your previous
registry file was located.

4 Restart your SAS session.

To restore a registry backup file created with the Registry Editor:
Open the Registry Editor with the regedit command.

Select File » Import Registry File

Select the registry file that you previously exported.

Click [Open].

Restart SAS.

To restore a registry backup file created with PROC REGISTRY:

1 Open the Program editor and submit the following program to import the registry
file that you created previously.

gl AW N =

proc registry import=<registry file specification>;

run;

This imports the registry file to the SASUSER library.

2 If the file is not already properly named, then use Explorer to rename the registry
file to regstry.sas7bitm:

3 Restart SAS.
To attempt to repair a damaged registry

1 Rename the damaged registry file to something other than “regstry”; for example,
temp.

2 Start your SAS session.
3 Define a library pointing to where the temp registry is

libname here ’.’
4 Run the REGISTRY procedure and redefine the SASUSER registry:

proc registry setsasuser="here.temp";

run;

5 Start the Registry Editor with the regedit command. Select Solutions »
Accessories » Registry Editor » View All

6 Edit any damaged fields under the HKEY_USER_ROOT key.

7 Close your SAS session and rename the modified registry back to the original
name.

8 Open a new SAS session to see if the changes fixed the problem.

Using the SAS Registry to Control Color

The SAS registry contains the RGB values for color names that are common to most
web browsers. These colors can be used for ODS and GRAPH output. The RGB value is
a triplet (Red, Green, Blue) with each component having a range of 00 to FF (0 to 255).
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The registry values for color are located in the COLORNAMES\HTML subkey. You
can create your own new color values by adding them to the registry in the
COLORNAMES\HTML subkey, using the Registry Editor:

1 Open the SAS Registry Editor using the REGEDIT command.
Select the COLORNAMES\HTML subkey.
Select Edit » New Binary Value. A pop-up menu appears.

& LW

Type the color name in the value Name field and the RGB value in the value
Data field.

5 Click .

Using the Registry Editor

When to Use the Registry Editor

The best way to view the contents of the registry is using the Registry Editor. The
Registry Editor is a graphical alternative to PROC REGISTRY, an experienced SAS
user might use the Registry Editor to do the following:

O View the contents of the registry, which shows keys and values stored in keys.
0 Add, modify, and delete keys and values stored in the registry.

o0 Import registry files into the registry, starting at any key.

0 Export the contents of the registry to a file, starting at any key.

0 Uninstall a registry file.

o Compare a registry file to the SAS registry.

Many of the windows in the SAS windowing environment update the registry for you
when you make changes to such items as your printer setting or your color preferences.
Because these windows update the registry using the correct syntax and semantics, it is
often best to use these alternatives when making adjustments to SAS.

Starting the Registry Editor

To run the Registry Editor, issue the regedit command on a SAS command line.
You can also open the registry window by selecting Solutions » Accessories »
Registry Editor

Finding Specific Data in the Registry

In the Registry Editor window, double-click a folder icon that contains a registry key.
This displays the contents of that key.
Another way to find things is to use the Find utility.

1 From the Registry Editor, select Edit » Find

2 Type all or part of the text string that you want to find, and click options to
specify whether you want to find a key name, a value name, or data.

3 Click .
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Display 16.2 The Registry Editor Find Utility
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Changing a Value in the SAS Registry

CAUTION:
Before modifying registry values, always back up the regstry.sas7hbitm file from SASUSER.
A

1 In the left pane of the Registry Editor window, click the key that you want to
change. The values contained in the key appear in the right pane.

2 Double-click the value. The Registry Editor displays several types of windows,
depending on the type of value you are changing.

Display 16.3 Example Window for Changing a Value in the SAS Registry
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Adding a New Value or Key to the SAS Registry

1 In the SAS Registry Editor, right-click the key that you want to add the value to.

2 From the pop-up menu, select the New menu item with the type that you want to
create.

3 Enter the values for the new key or value in the window that is displayed.

Display 16.4 Registry Editor with Pop-up Menu for Adding New Keys and Values
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Deleting an Item from the SAS Registry

From the SAS Registry Editor:
1 Right-click the item that you want to delete.
2 Select Delete from the pop-up menu and confirm the deletion.

Renaming an Item in the SAS Registry

From the SAS Registry Editor:
1 Right-click the item you want to rename.

2 Select Rename from the context menu and enter the new name.

Displaying the SASUSER and SASHELP Registry Items Separately

After you open the Registry Editor, you can change your view from the default, which
shows the registry contents without regard to the storage location. The other registry
view displays both SASUSER and SASHELP items in separate trees in the Registry
Editor’s left pane.

1 Select TOOLS » Options » Registry Editor. This opens the Select Registry

View group box.
2 Select view All to display the SASUSER and SASHELP items separately in the
Registry Editor’s left pane.

0 The SASHELRP portion of the registry will be listed under the
HKEY_SYSTEM_ROOT folder in the left pane.
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0 The SASUSER portion of the registry will be listed under the
HKEY_USER_ROOT folder in the left pane.

Display 16.5 The Registry Editor in View Overlay Mode
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Importing a Registry File

You usually import a registry file, or SASXREG file when you are restoring a back-up
registry file. A registry file can contain a complete registry or just part of a registry.
To import a registry file using the SAS Registry Editor:

1 Select File » Import Registry File
2 In the Open window, select the SASXREG file to import.

Note: In order to first create the back-up registry file, you can use the REGISTRY
Procedure or the Export Registry File menu choice in the Registry Editor. A

Exporting or Save a Registry File

You usually export a registry file or SASXREG file, when you are preparing a
back-up registry file. You can export a complete registry or just part of a registry.
To export a registry file using the SAS Registry Editor:
1 In the left hand pane of the Registry Editor, select the key you want to export to a
SASXREG file. To export the entire registry, select the top key.
2 Select File » Export Registry File

3 In the Save As window, give the export file a name.

4 Click .

When to Use PROC REGISTRY

Use PROC REGISTRY to modify the registry using a SAS program. PROC
REGISTRY has basically the same functionality as the Registry Editor in a

noninteractive mode. For detailed information about PROC REGISTRY, see Base SAS
Procedures Guide.
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Configuring Your Registry

Configuring Universal Printing

Universal Printers should be configured by using either the PRTDEF procedure or
the Print Setup window. The REGISTRY procedure can to used to back up a printer
definition and to restore a printer definition from a SASXREG file. Any other direct
modification of the registry values should only be done under the guidance of SAS
Technical Support.

Configuring SAS Explorer

While it is best to use the Explorer Options window to configure your Explorer
settings, you can use the Registry Editor to view the current Explorer settings in the
SAS registry. The Explorer Options Window is available from the TOOLS » Options »
Explorer drop-down menu from within the Explorer. All the Explorer configuration
data is stored in the registry under CORE\Explorer. The following table outlines the
location of the most commonly used Explorer configuration data.

Registry Key What portion of the Explorer it configures

CORE\EXPLORER\CONFIGURATION the portions of the Explorer get initialized at
startup.

CORE\EXPLORER\MENUS the context menus that get displayed in the
Explorer.

CORE\EXPLORER\KEYEVENTS the valid key events for the 3270 interface. This
key is only used on the mainframe platforms.

CORE\EXPLORER\ICONS Which icons to display in the Explorer. If the

icon value is %-1, this causes the icon to be
hidden in the Explorer.

CORE\EXPLORER\NEWS This subkey controls what types of objects are
available from the File » New menu in the
Explorer.

Configuring Libraries and File Shortcuts with the SAS Registry

When you use the New Library window or the File Shortcut Assignment window to
create a library reference (libref) or a file reference (fileref), these references are stored
for future use when you click the Enable at Startup check box in either of these two
windows.

Library references (librefs) and file references (filerefs) are saved when you check
“Enable at startup” and they are stored in the SAS registry, where it is possible to
modify or delete them, as follows:

Deleting an “Enable at Startup” library reference
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You can use the Registry Editor to delete an “Enable at Startup” library reference
by deleting the corresponding key under CORE\OPTIONS\LIBNAMES\”your
libref.” However, it is best to delete your library reference by using the SAS
Explorer, which removes this key from the registry when you delete the library
reference.

Deleting an “Enable at Startup” file shortcut
You can use the Registry Editor to delete an “Enable at Startup” file shortcut by
deleting the corresponding key under CORE\OPTIONS\FILEREFS\“your fileref.”
However, it is best to delete your library reference by using the SAS Explorer,
which removes this key automatically when you delete the file shortcut.

Creating an “Enable at Startup” File Shortcut as a site default
A site administrator might want to create a file shortcut which is available to all
users at a site. To do this, you first create a version of the file shortcut definition
in the SASUSER registry, then modify it so that it can be used in the SASHELP
registry.
Note: You need special permission to write to the SASHELP part of the SAS
registry. A
1 Type the DMFILEASSIGN command. This opens the File Shortcut Assignment
window.
Create the file shortcut that you want to use.
Check Enable at Startup.
Click [OK].

Type the command REGEDIT after verifying that the file shortcut was created
successfully.

Find and select the key CORE\OPTIONS\FILEREFS\<your fileref>.
Select File » Export Registry File and export the file.

8 Edit the exported file and replace all instances of HKEY_USER_ROOT with
HKEY_SYSTEM_ROOT.

9 To apply your changes to the site’s SASHELP, use PROC REGISTRY. The
following code will import the file:

g B 0N

~N o

proc registry import="yourfile.sasxreg" usesashelp;

run;

Creating an “Enable at Startup” Library as a site default
A site administrator might want to create a library which is available to all users
at a site. To do this, the SASUSER version of the library definition needs to be
migrated to SASHELP.

Note: You need special permission to write to the SASHELP part of the SAS
registry. A

1 Type the dmlibassign command. This opens the New Library window.
Create the library reference that you want to use.
Select Enable at Startup.
Click [OK].

Issue the regedit command after verifying that the library was created
successfully.

Find and select the registry key CORE\OPTIONS\LIBNAMES\ <your libref>.
Select File » Export Registry File. The Save As window appears.

g B N

Select a location to store your registry file.

O 0 N o

Enter a file name for your registry file in the File name field.
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10 Click to export the file.
11 Right-click the file and select Edit in Notepad to edit the file.

12 Edit the exported file and replace all instances of “HKEY_USER_ROOT” with
“HKEY_SYSTEM_ROOT.”

13 To apply your changes to the site’s SASHELP use PROC REGISTRY. The
following code will import the file:

proc registry import="yourfile.sasxreg" usesashelp;

run;

Fixing Library Reference (Libref) Problems with the SAS Registry

Library references (librefs) are stored in the SAS Registry. You may encounter a
situation where a libref that previously worked, fails. In some situations, editing the
registry is the fastest way to fix the problem. The following section describes what is
involved in repairing a missing or failed libref.

If any permanent libref that is stored in the SAS Registry fails at startup, then the
following note appears in the SAS Log:

NOTE: One or more library startup assignments were not restored.
The following errors are common causes of library assignment problems:
0 Required field values for libref assignment in the SAS Registry are missing

O Required field values for libref assignment in the SAS Registry are invalid. For
example, library names are limited to eight characters, and engine values must
match actual engine names.

O encrypted password data for a libref has changed in the SAS Registry.

Note: You can also use the New Library window to add and delete librefs. You can
open this window by typing LIBASSIGN in the toolbar, or selecting File » New from
the Explorer window. A

CAUTION:
You can correct many libref assignment errors in the SAS Registry Editor. If you are
unfamiliar with librefs or the SAS Registry Editor, then ask for technical support.
Errors can be made easily in the SAS Registry Editor, and can prevent your libraries
from being assigned at startup. A

To correct a libref assignment error using the SAS Registry Editor:

1 Select Solutions » Accessories » Registry Editor or issue the regedit command
to open the Registry Editor.

2 Select one of the following paths, depending on your operating environment, and
then make modifications to keys and key values as needed:

CORE\OPTIONS\LIBNAMES
or

CORE\OPTIONS\LIBNAMES\CONCATENATED

For example, if you determine that a key for a permanent, concatenated library has
been renamed to something other than a positive whole number, then you can rename
that key again so that it is in compliance. Select the key, and then select Rename from
the pop-up menu to begin the process.
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Introduction to Universal Printing

What Is Universal Printing?

Universal Printing is a printing system that provides both interactive and batch
printing capabilities to SAS applications and procedures on all the operating
environments that are supported by SAS.

When Universal Printing is ON, SAS routes all printing through Universal Printing
services. All Universal Printing features are controlled by system options, thereby
enabling you to control many print features even in batch mode.

Note: Prior to the introduction of Universal Printing, SAS supported a utility for
print jobs known as Forms. Forms printing is still available if you select File » Print
from the menu, then check the Use Forms check box. This turns off Universal Printing
menus and functionality. For more information, see “Forms Printing” on page 275. A

Turning Universal Printing On and Off

Universal Printing is available on all operating environments that SAS supports. By
default, Universal Printing is turned ON on all operating environments except Windows.
The UNIVERSALPRINT system option (alias UPRINT) must be set for Universal
Printing to be ON and used by SAS. This option can be set only in the SAS configuration

file or at startup. You cannot turn Universal Printing menus on or off after startup.

Note: When you use the PRINTERPATH option to specify a printer, the print job is
controlled by Universal Printing. A

Operating Environment Information: In the Windows operating environment, you
must set an additional system option, UPRINTMENUSWITCH, in order to access the
Universal Printing user interface. You must also set UPRINTMENUSWITCH, in order
to configure all menus in SAS to use the Universal Printing windows. To do this, include

-uprint -uprintmenuswitch

in the string that you use to invoke SAS under Windows. 2

What Type of Print Output Formats Are Available from Universal
Printing?

In addition to sending print jobs to a printer, you can also direct output to external
files that are widely recognized by different types of printers and print viewing software

programs. You can use Universal Printing to produce the following commonly
recognized file types:
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Table 17.1 Available Print Qutput Formats
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Type Full Name Description
PCL Printer Control Developed by Hewlett-Packard as a language that applications
Language use to control a wide range of printer features across a number of
printing devices. Universal Printing currently supports PCL5,
PCL5e and PCL5c levels of the language.
PDF Portable A file format developed by Adobe Systems for viewing and
Document printing a formatted document. To view a file in PDF format, you
Format need Adobe Acrobat Reader, a free application distributed by
Adobe Systems.
Optimized  Optimized A compressed PDF file format developed by Adobe Systems.
PDF Portable
Document
Format
PS Postscript A page description language also developed by Adobe Systems.

PostScript is primarily a language for printing documents on laser
printers, but it can be adapted to produce images on other types of
devices.

Universal Printing and 0DS

The ODS PRINTER destination uses Universal Printing whether the
UNIVERSALPRINT option is on or off. The PRINTER destinations used by the ODS
PRINTER statement are described in SAS Output Delivery System: User’s Guide.

The Output Delivery System (ODS) uses Universal Printing for the following ODS

statements:

Tahle 17.2 ODS Destinations that make use of the Universal Printing interface

ODS PRINTER Destination

Description

PRINTER= option
ODS PDF statement

ODS PS statement

ODS PCL statement

uses the selected printer
uses Universal Printing’s PDF printer

uses Universal Printing’s Postscript Level 1
printer

uses Universal Printing’s PCL5 printer

Operating Environment Information:

PRINTER destination will use the Windows system printers unless SAS was started
with the UNIVERSALPRINT option, or when you specify a printer with the

PRINTERPATH option. If Universal Printing is enabled in Windows, SAS will override
the use of the Windows system printer and cause ODS to use Universal Printing. A

For more information on ODS, see SAS Output Delivery System: User’s Guide.

In the Windows operating environment, the ODS
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Managing Printing Tasks with the Universal Printing User Interface

Overview of the Universal Printing Menu

You can open most Universal Printing windows by entering commands at the
command line or into the command box in the menu bar. The following table lists the
commands that you use to do the most common tasks.

Table 17.3 Commands to Open Universal Printing Windows

To do this... Use this command

Print the current window DMPRINT

Change the default printer DMPRINT, or DMPRINTSETUP
Create a new printer or previewer definition DMPRTCREATE PRINTER, or

DMPRTCREATE PREVIEWER
Modify, add, remove or test printer definitions DMPRINTSETUP

Show default printer properties sheet DMPRINTPROPS
Show page properties sheet DMPAGESETUP
Print preview the current window DMPRTPREVIEW

The SAS Universal Printing windows are also accessible from the File menu.
The following display shows the File menu containing the Universal Printing choices
of Page Setup, Print Setup, Print Preview and Print.

Display 17.1 File Menu Displaying Universal Printing Options
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Edit %iew Tools Solutions ‘Window Help
[ Hew o e SR Beo DB 09 |
@ Oper.. Ciil-0r
= !IHI!
Deez b1 by SAS Institute Inc., Cary, NC, USA. |
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[ New Program ting on the WIN_NT platform.
Open Program
& save Ci+S By
Save As B.12 seconds
45 Save As Object .54 seconds
4 Import Deta.. DCLOC not supported. Use file: or http:
%, Export Data...
FPage Setup...
Print Setup. . =
(8, Print Praview | H 4

Sew @
=1 Send Mail —

1 Cihsasuserikovtsas

2 G \Programinetscape.exe
3 Chsasuser\proccontents.sas
4 Chsasuserioption define.sas

Exit

L, of
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Table 17.4 Menu choices or commands open Universal Printing windows

Menu Choice Equivalent command
Page Setup DMPAGESETUP

Print Setup DMPRINTSETUP
Print Preview DMPRTPREVIEW
Print DMPRINT

Operating Environment Information: In the Windows operating environment, SAS
uses the Windows print windows as the default. To access the Universal Printing user
interface, UPRINTMENUSWITCH must also be set along with the UNIVERSALPRINT
option to configure all menus in SAS to use the Universal Printing windows. To do this,
include

-uprint -uprintmenuswitch

in the string that you use to invoke SAS in Windows. A

Setting Up Printers

Print Setup Window

The DMPRTSETUP command opens the Print Setup window, where you can
O change the default printer

O remove a printer from the selection list

O print a test page

O open the Printer Properties window

o launch the New Printer wizard.

Changing the Default Printer
To change the default printer device for this SAS session and future SAS sessions,
1 Issue the DMPRTSETUP command. The Print Setup window appears.

2 Select the new default device from the list of printers in the Printer field.

3 Click .

Removing a Printer from the Selection List

To remove a printer from the selection list, follow these steps.
1 Issue the DMPRTSETUP command. The Print Setup window appears.
2 Select the printer you want to delete from the list of printers in the Printer field

3 Click

Note: Only your system administrator can remove printers that the administrator
has defined for your site. If you select a printer that was defined by your system
administrator, the button will be unavailable. A
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Defining a New Printer

While Universal Printing provides you with predefined printers, you can also add
your own printers with the Define a New Printer wizard, which guides you step-by-step
through the process of installing a printer.

To start the New Printer wizard and define a new printer:

1 Issue the command DMPRTCREATE PRINTER. The following window appears.

Display 17.2 Printer Definition Window to Enter Name and Description

-*Define a new printer: Step 1 of 5

Alternatively, you can issue the DMPRTSETUP command and click [New].
2 Enter the name and a description for the new printer (127 character maximum, no
backslashes).

3 Click to proceed to Step 2. Select a printer model. If your exact printer
model is not available, select a more general model that is compatible with your
printer. For example, for the HP LaserdJet printer series, select PCL5.

Note: More general models might provide fewer options than the more specific
models. A
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Display 17.3 Printer Definition Window to Select Printer Model

Brother HL 1060 PS5
Brother HL 1270M FS
Brother HL 1650 PS5
Brother HL 1660e PS5
Brother HL 1670M FS
Brother HL 2060 PS

Brather HL 2400C PS
Brother HL 2460 P5
Brather HL 3400CH PS
Canon C LEBFP 360 PS5
Canon C LEBF 460 PS5

4 Click to proceed to Step 3. The following window appears:

Display 17.4 Printer Definition Window to Select Output Device

‘#*Define a new printer: Step 3 of 5
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5 Select the Device type for your print output. The device type selections are
host-dependent.

If you select catalog, Disk, Ftp, Socket, or Pipe as the device type, then you
must specify a destination.

If you select a device type of Printer, then a destination might not be required,
because some operating environments use the Host options box to route output.

Note: Examples for your operating system of Device Type, Destination and
Host options are also provided in “Sample Values for the Device Type, Destination
and Host Options Fields” on page 273 A

6 Enter the Destination for your file. The destination is the target location for
your device type. For example, if your device type is disk, then your destination
would be an operating environment-specific file name. With some system device
types, the destination might be blank and you can specify the target location using
the Host options box.

7 Select or enter any host-specific options for the device that you chose. This field
might be optional for your operating environment. For a list of host options, refer
to the FILENAME statement information for your operating environment.

Note: The Destination and Host Options lists can also be populated using
PROC REGISTRY. Click the Help button in step 3 to refer to the “Populating
Destination and Host Option Lists” topic, which contains more details. A

8 Click to proceed to Step 4, in which you select from a list of installed print
previewers. If no previewers are defined, proceed to the next step.

Display 17.5 Printer Definition Window to Select Previewer

‘#*Define a new printer: Step 4 of 5

If the previewer selection box appears, select the previewer for this printer. If
you do not need a previewer, choose None or leave the field blank.

Note: You can add a previewer to any printer through the DMPRTPROPS,
Advanced Tab, Previewer box. See “Defining a New Previewer” on page 262. A
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Note: It is not required that printers and print previewers share a common
language. A

9 Click to proceed to Step 5. The following window appears:

Display 17.6 Printer Definition Window to Complete Process

‘*Define a new printer: Step 5 of 5

10 Click to change any information. Click when you have completed
your printer definition.

You have now finished setting your default printer.
After you have returned to the Print Setup window, you can test your default printer

by clicking [Print Test Page|.

Setting Printer Properties for Your Default Printer

Printer properties that you can change include

O the printer name and description

O

the printer destination device and its properties
O the default font for the printer

o0 advanced features such as translation tables, printer resolution and the print
previewer associated with the printer.

To change printer properties for your default printer:
1 Issue the DMPRTPROPS command. The Printer Properties window appears.

2 From the Printer Properties window, select the tab that contains the information
that you need to modify.

0 In the Name tab, you can modify the printer name and the printer description.
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Display 17.7 Printer Properties Window Displaying Name Tab

Z; Printer Properties

FostScrpt Level 1 |

Genenc PostScript Lewel 1

0 The pestination tab enables you to designate the device type, destination, and
host options for the printer. See “Sample Values for the Device Type,
Destination and Host Options Fields” on page 273 for examples.
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Display 17.8 Printer Properties Window Displaying Destination Tab

Z: Printer Properties

ET

N

0 The Font tab controls the available font options. The selections available in the
drop-down boxes are printer specific. The font size is in points.
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Display 17.9 Printer Properties Window Displaying Font Tab

Z: Printer Properties x|

MHame | Degtination | F-:unt] Advanced ]

Font;

Style: I Regular

Wwieight: I Marmal

Size: I'I 2.00

L Led Lo Lo

Character zet: I'W'estern

g | Eancell Help |

O The Advanced tab lists the Resolution, Protocol, Translate table, Buffer size,
Previewer, and Preview command options for the printer. The information in
the drop-down fields is printer specific.
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Display 17.10 Printer Properties Window Displaying Advanced Tab

Z: Printer Properties X

Mame | Desgtination | Font .-'-‘-.dvanc:ed]

Reszolutior: a00 DRl

Pratocol: I Default j
Tranzlate table: I Mare j
Buffer size: |

Frewviewer: I Mo j
Presview n:-:ummanl:l:l j

]S | Eancell Help |

Resolution

specifies the resolution for the printed output in dots per inch (dpi).

Protocol
provides the mechanism for converting the output to a format that can be
processed by a protocol converter that connects the EBCDIC host
mainframe to an ASCII device. Protocol is required in the z/OS operating
environment, and if you must use one of the protocol converters that are
listed.

Translate table
manages the transfer of data between an EBCDIC host and an ASCII
device. Normally, the driver selects the correct table for your locale; the
translate table needs to be specified only when you require nonstandard
translation.

Buffer size
controls the size of the output buffer or record length. If the buffer size is
left blank, a default size will be used.

Previewer
specifies the Previewer definition to use when Print Preview is requested.
The Previewer box contains the previewer application that you have
defined. See “Defining a New Previewer” on page 262.

Preview command
is the command that will be used to open an external printer language
viewer. For example, if you want Ghostview as your previewer, type
ghostview %s. When a Preview Command is entered into a Printer
definition, the printer definition becomes a previewer definition.
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Note: The Previewer and Preview Command fields are mutually exclusive.
When you enter a command path into the Preview Command field, the Previewer
box will dim. A

How to Specify a Printer for Your Session

The PRINTERPATH option enables you to specify a printer to use for the current SAS
session. This printer specification is not retained across SAS sessions. PRINTERPATH
is primarily used in batch mode, when there is no windowing environment in which to
set the default printer. This option accepts a character string as its value, for example:

options printerpath="myprinter";

options printerpath="Print PostScript to disk";

You can get a list of valid character strings from two places:

O the list of printers in the Printer field of the Print Setup window.

O the list of defined printers in the registry under
SAS_REGISTRY\\CORE\\PRINTING\ \PRINTERS

You can also override the printer destination by specifying a fileref with the
PRINTERPATH-= option:

options printerpath= (myprinter printout);
filename printout ...;

Printing with Universal Printing

Printing a Test Page
To print a test page:
1 Issue the DMPRTSETUP command to open the Print Setup window.

2 Select the printer for which you would like a test page from Printer listview.

3 Click [Print Test Page].
Printing the Contents of an Active SAS Window

To print the contents of a window in SAS:
1 Click inside the window to make it active.

2 Select File » Print. A print window appears. Your print window might differ from
the window that follows.
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Display 17.11 Print Window

AiFages L
I *

= Erint Selected Text

3 Ifthe use Forms check box is visible, clear it in order to use Universal Printing.
4 From the Printer group box, select the name of the printer definition.
5 Enter the number of copies that you want.
6 If you want to save your print job to a file,
a Select Print to File.

b Select [OK]; the File Selection window appears.
¢ Select an existing file or enter a new filename.

Note: If you print to an already existing file, the contents of the file may be
overwritten or appended, depending on whether you choose replace or append
from the print window that is open. 2

~

Set additional printing options.

The fields in the Page Options area provide choices according to the content in
the SAS window that you are trying to print. By default, SAS prints the entire
contents of the selected window.

To print Do this

selected lines of text in a window Select the text that you want to print, and

Note: not available on 0S/390 then open the Print window. In the Page
Options box, check the Print Selected
Text box.

the page that is currently displayed in the Select Current page.

window
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To print Do this

a range of pages or other individual pages Select Range and enter the page numbers in
the Pages field. Separate individual page
numbers and page ranges with either a
comma (,) or a blank. You can enter page
ranges in any of these formats:

O n-m prints all pages from n to m,
inclusive.

O -n prints all pages from page 1 to page
n.

O n- prints all pages from page n to the

last page.
in color Check the Print Color box.
line numbers Check the Print Line Numbers box.
page numbers Check the Print Page Numbers box.
a graph Use the DMPRINT command, or select File »

Print. Verify that the Use SAS/GRAPH
Drivers check box is deselected in order to
use Universal Printing.

8 Click to print.

Working with Previewers

Defining a New Previewer

Previewers enable you to preview a print job. SAS does not set a default previewer
application. To use the Print Preview feature in SAS, you or your system administrator
must first define a previewer for your system.

Operating Environment Information: Print Previewers are not supported on z/OS A

Previewers can be defined using the New Previewer wizard. To use the New Previewer
wizard to define a new print previewer:

1 Issue the DMPRTCREATE PREVIEWER command. The following window
appears:
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Display 17.12 Previewer Definition Window to Enter Name and Description

*Define a new previewer: Step 1 of 4

2 Enter the name and a description for the new previewer (127 character maximum,
no backslashes).

3 Click to proceed to Step 2.

Display 17.13 Previewer Definition Window to Enter Previewer Language

‘*Define a new previewer: Step 2 of 4

Brother HL 1060 FS
Brother HL 1270M PS5
Brother HL 1650 PS5
Brother HL 1660e PS5
Brother HL 1670M PS
Brother HL 2060 FS

Brother HL 2400C PS5
Brother HL 2460 PS5
Brother HL 3400CH F5
Canon C LBF 360 FS

Canon CLBF 460 F5
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4 Select the printer model that you want to associate with your previewer definition.
The Postscript, PCL or PDF language generated for the model must be a language
that your external viewer package supports. For best results, select the generic
models such as PostScript Level 1 (Color) or PCL 5.

5 Click to proceed to Step 3.

Display 17.14 Previewer Definition Window to Enter Command to Open Previewer Application

‘*Define a new previewer: Step 3 of 4

6 Enter the command or commands used to open the previewer application, followed
by %s where you would normally put a file name. For example, if the command for
starting your previewer is “ghostview,” then you would type ghostview %s in the
text field.

Note: The %s can be used as many times as needed in the commands for
starting the viewer. A

7 Click to proceed to Step 4.
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Display 17.15 Previewer Definition Window to Complete Process

‘*Define a new previewer: Step 4 of 4

8 Click to correct any information. Click when you have finished
defining your default previewer.

The newly defined previewer will display a previewer icon in the Print Setup window.

Display 17.16 Print Setup Window Displaying New Previewer

=; Print Setup

Generic: PCL 5e Printer
Portable Document Format Version 1.2
Generic PostScrpt Level 1 Printer

5 PoztScript EPS Color Generic PostScript Color Encapsulated

5 PostScript EPS Gray Generic PostScrpt Gray Scale Encapsulated

&5 PostScript Level 1 Generic PostScrpt Lewel 1 Printer
&) PostScript Level 2 Gerneric PostScript Lewvel 2 Printer
W previswer

This previewer application can be tested with the button on the Print
Setup window.

Seeding the Print Previewer Command Box

Print Preview is supported by print previewer applications such as Ghostview, gv,
and Adobe Acrobat. The Preview command box that appears in the Previewer
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Definition wizard and on the Advanced tab of the Printer Properties window can be
prepopulated or “seeded” with a list of commands used to invoke print previewer
applications that are available at your site. Users and administrators can manually
update the registry, or define and import a registry file that contains a list of previewer
commands. An example of a registry file is:

[CORE\PRINTING\PREVIEW COMMANDS ]
"1"="/usr/local/gv %s"
Il2 n

"/usr/local/ghostview %s"

Previewing Print Jobs

You can use the print preview feature if a print viewer is installed for the designated
printer. Print Preview is always available from the File menu in SAS. You can also
issue the DMPRTPREVIEW command.

Setting Page Properties

For your current SAS session, you can customize how your printed output appears in
the Page Setup window. Depending on which printer you have currently set, some of
the Page Setup options that are described in the following steps may be unavailable.

To customize your printed output:

1 Issue the DMPAGESETUP command. The Page Setup window appears.
2 Select a tab to open windows that control various aspects of your printed output.
Descriptions of the tabbed windows follow.
The Page Setup window consists of four tabs: General, Orientation, Margins, and
Paper.

0 The General tab enables you to change the options for Binding, Collate, Duplex,
and Color Printing.

Display 17.17 Page Setup Window Displaying General Tab

Z; Page Setup x|

General] Orientation | kMarging | F'aper]

Binding: I Long Edge j

Collate: [T~ |
Diples: I [fe j

Color Printing: IYES j

ok | Qancell Help |

Binding
specifies the binding edge (Long Edge or Short Edge) to use with duplexed
output. This sets the BINDING option.
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Collate
specifies whether the printed output should be collated. This sets the COLLATE
option.

Duplex

specifies whether the printed output should be single-sided or double-sided.
This sets the DUPLEX option.

Color Printing
specifies whether output should be printed in color. This sets the
COLORPRINTING option.

0 The orientation tab enables you to change the output’s orientation on the page.
The default is Portrait. This tab sets the ORIENTATION option.

Display 17.18 Page Setup Window Displaying Orientation Tab

&S Page Setup x|

eneral Drientatiun] t arginz | F'aper]

 Lan
= Porfrat
" ReverseLandscape
¢ ReversePortrait

k. | Eancell Help |

0 The Margin tab enables you to change the top, bottom, left and right margins for
your pages. The value range depends upon the type of printer that you are using.
The values that are specified on this tab set the TOPMARGIN,
BOTTOMMARGIN, LEFTMARGIN, and RIGHTMARGIN options.
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Display 17.19 Page Setup Window Displaying Margins Tab

Z; Page Setup : x|

General | Orientation Margins] F'aper]

& dnches O Cerlimeters

Top: [0.000 = Lefe  [o000 =

Battom: [0.000 = Right [0.000 =

ok | Qancell Help |

0 The Paper tab specifies the Size, Type, Source, and Destination of the paper used
for the printed output.

Display 17.20 Page Setup Window Displaying Paper Tab

£ Page Setup |
General | Orientation | M argins | F'aper]
Size: Letter (8.5 217 |M]
Type: I j
Source: I j
Destination: I j
ok | Qancell Help |
Size

specifies the size of paper to use by setting the PAPERSIZE option. Paper
sizes include Letter, Legal, A4, and so on.

Type
specifies the type of paper to use. Examples of choices include Standard,

Glossy, and Transparency. This sets the PAPERTYPE option.

Source
designates which input paper tray is to be used. This sets the
PAPERSOURCE option.
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Destination
specifies the bin or output paper tray that is to be used for the resulting
output. This sets the PAPERDEST option.

Note: Although your Page Settings should remain in effect for your current working
session, changing default printers could cause some of the settings to have no effect. If
you change printers during a SAS session, check the Page Setup window to see if any of
your settings are not valid for your new default printer. A

Configuring Universal Printing with Programming Statements

Introduction

Universal Printing windows give you control over most printing functions through a
graphical user interface. (You can also write a program that uses various SAS language
elements to configure your printing environment and to control print jobs.)

System Options That Control Universal Printing

Universal Printing can configured in batch mode and interactive mode by setting
option values within an OPTIONS statement. The following options control Universal
Printing.

Tahle 17.5 System options that control Universal Printing

System Option Description

BINDING Specifies the binding edge for the printer

BOTTOMMARGIN Specifies the size of the margin at the bottom of
the page for printing

COLLATE Specifies the collation of multiple copies for
output for the printer

COLORPRINTING Specifies color printing, if it is supported

COPIES Specifies the number of copies to make when
printing

DUPLEX Specifies duplexing controls for printing

LEFTMARGIN Specifies the size of the margin on the left side
of the page

ORIENTATION Specifies the paper orientation to use (either
portrait or landscape)

PAPERDEST Specifies the bin or output paper tray to receive
printed output

PAPERSIZE Specifies the paper size to use when printing.

PAPERSOURCE Specifies the input paper tray to use for printing

PAPERTYPE Specifies the type of paper to use for printing.

PRINTERPATH Specifies a printer for Universal Printing print

jobs (see Note on page 270)
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System Option Description

RIGHTMARGIN Specifies the size of the margin on the right side
of the page

SYSPRINTFONT Specifies the font to use when printing

TOPMARGIN Specifies the size of the margin at the top of the
page

Note: The PRINTERPATH option specifies which printer will be used.

o If PRINTERPATH is blank, the default printer will be used.

o If PRINTERPATH is not blank, Universal Printing will be used.

In the Windows environment, the default printer is the current Windows system
printer or the printer specified by the SYSPRINT option; therefore, Universal Printing
is not used. In all other operating environments, Universal Printing is used and the

default printer is Postscript Level 1. To change this printer, use the DMPRINTSETUP
command to open the Print Setup window. 2

Defining Printers for Batch-Mode

Printer definitions can be created for an individual, or for all SAS users at a site, by
using the PRTDEF procedure. PROC PRTDEF can be used to do many of the same
printer management activities that you can also do with the Universal Printing
windows. PROC PRTDETF is especially useful if you use SAS in batch mode, where the
Universal Printing windows are unavailable.

Only system administrators or others who have write permission to the SASHELP
library can use PROC PRTDEF to create printer definitions for all SAS users at a site.

To define one or more printers with PROC PRTDEF, you first create a SAS data set
that contains variables corresponding to printer attributes. PROC PRTDEF reads the
data set and converts the variable attributes into one or more printer definitions in the
SAS registry.

See Base SAS Procedures Guide for more information about PROC PRTDEF.

Defining New Printers and Previewers with PROC PRTDEF

Introduction

These examples show you how to use PROC PRTDEF to define new printers and to
manage your installed printers and previewers.

After a program statement containing PROC PRINTDEF runs successfully, the
printers or previewers that have been defined will be displayed in the Print Setup
window. A complete set of all available printers and previewers will be displayed in the
Printer name list. Printer definitions can also be seen in the Registry Editor window
under CORE\\PRINTING\\PRINTERS.

Creating a Data Set that Defines Multiple Printers

When you create a data set to use with PROC PRTDEF to define a printer, you must
specify the name, model, device and destination variables.

See the PRTDEF procedure in Base SAS Procedures Guide for the names of the
optional variables that you can also use.
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data printers;
input name $& model $& device $& dest $&;

datalines;
Myprinter PostScript Level 1 PRINTER printerl
Laserjet PCL 5 Printer PIPE lp -dprinter5
Color LaserJet PostScript Level 2 PIPE lp -dprinter2
7
run;

After you create the data set containing the variables, you run a SAS program that
contains PROC PRTDEF. PROC PRTDEF defines the printers that are named in the
data set by creating the appropriate entries in the SAS registry.

proc prtdef data=printers usesashelp;

run;

Installing a Printer Definition for Multiple Users

This example creates a Tektronix Phaser 780 printer definition with a Ghostview
print previewer in the SASUSER registry. The bottom margin is set to two centimeters,
the font size to 14 point, and the paper size to A4.

data tek780;

name = "Tek780";
desc = "Test Lab Phaser 780P";
model = "Tek Phaser 780 Plus";
device = "PRINTER";
dest = "testlab3";
preview = "Ghostview";
units = "cm";
bottom = 2;
fontsize = 14;
papersiz = "ISO A4";
run;

proc prtdef data=tek780;

run;

Adding, Modifying, and Deleting Printer Definitions

This example uses the PRINTERS data set to add, modify, and delete printer
definitions. See the PRTDEF procedure in Base SAS Procedures Guide for more
variables that you can use to define a printer. The following list describes the variables
used in the example:

0 The MODEL variable specifies the printer prototype to use when defining this

printer.

o The DEVICE variable specifies the type of I/O device to use when sending output
to the printer.

0 The DEST variable specifies the output destination for the printer.

0o The OPCODE variable specifies what action (Add, Delete, or Modify) to perform on
the printer definition.

0 The first Add operation creates a new printer definition for Color Postscript in the
registry and the second Add operation creates a new printer definition for ColorPS
in the registry.

0 The Mod operation modifies the existing printer definition for Laserdet 5 in the
registry.
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0 The Del operation deletes the printer definitions for printers named “Gray
Postscript” and “test” from the registry.

The following example creates a printer definition in the SASHELP library. Because
the definition is in SASHELP, the definition becomes available to all users. Special
system administration privileges are required to write to the SASHELP library. An
individual user can create a personal printer definition by specifying the SASUSER
library instead.

data printers;

length name $ 80
model $ 80
device $ 8
dest $ 80
opcode $ 3;

input opcode $ & name $ & model $ & device $ & dest $ &;

datalines;

add Color Postscript PostScript Level 2 (Color) DISK sasprt.ps
mod LaserJet 5 PCL 5 DISK sasprt.pcl
del Gray Postscript PostScript Level 2 (Gray Scale) DISK sasprt.ps
del test PostScript Level 2 (Color) DISK sasprt.ps
add ColorPS PostScript Level 2 (Color) DISK sasprt.ps

r

proc prtdef data=printers list
library=sashelp;

run;

Note: If the end user modifies and saves new attributes for an administrator-defined
printer in the SASHELP library, the printer will become a user-defined printer in the
SASUSER library. Values that are specified by the user will override the values that
were set by the administrator. If the user-defined printer definition is deleted, the
administrator-defined printer will reappear. 2

Creating a Ghostview Previewer Definition for Previewing Postscript Output

This example creates the GSVIEW data set. The variables in the GSVIEW data set
have values that PROC PRTDEF uses to produce the print previewer definition in the
SAS registry.

o The NAME variable specifies the printer name that will be associated with the
rest of the attributes in the printer definition data record.

0 The DESC variable specifies the description of the printer.

0 The MODEL variable specifies the printer prototype to use when defining this
printer.

0 The VIEWER variable specifies the host system commands for print preview.

0 The DEVICE variable should always be DUMMY.

0 DEST should be blank to specify that output is not returned.

data gsview;
name = "Ghostview";
desc = "Print Preview with Ghostview";
model= "PostScript Level 2 (Color)";
viewer = ’'ghostview %s’;
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device = "dummy";
dest = " ";
run;
proc prtdef data=gsview list replace;

run;

Exporting and Backing Up Printer Definitions

PROC PRTEXP enables you to backup your printer definitions as a SAS data set that
can be restored with PROC PRTDEF.
PROC PRTEXP has the following syntax:

PROC PRTEXP [USESASHELP] [OUT=dataset]
[SELECT | EXCLUDE] printer 1 printer 2 ... printer n;

The following example shows how to back up four printer definitions (named PDF,
postscript, PCL5 and PCL5c) using PROC PRTEXP.

proc prtexp out=printers;
select PDF postscript PCL5 PCL5c;

run;

For more information, see the PRTEXP procedure in Base SAS Procedures Guide.

Sample Values for the Device Type, Destination and Host Options Fields

The following list provides examples of the printer values for device type, destination
and host options. Because these values can be dependent on each other, and the values
can vary by operating environment, several different examples are shown. You might
want to refer to this list when you are installing or modifying a printer or when you
change the destination of your output.

o0 Device Type: Printer
o z/0S
o Device type: Printer
o0 Destination: (leave blank)
0 Host options: sysout=class-value dest=printer-name

o UNIX and Windows
o Device type: Printer
O Destination: printer name
0 Host options: (leave blank)

o VMS
o0 Device type: Printer
O Destination: printer name
0 Host options: passall=yes queue=printer-name
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o Device Type: Pipe
Note: A sample command to send output to an lp-defined printer queue on a
UNIX host is Ip -ddest »
o UNIX
o Device Type: Pipe
0 Destination: command

0 Host options: (leave blank)

o Device type: Email
o Windows, UNIX and VMS
o Device Type: Email
0 Destination: name@isp.com
0 Host options: (leave blank)
o z/0S
o Device Type: Email
0 Destination: name@isp.com

0 Host options: recfm=vb

o Device Type: FTP

Note: An example of a nodename is pepper.unx A
o z/0S
o Device type: FTP
Destination: ftp.out
Host options: host="nodename’ recfm=vb prompt
Device type: Printer

Destination: printer name

O 0o o o g

Host options: (leave blank)

0 Windows
o Device type: FTP
0 Destination: ftp.out
0 Host options: host="nodename’ prompt

o UNIX and VMS
o Device type: FTP
0 Destination: host="nodename’ prompt

0 Host options: (leave blank)

0 Device Type: Socket

Note: An example of an lp destination queue is [p286nc0.prt:9100 »
o UNIX and VMS

0 Device type: Socket

0 Destination: destination-queue

0 Host options: (leave blank)



Printing with SAS /A Creating or Editing a Form 275

Forms Printing

Overview of Forms Printing

Before Universal Printing was introduced, SAS provided a utility for print jobs called
a form. A form was a standard template that let you control such things as line size
and margin information for pages in a print job. While Universal Printing is easier to
use and has more features than the simple controls offered in forms printing, SAS still
supports forms.

Printing with forms is still available through the Print window. You can switch to
forms print mode by selecting File » Print and selecting Use Forms.

Note: Forms printing is not available in batch mode. A

Creating or Editing a Form

If your organization has legacy reports that need to be printed using forms, you
might have to use the FORM window to create or edit a form. SAS still supports the
ability to create or edit forms, though Universal Printing provides more features, and is
the recommended method of printing.

You can create or edit a form by entering the FSFORM command:

FSFORMc< catalog-name.>form-name

If you do not specify a catalog-name, SAS uses the SASUSER.PROFILE catalog. If the
form name that you specify does not exist, SAS creates a new form.
If you are creating a new form, SAS displays the Printer Selection frame. If you are
editing an existing form, SAS displays the Text Body and Margin Information frame.
To move between the FORMS frames, you can

0 use the NEXTSCR command to scroll to the next frame and the PREVSCR
command to scroll to the previous frame.

O enter an equals sign (=) and the number of the frame that you want to go to. For
example, =1 displays the Text Body and Margin Information frame, and =2
displays the Carriage Control Information frame.

O select the name of the frame from the Tools menu.
O select Next Screen or Previous Screen from the Tools menu.
You can move between fields on a frame with the TAB key.

After you have finished defining or editing your form, issue the END command to
save your changes and exit the FORM window.

Note: Turning on Forms by checking the Use Forms checkbox in the print window
turns Universal Printing off for printing non-graphic windows. A

Operating Environment Information: For more information on printing with Forms,
see the documentation for your operating environment. 2
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Basic Features of the SAS Windowing Environment

What Is the SAS Windowing Environment?

SAS provides a graphical user interface that makes SAS easier to use. Collectively,
all the windows in SAS are called the SAS windowing environment.
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The SAS windowing environment contains the windows that you use to create SAS
programs, but you will also find other windows that enable you to manipulate data or
change your SAS settings without writing a single line of code.

You might find the SAS windowing environment a convenient alternative to writing a
SAS program when you want to work with a SAS data set, or control some aspect of
your SAS session.

Using SAS Window Features

Overview of SAS Windowing Environment Features

SAS windows have several features that operate in a similar manner across all
operating environments: drop-down menus, pop-up menus, toolbars, and online help.
You can customize many features of the SAS windowing environment, including
toolbars, menus, icons, and so on. Select Tools to explore some of the customization
options that are available. The examples in this section are from the Microsoft
Windows operating environment; menus and toolbars in other operating environments
have a similar appearance and behavior.

Operating Environment Information: If you are using Microsoft Windows, the active
window determines what items are available on the main menu bar. If you can not find
an option on the menu where you expect to find it, be sure you have opened the correct
window. A

Keyboard Equivalents for z/0S

Operating Environment Information: The following table shows you how to select
items if you use SAS in the z/OS operating environment. 2

Tahle 18.1 Mouse Actions and Keyboard Equivalents for z/0S

Mouse Action Keyboard Equivalent

double-click the item type an s or an x in the space next to the item,
then press ENTER or RETURN

right-click the item type ? in the space next to the item, then press
ENTER or RETURN.

Operating Environment Information: Other features that are specific to z/OS and
other operating environments are found later in this section. A
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Display 18.1 SAS z/0S Display

File Edit View Tools Solutions Help a
r5AS Environment—————— - 0 Contents of ‘Sasuser’
H _ SAS Environment
H _ Libraries _ Parms Catalog
_ Maps _ Profile Catalog
B _ Sashel _ Sasmbc Table
H_ E'EE!EQE ? SEERTEEE I I
_ Parms
_ Profile
M _ Work
_ File Shortcuts
_ DD Names

5H

Drop-Down Menus in SAS

A drop-down menu is a list of commands that appears when you click on a menu
name in the menu bar.

Display 18.2 A Typical SAS Menu Bar with a Drop-Down Menu for Help
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NDTE: This session is executing on

About SAS System

Drop-down menu choices change as you change the windows you are using.
The following steps demonstrate that selecting view from a menu bar results in a

different drop-down menu, depending on which window you are using when you make
the selection.

1 Select View » Explorer from the menu. The Explorer window appears.

2 Select View from the menu bar again. The drop-down menu lists the View
commands that are available for the Explorer window.

281
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Display 18.3 View Commands for Explorer Window
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3 Click Program Editor. The Program Editor window appears.
4 Select view from the menu again and notice that it offers different selections.

Display 18.4 View Commands for Program Editor Window
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Pop-Up Menus in SAS

A pop-up menu is a menu that appears when you select an item or an option. In SAS
windows, a pop-up menu displays when you right-click an item. A pop-up menu
remains visible until you make a selection from the menu or until you click something
outside of the pop-up menu area.
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Display 18.5 A Typical Pop-Up Menu
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To see a typical pop-up menu in SAS, perform the following steps:

1 In the Explorer window, right-click the Libraries icon. Notice that open and New
are available in the pop-up menu. Select Open.

2 Right-click the sasuser icon. The pop-up menu contains additional selections.
Click anywhere outside the pop-up menu to close it without selecting an action.
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Operating Environment Information: To open a pop-up menu using SAS on z/OS, you

select the item by placing a question mark (?) in the space next to the item, and then
press ENTER. See Table 18.1 on page 280 for more information. A

Toolbars in SAS

A toolbar is a block of window buttons or icons. When you click on items in the
toolbar, a function or an action is started. For example, clicking on a picture of a
printer in a toolbar starts a print process. The toolbar displays icons for many of the
actions that you perform most often in a particular window.

Operating Environment Information: SAS on z/OS is not equipped with a toolbar. A
Display 18.6 Typical SAS Toolbar from Microsoft Windows Operating System
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To see a typical toolbar menu in SAS, perform the following steps:

1 Click the Explorer window and look at the toolbar. Notice that currently
unavailable tools are grayed.

2 Move your mouse pointer to a tool and hold it there for a moment. A Tool Tip
displays the name of the tool.

3 Click the Editor (or Program Editor) window and view the tools available.

Getting Help from the Help Menu in SAS

There are several ways to access the Help system that comes with SAS. You can
either type help in the menubar, or select different choices from the Help menu. The
following list describes the Help menu choices.
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Using This Window
Opens a Help system window that describes the current active window.

SAS Help and Documentation
Opens the SAS Help and documentation system. Help is available for Base SAS
and other SAS products that are installed on your system.

Getting Started with SAS Software
Opens Getting Started with SAS Tutorial. This is a good way to learn the basics of
how to use SAS.

Learning SAS Programming

Opens SAS OnlineTutor: Advanced Programming sample data sets. SAS
OnlineTutor: Advanced Programming is a separately licensed product that
provides 50-60 hours of instruction for beginning as well as experienced SAS
programmers.

SAS on the Web
If you have web access, then this selection provides links to the SAS web site,
where you can

0 contact Technical Support

0 read Frequently Asked Questions (FAQs)
0 find information about Training Services
o0 send feedback

O browse the SAS home page.

About SAS System
Provides version and release information about SAS.

Getting Help from the Toolbar in SAS

You can get help when you type help <language element name> in the toolbar or at
the command line. This opens the Help system and displays the documentation for the
language element name that you typed.

Main Windows of the SAS Windowing Environment

List of SAS Windows and Window Commands

The basic SAS windows are the Explorer, Results, Program Editor, Log, and Output
windows, but there are more than thirty other windows to help you with such things as
printing and fine-tuning your SAS session.

The following table lists all portable SAS windows and the commands that open them.

Note: Additional information about how many of these windows work can be found
by clicking the help button inside each window. A
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Tahle 18.2 List of Portable SAS Windows and Window Opening Commands

285

Window Name

Window Command(s)

Define a new previewer“Defining a New

Previewer” on page 262

Define a new printer“Defining a New Printer” on

page 252

Distributed Multidimensional Metadata

Documents

Explorer

Explorer Options

EFI (External File Interface)
File Shortcut Assignment
Find

Font (host-specific)
Footnotes

FSBrowse

FSEdit

FSForm

FSLetter

FSList

FSView

Help

Keys

Log

Metadata Browser

Metafind

Metadata Server Connections
My Favorite Folders

New Library

Notepad

Options (SAS system options)
Output

Page Setup

Password

Preferences (host-specific)

Print

DMPRTCREATE PREVIEWER

DMPRTCREATE PRINTER

MDMDDB*
ODSDOCUMENTS

ACCESS, BUILD, CATALOG, DIR, EXPLORER,

FILENAME, LIBNAME, V6CAT, V6DIR,
V6FILENAME, V6LIBNAME

DMEXPOPTS

EFI*
DMFILEASSIGN
EXPFIND
DLGFONT*
FOOTNOTES
FSBROWSE
FSEDIT

FSFORM formname
FSLETTER
FSLIST

FSVIEW

HELP

KEYS

LOG
METABROWSE*
METAFIND
METACON
EXPROOT FILES*
DMLIBASSIGN
NOTEPAD, NOTE, FILEPAD filename
OPTIONS
OUTPUT, OUT, LISTING, LIST, LST
DMPAGESETUP

SETPASSWORD (followed by a two-level data
set name)

DLGPREF*
DMPRINT
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Window Name Window Command(s)

Print Setup DMPRTSETUP

Printer Properties DMPRTPROPS

Program Editor PROGRAM, PGM

Properties VAR libref.SAS-data-set, V6VAR
libref.SAS-data-set

Query QUERY

Registry Editor REGEDIT

Results ODSRESULTS

SAS/AF AF, AFA

SAS/ASSIST ASSIST

SASCOLOR SASCOLOR

SAS/EIS* EIS

System Options OPTIONS

Templates ODSTEMPLATES

Titles TITLES

Tool Editor (host-specific) TOOLEDIT*

Viewtable VIEWTABLE, VT

Window commands marked with * are not supported under z/OS.

Note: Some additional SAS windows that are specific to your operating environment
may also be available. Refer to the SAS documentation for your operating environment
for more information. A

The Five Main Windows in the Windowing Environment

Overview

The five main windows in SAS are: Explorer, Results, Program Editor, Log, and
Output windows.
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Display 18.7 Default View of SAS Windowing Environment (Microsoft Windows)
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Operating Environment Information: The arrangement of your SAS windows depends
on your operating environment. For example, in the Microsoft Windows operating
environment, the Editor window appears instead of the Program Editor. 2

SAS Explorer Window

Use to View, add or delete files, libraries, shortcuts.
Open by Typing EXPLORER in the command line, or select View » Explorer
Description The Explorer window enables you to manage your files in the

windowing environment. You can use the SAS Explorer to do the
following tasks:

O view lists of your SAS files

create shortcuts to external files

create new SAS files

open any SAS file and view its contents

move, copy, and delete files

o o o o g

open related windows, such as the new library window.

You can display the Explorer window with or without a tree view of its contents.

Display 18.8 SAS Explorer, with Tree View, Microsoft Windows Operating Environment
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Display 18.9 SAS Explorer, Without Tree View, Microsoft Windows Operating Environment
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Note: You can resize the Explorer window by dragging an edge or a corner of the
window. You can resize the left and right panes of the Explorer window by clicking the
split bar between the two panes and dragging it to the right or left. A

Exploring Files with the SAS Explorer

You can use the SAS Explorer to explore and manage SAS files and other files. In the
Explorer window, you can view and manage your SAS files, which are stored in
libraries. A library is a storage location for SAS files and catalogs. By default, SAS
defines several libraries for you.

This example uses the SAS Explorer to display the contents of a library:

1 In the Explorer window, double-click Libraries. The active libraries are listed.

Display 18.10 Typical Explorer Window, Without Tree View, Showing Active Libraries
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2 Double-click the sashelp library. All members of the Sashelp library are listed.
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Display 18.11 Explorer Window, Without Tree View, Showing the Contents of a Sashelp Library

3 Move back up to the top level of the Explorer window by clicking twice on the Up
One Level selection under view on the toolbar.

Using SAS Explorer to Assign File Shortcuts (filerefs)

A file shortcut is also known as a file reference or fileref. Filerefs save you
programming time by enabling you to assign a nickname to a commonly used file. You
can use the FILENAME statement to create a fileref or you can use the file shortcut
assignment window from SAS Explorer.

The following example shows you how to create a file shortcut with SAS Explorer.

1 In the top level of the Explorer window, select File Shortcuts.
2 Select File » New. The File Shortcut Assignment window appears.

Display 18.12 File Shortcut Assignment Window

&' File Shortcut Assignment

3 Type a name in the Name field (up to eight alphanumeric characters). This name is
the file shortcut reference (fileref), and you can use it to point to an external file.
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Select the Method that you want to use for the file shortcut. The devices that are
available from the Method drop-down list depend on your operating environment.
DISK is the default (if available for your operating environment). See your
operating environment documentation for more information.

Select Enable at Startup if you want SAS to automatically assign the file
shortcut each time that SAS starts. This option is not available for all file shortcut
methods. If it is not available, the Enable at Startup check box is disabled. If you
want to stop a file shortcut from being enabled at startup, select the file shortcut
in the SAS Explorer window, and then select Delete from the pop-up menu.

Fill in the fields of the Method Information area. The fields available in this
area depend on the method that you selected.

Note: Selecting a new method type erases any entries that you may have made
in the Method information field. A

Select to create the new file shortcut. The file shortcut appears in the File
Shortcut folder of the SAS Explorer window.

Using SAS Explorer to Copy a SAS Data Set

This example shows you how to copy a data set called Prdsale, which is a sample
data file included when you install SAS software.

1 Open the Explorer window by selecting View » Explorer

~N oo Ol AW

Display 18.13 SAS Explorer in Tree View Mode, Showing Some Members of a Sashelp Library
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In the left pane, single-click the sashelp library to show the library contents in
the right pane. Scroll to the icon for the Prdsale data set.

Right-click the Prdsale data set.

Select Copy from the menu.

Right-click the work Library.

Select Paste from the menu.

The Prdsale data set appears in the contents of the Work Library.
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Display 18.14 SAS Explorer In Tree View Mode, Showing a File in a Work Library
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Because the contents of the Work library are temporary, this copy of the Prdsale data
set will be deleted when you end your SAS session.

Using SAS Explorer to Rename a File

You can use SAS Explorer to rename anything in a SAS library that is not write
protected. This set of instructions outlines how to use SAS Explorer to rename a data
set:

1 Open SAS Explorer and click on a library. A list of files in the library appears.
2 Select the file you want to rename and right-click it. A pop-up menu appears.

3 Select Rename from the pop-up menu. A Rename window appears, containing the
name of the file you selected, and a blank space for typing in the new name.

4 Type in the new name and click [OK].

Note: Changing a file name may cause a SAS program that uses the old file name to
stop working. A

Using SAS Explorer to View Details about Files

You can use the vView menu to view the contents of a library with large icons or
small icons, as a list, and with details displayed. This example shows you how use
Explorer to view the details for the Sashelp.Prdsale data set.

1 Open the Sashelp library.

2 Select View » Details from the menu. Information about the files is displayed.

Note: The DETAILS system option controls how many details you can see
about a data set. If you enable the DETAILS system option, you can see additional
row and column information in the Explorer window. 2

3 Resize the Details columns by moving the pointer over the separator bar between

the detail fields. When the pointer changes to a resizing tool, click and drag the
separator bar to get the desired size.
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Display 18.15 Explorer Window with Pointer in Position (between Name and Engine) to Resize Columns.
DETAILS Option Set to NODETAILS
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Display 18.16 Explorer Window with DETAILS Option Enabled
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For more information about the DETAILS system option, see the SAS Language
Reference: Dictionary.

Using SAS Explorer to Sort Files

Files in the Explorer window are sorted alphabetically by file name. You can sort by
any column in ascending or descending order:

1 Open the Sashelp library.

2 Click the Type column to sort the files by file type.

3 Click the Type column again to reverse the sort order.

4 To return the files to their original order, select View » Refresh.

Using SAS Explorer to Open a File

You can view the contents of SAS files directly from the Explorer window:
1 Double-click the sashelp library.

2 Find the Prdsale data set in the list and double-click it to open it. The table
opens in the VIEWTABLE window in browse mode.

3 When you are finished looking at the data in the data set, select File » Close from
the VIEWTABLE window.

4 Return to the top level of the Explorer window.
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Display 18.17 Viewtable Window Displaying a Data Set
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Using SAS Explorer and NOTEPAD to Create and Save a Program

In addition to the NOTEPAD, which is described here, you can also use the Program
Editor (or Editor in some operating systems) to create and save programs. You can also
use NOTEPAD and the Program Editor to work on two programs in the same session.

The following set of instructions shows you how to create and save a SAS program:

1 In the top level of the Explorer window, select File » New
2 Select source Program, and click [OK]. The NOTEPAD window appears.
3 Type the following program into the NOTEPAD window:

proc options;

run;

4 Select Run » Submit. As a result, the Log window lists the settings for your

system options.
Select File » Save As

6 With the default directory selected, type sysopt.sas in the File name box.

Click or [Save].

Display 18.18 SAS Notepad, with a Program
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To recall and run the program that you just saved, follow this set of instructions:
1 Select File » Open

2 From the menu, select the library where you saved your program, if that library is
not already available.

3 Select sysopt.sas (the program you just saved) from the menu. The program
appears in NOTEPAD.

4 Select Run » Submit

Program Editor Window

Purpose Compose, edit, and submit SAS programs.
To open Type PROGRAM in a command line, or select View » Program Editor
Details In the Program Editor window, you can enter, edit, and submit SAS

programs. To open your SAS programs in the SAS windowing
environment, you can drag and drop them onto the Program Editor
window.

Display 18.19 Program Editor Window, with a Sample Program

Program Editor - accnt.sas

data work.balance; =
set clinic.insure;

rumn;

proc print datazwork.balnce;

Fumn;

1| | v

This set of instructions shows you how to use the Program Editor to create and save
a SAS program, submit the program, and view and save your results.
Create and Save a Program

1 In the top level of the Explorer window, select File » New

2 Select source Program and click [OK].

3 Type the following program into the Editor or Program Editor window:
proc datasets lib=sasuser;

run;
quit;
4 This program prints a listing of the contents of the SASUSER library (or to the log
on z/0OS).
5 Click Run » Submit to run the program.
Click File » Save as to save the program.
7 Type a name and select a location for the file in the save as window.
Operating Environment Information: In the Microsoft Windows operating
environment, the Results window is docked along with the Explorer window. When a

program produces output, the Results window comes to the front and overlays the
Explorer window. A
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Log Window

Purpose View messages about your SAS session and SAS programs.
To open Type LOG in a command line, or select View » Log
Details The Log window displays messages about your SAS session and any

SAS programs you submit. If the program you submit has
unexpected results, the SAS log is usually the first place you look to
gather clues about what changes you need to make in order to get
the intended results.

Note: To keep the lines of your log from wrapping when your
window is maximized, use the LINESIZE= system option. A

Display 18.20 Log Window

B Log - (Untitled) [_ (O] x|

10 proc print data=mylib.myvproductzales; :J
11 var region division actual;
12 Fun;

HOTE : PROCEDURE PRINT used:
real time 4.50 =zeconds
cpu time 0.07 seconds

Output Window

Purpose View the output of SAS programs

To open Type OUTPUT in a command line, or type LISTING in a command
line, or select View » Qutput

Details In the Output window, you can browse output from SAS programs
that you submit. By default, the Output window is positioned
behind the other windows. When you create output, the Output
window automatically moves to the front of your display.

Note: To keep the lines of your output from wrapping when your
window is maximized, use the LINESIZE= system option. A
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Display 18.21 OQutput Window
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Results Window

Purpose View the output from running a SAS program.
To open Type ODSRESULTS in a command line, or select View » Results
Details The Results window uses a tree structure to display various types of

output that you may have while you are running SAS. You can view,
save, and print individual items of output. By default, the Results
window is positioned behind the Explorer window and it is empty
until you submit a SAS program that creates output. Then the
Results window moves to the front of your display.

To use the Results window, you first run a SAS program that generates output. You can
run any SAS program that creates output, such as the following program, which creates
a graph with PROC PLOT.

options linesize=80;
data generate;
do x=0 to 100 by 2;
y=2.54+3.83*x;
output;
end;
run;
proc plot data=generate;
plot y*x;

run;
After running a program that produces output, the results window adds a line

indicating that the output was successfully generated. You can then select this output
from the Results Window and view it.
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Display 18.22 Results Window, Showing an OQutput List

R Plot of y*sx

@ Resultz

New Library Window
Purpose Assign a new library.

To open Type DMLIBASSIGN in a command line, or from the Explorer window,
select File » New

Details The New Library Window makes it easy to create libraries. After
you create a new library, you can use SAS Explorer to associate SAS
files, such as data sets, catalogs, and programs, with the library. By
default, SAS software defines several libraries for you (including
Sashelp, Sasuser, and Work).

When you define a library, you specify a location for your SAS files. When you
undefine a SAS library, SAS no longer has access to the contents of the library.
However, the contents of the library still exist in your operating environment. After you
create a library, you can manage SAS files within it.

Display 18.23 New Library Window

New Library m

Library

Mame:  [wyLIE Engine: |[STSEm] ~| W Enablealsaiie

Library [nformation

Path: | Browse... |

O ptions: |

QK | Cancell Helpl

Operating Environment Information: Depending on your operating environment, you
can create libraries using engines that allow you to read different file formats, including
file formats from other vendors. A
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Using the New Library Window to Assign a New Library

1 In the Explorer window, double-click Libraries.

2 From the Explorer menu, select File » New

3 In the New Library window, type Mylib for the name, and leave the Default
engine selected.

4 Select Enable at startup so that the library is created each time you start SAS.

5 Click and select a directory to use for this library. In the Select dialog you
must open the directory you want to use so that the full path into that directory is
assigned. Click [OK].

6 Click to assign the library. Mylib appears in the Active Libraries list.

Properties Window

Purpose View and change the properties of a data set.

To open Type VAR in the command line, followed by the name of the data set
that you want to open, in the form of libref.SAS-data-set, or
right-click on a data set from the SAS Explorer window and select
Properties.

Details When you open the Properties window, you can select tabs that give
you additional information about the data set.

Display 18.24 Properties Window Displaying the Details for Sashelp.Prdsale. Select Other Tabs for More
Information.

Keys Window

Purpose Change or create new keyboard commands.
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To open Type KEYS in a command line, or select Tools » Options » Keys

Details The Keys window displays function key definitions for the current
window. Default function key settings are provided with the SAS
System, but you can easily add, edit, or delete them.

To add new function key definitions:

1 After opening the Keys window, place your cursor next to the key you want to
assign to a command. Make sure your cursor is under the befinition column.

2 Type the name of the command you want to assign.

3 Click File » Save to save your changes.

To change existing key functions:

1 Type over the command that is already assigned to a particular key with the name
of a new function.

2 Click File » Save to save your changes.
To delete key functions:
1 Type over the command that is already assigned to a particular key.

2 Save the Keys window.

Valid Commands in the Keys Window

In the Keys window you can use these commands:
o SAS windows commands

o the Color, Search, Scrolling, Text Store, Window Management, and Window Size
and Position commands.

In addition, you can use the following commands:

Table 18.3 Other Commands That You Can Use in the Keys Window

Command Result

CANCEL Cancels any changes made to the current key settings and closes the
Keys window.

COPY <name> Copies another stored set of key definitions into the window. If
<name> is omitted, any changes that are made are cancelled and the
definitions from your user profile catalog are copied.

Note: If you change a key definition in the current
Keys window and then save the Keys window, you must
close and reopen the Keys window before issuing the
COPY command. A

END Saves the definitions and closes the Keys window.
PURGE Removes key definitions that are not shared among devices.
SAVE <name> Stores the current function key settings and lets you continue editing

the keys definitions. If <name> is omitted, the keys are, by default,
stored in the catalog SASUSER.PROFILE.

See SAS Help and Documentation for more information about commands.
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Introduction to Managing Your Data in the SAS Windowing Environment

The SAS windowing environment contains windows that enable you to do common
data manipulation and changes without writing code.

If you are new to SAS and are unfamiliar with writing code in the SAS language, then
you might find the windowing environment helpful. With the windowing environment,
you can open a data set in a window, point to rows and columns in your data, and then
click on menu items to reorganize and perform analyses on the information.

This section shows the main features of the SAS windowing environment, and
demonstrates many of the tools that enable you to view, modify, import and export data.

Operating Environment Information: If you use SAS on z/OS, refer to “Keyboard
Equivalents for z/OS” on page 280 to see the keyboard alternatives to using a mouse. A

Copying and Viewing Files in a Data Library

Copying a Practice File to the WORK Data Library

The following examples use a copy of the SASHELP.PRDSALE data set, which is a
read-only data set in the SASHELP library. In this section, you will learn how to copy
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SASHELP.PRDSALE to the WORK library, so that you can use it with the other
examples in this section.

Note: By default, files located in the WORK directory are deleted at the close of a
SAS session. A

To copy the PRDSALE file in the SASHELP library to the WORK library, follow these
steps:

1 Open the Explorer window by selecting View » Explorer from the menu.

2 Make sure you are in Tree view mode by enabling View » Show Tree. The
Explorer window now contains two panels.

Display 19.1 Explorer Window Displaying Tree View
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3 In the left panel, click the SASHELRP library to show the library contents in the
right panel. Scroll to the PRDSALE data set.

4 Right-click the PRDSALE data set and select Copy from the menu.

Display 19.2 Explorer Window Displaying Copy Menu Option
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5 In the left panel, right-click WoRK and select Paste.

Display 19.3 Explorer Window Displaying Paste Menu Option
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6 Double-click Work and confirm that the data set was copied.
Display 19.4 Explorer Window Displaying Copied PRDSALE Data Set (Icon View)

SAS - [Explorer]

Prdsale

~E File Shortcuts
w-{& Fawvarite Folders
=& My Computer
E-=D 3% Flappy (49
E——




304 Viewing the Contents of a Data Set with the VIEWTABLE Window A Chapter 19

Viewing the Contents of a Data Set with the VIEWTABLE Window

To quickly view the contents of your SAS data set, you can either
O double-click a file in the SAS Explorer, or

o0 open the VIEWTABLE window with the VT command, select File » Open then
select the data set.

For this example, use the SAS data set WORK.PRDSALE, which contains sample data
for product sales. The WORK.PRDSALE data set was created by copying PRDSALE

from the SASUSER library in the previous example. See “Copying a Practice File to the
WORK Data Library” on page 301.

1
2
3

Select Tools » Table Editor to open the VIEWTABLE window.
Select File » Open. The Open dialog box displays the current SAS libraries.

Under Libraries, select WORK. The data sets and views in the WORK library are
displayed on the right.

Double-click PRDSALE. The VIEWTABLE window opens.

Display 19.5 Explorer Window Displaying Copied PRDSALE Data Set (Details View)
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5 Scroll the VIEWTABLE window to view the WORK.PRDSALE data.
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Display 19.6 VIEWTABLE Window Displaying PRDSALE Data
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6 To save a copy of this file to use for practice in the next example, click File » Save
as. The save As dialog box opens.

Display 19.7 Data Table Save As Dialog Box

Save As

Data Tables (DATA)

7 Select the WORK library as your storage location and type Mywork in the Member
Name field.

8 Click .

Saving a Data Set as HTML

To save a SAS data set as HTML, follow these steps:
1 Right-click the file in the SAS Explorer.
2 Select save as HTML from the pop-up menu.
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3 Select a location in the save in box or leave it in the default location.

4 If you want to save the file with the default name of table-name.html, select save.

If you do not want the default name, you can enter a file name and then select
Save.

Copying a Data Set to Excel

To copy a SAS data set to Microsoft Excel, you can right-click a file in the SAS
Explorer and either

O select Copy Contents to Clipboard and then click File » Paste in Microsoft
Excel, or

O select view in Excel.

Display 19.8 Explorer Window Displaying Copy to Clipboard Menu Option
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Using the Workspace to Manipulate Data in a Data Set

Moving and Labeling Columns with the VIEWTABLE Window

With the VIEWTABLE window, you can rearrange columns and temporarily change
column headings. This example uses the WORK.MYWORK data set that was
previously created in the WORK library (see “ Viewing the Contents of a Data Set with
the VIEWTABLE Window” on page 304):

1 Click the heading for the country Column.
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Display 19.9 VIEWTABLE Window Displaying MYWORK Data Set With Country Column Selected

¥ SAS - [VIEWTABLE: Work Mywork]

2 Drag and drop Country onto Actual Sales. The Country column moves to the
right of the Actual Sales column.

Display 19.10 VIEWTABLE Window Showing Country Column Has Moved
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3 Right-click the heading for Region and select Column Attributes from the menu.

Display 19.11 VIEWTABLE Window Displaying Column Attributes Menu Option
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Column Atributes.

4 In the Label box, type Sales Region and then click [Apply]|.
Display 19.12 Column Attributes Dialog Box
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5 Click when you are finished.

Sorting Values of a Column with the VIEWTABLE Window

You can sort a data set in ascending or descending order, based on the values of a
column. You can sort data permanently or create a sorted copy of a data set. This
example creates a sorted copy.

This example continues to use the data set WORK.MYWORK that was created
previously in “ Viewing the Contents of a Data Set with the VIEWTABLE Window” on
page 304.

To sort the values of a column in WORK.MYWORK with the VIEWTABLE window:
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1 Make sure that the WORK.MYWORK data set is still available.
o If it is available, open it from SAS Explorer or VIEWTABLE.
o If it is not available, recreate it from “ Viewing the Contents of a Data Set
with the VIEWTABLE Window” on page 304.
2 Right-click the heading for Product.
3 Select sort.

Display 19.13 VIEWTABLE Window Displaying Sort Menu Option

4 Select Descending from the window.

5 When a warning message asks you if you want to create a new table, click to
create a sorted copy of the data set.

6 In the sort dialog box, Table Name field, type WORK.Mysorted as the name for
the sorted data set.
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Display 19.14 Sort Dialog Box

7 Click [OK]. Rows in the new data set are sorted in descending order by values of
Product.

Creating a WHERE Expression with the VIEWTABLE Window

You can create a WHERE expression with the VIEWTABLE window. SAS generates the
WHERE expression code automatically, and you can modify or edit the code.

A WHERE expression helps you subset a data set. A WHERE expression in SAS is
modeled after the WHERE clause in SQL.

This example uses the PRDSALE data set that was created at the beginning of this
topic, and shows you how to create a WHERE expression.

To create a WHERE Expression using the SAS workspace:

1 Double-click the WORK.PRDSALE data set created in the previous example. This

opens the PRDSALE data set in the VIEWTABLE window.

2 Right-click any table cell (not a heading) and select Where. The WHERE
EXPRESSION dialog box opens.
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Display 19.15 VIEWTABLE Window Displaying Where Menu Option

3 In the Available Columns list, click REGION.

Display 19.16 Where Expression Dialog Box
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4 Select EQ (equal to) from the pop-up list.

Display 19.17 Where Expression Dialog Box Displaying EQ Menu Option
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5 Click <Lookup Distinct Values>. This opens a window containing values. You
can select values from the list.

Display 19.18 Where Expression Dialog Box Displaying LOOKUP Option

T 85AS - [WHERE EXPRESSION]

PRODTYPE
PRODUCT

6 In the Lookup Distinct Values window, select WEST.

Display 19.19 Lookup Distinct Values Dialog Box

¥ SAS - [Lookup Distinct Yalues]
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7 Notice that the complete Where expression appears in the Where box near the
bottom of the display.
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Figure 19.1 Where Expression Dialog Box Displaying the Complete Where
Expression

8 Click [OK]|. The VIEWTABLE window now displays only the rows where the value
of Region is WEST.

Editing Values in a Cell with the VIEWTABLE Window

You can edit a cell in a data set by opening the data set in the VIEWTABLE window
and switching to edit mode. These are general instructions for editing cells in a SAS
data set.

1 Open the Explorer window by selecting View » Explorer from the menu, or
alternatively, by entering the explorer command in the command line.

2 Select a file that contains the cell that you want to edit.
3 Double-click the selected file to open it in the VIEWTABLE window.
4 Select Edit » Edit Mode from the VIEWTABLE menu.

Display 19.20 Where Expression Dialog Box Displaying Edit Mode Menu Option
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5 Click the cell that you want to edit.
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6 Highlight the existing value and type a new value.
7 Press ENTER.

8 Select File » Closel When prompted about saving changes to the data set, click
[Yes], if you want to save the change.

Clearing Subsetted Data from the VIEWTABLE Window

If you have subset rows in the VIEWTABLE window, as in the previous example, you
can clear subsets and then redisplay all data in the data set.
1 Right-click anywhere in the data set except a column heading.
2 Select where clear. The VIEWTABLE window removes any existing subset(s)
and displays all rows in the data set.
3 Select File » Close.

Importing and Exporting Data

Importing Data into a Data Set

The Import wizard guides you through the steps of importing data from many
different file types into a SAS data set.

Note: The types of files that can be imported depend on your operating system. A

If your data is not in a standard file format, you can use the External File Interface
(EFD) facility to import data. This tool enables you to define your file format, and offers
you a range of format options. To use the EFI, select User-defined formats in the
Import wizard and follow the instructions for describing your data file. This example
shows you how to import a standard file and view the results.

To import a standard file:

1 Select File » Import Data to open the Import wizard. Notice that Sstandard data

source is selected by default.

Display 19.21 Import Wizard Window Displaying Default Values

O* Import Wizard - Select import type =10 x|

What type of data do you wish to import?

ata source

Select a data source from the list below.

|Micrasof Excel 87 or 2000 -

[~ User-defined formats

Define a special file format uging the External File
Interface (EFI) facility.

SAS
Irmport YWizard

Import
EXCEL2000 data

Help Cancel < Back | MNext > I sk
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2 Click the drop-down arrow to see the list of data sources. If you exported data to
Excel, select Excel 97 Spreadsheet (*.xls). Otherwise, select the file format in

which your data are stored.

Display 19.22 Import Wizard Window Displaying List of Data Sources

™ Import Wizard - Select import type

Microsoft Excel 97, 2000 or 2002 Workbook

b ok B
Wicrosoft Excel 5 or 95 Waorkbook (*xls) ’7

Wicrosoft Excel 4 Spreadshest (*xs)
Microsoft Access 2000 or 2002 Database
Microsoft Access 97 Datshase

dBASE File (*.dbf)

Lotus 1-2-3 Spreadsheet (*wk1)

3 Click to continue.
4 In the select File dialog box, type the full path for your file, or click to

find it.
Display 19.23 Import Wizard File Selection Window

I Import Wizard - Select file

s
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5 Click to continue. The Select library and member dialog box appears.

Display 19.24 Import Wizard Library Selection Window

™ Import Wizard - Select library and member

Einies

6 Type WORK for the library name and MyImport for the member name.

7 Click to continue. If you are importing data from the Excel 97 Spreadsheet
format, you are asked about saving PROC IMPORT statements. Skip this option
and click [Finish]. Your data are imported into the SAS data set WORK.MyImport.

Exporting Your Data with the Export Wizard

You can easily export SAS data to a variety of file formats, using the Export Wizard.
The formats that are available depend on your operating environment and on the SAS
software products that you have installed. The example uses the PRDSALE data set
that was created in a previous example (see “Copying a Practice File to the WORK Data
Library” on page 301).

To export SAS data, do the following:

1 If it is not already open, double-click the WORK.PRDSALE data set to open it in

the VIEWTABLE window.

2 Select File » Export Data. The Export Wizard window opens. Note that the
LIBRARY and MEMBER lists contain the name of the data set (WORK.PRDSALE)
that is currently displayed in the VIEWTABLE window.
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Display 19.25 Export Wizard Window Displaying Default Values

3 Click to proceed to selecting an export type. Notice that Standard data
source is selected by default. In the data source list, select Tab Delimited File
(*.txt), or another format that is available on your operating environment.

Display 19.26 Export Wizard Window Displaying List of Data Sources

¥ SAS - [Export Wizard - Select export type]
=

Jol —  HinswESalimmo b B

Click and select a directory.

Click to proceed to selecting a destination file.
Type the file name MYEXPORT and click [OK].

Click [Finish].

The SAS data set is exported to MYEXPORT in the directory that you selected.

~N o o A&
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Why Use a DATA Step?

Using the DATA step is the primary method for creating a SAS data set with base
SAS software. A DATA step is a group of SAS language statements that begin with a
DATA statement and contains other programming statements that manipulate existing
SAS data sets or create SAS data sets from raw data files.

You can use the DATA step for

O creating SAS data sets (SAS data files or SAS data views)
O creating SAS data sets from input files that contain raw data (external files)

O creating new SAS data sets from existing ones by subsetting, merging, modifying,
and updating existing SAS data sets

analyzing, manipulating, or presenting your data
computing the values for new variables

report writing, or writing files to disk or tape
retrieving information

O o o o g

file management.

Note: A DATA step creates a SAS data set. This data set can be a SAS data file or a
SAS data view. A SAS data file stores data values while a SAS data view stores
instructions for retrieving and processing data. When you can use a SAS data view as a
SAS data file, as is true in most cases, this documentation uses the broader term SAS
data set. A

Overview of DATA Step Processing

Flow of Action

When you submit a DATA step for execution, it is first compiled and then executed.
The following figure shows the flow of action for a typical SAS DATA step.
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Figure 20.1 Flow of Action in the DATA Step
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The Compilation Phase

When you submit a DATA step for execution, SAS checks the syntax of the SAS
statements and compiles them, that is, automatically translates the statements into
machine code. In this phase, SAS identifies the type and length of each new variable,
and determines whether a type conversion is necessary for each subsequent reference to
a variable. During the compile phase, SAS creates the following three items:

input buffer is a logical area in memory into which SAS reads each record of raw
data when SAS executes an INPUT statement. Note that this buffer
is created only when the DATA step reads raw data. (When the
DATA step reads a SAS data set, SAS reads the data directly into
the program data vector.)

program data is a logical area in memory where SAS builds a data set, one

vector (PDV) observation at a time. When a program executes, SAS reads data
values from the input buffer or creates them by executing SAS
language statements. The data values are assigned to the
appropriate variables in the program data vector. From here, SAS
writes the values to a SAS data set as a single observation.

Along with data set variables and computed variables, the PDV
contains two automatic variables, N_ and ERROR_. The N_
variable counts the number of times the DATA step begins to
iterate. The _ERROR_ variable signals the occurrence of an error
caused by the data during execution. The value of _[ERROR_ is
either 0 (indicating no errors exist), or 1 (indicating that one or more
errors have occurred). SAS does not write these variables to the

output data set.

descriptor is information that SAS creates and maintains about each SAS data

information set, including data set attributes and variable attributes. It
contains, for example, the name of the data set and its member type,
the date and time that the data set was created, and the number,
names and data types (character or numeric) of the variables.

The Execution Phase

By default, a simple DATA step iterates once for each observation that is being
created. The flow of action in the Execution Phase of a simple DATA step is described
as follows:

1 The DATA step begins with a DATA statement. Each time the DATA statement
executes, a new iteration of the DATA step begins, and the _N_ automatic variable
is incremented by 1.

2 SAS sets the newly created program variables to missing in the program data
vector (PDV).

3 SAS reads a data record from a raw data file into the input buffer, or it reads an
observation from a SAS data set directly into the program data vector. You can use
an INPUT, MERGE, SET, MODIFY, or UPDATE statement to read a record.

4 SAS executes any subsequent programming statements for the current record.

5 At the end of the statements, an output, return, and reset occur automatically.
SAS writes an observation to the SAS data set, the system automatically returns
to the top of the DATA step, and the values of variables created by INPUT and
assignment statements are reset to missing in the program data vector. Note that
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variables that you read with a SET, MERGE, MODIFY, or UPDATE statement are
not reset to missing here.

6 SAS counts another iteration, reads the next record or observation, and executes
the subsequent programming statements for the current observation.

7 The DATA step terminates when SAS encounters the end-of-file in a SAS data set
or a raw data file.

Note: The figure shows the default processing of the DATA step. You can place
data-reading statements (such as INPUT or SET), or data-writing statements (such as
OUTPUT), in any order in your program. A

Processing a DATA Step: A Walkthrough

Sample DATA Step

The following statements provide an example of a DATA step that reads raw data,
calculates totals, and creates a data set:

data total points (drop=TeamName); @
input TeamName $ ParticipantName $ Eventl Event2 Event3; @
TeamTotal + (Eventl + Event2 + Event3); (3]
datalines;

Knights Sue 6 8 8

Cardinals Jane 9 7 8

Knights John 7 7 17

Knights Lisa 8 9 9

Knights Fran 7 6 6

Knights Walter 9 8 10

r

@ The DROP= data set option prevents the variable TeamName from being written
to the output SAS data set called TOTAL_POINTS.

@ The INPUT statement describes the data by giving a name to each variable,
identifying its data type (character or numeric), and identifying its relative
location in the data record.

© The Sum statement accumulates the scores for three events in the variable
TeamTotal.

Creating the Input Buffer and the Program Data Vector

When DATA step statements are compiled, SAS determines whether to create an
input buffer. If the input file contains raw data (as in the example above), SAS creates
an input buffer to hold the data before moving the data to the program data vector
(PDV). (If the input file is a SAS data set, however, SAS does not create an input buffer.
SAS writes the input data directly to the PDV.)

The PDV contains all the variables in the input data set, the variables created in
DATA step statements, and the two variables, _N_ and _ERROR_, that are
automatically generated for every DATA step. The _N_ variable represents the number
of times the DATA step has iterated. The _ERROR_ variable acts like a binary switch
whose value is 0 if no errors exist in the DATA step, or 1 if one or more errors exist.
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The following figure shows the Input Buffer and the program data vector after DATA
step compilation.

Figure 20.2 Input Buffer and Program Data Vector

Input Buffer
1 2
1234567890123456789012345

Program Data Vector

TeamName ParticipantName Eventl Event2 Event3 TeamTotal _N_ _ERROR_

. . . 0 1 0

Drop Drop | Drop |

Variables that are created by the INPUT and the Sum statements (TeamName,
ParticipantName, Eventl, Event2, Event3, and TeamTotal) are set to missing initially.
Note that in this representation, numeric variables are initialized with a period and
character variables are initialized with blanks. The automatic variable _N_ is set to 1;
the automatic variable _ERROR_ is set to 0.

The variable TeamName is marked Drop in the PDV because of the DROP= data set
option in the DATA statement. Dropped variables are not written to the SAS data set.
The _N_ and _ERROR_ variables are dropped because automatic variables created by
the DATA step are not written to a SAS data set. See Chapter 5, “SAS Variables,” on
page 77 for details about automatic variables.

Reading a Record

SAS reads the first data line into the input buffer. The input pointer, which SAS uses
to keep its place as it reads data from the input buffer, is positioned at the beginning of
the buffer, ready to read the data record. The following figure shows the position of the
input pointer in the input buffer before SAS reads the data.

Figure 20.3 Position of the Pointer in the Input Buffer Before SAS Reads Data

Input Buffer

1 2
1234567890123456789012345
(K[n[i |g[h]e]s] [S[ule[ | | [ Jo[ | [8] | [8] []]

'

The INPUT statement then reads data values from t